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CAPITOLO1

Introduzione al Corso

1.1 Premessa

Benvenuto al nostro corso! Ti mostreremo come usare QGIS in modo facile ed efficiente. Se sei nuovo al GIS, ti
diremo cosa ti serve per iniziare. Se sei un utente esperto, vedrai come QGIS presenti tutte le funzioni che ti aspetti
da un programma GIS, e molto altro!

1.1.1 Perché QGIS?

Anche se le informazioni diventano sempre più correlate allo spazio, non c’è carenza di strumenti dotati delle principali
funzioni usate nei GIS. Perché qualcuno dovrebbe usare QGIS invece di altri software GIS?
Queste sono solo alcune ragioni:

• È gratis, senza prezzo. Installare ed utilizzare il programmaQGIS non costa proprio nulla. Nessun costo iniziale,
nessuna rata, niente.

• È libero, come la libertà. Se in QGIS hai bisogno di funzionalità aggiuntive, puoi fare di più che sperare che
siano incluse nella prossima versione. Puoi promuovere lo sviluppo di una funzionalità o puoi aggiungerla te
stesso se sei pratico di programmazione.

• È costantemente in sviluppo. Dato che ognuno può aggiungere nuove funzionalità e migliorare quelle esistenti,
QGIS non si ferma mai. Lo sviluppo di un nuovo strumento può avvenire velocemente quanto la tua necessità.

• È disponibile una documentazione ed un sistema di aiuto esteso. Se sei bloccato con qualcosa, puoi rivolgerti
all’estesa documentazione, agli altri utenti QGIS, o anche agli sviluppatori.

• Multipiattaforma. QGIS può essere installato su macOS, Windows e Linux.
Ora che sai perché vuoi usare QGIS, questi esercizi ti faranno sapere come.
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1.1.2 Background

Nel 2008 abbiamo lanciato la Una breve introduzione al GIS, una risorsa completamente libera, a contenuto
aperto, per persone che vogliono imparare il GIS senza essere sovraccaricate da tecnicismi e nuovi termini. È stata
sponsorizzata dal governo del Sud Africa ed ha avuto un successo straordinario, con persone da tutto il mondo che
ci hanno scritto di come stanno usando il materiale per corsi universitari, per imparare il GIS e così via. La Breve
introduzione non è un corso sul programma, ma vuole essere un testo generico (anche se usiamo QGIS in tutti gli
esempi) per chiunque voglia imparare il GIS. C’è anche il Manuale QGIS che fornisce un’introduzione dettagliata alle
funzionalità dell’applicazione QGIS. Comunque, non è strutturato come un corso, ma come una guida di riferimento.
Alla Linfiniti Consulting CC. teniamo spesso dei corsi ed abbiamo realizzato che era necessaria una terza risorsa -
per guidare il lettore sequenzialmente all’apprendimento degli aspetti chiave di QGIS in una forma insegnante-allievo
- che ci ha indotto a produrre questo lavoro.
Il manuale di formazione intende fornire tutto il materiale necessario per un corso di 5 giorni su QGIS, PostgreSQL
e PostGIS. Il corso è strutturato con contenuti per novizi, utenti intermedi ed avanzati ed ha molti esercizi completi
con risposte commentate in tutto il testo.

1.1.3 Licenza

Il Free Quantum GIS Training Manual by Linfiniti Consulting CC. è basato su una vecchia versione da Linfiniti ed
è autorizzato tramite una Creative Commons Attribution 4.0 International. Permessi oltre lo scopo di questa licenza
possono essere disponibili come segue.
Abbiamo pubblicato questo manuale di istruzione con una licenza libera che ti permette di copiare, modificare e
ridistribuire liberamente questo lavoro. Una copia completa della licenza è disponibile alla fine di questo documento,
le linee guida per l’utilizzo sono come segue:

• Non puoi presentare questo lavoro come fosse tuo, o rimuovere da questo lavoro qualunque testo di paternità
o di accreditamento.

• Non puoi ridistribuire questo lavoro con autorizzazioni più restrittive di quelle con le quali ti è stato fornito.
• Se aggiungi al documento una porzione sostanziale e la dai come contributo al progetto (almeno un modulo
completo) puoi aggiungere il tuo nome alla fine della lista degli autori per questo documento (che apparirà sulla
copertina)

• Se contribuisci con modifiche minori e correzioni, puoi aggiungerti alla lista dei collaboratori di seguito.
• Se traduci questo documento nella sua interezza, puoi aggiungere il tuo nome alla lista degli autori nella forma
«Translated by Joe Bloggs».

• Se promuovi un modulo o una lezione, puoi chiedere all’autore di includere un riconoscimento all’inizio di ogni
lezione sponsorizzata, p.e.:

Nota: Questa lezione è sponsorizzata da MegaCorp.

• Se non sei sicuro di cosa puoi fare entro i termini di questa licenza, contattaci a office@linfiniti.com e ti diremo
se quello che vuoi fare è accettabile.

• Se pubblichi questo documento in un sito editoriale come https://www.lulu.com ti chiediamo di donare i profitti
al progetto QGIS.

• Non puoi commercializzare questo lavoro, se non con l’esplicita autorizzazione degli autori. Per essere chiari,
per commercializzazione intendiamo che non puoi venderlo per profitto, creare dei lavori commerciali derivati
(p.e. vendere il contenuto per utilizzo in articoli su riviste). Eccezione a tutto questo è nel caso tutti i profitti
vengano dati al progetto QGIS. Puoi (e ti incoraggiamo a farlo) usare questo lavoro come libro di testo per corsi
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di istruzione, anche se il corso è di sua natura commerciale. In altre parole, sei benvisto se fai un guadagno
tenendo un costo di istruzione che usa questo lavoro come libro di testo, ma non puoi trarre profitto dalla
vendita del libro stesso - tutti questi profitti dovrebbero essere dati come contributo a QGIS.

1.1.4 Promuovere capitoli

Questo lavoro non è un trattato completo su tutto quello che puoi fare con QGIS e incoraggiamo altri ad aggiungere
nuovi materiali per riempire i vuoti. Linfiniti Consulting CC. può anche creare materiali addizionali per te come
servizio commerciale, con l’intesa che tutto il lavoro prodotto diventerà parte del contenuto e pubblicato sotto la
stessa licenza.

1.1.5 Autori

• Rüdiger Thiede - Rudi ha scritto il materiale didattico di QGIS e parte del materiale di PostGIS.
• Tim Sutton (tim@kartoza.com) - Tim ha supervisionato e guidato il progetto ed è stato coautore delle parti
PostgreSQL e PostGIS. Tim è anche l’autore del tema personalizzato di Sphinx utilizzato per questo manuale.

• Horst Düster (horst.duester@kappasys.ch ) - Horst ha co-prodotto le parti su PostgreSQL e PostGIS
• Marcelle Sutton -Marcelle ha effettuato la correzione delle bozze e la consulenza editoriale durante la creazione
di quest’opera.

1.1.6 Contributi individuali

Il tuo nome qui!

1.1.7 Sponsor

• Cape Peninsula University of Technology

1.1.8 File sorgenti e segnalazione errori

Il sorgente di questo documento è disponibile su GitHub QGIS Documentation repository. Consulta GitHub.com
<https://github.com/>`_ per istruzioni su come utilizzare il sistema di controllo versione di git.
Nonostante i nostri sforzi, seguendo questo corso potresti trovare degli errori o delle omissioni. Per favore segnalali
a https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Ultima versione

Puoi sempre ottenere l’ultima versione di questo documento visitando la versione online che è parte del sito di
documentazione di QGIS (https://docs.qgis.org).

Nota: Il sito di documentazione contiene collegamenti sia alla versione online che alla versione PDF del manuale di
istruzione ed altre parti della documentazione di QGIS.
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1.2 Gli esercizi

Ora che sai perché vuoi usare QGIS, ti mostreremo come.

Avvertimento: Questo corso include istruzioni per aggiungere, cancellare e modificare i dataset GIS. A questo
scopo abbiamo predisposto dei dataset per il corso. Prima di utilizzare le tecniche qui descritte sui tuoi dati,
assicurati di avere sempre una copia!

1.2.1 Come utilizzare questo corso

Ogni testo che appare come questo si riferisce a qualcosa che puoi vedere sull’interfaccia di QGIS.
Il testo che appare ► come ► questo ti indirizza attraverso i menu.
Questo tipo di testo si riferisce a qualcosa che puoi scrivere, come un comando.
This/kind/of.text si riferisce ad un percorso o nome di file.
Questo+Quello si riferisce a scorciatoie di tastiera composte da due tasti.

1.2.2 Obiettivi del corso su più livelli

Questo corso si rivolge ad utenti con diversi livelli di esperienza. A seconda della categoria in cui ti consideri, ti puoi
aspettare diversi risultati. Ogni categoria contiene informazioni indispensabili per la successiva, perciò è indispensabile
fare tutti gli esercizi del tuo livello di esperienza o del livello inferiore.

Base

In questa categoria, il corso presume che tu abbia poca o nessuna esperienza con la teoria dei GIS o l’utilizzo di
software GIS.
Verrà fornita una conoscenza teorica limitata per spiegare lo scopo di un’azione che sarà eseguita nel programma, ma
l’enfasi è posta nell’imparare facendo.
Quando completerai il corso, avrai un’idea migliore delle possibilità dei GIS, e come imbrigliare la loro potenza
usando QGIS.

Intermedio

In questa categoria, si presume che tu abbia una conoscenza basilare ed esperienza nell’uso giornaliero del software
GIS.
Partendo dalle istruzioni per il livello principiante ti daremo una base conosciuta, ed inoltre ti informeremo dei casi
in cui QGIS si comporta in modo leggermente diverso dagli altri software che potresti conoscere. Imparerai anche
come utilizzare in QGIS le funzioni di analisi.
Quando completerai il corso, sarai a tuo agio nell’usare QGIS per tutte le funzioni normalmente necessarie nell’uso
giornaliero.
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Avanzato

In questa categoria, si presume tu abbia esperienza con i software GIS, abbia conoscenza ed esperienza dei database
spaziali, dell’utilizzo di dati su server remoti, forse di scrittura di script per scopi di analisi, ecc.
Partendo dalle istruzioni per gli altri due livelli familiarizzerai con l’approccio seguito dall’interfaccia di QGIS, e
saprai come accedere alle funzioni base di cui hai bisogno. Ti verrà anche mostrato come utilizzare il sistema di
plugin di QGIS, l’accesso ai database, e così via.
Quando completerai il corso, avrai un’ottima conoscenza delle operazioni di routine di QGIS, e delle sue funzioni
avanzate.

1.2.3 Dati

I dati di esempio che accompagnano questo corso sono liberamente disponibili da queste origini:
• Dataset strade e luoghi da OpenStreetMap (https://www.openstreetmap.org/)
• Confini di proprietà (urbani e rurali), corpi idrici da NGI (https://ngi.dalrrd.gov.za/)
• SRTM DEM dal CGIAR-CGI (http://srtm.csi.cgiar.org/)

Scarica il dataset predisposto dal Deposito dati del corso e scompatta il file. Tutti i dati necessari sono forniti nella
cartella exercise_data.
Se sei un istruttore, e vuoi usare dei dati più rilevanti, troverai le istruzioni per creare dei dati locali nell’appendice
Preparazione dei dati per le esercitazioni.
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CAPITOLO2

Module: Creazione ed Esplorazione di una Mappa di Base

In questo modulo, creerai una mappa di base che sarà usata successivamente come punto di partenza per ulteriori
dimostrazioni delle funzionalità di QGIS.

2.1 Lesson: Un’introduzione all’interfaccia

Esploreremo l’interfaccia utente di QGIS in modo che tu avrai familiarità con i menu, le barre degli strumenti, l’area
di mappa e la lista dei layer che formano la struttura di base dell’interfaccia.
Obiettivo di questa lezione: Capire le basi dell’interfaccia utente di QGIS
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2.1.1 Try Yourself: Le Basi

Gli elementi identificati nella figura sopra sono:
1. Lista dei Layer/ Pannello di navigazione
2. Barre degli strumenti
3. Area di mappa
4. Barra di Stato
5. Barra degli Strumenti Laterale
6. Barra localizzazione

La Lista dei Layer

Nella Lista dei Layer, tu puoi vedere una lista, sempre, di tutti i layer disponibili.
Espandere gli elementi ridotti (cliccando la freccia o il simbolo più a fianco ad essi) ti fornirà maggiori informazioni
sull’aspetto attuale del layer.
Passando il mouse sopra il layer vedrai delle informazioni di base: nome del layer, tipo di geometria, sistema di
riferimento per le coordinate e percorso completo del file nel tuo dispositivo.
Il clic con il tasto destro su di un layer ti darà un menu con molte opzioni extra. Userai alcune di esse a breve, per cui
dai uno sguardo!

Nota: Un layer vettoriale è un dataset, di solito uno specifico tipo di oggetto, quale delle strade, degli alberi, ecc. Un
layer vettoriale può essere fatto di punti, di linee o di poligoni.
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Il Pannello di Navigazione

Il Browser QGIS è un pannello di QGIS che consente di navigare facilmente nella tua base dati. Puoi accedere a file
vettoriali comuni (ad esempio file ESRI Shapefile o MapInfo), database (ad esempio PostGIS, Oracle, SpatiaLite,
GeoPackage o MS SQL Server) e connessioni WMS/WFS. Puoi anche visualizzare dati GRASS.
Se hai salvato un progetto, il pannello browser ti dà accesso veloce a tutti i layer salvati nella stessa cartella del progetto
sotto l’elemento Home del progetto.
Inoltre, puoi impostare una o più cartelle come Preferite: cerca nel tuo percorso e quando hai trovato la cartella,
clicca con il tasto destro sulla cartella e poi clicca su Aggiungi come Preferito. Dovresti vedere la tua
cartella nei Preferiti.

Suggerimento: Può accadere che la cartella aggiunta ai Preferiti abbia un nome molto lungo: non preoccuparti,
clicca con il tasto destro sul percorso e scegli Rinomina Preferito... per impostare un nome diverso.

Barre degli strumenti

I tuoi strumenti più spesso utilizzari possono essere visualizzati in barre degli strumenti per un accesso rapido e
semplice. Ad esempio, la barra degli strumenti Progetto consente di salvare, caricare, stampare e avviare un nuovo
progetto. Puoi personalizzare facilmente l’interfaccia per visualizzare solo gli strumenti che utilizzi più spesso,
aggiungendo o rimuovendo le barre degli strumenti come necessario tramite il menu :menuselection: Visualizza –>
Barre degli strumenti.
Anche se non sono visibili in una barra degli strumenti, tutti gli strumenti rimangono accessibili tramite i menu.
Ad esempio, se rimuovi la barra degli strumenti Progetto (che contiene il pulsante Salva), puoi comunque salvare la
mappa facendo clic sul menu Progetto e poi su Salva.

L’Area della Mappa

Qui è dove viene visualizzata la mappa e dove vengono caricati i layer. Nell’area della mappa puoi interagire con i
layer visibili: ingrandire/rimpicciolire, muovere la mappa, selezionare elementi e molte altre operazioni che saranno
viste approfonditamente nelle prossime sezioni.

La Barra di Stato

Mostra informazioni della mappa corrente. Ti permette anche di modificare la scala della mappa, la rotazione e vedere
le coordinate del mouse sulla mappa.

Barra strumenti laterale

Normalmente la barra laterale contiene i pulsanti per caricare il layer e tutti i pulsanti per creare un nuovo layer. Ma
ricorda che puoi muovere le barre strumenti ovunque dove ti sia più comodo.
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Barra localizzatore

Con questa barra puoi accedere a quasi tutti gli oggetti di QGIS: layer, elementi del layer, algoritmi, segnalibri spaziali,
ecc. Controlla tutte le opzioni nella sezione locator_options del Manuale Utente QGIS.

Suggerimento: Con la scorciatoia Ctrl+K puoi accedere facilmente alla barra.

2.1.2 Try Yourself 1

Prova ad identificare i quattro elementi elencati sopra sul tuo scermi, senza far riferimento al diagramma sopra. Vedi
se riesci ad identificare i loro nomi e le loro funzioni. Diventerai più familiare con questi elementi man mano che li
userai nei prossimi giorni.

Soluzione
Fai riferimento all’immagine chemostra il layout dell’interfaccia e verifica se ricordi i nomi e le funzioni degli elementi
nella schermata.

2.1.3 Try Yourself 2

Prova a trovare ciascuno di questi strumenti sul tuo schermo. Qual è il loro scopo?

1.

2.

3.

4. Visualizza

5.

Nota: Se alcuni di questi strumenti non sono visibili sullo schermo, prova ad abilitare alcune barre degli strumenti
che al momento sono nascoste. Tieni anche in mente che se non c’è abbastanza spazio sullo schermo, una barra degli
strumenti può essere accorciata nascondendo alcuni dei suoi strumenti. Puoi vedere gli strumenti nascosti cliccando
sul bottone con la doppia freccia a destra, in ogni barra degli strumenti ridotta.

Soluzione
1. Salva come

2. Zoom a layer

3. Inverti selezione

4. Visualizzazione on/off

5. Misura linea
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2.1.4 What’s Next?

Ora hai familiarizzato con le basi dell’interfaccia di QGIS, nella prossima lezione vedremo come caricare alcuni tipi
comuni di dati.

2.2 Lesson: Aggiungere i primi layer

Lanceremo l’applicazione, e creeremo una mappa di base da usare per gli esempi e gli esercizi.
Obiettivo di questa lezione: Iniziare con una mappa di esempio.

Nota: Prima di iniziare l’esercizio, QGIS deve essere installato sul tuo computer. Inoltre, dovresti aver scaricato i
sample data da utilizzare.

Lancia QGIS dal suo collegamento sul desktop, da voce di menu, ecc., dipende da come hai configurato l’installazione.

Nota: Le immagini dello schermo per questo corso sono state ricavate con QGIS 3.4 in esecuzione su Linux. A
seconda della tua configurazione, lo schermo potrebbe apparire differente. Comunque, sono disponibili gli stessi
pulsanti, e le istruzioni funzioneranno su ogni sistema operativo. Dovresti ricorrere a QGIS 3.4 (l’ultima versione al
momento della redazione) per usare questo corso.

Iniziamo!

2.2.1 Follow Along: Preparare una mappa

1. Apri QGIS. Dovresti avere una nuova mappa in bianco.
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2. La finestra di dialogo Data Source Manager ti permette di scegliere i dati da caricare a seconda del tipo di dati.
Lo userai per caricare il tuo dataset: clicca sul pulsante Apri Gestore delle Sorgenti Dati.
Se non vedi l’icona, controlla che la barra strumenti Gestione della sorgente dati sia abilitata nel menu
Impostazioni ► Barre degli strumenti.

3. Carica il dataset vettoriale protected_areas.shp:
1. Clicca sulla scheda Vettore.

2. Attiva il tipo di sorgente File.
3. Premi il pulsante… vicino a Dataset Vettoriale.
4. Seleziona il file exercise_data/shapefile/protected_areas.shp nella tua cartella degli

esercizi.
5. Clicca su Apri. Vedrai la finestra di dialogo, con il percorso del file immesso.
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6. Qui clicca Aggiungi. I dati che hai indicato saranno caricati: potrai vedere un elemento
protected_areas nel pannello Layer (in basso a sinistra) con i suoi elementi visibili nell’area mappa
principale.
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Congratulazioni! Ora hai una mappa di base. Ora è un buon momento per salvare il tuo lavoro.

1. Clicca sul pulsante Salva Progetto

2. Salva la mappa in una cartella solution vicino alla cartella exercise_data e chiamala basic_map.
qgz.

2.2.2 Try Yourself

Ripeti i passi precedenti per aggiungere alla mappa i vettori places.shp e rivers.shp dalla stessa cartella
(exercise_data/shapefile).

Soluzione
Nell’area principale della finestra di dialogo dovresti vedere molte forme con colori diversi. Ogni forma appartiene a
un layer che puoi identificare dal suo colore nel pannello di sinistra (i tuoi colori potrebbero essere diversi da quelli
sotto)

Fig. 2.1: Una mappa di base

2.2.3 Follow Along: Caricare dati vettoriali da un database GeoPackage

I database permettono di immagazzinare un gran volume di dati fra loro associati in un solo file. Potresti già conoscere
sistemi di gestione dei database (DBMS) come Libreoffice Base o MS Access. Anche le applicazioni GIS possono
far uso di database. DBMS specifici per GIS (come PostGIS) hanno funzioni aggiuntive, perché hanno bisogno di
gestire dati spaziali.
Il formato aperto GeoPackage è un contenitore che permette di immagazzinare dati GIS (vettori) in un singolo file.
Al contrario del formato ESRI Shapefile (p.e. il dataset protected_areas.shp caricato poco fa) un singolo
file GeoPackage può contenere dati diversi (sia vettoriali che raster) in diversi sistemi di coordinate, sia tabelle di
informazioni spaziali; tutte queste caratteristiche permettono di condividere i dati facilmente evitando duplicazioni.
Per caricare un vettore da un GeoPackage, è prima necessario creare la connessione con esso:

1. Clicca sul pulsante Apri Gestore Sorgenti Dati.
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2. Sulla sinistra clicca sulla scheda GeoPackage.
3. Clicca sul pulsante Nuovo e cerca il file training_data.gpkg nella cartella exercise_data

precedentemente scaricata.
4. Seleziona il file e premi Apri. Il percorso del file viene aggiunto alla lista delle connessioni Geopackage, ed

appare nel menu a scomparsa.
Ora puoi aggiungere a QGIS qualunque layer da questo GeoPackage.

1. Clicca sul pulsante Connetti. Nella parte centrale della finestra dovresti vedere la lista di tutti i vettori contenuti
nel file GeoPackage.

2. Seleziona il vettore roads e clicca sul pulsante Aggiungi.

Un vettore roads viene aggiunto al pannello Layer con gli elementi visibili nell’area mappa.
3. Clicca su Chiudi.

Congratulazioni! Hai caricato il primo vettore da un GeoPackage.

2.2.4 Follow Along: Caricare dati vettoriali da un database SpatiaLite Database
con il browser

QGIS dà accesso a molti altri formati di database. Come GeoPackage, il formato database SpatiaLite è un’estensione
della libreria SQLite. L’aggiunta di un vettore da un fornitore SpatiaLite segue le stesse regole sopra descritte: Creare
una connessione –> Abilitarla –> Aggiungere i(l) layer.
Questo è uno dei modi per aggiungere dati SpatiaLite alla tua mappa, esaminiamo un altro potente metodo per
aggiungere dati: il Browser.

1. Clicca sull’icona per aprire la finestra del Data Source Manager.

2. Clicca sulla scheda Browser.
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3. In questa scheda puoi vedere tutti i dischi di archiviazione collegati al tuo computer e le voci per la maggior
parte delle schede a sinistra. Queste permettono un accesso rapido ai database o alle cartelle collegate.

Per esempio, clicca sull’icona a scomparsa vicino all’elemento GeoPackage. Vedrai il file
training-data.gpkg precedentemente connesso (ed i suoi vettori, se espanso).

4. Clicca col tasto destro SpatiaLite e seleziona Nuova connessione….
5. Esplora fino alla cartella exercise_data, seleziona il file landuse.sqlite e clicca Apri.

Nota che è stato aggiunto l’elemento landuse.sqlite sotto SpatiaLite.

6. Espandi l’elemento landuse.sqlite.

7. Fai doppio click sul vettore landuse o seleziona e trascina il vettore sull’area mappa. Un nuovo vettore è
aggiunto al pannello ed i suoi elementi sono mostrati sull’area mappa.

Suggerimento: Abilita il pannello Browser in Impostazioni ► Pannelli ► ed usalo per aggiungere i tuoi dati. È una
scorciatoia per la scheda Gestore sorgente dati ► Browser, con le stesse funzionalità.

Nota: Ricorda di salvare spesso il tuo progetto! Il file del progetto non contiene i dati, ma ricorda quali vettori sono
stati caricati nella mappa.
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2.2.5 Try Yourself Caricare altri dati vettoriali

Carica i seguenti dataset dalla cartella exercise_data nella mappa usando alcuni dei metodi appena visti:
• buildings

• water

Soluzione
La tua mappa dovrebbe avere sette layer:

• protected_areas

• places

• rivers

• roads

• landuse

• buildings (preso da training_data.gpkg) e
• water (preso da exercise_data/shapefile).

2.2.6 Follow Along: Riordinare i Vettori

I vettori nella lista Layer sono disegnati sulla mappa in un determinato ordine. Il vettore in fondo alla lista è disegnato
per primo, e quello in cima per ultimo. Cambiando l’ordine nella lista, cambia l’ordine con cui sono disegnati.

Nota: Puoi modificare questo comportamento usando il checkbox Controllo ordine di visualizzazione sotto il pannello
Ordine Layer. Comunque per il momento non vedremo questa funzione.

In questo momento l’ordine con cui i vettori sono caricati sulla mappa probabilmente non è logico. È possibile che il
vettore roads sia completamente nascosto da altri vettori sopra di esso.
Per esempio, questo ordine dei vettori…

… avrebbe come risultato che roads e places sarebbero nascosti perché finiscono sotto i poligoni del vettore landuse.
Per risolvere il problema:

1. Clicca e trascina un vettore nella lista Layer.
2. Riordinali per ottenere questo:
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Vedrai ora che visualmente la mappa avrà più senso, con roads e buildings visibili sopra i poligoni landuse.

2.2.7 In Conclusion

Ora sono stati aggiunti i vettori necessari da diverse sorgenti ed è stata creata la mappa di base!

2.2.8 What’s Next?

Ora sei familiare con le funzioni base del pulsante Apri Gestore sorgenti dati, e tutti gli altri? Come opera questa
interfaccia? Prima di proseguire, vediamo alcune interazioni di base dell’interfaccia QGIS. Questo è l’argomento
della prossima lezione.

2.3 Lesson: Navigare l’area della mappa

Questa sezione si concentra sugli strumenti di navigazione base di QGIS utilizzati per navigare l’area della mappa.
Questi strumenti permetteranno di esplorare in modo visuale i vettori a diverse scale.
Obiettivo di questa lezione: Imparare ad utilizzare gli strumenti Sposta e Zoom all’interno di QGIS e conoscere la
scala della mappa.

2.3.1 Follow Along: Strumenti di navigazione di base

Prima di imparare come navigare all’interno dell’area mappa, aggiungiamo alcuni vettori da esplorare durante questa
esercitazione.

1. Apri un nuovo progetto vuoto usando i passi già visti in Create a Map, carica nel progetto i vettori già visti
protected_areas, roads e buildings. il risultato dovrebbe essere simile a a quello in Fig. 2.2
riportato di seguito (i colori non hanno importanza):
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Fig. 2.2: Aggiunti areas, roads, e buildings

Vediamo prima come usare lo strumento Sposta.

1. Nella Barra navigazione mappa, assicurati che il pulsante Sposta Mappa sia attivato.
2. Muovi il mouse al centro dell’area mappa.
3. Clicca e tenendo premuto, trascina il mouse in ogni direzione per spostare la mappa.

Poi, ingrandiamo per avere una visione ravvicinata di quello che abbiamo importato.

1. Nella Barra navigazione mappa, clicca sul pulsante Ingrandisci.
2. Muovi il mouse all’angolo superiore sinistro dell’area dove c’è la densità maggiore di edifici e strade.
3. Clicca col pulsante sinistro e tieni premuto.
4. Poi trascina il mouse, che creerà un rettangolo e coprirà l’area densa di edifici e strade (Fig. 2.3).
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Fig. 2.3: Ingrandisci

5. Rilascia il pulsante del mouse. Questo ingrandirà l’area selezionata con il rettangolo.
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6. Per rimpicciolire, seleziona il pulsante Rimpicciolisci ed esegui la stessa azione fatta per ingrandire.
QGIS salva nello storico le azioni di spostamento, ingrandimento e rimpicciolimento. Questo permette di tornare ad
una visualizzazione precedente.

1. Nella Barra navigazione mappa, clicca sul pulsante Zoom Precedente per tornare alla visualizzazione
precedente.

2. Clicca sul pulsante Zoom Successivo per andare avanti nello storico.
A volte dopo aver esplorato i dati, è necessario reinizializzare la visualizzazione per l’estensione di tutti i vettori.
Invece di provare a Rimpicciolire più volte, QGIS mette a disposizione un pulsante per questa azione.

1. Clicca sul pulsante Zoom Completo.
Quando ingrandisci e rimpicciolisci, nota che il valore Scala nella Barra di stato cambia. Il valore Scala rappresenta
la scala della mappa. In generale, il numero a destra di : rappresenta quante volte l’oggetto che stai vedendo nell’area
mappa è più piccolo dell’oggetto reale.
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Puoi anche usare questo campo per impostare manualmente la Scala della mappa.
1. Nella Barra di stato, clicca sul testo Scala.
2. Scrivi 50000 e premi Invio. Questo ridisegnerà gli elementi nell’area della mappa secondo la scala che hai

impostato.
3. In alternativa, clicca sulla freccia del campo Scala per vedere le scale predefinite.

4. Seleziona 1:5000. Questo aggiornerà la scala della mappa nell’area mappa.
Ora conosci le basi della navigazione dell’area mappa. Consulta il Manuale Utente in Zoom e Pan per imparare metodi
alternativi di navigare l’area mappa.

2.3.2 In Conclusion

Conoscere come navigare l’area mappa è importante, permette di esplorare ed esaminare visualmente i vetttori.
Questo dovrebbe essere fatto per un’esplorazione iniziale dei dati, o per verificare il risultato di un’analisi spaziale.

2.4 Lesson: Simbologia

La simbologia di un vettore è il suo aspetto visuale sulla mappa. La forza del GIS rispetto ad altri modi di rappresentare
dati con aspetti spaziali è che con il GIS si ha una rappresentazione visuale dinamica dei dati con cui stai lavorando.
Quindi, l’aspetto visuale della mappa (che dipende dalla simbologia dei singoli vettori) è molto importante. L’utente
finale delle mappe che si producono deve essere in grado di capire semplicemente cosa la mappa rappresenti. È inoltre
molto importante che tu possa essere in grado di esplorare i dati con cui si sta lavorando, ed una buona simbologia
aiuta molto.
In altre parole, avere una buona simbologia non è un lusso. Infatti, è essenziale per te utilizzare il GIS in maniera
adeguata e produrre mappe ed informazioni che gli utenti possano essere in grado di utilizzare.
Obiettivo di questa lezione: Essere in grado di creare qualsiasi simbologia si voglia per qualsiasi vettore.
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2.4.1 Follow Along: Cambiare i colori

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the landuse layer.
1. Right-click on the landuse layer in the layers list.
2. Seleziona l’elemento Proprietà… nel menu che appare.

Nota: Per impostazione predefinita, puoi accedere alle proprietà del vettore tramite doppio clic sul vettore
nella lista dei vettori.

Suggerimento: Il pulsante all’inizio del pannello Layer apre il pannello Simbologia. Puoi usare questo
pannello per cambiare alcune proprietà del vettore: le modifiche vengono applicate immediatamente!

3. Nella finestra Proprietà Layer, seleziona la scheda Simbologia:

4. Clicca il pulsante di selezione colore vicino all’etichetta Colore. Apparirà una finestra di selezione colore
standard.

5. Seleziona un colore grigio e fai clic su OK.
6. Fai nuovamente clic su OK nella finestra Proprietà Layer, e vedrai il cambiamento di colore applicato al vettore.
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2.4.2 Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Soluzione
• Verifica che i colori stiano cambiando come ti aspetti che cambino.

• It is enough to select the water layer in the legend and then click on the Open the Layer Styling panel button.
Change the color to one that fits the water layer.

Se vuoi lavorare solo su un layer alla volta e non vuoi che gli altri layer ti distraggano, puoi nascondere un layer
cliccando sulla casella di controllo accanto al suo nome nell’elenco dei layer. Se la casella è vuota, allora il layer è
nascosto.

2.4.3 Follow Along: Cambiare la Struttura del Simbolo

Tutto questo è molto utile, ma la simbologia di un vettore comprende molto di più che il semplice colore. Vogliamo
ora eliminare le linee tra differenti aree di uso del suolo in modo da rendere la mappa meno ingombra alla vista.

1. Open the Layer Properties window for the landuse layer.

Sotto la scheda Simbologia, vedrai lo stesso tipo di finestra. Questa volta, comunque, farai qualcosa di
più di un veloce cambio di colore.

2. Nell’albero simboli del vettore, espandi la lista a scomparsa Riempimento e seleziona l’opzione Riempimento
semplice.

3. Clicca sulla lista a scomparsa Stile tratto. All’inizio, dovrebbe mostrare una breve linea e le parole Linea
continua.

4. Cambialo con Nessuna linea.
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5. Clicca OK.
Now the landuse layer won’t have any lines between areas.

2.4.4 Try Yourself

• Change the water layer’s symbology again so that it has a darker blue outline.
• Change the rivers layer’s symbology to a sensible representation of waterways.

Ricorda: puoi usare il pulsante Apri il pannello Stile Layer e vedere tutte le modiche istantaneamente. Il pannello ti
permette anche di annullare singole modifiche modificando la simbologia di un vettore.

Soluzione
La tua mappa dovrebbe ora assomigliare a questa:
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Se sei un utente di livello principiante, puoi fermarti qui.
• Usa il metodo di cui sopra per cambiare i colori e gli stili per tutti i layer rimanenti.
• Prova a usare colori naturali per gli oggetti. Per esempio, una strada non dovrebbe essere rossa o blu, ma può
essere grigia o nera.

• Sentiti anche libero di sperimentare con diverse impostazioni Stile riempimento e Stile tratto per i poligoni.
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2.4.5 Follow Along: Visibilità Basata sulla Scala

Alcune volte puoi avere un vettore che non è adatto per una certa scala. Ad esempio, un insieme di dati di tutti i
continenti potrebbe avere poco dettaglio, e non molto accurato a livello di strada. Quando ciò accade, potresti voler
nascondere l’insieme di dati alle scale inappropriate.
Nel nostro caso, possiamo decidere di nascondere gli edifici a scale piccole. Questa mappa, per esempio…

… non è molto utile. Gli edifici sono difficili da distinguere a questa scala.
Per abilitare la visualizzazione basata sulla scala:

1. Open the Layer Properties dialog for the buildings layer.

2. Attiva la scheda Visualizzazione.
3. Abilita la visualizzazione dipendente dalla scala nella casella di controlloVisualizzazione Dipendente dalla Scala

4. Cambia il valore Minimo in 1:10000.

2.4. Lesson: Simbologia 29



QGIS Training Manual

5. Clicca OK.
Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and
reappears.

Nota: Puoi usare la rotella del mouse per aumentare il livello di zoom. Alternativamente, utilizzare gli strumenti di
zoom per fare zoom su una finestra:

2.4.6 Follow Along: Aggiungere Livelli Simbolo

Ora che sai come modificare una simbologia semplice per i tuoi vettori, il passo successivo è creare una simbologia
più complessa. QGIS permette di farlo utilizzando i livelli simbolo.

1. Go back to the landuse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).
In questo esempio, il simbolo corrente non ha bordo (p.e. usa lo stile del bordo Nessuna linea ).
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2. Nell’albero seleziona Riempimento e clicca il pulsante Aggiungi layer simbolo. La finestra cambierà mostrando
qualcosa di simile a questo, con un nuovo simbolo aggiunto:
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Potrà apparire di un colore diverso, per esempio, ma questo sarà cambiato.
Ora c’è un secondo livello di simbolo. Essendo un colore pieno, nasconderà completamente il precedente tipo di
simbolo. Inoltre, ha uno stile di bordo Linea continua, che non vogliamo. Chiaramente questo simbolo deve essere
cambiato.

Nota: È importante non confondere tra un layer di mappa ed un layer di simbolo. Un layer di mappa è un vettore
(o raster) che è stato caricato nella mappa. Un layer di simbolo è parte del simbolo usato per rappresentare il layer
di mappa. In questo corso ci si riferisce al layer di mappa semplicemente con vettore, ma un layer di simbolo sarà
sempre chiamato livello di simbolo, per evitare confusione.

Con il nuovo livello di simbolo Riempimento semplice selezionato:
1. Imposta lo stile del bordo a Nessuna linea, come prima.
2. Cambia lo stile di riempimento in qualcosa di diverso da Pieno o Vuoto. Per esempio:
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3. Clicca OK.
Ora puoi vedere i risultati ed aggiustarli se necessario. Puoi anche aggiungere livelli di simbolo aggiuntivi e creare un
tipo di trama per il tuo vettore.

È divertente! Ma probabilmente ci sono troppi colori per usarlo in una mappa vera…
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2.4.7 Try Yourself

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using
the methods above.

Soluzione
Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on
the map.
Ecco un esempio:

2.4.8 Follow Along: Ordinare i livelli di simbolo

Quando i livelli di simbolo sono visualizzati, sono disegnati in sequenza, in modo simile a come sono disegnati i
vettori di mappa. Questo significa che in alcuni casi, avendo molti livelli di simbolo in un unico simbolo, si possono
avere risultati inaspettati.

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Definisci per la linea base uno Spessore tratto di 1.5 e un colore nero.
3. Definisci per il nuovo livello in alto uno spessore di 0.8 e un colore bianco.

Noterai che succede questo:
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Bene, le strade ora hanno una simbologia tipo strada, ma vedrai che le linee si sovrappongono ad ogni incrocio. Non
è quello che vogliamo!
Per evitare che ciò avvenga, puoi ordinare i livelli di simbolo e perciò controllare l’ordine con cui i diversi livelli di
simbolo vengono disegnati.
Per cambiare l’ordine dei livelli di simbolo:

1. Seleziona il primo livello Linea nell’albero dei livelli di simbolo.
2. Clicca su Avanzato ► Livelli Simbolo… nell’angolo in basso a destra della finestra.
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Si aprirà una finestra come questa:

3. Abilita la casella di controllo Abilita livelli simbolo. Poi puoi impostare l’ordine dei livelli di ogni simbolo
inserendo il corrispondente numero di livello. 0 è il livello più basso.
Nel nostro caso, vogliamo attivare l’opzione, come questa:

Ciò disegnerà la linea bianca sopra gli spessi bordi neri:
4. Clicca OK due volte per ritornare alla mappa.

La mappa apparirà come questa:
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Quando hai fatto, ricorda di salvare il simbolo stesso per non perdere il tuo lavoro se cambi nuovamente il simbolo
in futuro. Puoi salvare lo stile del simbolo corrente cliccando il pulsante Salva Stile… in fondo alla finestra Proprietà
vettore. Useremo il formato QGIS QML Style File.
Salva il tuo stile nella cartella solution/styles/better_roads.qml. Puoi caricare uno stile salvato
precedentemente in ogni momento, cliccando il pulsante Carica Stile…. Prima di cambiare uno stile, tieni a mente
che ogni stile non salvato viene perso.

2.4.9 Try Yourself

Change the appearance of the roads layer again.
Fai le strade gialle e strette, con un sottile contorno grigio tenue e una linea sottile nera nel mezzo. Ricorda che potresti
dover cambiare l’ordine di disegno dei livelli con la finestra Avanzate ► Livelli Simbolo….

Soluzione
Per realizzare il simbolo richiesto, hai bisogno di tre livelli di simbolo:
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Il livello più basso del simbolo è un’ampia linea continua grigia. Sopra di essa c’è una linea continua gialla leggermente
più sottile e infine un’altra linea continua nera più sottile.
Se i tuoi livelli di simbolo assomigliano a quelli di cui sopra, ma non stai ottenendo il risultato che vuoi:

1. Controlla che i tuoi livelli di simbolo abbiano un aspetto simile a questo:

2. Ora la tua mappa dovrebbe apparire così:
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2.4.10 Try Yourself

I livelli di simbolo funzionano anche per i livelli classificati (p.e. livelli con simboli multipli). Dato che non abbiamo
ancora spiegato la classificazione, lavorerai con dei dati elementari pre-classificati.

1. Create a new project and add only the roads dataset.
2. Applica al layer il file di stile advanced_levels_demo.qml fornito in exercise_data/styles.

Questo può essere fatto attraverso il menu a tendina Simbologia► Stile in fondo alla finestra di dialogo Proprietà
layer.

3. Ingrandisci l’area Swellendam.
4. Usando i livelli di simbolo, assicurati che i bordi dei livelli stiano uno dentro l’altro come nell’immagine

seguente:
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Soluzione
1. Regola i tuoi livelli di simbolo su questi valori:

1. Sperimenta con valori diversi per ottenere risultati differenti.
2. Apri di nuovo la tua mappa originale prima di continuare con il prossimo esercizio.
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2.4.11 Follow Along: Tipo di livelli di simbolo

Oltre ad impostare i colori di riempimento ed utilizzare motivi predefiniti, puoi usare tipi di livello di simbolo
completamente diversi. Il solo tipo utilizzato finora è stato il tipo Riempimento semplice. I tipi di livelli di simbolo più
avanzati permettono di personalizzare molto di più i simboli.
Ogni tipo di vettore (punto, linea, e poligono) ha i suoi tipi di livello di simbolo. Prima vedremo i tipi disponibili per
i punti.

Tipi per livello di simbolo punto

1. Uncheck all the layers except for places.
2. Change the symbol properties for the places layer:

3. Puoi accedere ai vari tipi di livello di simbolo selezionando il livello Simbolo semplice nell’albero dei livelli di
simbolo, poi clicca l’elenco a scomparsa Tipo simbolo del vettore:
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4. Esamina le varie opzioni disponibili, e scegli un simbolo con uno stile che ritieni appropriato.
5. Se in dubbio, usa un Simbolo semplice rotondo con un bordo bianco e un riempimento verde tenue, con una

Dimensione 3.00 e uno Spessore tratto di 0.5.

Tipi di livello di simbolo linea

Per vedere la varie opzioni disponibili per i dati linea:
1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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2. Seleziona il livello Simbolo semplice nell’albero dei livelli di simbolo. Cambia le proprietà del simbolo in modo
che corrisponda a questa finestra:
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3. Seleziona il livello Linea di evidenziazione e cambia gli intervalli in 1.00:
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4. Assicurati che i livelli di simbolo siano corretti (usando la finestra Avanzate ► Livelli simbolo usata in
precedenza) prima di applicare lo stile.

Una vota applicato lo stile, controlla il risultato sulla mappa. Come puoi vedere questi simboli cambiano direzione
lungo la strada ma non sempre si piegano con essa. Questo è utile per alcuni scopi, ma non per altri. Se preferisci,
puoi cambiare il livello di simbolo per farlo tornare com’era prima.

Tipi di livello di simbolo poligono

Per vedere le varie opzioni disponibili per i dati poligono:
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Esamina le diverse opzioni nella lista.
3. Scegline una che ritieni adatta.
4. Se in dubbio, usa Riempimento a pattern puntuale con le seguenti opzioni:
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5. Aggiungi un livello di simbolo con un normale Riempimento semplice.
6. Dagli lo stesso blu leggero con un bordo blu scuro.
7. Muovilo sotto il livello di simbolo pattern puntuale con il pulsante Sposta in basso:
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Come risultato, avrai un simbolo a trama per il vettore water, con il vantaggio aggiuntivo che puoi cambiare la
dimensione, forma e distanza dei singoli punti che formano la trama.

2.4.12 Try Yourself

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Soluzione
Ecco degli esempi di struttura dei simboli:
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2.4.13 Follow Along: Simbologia tramite generatore geometria

Puoi utilizzare la simbologia del generatore geometria con tutti i tipi di vettore (punti, linee e poligoni). Il simbolo
risultante dipende direttamente dal tipo di vettore.
In sintesi, la simbologia del generatore di geometria ti consente di eseguire alcune operazioni spaziali usando la
simbologia stessa. Ad esempio, puoi rappresentare un centroide reale sul poligono senza dover creare un livello punto.
Inoltre, hai tutte le opzioni di stile per cambiare l’aspetto del simbolo risultante.
Prova!

1. Select the water layer.
2. Clicca su Riempimento semplice e cambia Tipo simbolo del vettore con Generatore geometria.

50 Capitolo 2. Module: Creazione ed Esplorazione di una Mappa di Base



QGIS Training Manual

3. Prima di iniziare a scrivere l’interrogazione spaziale, devi scegliere il tipo di geometria che vai a realizzare. In
questo esempio creerai centroidi per ogni elemento, quindi cambia il tipo di geometria in Punto / Multipunto.

4. Adesso scrivi l’interrogazione nell’apposito pannello.

centroid($geometry)
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5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a spatial
operation within the layer symbology itself, isn’t that amazing?
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Con la simbologia tramite Generatore geometria puoi oltrepassare i limiti di una normale simbologia.

Try Yourself

Il generatore geometria è un altro livello per i simboli. Prova ad aggiungere un altro Riempimento semplice sotto quello
di Generatore geometria.
Modifica anche l’aspetto del simbolo punto della simbologia del Generatore geometria.
Il risultato finale dovrebbe assomigliare a questo:
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Soluzione

1. Clicca sul pulsante per aggiungere un altro livello di simbolo.

2. Sposta il nuovo simbolo in fondo alla lista cliccando il pulsante .
3. Scegli un buon colore di riempimento per i poligoni water.
4. Clicca su Simbolo del generatore di geometrie della simbologia e cambia il cerchio con un’altra forma come

desideri.
5. Prova a sperimentare altre opzioni per ottenere risultati più efficaci.
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2.4.14 Follow Along: Crea un riempimento SVG personalizzato

Nota: Per fare questo esercizio, devi avere installato il programma di creazione vettoriale gratuito Inkscape.

1. Avvia il programma Inkscape. Vedrai la seguente interfaccia:

Dovresti trovarlo familiare se hai usato altri programmi per immagini vettoriali, come Corel.
Innanzitutto, riduci la pagina a una dimensione appropriata per una piccola trama.

2. Clicca su File ► Proprietà del documento. Avrai la finestra di dialogo Proprietà del documento.
3. Cambia Unità con px.
4. Cambia Larghezza e Altezza a 100.
5. Chiudi la finestra di dialogo quando lo hai fatto.
6. Clicca su Visualizza ► Ingrandimento ► Pagina per vedere la pagina su cui stai lavorando.
7. Seleziona lo strumento Crea circolo:
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8. Clicca e spostati sulla pagina per disegnare un ellisse. Per trasformare l’ellisse in un cerchio, tieni premuto il
pulsante Ctrl mentre lo disegni.

9. Clicca col tasto destro sul cerchio che hai appena creato e apri le relative opzioni Riempimenti e contorni. Puoi
modificare la vista, ad esempio:
1. Cambia il colore Riempimento in un grigio-blu chiaro,
2. Assegna al contorno un colore scuro nella scheda Colore contorno,
3. E riduci lo spessore del bordo nella scheda Stile contorno .
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10. Disegna una linea usando lo strumento Matita:
1. Clicca una volta per iniziare la linea. Tieni premuto Ctrl per avere incrementi di 15 gradi.
2. Muovi i puntatore orizzontalmente e fai un punto con un semplice click.
3. Clicca e scatta sul vertice della linea e traccia una linea verticale, termina con un semplice click.
4. Ora unisci i due vertici terminali.
5. Cambia colore e spessore del simbolo triangolo perché coincida con lo spessore del cerchio e spostalo se

necessario, così avrai un simbolo come questo:
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is
in, under exercise_data/symbols, as SVG file.

In QGIS:
1. Open the Layer Properties for the landuse layer.

2. In the Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill shown
below.

3. Clicca il pulsante… e poi Seleziona File… per selezionare l’immagine SVG.
È aggiunto all’albero dei simboli e puoi personalizzarlo nelle sue caratteristiche (colori, angoli, effetti, unità…).
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Once you validate the dialog, features in landuse layer should now be covered by a set of symbols, showing a
texture like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set
in the layer properties a bigger Texture width.
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2.4.15 In Conclusion

Modificando la simbologia dei diversi vettori abbiamo trasformato un insieme di file di vettori in una mappa leggibile.
Non solo puoi vedere quelle che sta succedendo, è anche piacevole guardarlo!

2.4.16 Further Reading

Esempi di belle mappe

2.4.17 What’s Next?

Modificare i simboli per tutti i vettori è utile, ma l’informazione contenuta in ogni vettore non è ancora disponibile per
chi legge queste mappe. Come sono chiamate le strade? A quale regione amministrativa appartengono determinate
aree? Quali sono le aree delle superfici delle fattorie? Tutte queste informazioni sono ancora nascoste. La prossima
lezione spiegherà come rappresentare questi dati sulla mappa.

Nota: Ti sei ricordato di salvare la mappa di recente?
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Module: Classificare dati vettoriali

Classificare dati vettoriali ti permette di assegnare differenti simboli agli elementi (differenti oggetti nello stesso
layer) in base ai loro attributi. Questo permette a chi utilizzerà la mappa di visualizzare facilmente gli attributi dei
vari elementi.

3.1 Lesson: Dati Attributo dei vettori

I dati vettoriali sono probabilmente il tipo più comune di dati nell’uso giornaliero di un GIS. Il modello vettore
rappresenta la localizzazione e la forma di elementi geografici utilizzando punti, linee e poligoni (e per i dati 3D
anche superfici e volumi), mentre le altre proprietà sono incluse come attributi (in QGIS spesso rappresentati come
una tabella).
Fino ad ora, nessuna delle modifiche fatte alla mappa è stata influenzata dagli oggetti che saranno mostrati. In altre
parole, tutte le aree dei terreni si somigliano, tutte le strade si somigliano. Guardando alla mappa, l’osservatore non
conosce nulla riguardo le strade che sta vedendo; solo che c’è una strada con una certa forma in una determinata area.
Ma la vera forza di un GIS è che tutti gli oggetti che sono visibili sulla mappa hanno anche degli attributi. Le mappe
in un GIS non sono solamente delle immagini. Non rappresentano solo oggetti in località, ma anche informazioni su
quegli oggetti.
Obiettivo di questa lezione: Conoscere la struttura dei vettori dati ed esplorare gli attributi di un oggetto

3.1.1 Follow Along: Visualizzare gli attributi di un vettore

È importante sapere che i dati con cui lavorerai non rappresentano solo dove sono gli oggetti nello spazio, ma dicono
anche cosa sono quegli oggetti.
Dall’esercizio precedente, dovresti aver caricato il vettore protected_areas nella mappa. Se così non fosse,
puoi trovare il dataset in formato ESRI Shapefile protected_areas.shp nella cartella exercise_data/
shapefile.
I poligoni rappresentanti le aree protette costituiscono il dato spaziale, ma possiamo conoscere di più riguardo le
aree protette esplorando la tabella attributi.

1. Nel pannello Layer, clicca sul vettore protected_areas per selezionarlo.
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2. Nel menu Layer, fai clic sul pulsante Apri Tabella Attributi (accessibile anche dai pulsanti delle barre
degli strumenti superiori). Si aprirà una nuova finestra che mostra la tabella degli attributi del layer
protected_areas.

Una riga è chiamata record ed è associata con un elemento nell’area mappa, come un poligono. Una colonna
è chiamata campo (o attributo), ed ha un nome che aiuta a descriverlo, come name o id. I valori nelle celle
sono conosciuti come valori attributo. Queste definizioni sono normalmente usate nei GIS, quindi è bene
familiarizzare con esse.
Nel vettore protected_areas, ci sono due elementi, che sono rappresentati dai due poligoni visibili
nell’area mappa.

Nota: Per capire che cosa rappresentano i campi ed i valori attributo, può essere necessario trovare della
documentazione (o dei metadati) che descrivano il significato dei valori attributo. Questa è di solito disponibile
dal creatore del dataset.

Poi, vedremo come un record nella tabella attributi è collegato ad un elemento poligono che vediamo sull’area mappa.
1. Torniamo indietro alla finestra principale di QGIS.

2. Nel menu Modifica –> Seleziona, fai clic sul pulsante Seleziona Elemento(i).
3. Assicurati che il vettore protected_areas sia ancora selezionato nel pannello Layer.
4. Sposta il mouse sulla area di disegno della mappa e faie clic con il pulsante sinistro del mouse sul poligono più

piccolo dei due. Il poligono diventa giallo per indicare che è stato selezionato.
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5. Torna alla finestra Tabella Attributi e dovresti vedere un record (riga) evidenziato. Si tratta dei valori degli
attributi del poligono selezionato.
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Puoi anche selezionare un elemento usando la Tabella Attributi.
1. Nella finestra Tabella Attributi, all’estrema sinistra, clicca sul numero di riga del record che non è selezionato.

2. Torna alla finestra principale di QGIS e guarda l’area mappa. Dovresti vedere il più grande dei poligoni colorato
di giallo.

3. Per deselezionare l’elemento, vai alla finestra Tabella degli attributi e clicca sul pulsante
Deseleziona tutti gli elementi dal layer.

A volte ci sono molti elementi visibili sull’area mappa e può essere difficoltoso vedere quale elemento è selezionato
dalla Tabella Attributi. Un altro modo per trovare la localizzazione di un elemento è usare lo strumento Lampeggia
Geometria.

1. Nella Tabella Attributi, clicca col tasto destro una qualunque cella della riga con il valore attributo r2855697
nel campo full_id.

2. Nel menu contestuale, clicca su Lampeggia Geometria e guarda l’area mappa.

Dovresti vedere il poligono lampeggiare in rosso. Se non lo vedi, riprova.
Un altro utile strumento è Zoom all’elemento, che dice a QGIS di zoommare all’elemento di interesse.

1. Nella Tabella Attributi, clicca con il tasto destro su una qualunque cella della riga con il valore attributo
r2855697 nel campo full_id.

2. Nel menu contestuale, clicca su Zoom all’elemento
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Guarda l’area di disegno della mappa. Il poligono dovrebbe ora occupare tutta l’estensione dell’area di disegno
della mappa.

Ora puoi chiudere la tabella attributi.

3.1.2 Try Yourself Esplorare gli attributi dei vettori dati

1. Quanti campi sono disponibili nel vettore rivers ?
2. Dicci qualcosa riguardo i punti town nel tuo layer places.
3. Apri la tabella attributi per il vettore places. Quale campo sarà il più utile da rappresentare come etichetta e

perché?

Risposta
• Ci sono 9 campi nel layer rivers:

1. Seleziona il layer nel pannello Layer.

2. Fai clic con il pulsante destro del mouse e scegli Apri Tabella Attributi, oppure premi il pulsante
sulla Barra degli Strumenti relativi agli Attributi (può essere attivata dal menu Visualizza ► Barre degli
strumenti).

3. Conta il numero delle colonne.
Un approccio più rapido potrebbe essere quello di fare doppio clic sul layer rivers, aprire la scheda Proprietà…
► Campi, dove troverai una lista numerata dei campi della tabella.

• Le informazioni sulle town sono disponibili nel layer places. Apri la sua tabella degli attributi come hai fatto con
il layer rivers: ci sono due elementi il cui attributo place è impostato su town: Swellendam e Buffeljagsrivier.
Puoi aggiungere un commento su altri campi di questi due record, se vuoi.

• Il campo name è il più utile da mostrare come etichetta. Questo perché tutti i suoi valori sono univoci per ogni
oggetto ed è molto improbabile che contengano valori NULL. Se i tuoi dati hanno alcuni valori NULL, non
preoccuparti, purché la maggior parte dei tuoi places abbia un name.
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3.1.3 In Conclusion

Ora sai come utilizzare la tabella attributi per vedere quali sono i dati che stai utilizzando. Qualunque dataset ti sarà
utile solo se ha gli attributi che ti interessano. Se conosci quali attributi ti servono, puoi velocemente decidere se
potrai usare un dato dataset, o se devi cercarne un altro con i dati attributi necessari.

3.1.4 What’s Next?

Attributi diversi sono utili per scopi diversi. Alcuni di loro possono essere rappresentati direttamente come testo
perché l’utilizzatore della mappa li possa vedere. Imparerai come fare nella prossima lezione.

3.2 Lesson: Etichette

Le etichette possono essere aggiunte ad una mappa per mostrare qualunque informazione di un oggetto. Qualunque
vettore può avere delle etichette associate. Queste etichette prendono il contenuto dagli attributi dati del vettore.
Obiettivo di questa lezione: Applicare ad un vettore delle etichette utili e di bell’aspetto.

3.2.1 Follow Along: Utilizzare le etichette

Prima, assicurati che il pulsante sia visibile nella GUI.
1. Vai all’elemento di menu Visualizza ► Barre degli strumenti

2. Assicurati che l’elemento Barra delle etichette abbia il segno di spunta vicino. Se non lo ha, clicca sull’elemento
Barra delle etichette per attivarlo.

3. Clicca sul vettore places nel pannello Layer in modo che sia evidenziato
4. Clicca sul pulsante sulla barra strumento per aprire la scheda Etichette del pannello Stile Layer

5. Cambia da Non mostrare etichette a Etichette Singole

Devi scegliere quale campo fra gli attributi dev’essere usato per le etichette. Nella lezione precedente, hai deciso
che il campo name era quello più adatto a questo scopo.

6. Seleziona name dalla lista Valore:
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7. Clicca su Applica

La mappa ora dovrebbe avere etichette come questa:
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3.2.2 Follow Along: Cambiare le opzioni dell’etichetta

A seconda degli stili che hai scelto per la mappa nelle lezioni precedenti, potresti trovare che le etichette non sono
formattate correttamente e potrebbero sovrapporsi o essere troppo lontane dal loro simbolo.

Nota: Prima, hai usato il pulsante nella Barra etichette per aprire il pannello Stile Layer. Come per la Simbologia,
le stesse opzioni per le etichette sono disponibili sia tramite il pannello Stile Layer sia con la finestra di dialogoProprietà
Layer. Qui userai la finestra di dialogo Proprietà Layer.

1. Apri la finestra di dialogo Proprietà… layer facendo doppio clic sul vettore places
2. Seleziona la scheda Etichette
3. Assicurati che sia selezionato Testo dalla lista delle opzioni a sinistra, poi modifica le opzioni di formattazione

del testo in modo che corrispondano a quelle mostrate qui:
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4. Clicca su Applica

Quel carattere può essere maggiore e più familiare agli utenti, ma la sua leggibilità è ancora dipendente da
quali vettori sono disegnati sotto di esso. Per rimediare, dai un’occhiata all’opzione Buffer.

5. Seleziona Buffer dalla lista di opzioni a sinistra
6. Seleziona la casella di controllo Disegna buffer del testo, poi scegli le opzioni come mostrate qui:
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7. Clicca su Applica

Vedrai che questo aggiunge un buffer o bordo colorato alle etichette, rendendole più visibili sulla mappa:
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Ora possiamo affrontare il posizionamento delle etichette in relazione ai loro simboli.
8. Seleziona Posizionamento dalla lista di opzioni a sinistra
9. Seleziona Intorno al punto e cambia il valore di Distanza in 2.0Millimetri:
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10. Clicca su Applica

Vedrai che le etichette non si sovrappongono più con i loro simboli.

3.2.3 Follow Along: Usare etichette invece di simboli layer

Inmolti casi, la posizione di un punto non deve essere troppo precisa. Per esempio, molti dei punti nel vettoreplaces
si riferiscono ad intere città o sobborghi, ed il punto associato con questo elemento non è così preciso a larga scala.
Infatti, dare un punto troppo preciso può rendere confusa la mappa a qualche lettore.
Per fare un esempio: in una mappa del mondo, il punto dato per l’Unione Europea potrebbe essere in qualche parte
della Polonia, per esempio. Per un lettore della mappa, vedendo un punto chiamato Unione Europea in Polonia, può
sembrare che la capitale dell’Unione Europea sia in Polonia.
Quindi, per prevenire questo tipo di equivoco, è spesso utile disattivare i punti simbolo e rimpiazzarli completamente
con etichette.
In QGIS, può essere fatto cambiando la posizione delle etichette perché vengano disegnate sopra i punti a cui si
riferiscono.

1. Apri la scheda Etichette della finestra di dialogo Proprietà Layer per il vettore places
2. Seleziona l’opzione Posizionamento dalla lista di opzioni
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3. Clicca sul pulsante Offset dal punto
Questo mostrerà le opzioni di Quadrante che puoi usare per impostare la posizione dell’etichetta in relazione
al simbolo. In questo caso, vogliano che l’etichetta sia centrata sul simbolo, quindi scegli il quadrante centrale:

4. Nascondi il simbolo modificando la Simbologia del vettore come al solito, e imposta la dimensione del Simbolo
in 0.0:
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5. Clicca Applica e dovresti vedere questo risultato:
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Se rimpicciolisci la mappa, dovresti vedere che alcune etichette scompaiono a scale maggiori per evitare
sovrapposizioni. Qualche volta è ciò che si vuole quando si ha a che fare con dataset con molti punti, ma altre volte
così si possono perdere informazioni. Per gestire casi come questo c’è un’altra possibilità, che vedremo in un esercizio
più avanti nella lezione. Per ora, rimpicciolisci e clicca sul pulsante nella barra strumenti e vedi cosa succede.

3.2.4 Try Yourself Personalizzare le etichette

• Ripristina l’etichetta ed il simbolo in modo da avere un simbolo semplice e un’etichetta con un offset di 2.0
Millimetri.

Soluzione
La tua mappa dovrebbe ora mostrare i punti di marcatura e le etichette dovrebbero essere spostate di 2mm. Lo stile
dei marcatori e delle etichette dovrebbe permettere ad entrambi di essere chiaramente visibili sulla mappa:
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• Imposta la scala della mappa a 1:100000. Puoi farlo scrivendolo nel box Scala nella Barra di Stato. Modifica
le etichette perché siano visibili a questa scala.

Soluzione
Una possibile soluzione ha questo risultato finale:
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Per arrivare a questo risultato:
• Usa una dimensione del carattere di 10.
• Utilizza una distanza di posizionamento del punto di circa 1,5 mm.
• Usa un marcatore di dimensioni 3.0 mm.
• Inoltre, questo esempio usa l’opzione A capo con il carattere:
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• Inserisci uno spazio in questo campo e clicca su Applica per ottenere lo stesso effetto. Nel nostro caso, alcuni
dei nomi dei luoghi sono molto lunghi, risultando in nomi con linee multiple che non è molto facile da usare.
Potresti trovare questa impostazione più appropriata per la tua mappa.
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3.2.5 Follow Along: Etichettare linee

Ora che sai come funzione l’etichettatura, c’è un problema in più. Punti e poligoni sono facili da etichettare, ma le
linee? Se le etichetti allo stesso modo dei punti, il risultato potrebbe essere come questo:

Ora riformatteremo le etichette del vettore roads in modo che siano facili da comprendere.
1. Nascondi il vettore places in modo che non ti distragga
2. Attiva Etichette Singole per il vettore roads come fatto in precedenza con places
3. Imposta la Dimensione carattere a 10 così puoi vedere più etichette
4. Ingrandisci l’area della città Swellendam
5. Nella scheda Posizionamento della scheda Etichette, imposta i seguenti valori:
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Probabilmente troverai che lo stile del testo è stato impostato con valori predefiniti e le etichette sono difficili
da leggere. Modifica Testo per usare un Colore grigio scuro a nero e Buffer con un Color giallo chiaro.
La mappa apparirà simile a questa, dipende dalla scala:
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Vedrai che i nomi delle strade appariranno più di una volta e non è sempre necessario. Per evitare che avvenga:
6. Nella scheda Etichette della finestra di dialogo Proprietà…, scegli l’opzione Visualizzazione e seleziona Fondi

(merge) le linee connesse per evitare la duplicazione delle etichette come mostrato:
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7. Clicca su OK

Un’altra utile funzione serve per evitare la visualizzazione di etichette per elementi troppo corti per essere
notati.

8. Nello stesso pannello Visualizzazione, imposta il valore di Elimina etichettatura degli elementi più piccoli di a
5.00 mm e nota il risultato quando clicchi su Applica

Prova anche diverse impostazioni di Posizionamento. Come abbiamo visto prima, l’opzione Orizzontale in
questo caso non è una buona idea, quindi proviamo l’opzione Curvato.

9. Seleziona l’opzione Curvato nel pannello :guilabel: Posizionamento della scheda :guilabel: Etichette.
Ecco il risultato:
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Come puoi vedere, questo nasconde alcune etichette che erano visibili, per la difficoltà di renderle leggibili seguendo
le curve delle strade. Questo rende le altre etichette più utili perché seguono le strade invece di fluttuare nello spazio
fra di loro. Puoi decidere quale di queste opzioni usare, a seconda di cosa pensi sia più utile o appaia migliore.

3.2.6 Follow Along: Impostazioni definite dai dati

1. Disattiva l’etichettatura per il vettore roads
2. Riattiva l’etichettatura per il vettore places

3. Apri la tabella attributi per places con il pulsante
C’è un campo che ora ci interessa: place che definisce il tipo di area urbana per ogni record. Possiamo usare
questo dato per influenzare lo stile dell’etichetta.

4. Scorri fino al pannello Testo nel pannello Etichette di places

5. Clicca il pulsante vicino al pulsante Corsivo sotto a Stile e seleziona Modifica… per aprire il Costruttore
stringhe espressione:
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6. Sotto Campi e valori, fai doppio clic su place e poi clicca Tutti i Valori Univoci. Questo elencherà tutti i valori
univoci del campo place di questo vettore. Aggiungi un = nell’editor di testo e poi fai doppio clic su town.
Alternativamente, puoi scrivere direttamente "place" = 'town' nell’editor di testo.

7. Clicca OK due volte:

Nota che tutte le etichette per i luoghi il cui campo place è pari a town sono mostrate in corsivo.
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3.2.7 Try Yourself Usare le impostazioni definite dai dati

Nota: Facciamo un salto in avanti per mostrare alcune impostazioni avanzate per l’etichettatura. Al livello avanzato,
si presume che tu conosca il significato di quello che segue. Se non è così, puoi saltare questa sezione e tornarci più
tardi quando si è visto il materiale necessario.

1. Apri la la Tabella Attributi per places

2. Entra in modalità modifica cliccando il pulsante

3. Aggiungi una nuova colonna con il pulsante
4. Configuralo come questo:
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5. Usa questo per personalizzare le dimensioni dei caratteri per differenti tipi di luoghi (ogni chiave nel campo
place)

Soluzione
1. Sempre in modalità modifica, imposta i valori di FONT_SIZE a quello che preferisci. L’esempio usa 16 per

le town, 14 per i suburb, 12 per le locality e 10 per le hamlet.
2. Ricordati di salvare le modifiche e di uscire dalla modalità di modifica

3. Torna alle opzioni di formattazione di Testo per il layer places e seleziona in:guilabel:Dimensione
Sovrascrittura definita dai dati, opzione Assistente in Ingresso seleziona FONT_SIZE :

Il tuo risultato, se usi i valori di cui sopra, dovrebbero essere questo:
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3.2.8 Ulteriori possibilità con l’etichettatura

In questo corso non possiamo vedere tutte le opzioni, ma stai certo che la scheda Etichette ha molte altre utili funzioni.
Puoi impostare la visualizzazione basata sulla scala, modificare la priorità di visualizzazione delle etichette in un
vettore, ed impostare ogni opzione di etichetta usando gli attributi del vettore. Puoi anche impostare rotazione, la
posizione XY, ed altre proprietà di un’etichetta (se hai dei campi attributi assegnati per lo scopo), quindi modifica
queste proprietà usando gli strumenti al pulsante principale Opzioni per le Etichette del layer:

(Questi strumenti saranno attivi se i necessari campi attributo esistono e sei in modalità modifica.)
Sentiti libero di esplorare altre possibilità del sistema di etichettatura.
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3.2.9 In Conclusion

Hai imparato come utilizzare gli attributi del vettore per creare etichette dinamiche. Questo può rendere la tua mappa
più informativa ed elegante!

3.2.10 What’s Next?

Ora che sai come gli attributi possono fare la differenza visiva per la tua mappa, perché non utilizzarli per cambiare
la simbologia dell’oggetto stesso? Questo è l’argomento della prossima lezione!

3.3 Lesson: Classificazione

L’etichettatura è un buon metodo per comunicare informazione come i nomi di singoli luoghi, ma non può essere
usata per ogni cosa. Per esempio, mettiamo che qualcuno voglia sapere per cosa viene usata ogni area di landuse.
Utilizzando le etichette, si otterrebbe questo:

Questo rende la mappa difficile da leggere ed anche sovraccaricata se ci sono numerose aree landuse sulla mappa.
Obiettivo di questa lezione: Imparare come classificare efficacemente i dati vettore.

3.3.1 Follow Along: Classificare i dati nominali

1. Apri la finestra di dialogo Proprietà… per il vettore landuse
2. Vai alla scheda Simbologia

3. Clicca sulla lista a scomparsa che dice Simbolo Singolo e cambialo in Categorizzato:
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4. Nel nuovo pannello, cambia Value in landuse e la Scala colore in Random colors

5. Clicca il pulsante etichettato Classifica

6. Clicca su OK

Vedrai qualcosa simile a questo:
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7. Clicca la freccia (o segno più) vicino a landuse nel pannello Layer, vedrai le categorie elencate:
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Ora i poligoni landuse sono colorati e classificati in modo che aree con lo stesso utilizzo hanno lo stesso colore.
8. Se vuoi, puoi cambiare il simbolo di ogni area facendo doppio clic sul blocco colore relativo nel pannello Layer

o nella finestra di dialogo Proprietà… del layer:
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Nota che c’è una categoria vuota:
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Questa categoria vuota è usata per colorare tutti gli oggetti che non hanno il valore landuse definito o che hanno
un valore NULL. Può essere utile tenere questa categoria vuota così le aree con un valore NULL vengono ancora
rappresentate sulla mappa. Puoi voler cambiare il colore in qualcosa di più rappresentativo per un valore NULL.
Ricorda di salvare la mappa ora così non perdi tutte le modifiche duramente ottenute!

3.3.2 Try Yourself Ancora classificazione

Utilizza quanto imparato per classificare il vettore buildings. Imposta la categorizzazione in base al campo
building e usa una scala colore Spectral.

Nota: Ricorda di ingrandire l’area urbana per vedere i risultati.

3.3.3 Follow Along: Classificazione proporzionale

Ci sono quattro tipo di classificazione: nominale, seriale, intervallo e proporzionale.
Nella classificazione nominale, le categorie in cui vengono classificati gli oggetti sono basate sul nome; non sono
ordinate. Per esempio: nomi di città, codici distrettuali, ecc. I simboli utilizzati per dati nominali non dovrebbero
implicare un ordinamento o grandezza.

• Per i punti, possiamo usare simboli di diverse forme.
• Per i poligoni, possiamo usare diversi tipi di tratteggio o diversi colori (evitando di mescolare colori chiari e
scuri).

• Per le linee, possiamo usare diversi tratteggi, diversi colori (evitando di mescolare colori chiari e scuri) e diversi
simboli lungo le linee.

Nella classificazione seriale, le categorie sono organizzate in un determinato ordine. Per esempio, alle città del mondo
viene dato un punteggio dipendente dalla loro importanza per il commercio mondiale, viaggi, cultura, ecc. I simboli
utilizzati per dati ordinali dovrebbero implicare un ordine, ma non una grandezza.
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• Per i punti, possiamo usare simboli con colori dal chiaro allo scuro.
• Per i poligoni, possiamo usare gradienti di colori (dal chiaro allo scuro).
• Per le linee, possiamo usare gradienti di colori (dal chiaro allo scuro).

Nella classificazione intervallo, i numero sono in una scala con valori positivi, negativi e zero. Per esempio: altezza
sopra/sotto il livello del mare, temperatura in gradi. I simboli utilizzati per i dati di intervallo dovrebbero implicare
un ordine e una grandezza.

• Per i punti, possiamo usare simboli con dimensione variabile (da piccolo a grande).
• Per i poligoni, possiamo usare gradienti di colore (dal chiaro allo scuro) o aggiungere diagrammi di varia
grandezza.

• Per le linee, possiamo usare lo spessore (da sottile a spesso).
Nella classificazione proporzionale, i numeri sono in una scala con valori solo positivi o zero. Per esempio:
temperatura sopra lo zero assoluto (0 gradi Kelvin), distanza da un punto, il traffico medio per mese in una data
strada, ecc. I simboli utilizzati per dati proporzionali dovrebbero implicare un ordine e una grandezza.

• Per i punti, possiamo usare simboli con dimensione variabile (da piccolo a grande).
• Per i poligoni, possiamo usare gradienti di colore (dal chiaro allo scuro) o aggiungere diagrammi di varia
grandezza.

• Per le linee, possiamo usare lo spessore (da sottile a spesso).
Nell’esempio precedente, abbiamo usato la classificazione nominale per colorare ogni record nel vettore landuse in
base al suo attributo landuse. Ora useremo la classificazione proporzionale per classificare i record in base all’area.
Stiamo per riclassificare il vettore, quindi le classi esistenti andranno perse se non salvate. Per memorizzare la
classificazione corrente:

1. Apri la finestra di dialogo proprietà del vettore
2. Clicca sul pulsante Salva Stile … nel menu a scomparsa Stile.
3. Seleziona Rinomina stile corrente…, inserisce land usage e premi OK.

Le categorie ed i loro simboli sono salvate nelle proprietà del vettore.
4. Ora clicca sulla voce Aggiungi… del menu a scomparsa Stile e crea un nuovo stile chiamato ratio. Questo

memorizzerà la nuova classificazione.
5. Chiudi la finestra di dialogo Proprietà Layer

Vogliamo classificare le aree landuse in base alla dimensione, ma c’è un problema: non hanno campo dimensione,
quindi dobbiamo farne uno.

1. Apri la Tabella Attributi per il vettore landuse.

2. Entra in modalità modifica cliccando il pulsante Attiva modifiche

3. Aggiungi una nuova colonna di tipo decimale, chiamata AREA, usando il pulsante Nuovo campo

4. Clicca su OK
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Il nuovo campo sarà aggiunto (all’estrema destra della tabella; potresti dover scorrere orizzontalmente per
vederlo). Comunque, al momento non è popolato, ha tutti valori NULL.
Per risolvere il problema, dobbiamo calcolare le aree.

1. Apri il calcolatore di campo con il pulsante .
Vedrai questa finestra di dialogo:

2. Clicca Aggiorna un campo esistente

3. Seleziona AREA nel menu a scomparsa dei campi
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4. Sotto la scheda Espressione. espandi il gruppo funzioni Geometria dalla lista e trova $area
5. Fai doppio click su di esso in modo che appaia nel campo Espressione

6. Clicca su OK

7. Scorri al campo AREA nella tabella attributi e noterai che è stato popolato con i valori (potresti dover
cliccare sull’intestazione di colonna per aggiornare i dati).

Nota: Queste aree rispecchiano le impostazioni per le unità di misura del progetto, quindi possono apparire
in metri quadrati e gradi quadrati.

5. Premi per salvare le modifiche ed esci dalla modalità modifica con Attiva modifiche

6. Chiudi la tabella attributi
Ora che abbiamo i dati, utilizziamoli per rappresentare il vettore landuse.

1. Apri la scheda Simbologia della finestra di dialogo Proprietà Layer per il vettore landuse
2. Cambia lo stile di classificazione da Categorizzato a Graduato

3. Cambia il Valore in AREA
4. Sotto Scala colore, scegli l’opzione Crea Nuova Scala Colore…:
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5. Scegli Gradiente (se non è già selezionata) e clicca OK. Vedrai questo:
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Useremo questo per denotare l’area, piccole aree con Colore 1 e grandi aree con Colore 2.
6. Scegli dei colori appropriati

Nell’esempio, il risultato è come questo:
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7. Clicca su OK

8. Puoi salvare la scala di colori selezionando Salva Scala Colore… sotto Scala colore. Scegli un nome appropriato
per la scala e clicca Salva. Ora sarai in grado di selezionare la stessa scala di colori in Tutte le Scale Colore.

9. In Modalità scegli Conteggio uguale (quantile) .
10. Clicca Classifica

Ora dovresti avere qualcosa come questo:
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Lascia tutto il resto com’è.
11. Clicca OK:
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3.3.4 Try Yourself Affinare la classificazione

• Cambia i valori di Modalità e Classi finché avrai una classificazione che abbia senso.

Soluzione
Le impostazioni che hai usato potrebbero non essere le stesse, ma con i valori Classi = 6 e Modalità = Intervalli
Naurali (Jenks) (e usando gli stessi colori, ovviamente), la mappa sarà come questa:

3.3.5 Follow Along: Classificazione basata su regole

È spesso utile combinare criteri multipli per una classificazione, ma sfortunatamente la classificazione normale tiene
conto di un solo attributo. Qui viene in aiuto la classificazione basata su regole.
In questa lezione, rappresenteremo il vettorelanduse inmodo da identificare facilmente la città Swellendam rispetto
le altre aree residenziali, e dagli altri tipi di landuse (in base alla loro area).

1. Apri la finestra di dialogo Proprietà… per il vettore landuse
2. Vai alla scheda Simbologia

3. Cambia lo stile di classificazione in Tramite regole

QGIS mostra automaticamente le regole che rappresentano la classificazione attuale implementata per questo
vettore. Per esempio, dopo aver completato l’esercizio precedente, dovresti avere qualcosa come questo:
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4. Clicca e trascina per selezionare tutte le regole

5. Usa il pulsante Rimuovi regole selezionate per rimuovere tutte le regole esistenti
Ora aggiungiamo le nostre regole.

1. Clicca il pulsante Aggiungi regola

2. Appare il dialogo Edit rule

3. Inserisci Swellendam city come Etichetta

4. Clicca il pulsante vicino all’area di testo Filtro per aprire il Costruttore stringhe espressione
5. Inserisci il criterio "name" = 'Swellendam' e conferma

6. Tornando alla finestra di dialogo Modifica regola, assegna un colore grigio-blu più scuro per indicare
l’importanza della città nella regione e rimuovi il bordo
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7. Premi OK
8. Ripeti i passi precedente per aggiungere le seguenti regole:

1. Etichetta Other residential con il criterio "landuse" = 'residential' AND "name" <>
'Swellendam'. Scegli un colore blu-grigio pallido Colore di riempimento

2. Etichetta Big non residential areas con criterio "landuse" <> 'residential' AND "AREA"
>= 605000. Scegli un colore verde medio.

Questi filtri sono escludenti, nel senso che escludono aree della mappa (aree non residenziali che sono più
piccole di 605000 (metri quadrati) e non incluse in altre regole).

3. Comprenderemo gli elementi rimanenti utilizzando una nuova regola etichettata Small non residential
areas. Invece di un’espressione filtro, seleziona Else. Dai a questa categoria un colore verde tenue.
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Le tue regole dovrebbero apparire così:

9. Applica la simbologia
La tua mappa dovrebbe apparire come questa:
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Ora hai una mappa con Swellendam area residenziale principale e altre aree non residenziali colorate in base alla loro
dimensione.

3.3.6 In Conclusion

La simbologia ci permette di rappresentare gli attributi di un vettore in un modo facile da leggere. Permette a noi
ed al lettore della mappa di comprendere il significato degli elementi, utilizzando gli attributi rilevanti che abbiamo
scelto. A secondo del problema che affronti, applicherai diverse tecniche di classificazione per risolverlo.

3.3.7 What’s Next?

Ora abbiamo una bella mappa, ma come faremo per averla fuori da QGIS in un formato che possa essere stampato,
o farlo diventare un’immagine o un PDF? È l’argomento della prossima lezione!
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CAPITOLO4

Module: Vestizione e Stampa delle Mappe

In questo modulo, imparerai come usare il gestore del layout di stampa di QGIS per produrre mappe di qualità con
tutti i componenti richiesti.

4.1 Utilizzare il layout di stampa

Ora che hai una mappa, devi essere in grado di stamparla o esportarla in un documento. Il motivo è che un file di
mappa GIS non è un’immagine. Piuttosto, salva lo stato del programma GIS, con riferimenti a tutti i layer, le loro
etichette, colori, ecc. Quindi per qualcuno che non ha i dati o lo stesso programma GIS (come QGIS), il file di mappa
sarà inutile. Fortunatamente, QGIS può esportare il suo file di mappa in un formato che ogni altro computer può
leggere, oppure può stampare la mappa se connesso ad una stampante. Sia l’esportazione che la stampa è gestita
tramite il Layout di stampa.
Obiettivo di questa lezione:Usare il Layout di stampa di QGIS per creare una mappa base con tutte le impostazioni
richieste.

4.1.1 Follow Along: Il gestore dei layout

QGIS ti permette di creare mappe multiple usando lo stesso file di mappa. Per questa ragione, ha uno strumento
chiamato Gestore dei Layout.

1. Fai clic sulla voce di menu Progetto ► Gestore dei Layout… per aprire questo strumento. Vedrai apparire una
finestra di dialogo vuota del Gestore dei Layout.
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2. Sotto Nuovo da Modello, seleziona Layout vuoto e premi il pulsante Crea… .
3. Dai al nuovo layout il nome di Swellendam e clicca su OK.
4. Ora vedrai la finestra Layout di stampa :

Puoi anche creare questo nuovo layout tramite il menu Progetto ► Nuovo Layout di Stampa….
Qualunque strada tu prenda, il nuovo layout di stampa è ora accessibile dal menu Progetto ► Layout ►, come
nell’immagine qui sotto.
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4.1.2 Follow Along: Composizione della mappa base

In questo esempio, la composizione è già indirizzata come vogliamo. Assicurati che lo sia anche la tua.
1. Fai clic destro sul foglio nella parte centrale della finestra del layout e scegli Proprietà pagina… nel menu

contestuale.
2. Controlla che i valori nella scheda Proprietà dell’oggetto siano impostati come segue:

• Dimensione: A4
• Orientazione: Orizzontale

Ora hai il layout di pagina come voluto, ma questa pagina è ancora vuota. Chiaramente manca una mappa.
Provvediamo!

3. Clicca sul pulsante Aggiungi Mappa.
Con questo strumento attivato, potrai piazzare una mappa sulla pagina.

4. Clicca e trascina a formare un rettangolo sulla pagina vuota:
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La mappa apparirà sulla pagina.
5. Muovi la mappa cliccando e trascinandola:

6. Ridimensionala cliccando e trascinando i riquadri sui bordi:
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Nota: Naturalmente, la tua mappa apparirà diversa! Questo dipende da come è impostato il tuo progetto. Ma
non preoccuparti! Queste istruzioni sono generiche, quindi funzioneranno ugualmente indipendentemente da
come appare la mappa.

7. Assicurati di lasciare dei margini lungo i bordi, e una spazio in alto per il titolo.
8. Ingrandisci e rimpicciolisci la pagina (ma non la mappa!) usando questi pulsanti:

9. Usa lo zoom e sposta la mappa nella finestra principale di QGIS. Puoi anche spostare la mappa usando lo
strumento Sposta il contenuto dell’oggetto.
La vista della mappa si aggiorna quando ingrandisci o rimpicciolisci.

10. Se, per qualsiasi ragione, la visualizzazione della mappa non viene aggiornata correttamente, puoi forzare
l’aggiornamento della mappa cliccando il pulsante Aggiorna vista.
Ricorda che la dimensione e posizione che hai dato alla mappa non deve essere necessariamente quella finale.
Puoi sempre tornare indietro e cambiarla se non ti soddisfa. Per il momento, devi assicurarti di aver salvato il
tuo lavoro su questa mappa. Siccome un Layout di stampa in QGIS è parte del file di mappa principale, devi
salvare il progetto.

11. Vai inLayout► Salva Progetto. Questa è una comoda scorciatoia a quella della finestra di dialogo principale.
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4.1.3 Follow Along: Aggiungere un titolo

Ora la tua mappa appare bene sulla pagina, ma ai tuoi lettori/utilizzatori non viene ancora detto che sta succedendo.
Hanno bisogno di qualche contesto, che è quello che darai aggiungendo alcuni elementi. Primo, aggiungiamo un titolo.

1. Clicca sul pulsante Aggiungi Etichetta

2. Clicca sulla pagina, sopra la mappa, accetta i valori suggeriti nella finestra di dialogo Proprietà Oggetto, e
un’etichetta apparirà in cima alla mappa.

3. Ridimensionala e posizionala al centro in alto sulla pagina. Può essere ridimensionata e spostata nello stesso
modo fatto per la mappa.
Quando muovi il titolo, noterai apparire delle linee guida per aiutarti a posizionare il titolo al centro della
pagina.
Comunque, c’è anche uno strumento nella Barra delle Azioni per aiutarti a posizionare il titolo rispetto la mappa
(non la pagina):

4. Clicca la mappa per selezionarla
5. Tieni premuto il tasto Maiuscolo sulla tastiera e clicca sull’etichetta così sia la mappa che l’etichetta sono

selezionate.

6. Cerca il pulsante Allinea a sinistra oggetti selezionati e clicca sulla freccetta vicino per far apparire le opzioni di
posizionamento e clicca Allinea al Centro:

Ora la cornice dell’etichetta è centrata sulla mappa, ma non il suo contenuto. Per centrare i contenuti
dell’etichetta:
1. Seleziona l’etichetta cliccandoci sopra.
2. Clicca sulla scheda Proprietà dell’oggetto nel pannello laterale della finestra layout.
3. Cambia il testo dell’etichetta in «Swellendam»:
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4. Usa questa interfaccia per impostare le opzioni carattere e allineamento sotto la sezione Aspetto:
1. Scegli un carattere grande ma adeguato (l’esempio userà il carattere predefinito con una dimensione

di 36)
2. Imposta Allineamento orizzontale a Centro.

Puoi anche cambiare il colore del carattere, ma probabilmente è meglio tenere il colore nero predefinito.
5. L’impostazione predefinita è di non aggiungere una cornice al testo del titolo. Comunque, se vuoi

aggiungere una cornice, puoi fare così:
1. Nella scheda Proprietà dell’oggetto, scorri verso il basso finché vedi l’opzione Cornice.
2. Clicca la casella di spunta Cornice per abilitare la cornice. Puoi anche cambiare il colore e lo spessore

della cornice.
In questo esempio, non metteremo la cornice, quindi questa è la nostra pagina:
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Per assicurarti di non muovere accidentalmente questi elementi ora che sono allineati, puoi bloccarli sul posto:
1. Seleziona sia l’etichetta che gli oggetti mappa

2. Fai clic sul pulsante Blocca Oggetti Selezionati nella barra degli strumenti Barra delle Azioni.

Nota: Clicca sul pulsante Sblocca Tutti gli Elementi nella Barra delle Azioni per poter modificare di nuovo
gli oggetti.

4.1.4 Follow Along: Aggiungere una legenda

Il lettore della mappa deve anche vedere il significato dei vari oggetti sulla mappa. In alcuni casi, come i nuovi di
luoghi, questo è ovvio. in altri casi, è più difficile indovinarlo, come i colori delle foreste. Aggiungiamo una nuova
legenda.

1. Clicca sul pulsante Aggiungi Legenda

2. Clicca sulla pagina per posizionare la legenda, accetta i valori suggeriti nella finestra di dialogo Proprietà Nuovo
Oggetto,

3. Una legenda viene aggiunta alla pagina del layout, mostrando la simbologia dei layer come impostata nella
finestra di dialogo principale.

4. Come al solito, puoi cliccare e spostare l’oggetto dove vuoi:
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4.1.5 Follow Along: Personalizzare gli elementi della legenda

Non tutto è necessario sulla legenda, quindi rimuoviamo gli elementi non voluti.
1. Nella scheda Proprietà dell’oggetto, troverai il gruppo Oggetti Legenda.

2. Deseleziona la casella Aggiorna automaticamente, permettendoti di modificare direttamente gli oggetti della
legenda

3. Seleziona la voce buildings.

4. Eliminala dalla legenda cliccando sul pulsante
Puoi anche rinominare gli elementi.

1. Seleziona un layer dalla stessa lista.

2. Fai clic sul pulsante Modifica le proprietà dell’oggetto selezionato.
3. Rinomina i layer in Places, Roads and Streets, Surface Water, e Rivers.

Puoi anche riordinare gli elementi:
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La legenda potrebbe essersi allargata a seguito della modifica dei nomi, potresti voler muovere e ridimensionare la
legenda o la mappa. Questo è il risultato:
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4.1.6 Follow Along: Esportare la mappa

Nota: Ti sei ricordato di salvare spesso il lavoro?

Finalmente la mappa è pronta per l’esportazione! Potrai vedere i pulsanti per l’esportazione vicino all’angolo superiore
sinistro della finestra layout:

• Stampa Layout: si interfaccia con una stampante. Dato che le opzioni di stampa differiscono a seconda del
modello di stampante con cui stai lavorando, è meglio consultare il manuale della stampante o una guida sulla
stampa per maggiori informazioni sull’argomento.
Gli altri pulsanti ti permettono di esportare la pagina della mappa in un file.

• Esporta come immagine: ti permette di scegliere fra una selezione dei più comuni formati immagine . Questa
probabilmente è l’opzione più semplice, ma l’immagine creata è «morta» e difficile da modificare.

• Esporta come SVG: se stai inviando la mappa ad un cartografo (che può voler modificare la mappa per la
pubblicazione), è meglio esportarla come SVG. SVG sta per «Scalable Vector Graphic», e può essere importata
con programmi come Inkscape o altri software per la modifica di immagini vettoriali.

• Esporta come PDF: se deve inviare la mappa ad un cliente, è comune usare un PDF, perché è più semplice
impostare le opzioni di stampa per un PDF. Anche alcuni cartografi preferiscono il PDF, se hanno un
programma che gli permette di importare e modificare il formato PDF.

Per i nostri scopi, utilizzeremo il PDF.

1. Clicca sul pulsante Esporta come PDF

2. Come al solito scegli una cartella ed un nome per il file. Apparirà la finestra di dialogo seguente.
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3. Puoi tranquillamente utilizzare i valori predefiniti e cliccare Salva.
QGIS procederà con l’esportazione della mappa e metterà un messaggio in cima al dialogo layout di stampa
appena finito.

4. Clicca sul link nel messaggio per aprire la cartella dove è stato salvato il PDF
5. Aprilo e vedi come appare il tuo layout.

Tutto OK? Congratulazioni per il tuo primo progetto QGIS completato!
6. Qualcosa non soddisfa? Torna alla finestra QGIS, fai le modifiche necessarie ed esporta di nuovo.
7. Ricorda di salvare il tuo progetto.
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4.1.7 In Conclusion

Ora sai come creare un layout di mappa di base. Possiamo fare un ulteriore passo in avanti e creare un layout di
mappa che si adatta dinamicamente, con più oggetti.

4.2 Lesson: Creare un layout di stampa dinamico

Ora che hai imparato a creare un layout di base per la mappa facciamo un passo in avanti e creiamo un layout che
si adatta dinamicamente all’estensione della nostra mappa ed alle proprietà della pagina, p. e. quando si cambia la
dimensione della pagina. Inoltre, anche la data di creazione di adatterà dinamicamente.

4.2.1 Follow Along: Creare l’area della mappa dinamica

1. Carica i dataset ESRI protected_areas.shp, places.shp, rivers.shp e water.shp nell’area
mappa ed adatta le proprietà a tua preferenza.

2. Dopo che tutto è stato elaborato e simbolizzato a tuo piacimento, fai clic sull’icona Nuovo layout di stampa nella
barra degli strumenti Progetto o scegli Progetto► |nuovoLayout| Nuovo layout di stampa. Ti verrà richiesto di
scegliere un titolo per il nuovo layout di stampa.

3. Vogliamo creare un layout consistente in un’intestazione e una mappa della regione vicino Swellendam, South
Africa. Il layout dovrebbe avere un margine di 7,5 mm e l’intestazione dovrebbe essere alta 36 mm.

4. Crea un elemento chiamato main map sull’area e vai al pannello Layout. Scorri verso il basso alla sezione
Variabili e trova la parte Layout. Qui imposteremo alcune variabili che puoi usare su tutto il layout dinamico.
Vai al pannello Layout e scorri verso il basso alla sezione Variabili. La prima variabile definirà il margine.
Premi il pulsante e scrivi il nome sw_layout_margin. Imposta il valore di 7,5. Premi il pulsante

di nuovo e scrivi il nome sw_layout_height_header. Imposta il valore 36.
5. Ora sei pronto per creare automaticamente la dimensione e posizione dell’area di mappa in base alle variabili.

Assicurati che il tuo elemento mappa sia selezionato, vai al pannello Proprietà dell’oggetto, scorri verso il basso
e apri la sezione Posizione e Dimensione. Clicca su Sovrascrittura definita dai dati per X e dalla voce Variabile,
scegli @sw_layout_margin.

6. Clicca Sovrascrittura definita dai dati per Y, scegli Modifica… e scrivi la formula:

to_real(@sw_layout_margin) + to_real(@sw_layout_height_header)

7. Puoi creare la dimensione dell’elemento mappa usando le variabili per Larghezza e Altezza. Clicca
Sovrascrittura definita dai dati per Larghezza e scegli Modifica … di nuovo. Inserisci la formula:

@layout_pagewidth - @sw_layout_margin * 2

Clicca Sovrascrittura definita dai dati per Altezza e scegli Modifica …. Qui inserisci la formula:

@layout_pageheight - @sw_layout_height_header - @sw_layout_margin * 2

8. Creeremo anche un reticolo contenente le coordinate dell’estensione dell’area mappa. Vai di nuovo su Proprietà
dell’oggetto e scegli la sezione Reticoli. Inserisci un reticolo cliccando sul pulsante . Clicca su Modifica
Reticolo … ed imposta Intervallo per X, Y e Offset in base alla scala della mappa che hai scelto nell’area mappa
in QGIS. Il Tipo Reticolo Croce è adatto ai nostri scopi.
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4.2.2 Follow Along: Creare l’intestazione dinamica

1. Inserisci il rettangolo che conterrà l’intestazione con il pulsante Aggiungi Forma. Nel pannello Oggetti inserisci
il nome header.

2. Di nuovo, vai in Proprietà dell’oggetto ed apri la sezione Posizione e Dimensione. Usando
Sovrascrittura definita dai dati, scegli la variabile sw_layout_margin per X come per Y. Larghezza sarà definita
dall’espressione:

@layout_pagewidth - @sw_layout_margin * 2

e Altezza dalla variabile sw_layout_height_header.

3. Inseriremo una linea orizzontale e due linee verticali per dividere l’intestazione in sezioni usando
Aggiungi Nodo. Crea una linea orizzontale e due linee verticali e chiamale Horizontal line, Vertical
line 1 Vertical line 2.
1. Per la linea orizzontale:

1. Imposta X alla variabile sw_layout_margin
2. Imposta l’espressione per Y a:

@sw_layout_margin + 8

3. Imposta l’espressione perWidth a:

@layout_pagewidth - @sw_layout_margin * 3 - 53.5

2. Per la prima linea verticale:
1. Imposta l’espressione perWidth a:

@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Imposta Y alla variabile sw_layout_margin
3. L’altezza deve essere la stessa dell’intestazione creata, quindi imposta Altezza alla variabile

sw_layout_height_header.
3. La seconda linea verticale è piazzata a sinistra della prima.

1. Imposta l’espressione perWidth a:

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. Imposta Y alla variabile sw_layout_margin
3. L’altezza dovrà essere la stessa dell’altra linea verticale, quindi imposta Altezza alla variabile

sw_layout_height_header.
La figura seguente mostra la struttura del nostro layout dinamico. Riempiremo le aree create dalla linea con
alcuni elementi.
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4.2.3 Follow Along: Creare etichette per l’intestazione dinamica

1. Il titolo del nostro progetto QGIS può essere incluso automaticamente. Il titolo è impostato in Proprietà Progetto.
Inserisci un’etichetta con il pulsante Aggiungi Etichetta e chiamala project title (variable). In Proprietà
Principali del pannello Proprietà dell’oggetto inserisci l’espressione:

[%@project_title%]

Imposta la posizione dell’etichetta.
1. Per X, usa l’espressione:

@sw_layout_margin + 3

2. Per Y, usa l’espressione:

@sw_layout_margin + 0.25

3. PerWidth, usa l’espressione:

@layout_pagewidth - @sw_layout_margin *2 - 90

4. Inerisci 11,25 per Altezza
Sotto Aspetto imposta la dimensione del carattere a 16 pt.

2. La seconda etichetta includerà una descrizione della mappa che hai creato. Di nuovo, inserisci un’etichetta e
chiamala map description. In Proprietà Principali inserisci il testo map description. In Proprietà
Principali includeremo anche:

printed on: [%format_date(now(),'dd.MM.yyyy')%]

Qui abbiamo usato due funzioni di Data e Ora (now e format_date).
Imposta la posizione dell’etichetta.
1. Per X, usa l’espressione:

4.2. Lesson: Creare un layout di stampa dinamico 121



QGIS Training Manual

@sw_layout_margin + 3

2. Per Y, usa l’espressione:

@sw_layout_margin + 11.5

3. La terza etichetta includerà informazioni sulla tua azienda. Prima crea alcune variabili nel menu Variabili

di Proprietà dell’oggetto. Vai la menu Layout, clicca sul pulsante ogni volta ed inserisci i nomi
o_department, o_name , o_adress e o_postcode. Nella seconda riga inserisci le informazioni della
tua azienda. Useremo queste variabili nella sezione Proprietà Principali.
In Proprietà Principali inserisci:

[% @o_name %]
[% @o_department %]
[% @o_adress %]
[% @o_postcode %]

Imposta la posizione dell’etichetta.
1. Per X, usa l’espressione:

@layout_pagewidth - @sw_layout_margin - 49.5

2. Per Y, usa l’espressione:

@sw_layout_margin + 15.5

3. Per Larghezza, usa 49,00
4. Per Altezza, usa l’espressione:

@sw_layout_height_header - 15.5
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4.2.4 Follow Along: Aggiungere immagini all’intestazione dinamica

1. Usa il pulsante Aggiungi Immagine per inserire un’immagine sopra l’etichetta organisation
information. Dopo aver inserito il nome organisation logo definisci la posizione e dimensione
del logo:
1. Per X, usa l’espressione:

@layout_pagewidth - @sw_layout_margin - 49.5

2. Per Y, usa l’espressione:

@sw_layout_margin + 3.5

3. Per Larghezza, usa 39,292
4. Per Altezza, use 9,583

Per includere un logo della tua azienda devi salvare il logo nella tua cartella principale ed inserire il percorso
in Proprietà Principali ► Sorgente dell’immagine.

2. Il nostro layout ha ancora bisogno di una freccia per il nord. Questa sarà inserita usando Aggiungi Freccia Nord.
Useremo la freccia nord predefinita. Definisci la posizione:
1. Per X, usa l’espressione:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Per Y, usa l’espressione:
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@sw_layout_margin + 9

3. Per Larghezza, usa 21,027
4. Per Altezza, usa 21,157

4.2.5 Follow Along: Creare la barra di scala per l’intestazione dinamica

1. Per inserire una barra di scala nell’intestazione clicca su Aggiungi Barra di Scala e posizionala nel rettangolo sopra
la freccia nord. InMappa sotto Proprietà Principali scegli main map(Map 1). Questo significa che la scala
cambierà automaticamente a seconda che hai scelto nell’area di disegno principale di QGIS. Scegli lo Stile
Numerico. Questo significa che inseriremo una semplice scala senza barra. La scala necessita ancora di una
posizione e dimensione.
1. Per X, usa l’espressione:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Per Y, usa l’espressione:

@sw_layout_margin + 1

3. Per Larghezza, usa 25
4. Per Altezza, use 8
5. Posiziona il Punto di riferimento al centro.

Congratulazioni! Hai creato il tuo primo layout di mappa dinamico. Dai uno sguardo al layout e controlla se tutto
appare come vuoi! Il layout di mappa dinamico reagisce automaticamente quando cambi le Proprietà pagina. Per
esempio, se cambi la dimensione della pagina da DIN A4 a DIN A3, clicca sul pulsante Aggiorna vista e la struttura
della pagina viene adattata.

124 Capitolo 4. Module: Vestizione e Stampa delle Mappe



QGIS Training Manual

4.2.6 What’s Next?

Nella prossima pagina, ti sarà dato un compito da completare. Questo ti permetterà di fare pratica con le tecniche
che hai appena appreso.

4.3 Compito 1

Apri il tuo progetto di mappa esistente e modificalo accuratamente. Se hai notato piccoli errori o cose che avresti
voluto risolvere prima, fallo ora.
Mentre personalizzi la tua mappa, continua a farti delle domande. Questa mappa è facile da leggere e capire per
qualcuno che non ha familiarità con i dati? Se vedessi questa mappa su Internet, o su un poster o su una rivista,
catturerebbe la mia attenzione? Vorrei leggere questa mappa se non fosse mia?
Se stai facendo questo corso in un Livello base o Livello intermedio, leggi le tecniche dalle sezioni più avanzate. Se
vedi qualcosa che ti piacerebbe fare nella tua mappa, perché non provare ad implementarlo?
Se questo corso viene presentato a te, il presentatore del corso potrebbe richiedere di inviare una versione finale della
mappa, esportata in PDF, per la valutazione. Se stai facendo questo corso da solo, ti consigliamo di valutare la tua
mappa utilizzando gli stessi criteri. Lamappa verrà valutata sull’aspetto generale e sulla simbologia della mappa stessa,
nonché sull’aspetto e il layout della pagina della mappa e degli elementi. Ricorda che l’enfasi per valutare l’aspetto
delle mappe sarà sempre facilità d’uso. Più la mappa è bella da guardare e più è facile da capire a colpo d’occhio.
Felice personalizzazione!

4.3.1 In Conclusion

I primi quattro moduli ti hanno insegnato come creare e disegnare una mappa vettoriale. Nei prossimi quattro moduli,
imparerai come utilizzare QGIS per un’analisi GIS completa. Ciò includerà la creazione e la modifica di dati vettoriali;
analizzare i dati vettoriali; utilizzare e analizzare dati raster; e utilizzando GIS per risolvere un problema dall’inizio
alla fine, utilizzando sia le origini dati raster sia quelle vettoriali.
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CAPITOLO5

Module: Creare dati vettoriali

Creare mappe usando dati esistenti è solo l’inizio. In questo modulo, imparerai come modificare vettori esistenti e
creare nuovi dataset.

5.1 Lesson: Creare un nuovo vettore dati

I dati che utilizzi devono provenire da qualcosa. Per le applicazioni più comuni, i dati esistono già; ma più il progetto
è specializzato e particolare, meno probabile è che i dati siano già disponibili. In questi casi, hai bisogno di creare i
tuoi nuovi dati.
Obiettivo di questa lezione: Creare un nuovo vettore dati.

5.1.1 Follow Along: La finestra di dialogo crea nuovo layer

Prima di poter aggiungere un nuovi dati al vettore, hai bisogno di un vettore dati a cui aggiungerli. Nel nostro caso,
inizierai creando dei dati completamente nuovi, invece di modificarne di esistenti. Perciò, devi prima definire il tuo
nuovo insieme di dati.

1. Apri QGIS e crea un nuovo progetto vuoto.
2. Vai la menu e seleziona la voce Layer ► Crea Vettore ► Nuovo Shapefile. Ti verrà presentata la finestra di

dialogo Nuovo Shapefile, che ti permetterà di definire un nuovo vettore (layer).

127



QGIS Training Manual

3. Clicca… accanto al campo Nome file. Apparirà una finestra di dialogo con Salva.
4. Naviga fino alla cartella exercise_data.
5. Salva il nuovo vettore come school_property.shp.

È importante decidere in questa fase che tipo di insieme di dati vuoi. Ogni tipo di vettore è «costruito
diversamente» in background, quindi una volta creato il vettore, non è possibile cambiarne il tipo.
Per il prossimo esercizio, creeremo degli elementi che descrivono aree. Per questi elementi, è necessario creare
un insieme di dati poligono.

6. Per Tipo di geometria, seleziona Poligono dal menu a scomparsa:
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Questo non ha conseguenze sul resto della finestra di dialogo, ma comporterà l’utilizzo del tipo corretto di
geometria da utilizzare quando il vettore viene creato.
Il campo successivo permette di specificare il Coordinate Reference System (Sistema di Riferimento delle
Coordinate), o SR. Il SR è un metodo per associare le coordinate numeriche con una posizione sulla superficie
della terra. Vedi il Manuale Utente alla voce Working with Projections per saperne di più.
Per questo esempio useremo il SR predefinito associato con questo progetto, che è WGS84.

Poi c’è una collezione di campi raccolti sotto Nuovo Campo. Per impostazione predefinita, un nuovo campo ha
un solo attributo, il campo id (che dovresti vedere in Lista Campi). Comunque, perché i tuoi dati siano utili,
ora devi dire qualcosa riguardo gli elementi che creerai in questo vettore. Per i nostri scopi, sarà sufficiente
aggiungere un campo chiamato name che conterrà Testo e sarà limitato ad una lunghezza di 80 caratteri.

7. Riproduci la configurazione sotto riportata, poi clicca il pulsante Aggiungi a Lista Campi:

8. Controlla che la tua finestra di dialogo appaia come segue:
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9. Fai clic su OK

Il nuovo vettore dovrebbe apparire nel tuo pannello Layer.

5.1.2 Follow Along: Fonti dei dati

Quando crei nuovi dati, ovviamente devono riguardare oggetti che esistono realmente sul terreno. Perciò, devi ricevere
le informazioni da qualche parte.
Ci sono diversi modi per ottenere dati sugli oggetti. Per esempio, potresti usare un GPS per rilevare i punti nel
mondo reale, e successivamente importarli in QGIS. Oppure potresti misurare i punti con un teodolite, ed inserire le
coordinate manualmente per creare nuovi elementi. Oppure puoi usare un processo di digitalizzazione per tracciare
oggetti raccolti da sistemi remoti, come immagini da satellite o foto aeree.
Per il nostro esempio, useremo un approccio digitale. Sono forniti degli insiemi di dati raster, quindi dovrai importarli
per quello che ti serve.
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1. Clicca sul pulsante Apri Gestore delle sorgenti dati.

2. Selezione Raster sulla sinistra.
3. Nel pannello Sorgente, clicca sul pulsante…:
4. Naviga in exercise_data/raster/.
5. Seleziona il file 3420C_2010_327_RGB_LATLNG.tif.
6. Clicca Apri per chiudere la finestra di dialogo.

7. Clicca Aggiungi e Chiudi. Un’immagine sarà carica sulla mappa.
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8. Se non vedi apparire un’immagine aerea, seleziona il nuovo layer, clicca col tasto destro, e scegli Zoom sul
Layer nel menu contestuale.
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9. Clicca sul pulsante Ingrandisci, ed ingrandisci l’area sotto evidenziata in blu:
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Ora sei pronto per digitalizzare questi tre campi:
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Prima di iniziare a digitalizzare, spostiamo il layer school_property sopra l’immagine aerea.
1. Seleziona il layer school_property in Layer spostalo in cima.
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Per iniziare a digitalizzare, devi entrare in modalitàmodifica. I software GIS comunemente lo richiedono per evitare
che accidentalmente vengano modificati o cancellati dati importanti. La modalità modifica è attivata e disattivata
individualmente per ogni layer.
Per entrare in modalità modifica per il layer school_property:

1. Clicca sul layer school_property sul pannello Layer per selezionarlo.

2. Clicca sul pulsante Attiva Modifiche.
Se non riesci a trovare questo pulsante, controlla che la barra strumenti Strumenti di Digitalizzazione sia abilitata.
Dovrebbe esserci una spunta alla voce di menu Visualizza ► Barra degli Strumenti ► Barra Strumenti di
Digitalizzazione.
Appena entri in modalità modifica, vedrai attivarsi alcuni strumenti di digitalizzazione:

• Aggiungi Elemento Poligonale

• Strumento Vertice

Altri pulsanti importanti sono ancora inattivi, diventeranno attivi quando inizierai ad interagire con i nuovi dati.
Nota che il layer school_property nel pannello Layer ha un’icona penna, indicante che è in modalità
modifica.

3. Clicca sul pulsante Aggiungi Elemento Poligonale per iniziare a digitalizzare i nostri campi scolastici.
Noterai che il cursore del mouse è diventato unmirino. Questo ti permette di essere più accurato nel posizionare
i punti da digitalizzare. Ricorda che anche quando stai utilizzando lo strumento di digitalizzazione, puoi
ingrandire e rimpicciolire la mappa ruotando la rotella del mouse, e puoi spostarla tenendo premuto la rotella
del mouse e spostandoti sulla mappa.
Il primo elemento che digitalizzerai è athletics field:

4. Inizia la digitalizzazione cliccando in un punto lungo il bordo del campo.
5. Piazza più punti cliccando lungo il bordo, finché la forma che stai disegnando non ricopre completamente il

campo.
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6. Dopo aver posizionato il tuo ultimo punto, clicca col tasto destro per finire il disegno del poligono. Questo
completerà l’elemento e ti mostrerà la finestra di dialogo Attributi elemento.

7. Inserisci i valori come di seguito:
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8. Clicca OK, ed hai creato un nuovo elemento!

9. Nel pannello Layer seleziona il layer school_property.
10. Clicca col tasto destro e seleziona Apri tabella attributi nel menu contestuale.
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Nella tabella vedrai l’elemento appena aggiunto. Nella modalità modifica puoi aggiornare i dati degli attributi
facendo doppio clic sulla cella che vuoi aggiornare.
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11. Chiudi la tabella attributi

12. Per salvare l’elemento appena creato, clicca sul pulsante Salva Modifiche Vettore.
Ricorda, se hai fatto un errore digitalizzando un elemento, puoi sempre modificarlo dopo averlo creato. Se hai fatto
un errore, continua la digitalizzazione finché non hai creato l’elemento come sopra. Poi:

1. Clicca sul pulsante Strumento Vertice.
2. Sposta il mouse sopra un vertice che vuoi spostare e clicca col tasto destro sul vertice.
3. Muovi il mouse nella posizione corretta del vertice, e clicca col tasto sinistro. Questo muoverà il vertice nella

nuova posizione.
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La stessa procedura può essere utilizzata per spostare una linea, ma dovrai spostarti sopra il punto mediano
della linea.

Se vuoi annullare una modifica, puoi premere il pulsante Annulla o premere Ctrl+Z.

4. Ricorda di salvare le modifiche cliccando il pulsante Salva Modifiche Vettore.

5. Quando hai finito di modificare, clicca sul pulsante Attiva Modifiche per uscire dalla modalità di modifica.
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5.1.3 Try Yourself Digitalizzare Poligoni

Digitalizza la scuola stessa ed il campo in alto. Usa questa immagine come aiuto:

Ricorda che ogni nuovo elemento deve avere un unico campo id!

Nota: Quando hai finito di aggiungere elementi ad un layer, ricorda di salvare le modifiche e poi esci dalla modalità
modifica.

Nota: Puoi cambiare stile del riempimento, del contorno e posizionamento delle etichette e la formattazione del
school_property usando le tecniche imparate nelle lezioni precedenti.
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5.1.4 Follow Along: Usare la tabella modifica vertici

Un altro modo per modificare un elemento è inserire manualmente i valori delle coordinate per ogni vertice usando
la tabella Modifica Vertici.

1. Assicurati di essere in modalità modifica sul layer school_property.

2. Se non ancora attivato, clicca sul pulsante Strumento Vertice.
3. Muovi il mouse sopra uno degli elementi poligono creati sul layer ``school_property``e cliccaci sopra col tasto

destro. Questo selezionerà l’elemento ed apparirà un pannello Modifica Vertici.

Nota: Questa tabella contiene le coordinate dei vertici dell’elemento. Nota che ci sono 7 vertici su questa figura,
ma solo sei sono visualizzabili sulla mappa. Guardando attentamente, si noterà che le righe 0 e 6 contengono
le stesse coordinate. Questi sono i vertici di inizio e fine della geometria dell’elemento, e sono necessari per
creare un elemento poligono chiuso.

4. Clicca e trascina un rettangolo sopra uno o più vertici, dell’elemento selezionato.
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I vertici selezionati cambieranno colore in blu e nella tabella Modifica Vertici le righe corrispondenti alle
coordinate dei vertici saranno evidenziate,.
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5. Per modificare una coordinata, fai doppio clic col tasto sinistro sulla cella nella tabella che vuoi modificare ed
inserisci il valore. In questo esempio, la coordinata x della riga 4 è modificata da 20.4450 a 20.4444.
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6. Dopo aver inserito il valore, premi il tasto Invio per applicare la modifica. Vedrai il vertice spostarsi nella nuova
posizione nella finestra della mappa.

7. Quando hai finito le modifiche, clicca il pulsante Attiva Modifiche per uscire dalla modalità modifica, e salva
le modifiche.

5.1.5 Try Yourself Digitalizzare linee

Digitalizzeremo due strade che non sono ancora segnate come strade sul layer; uno è un sentiero (path), l’altro una
pista (track). Il nostro sentiero corre lungo il confine sud della periferia di Railton, iniziando e finendo su strade già
tracciate:
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La nostra pista è un po” più a sud:
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1. Se il layer roads non è ancora presente nella tua mappa, allora aggiungi il layer roads dal file GeoPackage
training-data.gpkg incluso nella cartella exercise_data dei dati di formazione che hai scaricato.
Puoi leggere ��� Passo dopo passo: Caricare dati vettoriali da un Database GeoPackage per sapere come fare.

2. Crea un nuovo insieme di dati ESRI Shapefile chiamato routes.shp nella cartella exercise_data`,
con gli attributi id e type (usa come guida il procedimento di cui sopra).

3. Attiva la modalità di modifica sul layer routes.

4. Dato che stai lavorando con una elemento lineare, clicca sul pulsante Aggiungi Elemento Lineare per avviare la
modalità di digitalizzazione delle linee.

5. Uno alla volta, digitalizza il sentiero e la traccia sul layer routes. Prova a seguire i percorsi il più
accuratamente possibile, aggiungendo ulteriori punti sugli angoli e sulle curve.

6. Imposta il valore dell’attributo type a path o track.
7. Usa la finestra di dialogo Proprietà Layer per aggiungere uno stile ai percorsi. Sentiti libero di usare diversi

stili per i sentieri e le piste.
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8. Salva le modifiche e disattiva la modalità modifica premendo il pulsante Attiva Modifiche.

Soluzione
La simbologia non ha importanza, ma i risultati dovrebbero essere più o meno così:

5.1.6 In Conclusion

Ora sai come creare elementi! Questo corso non mostra come aggiungere elementi punto, perché non è realmente
necessario dopo aver lavorato con elementi più complicati (linee e poligoni). Si opera allo stesso modo, solo che devi
cliccare una sola volta dove vuoi che il punto stia, gli si danno degli attributi come al solito, e l’elemento è creato.
Conoscere come digitalizzare è importante perché è un’attività molto comune nei programmi GIS.

5.1.7 What’s Next?

Gli elementi in un layer GIS non sono solo figure, sono oggetti nello spazio. Per esempio, poligoni adiacenti sanno
dove sono in relazione uno con l’altro. Questa è chiamata topologia. Nella prossima lezione vedrai un esempio di
perché questo è utile.
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5.2 Lesson: Funzioni della topologia

La topologia è un utile aspetto dei dati vettoriali perché minimizza gli errori come la sovrapposizione o gli spazi vuoti.
Per esempio: se due elementi condividono un bordo, e lo modifichi usando la topologia, allora non hai bisogno
di modificare prima un elemento, poi un altro, ed allineare attentamente i bordi perché coincidano. Invece, puoi
modificare il loro bordo comune e entrambi gli elementi cambieranno contemporaneamente.
Obiettivo della lezione: Comprendere la topologia usando degli esempi.

5.2.1 Follow Along: Aggancio

L’aggancio rende facile la modifica della topologia. Questo permetterà al cursore del mouse di agganciarsi ad altri
oggetti mentre stai digitalizzando. Per impostare le opzioni di aggancio:

1. Entra nella voce di menu Progetto ► Opzioni di Aggancio….
2. Imposta la finestra di dialogo Opzioni di Aggancio per attivare il layer landuse con Tipo vertice e tolleranza

12 pixel:

3. Assicurati che sia spuntata la voce Evita sovrapposizione.
4. Esci dalla finestra di dialogo.

5. Seleziona il layer landuse ed entra in modalità modifica ( )
6. Controlla (in Visualizza ► Barre degli strumenti) che la barra Digitalizzazione Avanzata sia abilitata.
7. Ingrandisci questa area (abilita layer ed etichette se necessario):
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8. Digitalizza questa nuova area (fittizia) indicata in rosso:

9. Quando ti verrà chiesto, dai il valore di 999 a OGC_FID, lascia pure come sono gli altri valori.
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Se stai attento mentre digitalizzi, e lasci che il cursore si agganci ai vertici delle aree adiacenti, noterai che non
ci sarà nessuno spazio fra la tua nuova area e le aree adiacenti.

10. Nota gli strumenti Annulla e Ripristina nella barra Digitalizzazione Avanzata.

5.2.2 Follow Along: Correzione degli elementi topologici

A volte gli elementi topologici devono essere aggiornati. Nella tua area di studio, l’area è stata impostata come
foresta, quindi il layer landuse deve essere aggiornato. Perciò vogliamo espandere e unire alcuni elementi foresta
in quest’area:

Invece di creare nuovi poligoni per unire le aree foresta, utilizzeremo lo Strumento Vertice per modificare ed unire i
poligoni esistenti.

1. Entra in modalità modifica (se non è già attiva)

2. Seleziona lo strumento Strumento Vertice.
3. Scegli un’area foresta, seleziona un vertice, e muovilo verso un vertice adiacente così che i due elementi foresta

si incontrino:
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4. Clicca sugli altri vertici e agganciali al loro posto.
Il bordo topologico corretto appare come questo:
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Vai avanti e unisci qualche altra area usando lo Strumento Vertice.

Puoi anche utilizzare lo strumento Aggiungi Elemento Poligonale per riempire lo spazio fra due poligoni foresta.
Se hai abilitato Evita sovrapposizione, non hai bisogno di aggiungere ogni singolo vertice - saranno aggiunti
automaticamente se il nuovo poligono si sovrappone a quelli esistenti.
Se stai utilizzando i nostri dati di esempio, dovresti avere un’area foresta come questa:

Non preoccuparti se hai unito più, meno o diverse aree di foresta.

5.2.3 Follow Along: Strumento: Semplifica Elemento

Continuando con lo stesso layer, esamineremo lo strumento Semplifica Elemento:
1. Clicca su di esso per attivarlo.
2. Clicca su una della aree che hai unito utilizzando lo strumento Strumento Vertice o Aggiungi Elemento. Apparirà

questa finestra di dialogo:
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3. Modifica la Tolleranza e guarda cosa succede:

Questo permette di ridurre il numero di vertici.
4. Fai clic su OK
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Il vantaggio di questo strumento è che ti fornisce un’interfaccia semplice e intuitiva per la generalizzazione. Ma nota
che lo strumento rovina la topologia. Il poligono semplificato non condivide più i confini con i poligoni adiacenti,
come dovrebbe. Quindi questo strumento è più adatto per elementi a sé stanti.
Prima di continuare, imposta il poligono al suo stato originario annullando l’ultima modifica.

5.2.4 Try Yourself Strumento: Aggiungi Buco

Lo strumento Aggiungi Buco permette di aggiungere un buco all’interno di un elemento poligono (ritagliare un buco
nel poligono), purché il buco sia completamente contenuto nel poligono (può toccare il bordo). Per esempio, se hai
digitalizzato i confini esterni del Sud Africa e devi aggiungere un buco per il Lesotho, potrai usare questo strumento.
Se provi questo strumento, noterai che le opzioni di aggancio ti impediscono di creare il buco all’interno del poligono.
Quindi sei avvisato di togliere l’aggancio prima di tagliare un buco.

1. Disabilita l’aggancio per il layer landuse utilizzando il pulsante Abilita Aggancio (oppure utilizza la
scorciatoia s).

2. Usa lo strumento Aggiungi Buco per creare un buco in mezzo ad un poligono.

3. Disegna un poligono sull” elemento di destinazione, come se si stesse usando lo strumento :sup: Aggiungi
poligono.

4. Quando clicchi con il tasto destro, il buco diverrà visibile.

5. Rimuovi il buco che hai appena creato usando lo strumento Elimina Buco. Clicca all’interno del buco per
eliminarlo.

Soluzione
La forma esatta non ha importanza, ma dovresti ottenere un buco nel mezzo del tuo elemento, come questo:
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• Annulla la modifica prima di continuare con l’esercizio per lo strumento successivo.

5.2.5 Try Yourself Strumento: Aggiungi Parte

Lo strumento Aggiungi Parte permette di aggiungere una nuova parte ad un elemento, che non è direttamente connesso
con l’elemento principale. Per esempio, se hai digitalizzato i confini del Sud Africa continentale, ma non hai aggiunto
le Prince Edward Islands, potrai usare questo strumento per crearle.

1. Seleziona il poligono a cui vuoi aggiungere la parte usando lo strumento
Seleziona Elementi con un’area o con un singolo clic.

2. Usa lo strumento Aggiungi Parte per aggiungere un’area esterna.

3. Cancella la parte appena creata usando lo strumento Elimina Parte.

Nota: Clicca all’interno della parte per eliminarla.

Soluzione
1. Prima seleziona la Bontebok National Park:

2. Ora aggiungi la tua nuova parte:
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3. Annulla la modifica prima di continuare con l’esercizio per lo strumento successivo.

5.2.6 Follow Along: Strumento: Modifica Forma

Lo strumento Modifica Forma è usato per estendere un elemento poligono o tagliarne una parte (lungo il bordo).
Estensione:

1. Seleziona il poligono usando lo strumento Seleziona Elementi con un’area o con un singolo clic.
2. Clicca con il tasto sinistro all’interno del poligono per iniziare il disegno.
3. Disegna una forma fuori dal poligono. L’ultimo vertice dovrà essere di nuovo dentro il poligono.
4. Clicca col tasto destro per finire la forma:
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Questo di darà un risultato simile a:

Tagliare una parte:

1. Seleziona il poligono usando lo strumento Seleziona Elementi con un’area o con un singolo clic.
2. Clicca fuori dal poligono.
3. Disegna una forma dentro al poligono. L’ultimo vertice dovrà essere di nuovo fuori dal poligono.
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4. Clicca col tasto destro fuori dal poligono:

Il risultato di quanto sopra:

5.2. Lesson: Funzioni della topologia 161



QGIS Training Manual

5.2.7 Try Yourself Strumento: Dividi Elementi

Lo strumento Dividi Elementi è simile allo strumento Modifica Forma, eccetto che non cancella nessuna delle due
parti. Invece, le tiene entrambe.
Useremo lo strumento per suddividere un angolo da un poligono.

1. Prima, seleziona il layer landuse e riabilita l’aggancio.

2. Seleziona lo strumento Dividi Elementi e clicca su un vertice per iniziare a disegnare una linea.
3. Disegna la linea di confine.
4. Clicca su un vertice della parte «opposta» del poligono che vuoi dividere e clicca col tasto destro per completare

la linea:

5. A questo punto, sembra non sia successo nulla. Ma ricorda che il layer landuse è disegnato senza le linee di
bordo, quindi la nuova linea di separazione non sarà mostrata.

6. Usa lo strumento Seleziona Elementi con un’area o con un singolo clic la parte che hai appena diviso; il nuovo elemento
sarà evidenziato:
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5.2.8 Try Yourself Strumento: Fondi Elementi Selezionati

Ora vogliamo riunificare l’elemento appena diviso alla parte rimanente del poligono:

1. Prova gli strumenti Unisci Elementi Selezionati e Unisci attributi di elementi selezionati.
2. Nota le differenze.

Soluzione
• Utilizza lo strumento :guilabel:”Unisci Elementi Selezionati”, assicurandoti di selezionare prima entrambi i
poligoni che vuoi unire.

• Usa la funzione con :guilabel:”OGC_FID” di “”1”” come origine dei tuoi attributi (fai clic sulla sua voce nella
finestra di dialogo, quindi fai clic sul pulsante :guilabel:”Prendi attributi dall’elemento selezionato”):

Se stai usando un set di dati diverso, è molto probabile che la OGC_FID del poligono originale non sia 1. Scegli
soltanto l’elemento che ha una OGC_FID.
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L’utilizzo dello strumento :guilabel:”Unisci attributi di elementi selezionati” manterrà le geometrie distinte, ma darà
loro gli stessi attributi.

5.2.9 In Conclusion

La modifica della topologia è uno strumento potente che permette di creare e modificare velocemente e facilmente
degli oggetti, assicurando che rimangano topologicamente corretti.

5.2.10 What’s Next?

Ora sai come digitalizzare facilmente la forma degli oggetti, ma l’aggiunta di attributi dà ancora del mal di testa!
Prossimamente vedremo come usare le forme, facendo in modo che la modifica degli attributi sia semplice ed efficace.

5.3 Lesson: Moduli

Quando aggiungi nuovi dati con la digitalizzazione, ti viene presentata una finestra di dialogo che ti permette di
inserire gli attributi per quegli elementi. Comunque, questo dialogo non è molto bello da vedere. Questo può causare
un problema di usabilità, specialmente sei devi creare degli insiemi di dati molto grandi, o se vuoi che altre persone
ti aiutino nella digitalizzazione e trovano confuso il modulo predefinito.
Fortunatamente QGIS ti consente di personalizzare i tuoi moduli per un layer. Questa lezione ti mostra come.
Obiettivo di questa lezione: Creare un modulo per un layer.
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5.3.1 Follow Along: Usare la funzionalità di progettazione moduli di QGIS

1. Seleziona il layer roads nel pannello Layer

2. Entra in modalità modifica come già fatto
3. Apri la tabella attributi del layer roads
4. Clicca col tasto destro in una cella della tabella. Apparirà un breve menu, che include la voce Apri modulo.
5. Clicca su di essa per vedere il modulo che QGIS ha generato per questo layer

Ovviamente sarebbe bello poterlo fare guardando la mappa, piuttosto che dover cercare una specifica strada nella
:guilabel:`Tabella attributi”.

1. Seleziona il layer roads nel pannello Layer

2. Usando lo strumento Informazioni Elementi, clicca su una strada nella mappa.
3. Si apre il pannello Informazioni Risultati e mostra una vista ad albero dei valori dei campi ed altre informazioni

generiche sull’elemento selezionato.
4. Nella parte superiore del pannello, spunta la casella Apri automaticamente il modulo per risultati su singolo

elemento nel menu Informazione Risultati.
5. Ora, fai di nuovo clic su una qualsiasi strada della mappa. Lungo la precedente finestra di dialogo Informazioni

risultati vedrai il modulo familiare:

6. Ogni volta che clicchi su un elemento singolo con lo strumento Informazioni, apparirà il suo modulo finché è
selezionato Apri automaticamente il modulo per risultati su singolo elemento`.
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5.3.2 Try Yourself Usare il modulo per modificare i valori

Se sei in modalità di modifica, puoi utilizzare questo modulo per modificare gli attributi di un elemento.
1. Attiva la modalità di modifica (se non è già attivata).

2. Usando lo strumento Informazioni Elementi, clicca sulla strada principale che attraversa Swellendam:

3. Modifica il suo valore highway in secondary
4. Esci dalla modalità modifica e salve le modifiche
5. Apri la Tabella Attributi è nota che il valore è stato modificato nella tabella attributi e perciò nei dati originali

5.3.3 Follow Along: Impostazione dei tipi di campo del modulo

È più facile modificare le cose usando un modulo, ma devi comunque inserire tutto a mano. Fortunatamente, i moduli
hanno diversi tipi di cosiddetti widget che consentono di modificare i dati in vari modi.

1. Apri Proprietà… del layer roads
2. Passa alla scheda Campi. Vedrai questo:
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3. Vai alla scheda Modulo Attributi. Vedrai questo:

4. Clicca sulla riga oneway e scegli Casella di controllo per Tipo Widget nella lista delle opzioni:
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5. Fai clic su OK

6. Entra in modalità modifica (se il layer roads non è già in modifica)
7. Clicca sulla strumento Informazioni Elementi

8. Clicca sulla stessa strada scelta prima
Vedrai che l’attributo oneway ha un casella di controllo vicino ad indicare Vero (spuntato) o Falso (non spuntato).

5.3.4 Try Yourself

Imposta nel modulo un widget più appropriato per il campo highway.

Soluzione
Per il TYPE, c’è ovviamente una quantità limitata di tipi che una strada può essere, e se controlli la tabella degli
attributi per questo layer, vedrai che sono predefiniti.

1. Imposta il widget su Mappa valori e clicca su Carica Dati dal Vettore.
2. Seleziona roads nel menu a tendina di Layer e highway per entrambe le opzioni Valore e Descrizione:
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3. Clicca OK tre volte.
4. Se ora usi lo strumento Informazioni elementi su una strada mentre la modalità di modifica è attiva, la finestra

di dialogo che ottieni dovrebbe essere simile a questa:
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5.3.5 Try Yourself Creare dati di prova

Puoi anche progettare il tuo modulo personalizzato completamente da zero.
1. Crea un semplice layer di punti chiamato test-data con due attributi:

• name (text)
• age (integer)

2. Disegna alcuni punti sul tuo nuovo layer usando gli strumenti di digitalizzazione in modo da avere un po” di
dati con cui lavorare. Dovrebbe apparire il modulo di acquisizione degli attributi predefinito generato da QGIS
ogni volta che disegni un nuovo punto.

Nota: Devi disabilitare l’aggancio se ancora abilitato da attività precedenti.
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5.3.6 Follow Along: Creare un nuovo modulo

Ora vogliamo creare il nostro modulo personalizzato per la fase di cattura degli attributi. Per fare questo devi avere
QT Designer installato (necessario solo per la persona che crea i moduli).

1. Esegui QT Designer.
2. Nella finestra di dialogo che appare, crea una nuova finestra di dialogo:

3. GuardaWidget Box sulla sinistra del tuo schermo (predefinito). Contiene un oggetto Line Edit.
4. Clicca e trascina questo oggetto nel tuo modulo. Questo crea una nuova Line Edit nel modulo.
5. Con il nuovo elemento line edit selezionato, vedrai le sue proprietà lungo il lato dello schermo (sulla destra per

impostazione predefinita):
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6. Imposta il suo nome a name.
7. Usando lo stesso metodo, crea una nuova Casella e imposta il suo nome a age.
8. Aggiungi una Label con testo Aggiungi una nuova persona in grassetto (guarda nelle proprietà

dell’oggetto per trovare come impostarlo). Oppure potresti voler impostare il titolo del dialogo (invece di
aggiungere un’etichetta).

9. Aggiungi una Etichetta per la tua Line Edit e la tua Casella.
10. Disponi gli elementi secondo il tuo gradimento
11. Fai clic in qualsiasi punto della finestra di dialogo.
12. Trova il pulsante Lay Out in a Form Layout (in una barra degli strumenti lungo il bordo superiore dello schermo,

di default). Questo disporrà la tua finestra di dialogo automaticamente.
13. Imposta la dimensione massima della finestra di dialogo (nelle sue proprietà) a 200 (larghezza) per 150

(altezza).
14. Il tuo modulo dovrebbe ora avere un aspetto simile a questo:

172 Capitolo 5. Module: Creare dati vettoriali



QGIS Training Manual

15. Salva il tuo nuovo modulo in exercise_data/forms/add_people.ui
16. Quando hai salvato, puoi chiudere Qt Designer

5.3.7 Follow Along: Associare il modulo con il tuo Layer

1. Torna a QGIS
2. Fai doppio clic sul layer test-data nella legenda per accedere alle sue proprietà.
3. Clicca sulla scheda Modulo Attributi nella finestra di dialogo Proprietà vettore

4. Nel menu a tendina Attribute editor layout, seleziona Fornisci file UI.
5. Clicca sul pulsante con i tre punti e scegli il file add_people.ui appena creato:

6. Clicca OK nella finestra di dialogo Proprietà vettore

7. Entra in modalità modifica e cattura un nuovo punto
8. Quando lo fai, ti verrà presentata la finestra di dialogo personalizzata (invece di quella generica che QGIS crea

abitualmente).
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9. Se clicchi su uno dei tuoi punti usando lo strumento Informazioni Elementi, puoi selezionare il modulo cliccando
col tasto destro nella finestra informazioni risultati e scegliendo Vedi Modulo Elementi dal menu contestuale.

10. Se sei in modalità modifica su questo layer, il menu contestuale mostrerà invece Modulo modifica attributo, e
puoi modificare gli attributi nel nuovo modulo anche dopo la cattura iniziale.

5.3.8 In Conclusion

Usando i moduli, puoi semplificarti la vita durante la modifica o la creazione di dati. Modificando i tipi di widget o
creando un modulo completamente nuovo da zero, puoi facilitare chi digitalizza nuovi dati per quel layer, riducendo
al minimo incomprensioni ed errori non necessari.

5.3.9 Further Reading

Se hai completato la sezione avanzata precedente e conosci Python, potresti voler controllare questa voce del blog
sulla creazione di attributi personalizzati per i moduli con la logica di Python, che permette funzionalità avanzate
come la verifica dei dati, l’auto completamento, ecc.

5.3.10 What’s Next?

Aprire un modulo con l’identificazione di un elemento è una delle azioni che QGIS può eseguire. Tuttavia, puoi anche
indirizzarlo per eseguire azioni personalizzate definite dall’utente. Questo è l’argomento della prossima lezione.

5.4 Lesson: Azioni

Ora che hai visto un’azione predefinita nella lezione precedente, è il momento di definire le tue azioni.
Un’azione è qualcosa che accade quando clicchi su un elemento. Può aggiungere alla tua mappamolte funzionalità, per
esempio, permettendoti di recuperare informazioni addizionali su un oggetto. L’assegnazione di azioni può aggiungere
alla tua mappa un’intera nuova dimensione.
Obiettivo di questa lezione: Imparare come aggiungere azioni personalizzate.
In questa lezione useremo il layer school_property creato precedentemente. I dati di esempio comprendono foto di
ognuna delle tre proprietà che hai digitalizzato. Quello che faremo è associare ogni proprietà con la sua immagine.
Poi creeremo un’azione che aprirà l’immagine della proprietà quando si clicca sulla proprietà.

5.4.1 Follow Along: Aggiungi un campo per le immagini

Al momento il layer school_property non ha modo di associare una proprietà con un’immagine. Prima
creeremo un campo a questo scopo.

1. Apri la finestra Proprietà vettore.
2. Spostati sulla scheda Campi.
3. Attiva modifica:
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4. Aggiungi una nuova colonna

5. Inserisci i seguenti valori:
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6. Dopo aver creato il campo, vai alla scheda Modulo Attributi e seleziona il campo image.
7. Imposta il Tipo widget in Allegato:

8. Clicca su OK nel dialogo Proprietà vettore.
9. Usa lo strumento Informazioni elementi cliccando su una delle tre geometrie del layer school_property.

Dato che sei ancora in modalità modifica, il dovrebbe essere attivo e apparire come questo:
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10. Clicca il pulsante di selezione ( il… vicino al campo image).
11. Seleziona il percorso per la tua immagine. Le immagini sono in exercise_data/

school_property_photos/ e sono nominate allo stesso modo degli elementi a cui dovrebbero
essere associate.

12. Clicca OK.
13. Usando questo metodo associa tutte le immagine con gli elementi corretti.
14. Salva le modifiche ed esci da modalità modifica.

5.4.2 Follow Along: Creare un’azione

1. Apri la scheda Actions per il layer school_property, e clicca sul pulsante Aggiunge una nuova azione.

2. Nel dialogo Aggiungi nuova azione, inserisci nel campo Descrizione le parole``Show Image``:
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Cosa fare dopo varia a seconda del sistema operativo, quindi scegli il percorso appropriato:
• Windows
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Clicca Type sulla tendina e scegli Apri.
• Ubuntu Linux
SottoTesto Azione, scrivieog perGnome Image Viewer, oppure scrividisplay per usare ImageMagick.
Ricorda di inserire uno spazio dopo il comando!

• macOS
1. Clicca Type sulla tendina e scegli Mac.
2. Sotto Testo Azione, scrivi open. Ricorda di inserire uno spazio dopo il comando!

Ora puoi continuare scrivendo il comando.
Vogliamo aprire l’immagine, e QGIS sa dove è. Tutto ciò che devi fare è dire a Azioni dove è l’immagine.

3. Seleziona dalla lista image:
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4. Clicca il pulsante Inserisci campo. QGIS aggiungerà la frase [% "image" %] nel campo Testo Azione.
5. Clicca sul pulsante OK per chiudere il dialogo Aggiungi nuova azione
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6. Clicca su OK per chiudere il dialogo Proprietà vettore

Ora è il momento di provare la nuova azione:
1. Clicca sul layer school_property nel pannello Layer in modo che sia evidenziato.

2. Trova il pulsante Esegui azione elemento (nella Barra strumenti attributi).
3. Clicca sulla freccia verso il basso a destra del pulsante. C’è solo un’azione definita per questo layer, che è quella

appena creata.

4. Clicca il pulsante per attivare lo strumento.
5. Utilizzando questo strumento, clicca su uno dei tre oggetti della scuola.

L’immagine per quella proprietà dovrebbe aprirsi.

5.4.3 Follow Along: Cercare in internet

Mettiamo che stiamo guardando la mappa e vogliamo sapere di più riguardo l’area dove c’è una fattoria. Supponi
di non sapere nulla dell’area in questione e vuoi trovare delle informazioni generiche al riguardo. Il primo impulso,
considerando che stai usando un computer, probabilmente sarà di cercare in Google il nome dell’area. Diciamo a
QGIS di farlo automaticamente per noi!

1. Aprire la tabella attributi per il layer landuse.
Useremo il campo name per ognuna delle nostre landuse per la ricerca in Google.

2. Chiudi la tabella attributi
3. Torna a Azioni nella finestra Proprietà vettore.
4. Clicca sul pulsante Crea Azioni Predefinite per aggiungere delle azioni predefinite.

5. Rimuovi tutte le azioni tranne Apri URL con titolo breve Cerca nel Web usando il pulsante
Rimuovi l’azione selezionata in basso.

6. Fai doppio click sull’azione rimasta per modificarla
7. Cambia la Descrizione in Google Search, e rimuovi il contenuto del campo Breve descrizione.
8. Assicurati che Mappa sia fra gli Ambiti Azione selezionati.

Cosa fare dopo varia a seconda del sistema operativo, quindi scegli il percorso appropriato:
• Windows
Sotto: guilabel:Tipo, scegli Apri. Questo dirà a Windows di aprire un indirizzo Internet nel browser
predefinito, ad esempio Internet Explorer.

• Ubuntu Linux
Sotto Testo Azione, scrivi xdg-open. Questo dirà ad Ubuntu di aprire un indirizzo Internet nel tuo
browser predefinito, come Chrome o Firefox.

• macOS
Sotto Azione, scrivi apri. Questo indicherà a macOS di aprire un indirizzo Internet nel browser
predefinito, come Safari.
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Ora puoi continuare scrivendo il comando
Qualunque sia il comando usato in precedenza, è necessario dare l’indirizzo Internet. Vuoi usareGoogle, cercare
una frase automaticamente.
Normalmente quando usi Google, inserisci la frase di ricerca nella barra di ricerca Google. Ma in questo caso,
vuoi che sia il computer a fare questo per te. Il modo in cui dici a Google di cercare qualcosa (se non vuoi
usare direttamente la barra di ricerca) è dando al tuo browser l’indirizzo https://www.google.com/
search?q=SEARCH_PHRASE, dove SEARCH_PHRASE è quello che vuoi cercare. Dato che ancora non
conosciamo cosa cercare, inseriremo la prima parte (senza la frase di ricerca).

9. Nel campo Testo Azioni, scrivere https://www.google.com/search?q=. Ricorda di aggiungere uno
spazio dopo il comando iniziale e prima di aggiungere questo!
Ora vuoi che QGIS dica al browser di dire a Google di cercare il valore di name per ogni elemento su cui
potresti cliccare.

10. Seleziona il campo name.
11. Clicca il pulsante Inserisci:
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Questo significa che QGIS aprirà il browser e lo invierà all’indirizzo https://www.google.com/
search?q=[% "name" %]. [% "name" %] dice a QGIS di usare il contenuto del campo name
come frase di ricerca.
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Se, per esempio, l’area landuse su cui clicchi ha nome Marloth Nature Reserve, QGIS invierà
il browser a https://www.google.com/search?q=Marloth%20Nature%20Reserve`, che visiterà Google, che
cercherà «Marloth Nature Reserve».

12. Se non lo hai già fatto, imposta tutto come sopra indicato.
13. Clicca sul pulsante OK per chiudere il dialogo Aggiungi nuova azione

14. Clicca su OK per chiudere il dialogo Proprietà vettore

Ora prova la nuova azione.

1. Con il layer landuse attivo nel pannello Layer, clicca sulla freccia verso il basso a destro del pulsante
Esegui azione elemento, e seleziona l’unica azione (Google Search) definita per questo layer.

2. Clicca su qualche area landuse che vedi sulla mappa. Il tuo browser si aprirà, ed inizierà una ricerca Google
per il luogo che è registrato come valore name dell’area.

Nota: Se l’azione non funziona, controlla che tutto sia stato inserito correttamente; errori di battitura sono comuni
con questo tipo di lavoro!

5.4.4 Follow Along: Apri un sito direttamente in QGIS

Sopra, hai visto come aprire una pagina web in un browser esterno. Ci sono alcuni difetti con questo approccio nel
fatto che viene aggiunta una dipendenza sconosciuta - l’utente finale nel suo sistema avrà il software necessario per
eseguire l’azione? Come hai visto, non hanno necessariamente lo stesso tipo di comando per lo stesso tipo di azione,
se non sai su quale sistema operativo sarà usata. Con alcune versioni di sistema operativo, i comandi usato per aprire
il browser potrebbero non funzionare. Questo potrebbe essere un problema insormontabile.
Comunque, QGIS opera utilizzando l’incredibilmente potente e versatile libreria Qt. Inoltre, le azioni QGIS posso
essere arbitrari comandi Python, composti (p.e. usando informazioni variabili basate sul contenuto dell’attributo di
un campo)!
Ora vedrai come utilizzare un’azione python pe mostrare una pagina web. È la stessa idea generale per aprire un sito
in un browser esterno, ma non richiede alcun browser nel sistema dell’utente dato che utilizza la classe Qt QWebView
(che è un widget html basato su webkit) per visualizzare il contenuto in una finestra a comparsa.
Questa volta useremo Wikipedia. Quindi il URL che richiederai sarà come questo:
https://wikipedia.org/wiki/SEARCH_PHRASE

Per creare l’azione sul layer:
1. Apri la finestra Proprietà vettore e vai alla scheda Azioni.
2. Configura una nuova azione usando le seguenti proprietà:

• Type: Python
• Descrizione: Wikipedia
• Scope: Feature, Canvas
• Action Text:

from qgis.PyQt.QtCore import QUrl
from qgis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView(None)
myWV.load(QUrl('https://wikipedia.org/wiki/[%name%]'))
myWV.show()
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Ci sono un paio di cose da dire:
• [%name%] sarà rimpiazzato con l’attuale valore dell’attributo quando l’azione è invocata (come
precedentemente).

• Il codice semplicemente crea una nuova istanza di QWebView, imposta il suo URL, e chiama show()
per renderla visibile come una finestra sullo schermo dell’utente.

Puoi anche usare questo approccio per visualizzare un’immagine senza richiedere che l’utente abbia un
particolare visualizzatore di immagini sul suo sistema.

3. Prova ad utilizzare i metodi sopra descritti per caricare una pagina Wikipedia utilizzando l’azione Wikipedia
appena creata.
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5.4.5 In Conclusion

Le azioni di permettono di dare alla tua mappa della funzionalità extra, utili per l’utente finale che vede la stessa mappa
in QGIS. Dato che puoi utilizzare dei comandi shell per qualunque sistema operativo, oppure puoi usare Python, non
c’è limite alle funzioni che potresti incorporare!

5.4.6 What’s Next?

Ora che hai fatto tutti i tipi di creazione di vettori dati, imparerai come analizzare i dati per risolvere problemi. È
l’argomento del prossimo modulo.
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Module: Strumenti di analisi vettoriale

Ora che hai modificato alcuni elementi, vorrai sapere che altro puoi fare con essi. Avere elementi con attributi è bello,
ma ora puoi sapere tutto, anche quello che una mappa non-GIS non può dire.
Il vantaggio chiave del GIS è questo: un GIS può rispondere alle domande.

Nei prossimi tre moduli, tenteremo di rispondere ad una domanda di ricerca usando le funzioni di QGIS. Per esempio,
se fossi un agente immobiliare potresti dover cercare una proprietà residenziale in Swellendam per dei clienti che
dovrebbe soddisfare i criteri seguenti:

1. Deve essere in Swellendam.
2. Deve essere ad una distanza ragionevole da essere raggiunta in auto (diciamo 1 km).
3. Deve essere grande almeno 100 mq.
4. Deve essere a meno di 50 m da una strada principale.
5. Deve essere a meno di 500 m da un ristorante.

Con i prossimi moduli, utilizzeremo la potenza degli strumenti di analisi in QGIS per trovare il luogo adatto per
questo nuovo sviluppo residenziale.

6.1 Lesson: Riproiezione e trasformazione dei dati

Parliamo nuovamente dei Sistemi di Riferimento delle Coordinate (SR). L’abbiamo visto brevemente in precedenza,
ma non abbiamo discusso di cosa significhi nella pratica.
Obiettivo della lezione: Riproiettare e trasformare dataset vettoriali.
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6.1.1 Follow Along: Proiezioni

Il SR che tutti i dati, come la mappa stessa, ora utilizzano è chiamato WGS84. Questo è un Sistema di Coordinate
Geografiche (GCS) molto comune per la rappresentazione di dati. Ma, come vedremo, c’è un problema.

1. Salva la mappa attuale.
2. Poi apri la mappa del mondo che trovi in exercise_data/world/world.qgs
3. Ingrandisci il Sud Africa utilizzando lo strumento Ingrandisci

4. Prova ad impostare una scala nel campo Scala, che è nella Barra di Stato in fondo allo schermo. Mentre sei sul
Sud Africa, imposta il valore a 1:5 000 000 (1 a cinque milioni).

5. Muovi la mappa osservando il campo Scala

Noti che la scala cambia? Questo è perché ti stai spostando dal punto in cui eri quando hai ingrandito a 1:5 000
000, che era al centro dello schermo. Tutto attorno a quel punto, la scala è diversa.
Per comprendere il perché, pensa al globo della Terra. Ha delle linee che scorrono su di esso da Nord verso Sud.
Queste linee di longitudine sono distanziate all’equatore, ma si incontrano ai poli.
In un GCS, stai lavorando su questa sfera, ma il tuo schermo è piatto. Quando si tenta di rappresentare una sfera su
una superficie piatta, avvengono delle distorsioni, come succederebbe se tagli una palla da tennis e tenti di appiattirla.
In una mappa questo significa che le linee di longitudine stanno equamente distanziate una dall’altra, anche ai poli
(quando si dovrebbero incontrare). Questo significa che, nella tua mappa, come ti allontani dall’equatore, la scala degli
oggetti che vedi diventa sempre più grande. Per noi significa, in pratica, che non c’è una scala costante sulla mappa!
Per risolvere il problema, usiamo invece un Sistema di Coordinate di Progetto (PCS). Un PCS «proietta» o converte
i dati in modo da tener conto della modifica della scala e correggerla. Perciò, per tenere la scala costante, dobbiamo
riproiettare i nostri dati usando un PCS.

6.1.2 Follow Along: Riproiezione «al volo»

Per per definizione, QGIS riproietta i dati «al volo». Questo significa che anche se i tuoi dati sono in un altro SR,
QGIS può riproiettarli come se fossero in un SR di tua scelta.

Puoi cambiare il SR del tuo progetto cliccando sul pulsante SR attuale nell’angolo in basso a destra di QGIS.
1. Nella finestra di dialogo che appare, inserisci la parola global nel campo Filtro. Alcuni SR dovrebbero

apparire nel campo in basso Sistema di Riferimento delle Coordinate Predefinito.
2. Seleziona la voce WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 cliccando su di essa, e poi cliccando

OK.
Nota come la forma del Sud Africa cambia. Tutte le proiezioni lavorano cambiando la forma apparente degli
oggetti sulla terra.

3. Ingrandisci alla scala 1:5 000 000 di nuovo, come prima.
4. Sposta attorno la mappa.

Nota che la scala rimane la stessa!
La riproiezione «al volo» viene utilizzata anche per combinare dataset in differenti SR.

1. Aggiungi un altro layer vettoriale alla mappa che ha soli i dati per il Sud Africa. Lo troverai come
exercise_data/world/RSA.shp.

2. Caricalo. Un modo veloce per vedere il suo SR è spostare il mouse sopra il layer nella legenda. È EPSG:3410.
Che cosa noti?
Il layer è visibile anche se ha un SR diverso da quello di continents.

188 Capitolo 6. Module: Strumenti di analisi vettoriale



QGIS Training Manual

6.1.3 Follow Along: Salvare un data set con un SR diverso

A volte è necessario salvare un dataset esistente con un SR diverso. Come vedremo nella prossima lezione, se hai
bisogno di calcolare distanze sul layer, è meglio avere il layer in un sistema di coordinate proiettate.
Fai attenzione che la riproiezione «al volo» si riferisce al progetto non al singolo layer. Questo significa che il layer
può avere un SR diverso dal progetto anche se lo vedi nella posizione corretta.
Puoi facilmente esportare il layer con un diverso SR.

1. Aggiungi il dataset buildings dal file training_data.gpkg
2. Clicca col tasto destro sul layer buildings nel pannello Layers

3. Seleziona Esporta► Salva Elementi Come… nel menu che appare. Ti apparirà il dialogo Salva Vettore Come….
4. Clicca sul pulsante Sfoglia vicino al campo Nome file

5. Sfoglia in exercise_data/ e inserisci buildings_reprojected.shp come nome del nuovo layer
6. Cambia il valore di SR. Nel menu a scomparsa saranno visualizzati solo i SR utilizzati di recente. Clicca sul

pulsante Seleziona SR vicino al menu a scomparsa.
7. Apparirà la finestra di dialogo Coordinate Reference System Selector. Nel campo Filtro, cerca 34S.
8. Seleziona dalla listaWGS 84 / UTM zone 34S | EPSG:32734
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9. Lascia le altre opzione come sono. Il dialogo Save Vector Layer as… appare come questo:
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10. Clicca su OK

Ora puoi confrontare la vecchia e nuova proiezione del layer e vedere che sono in due diversi SR ma ancora si
sovrappongono.
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6.1.4 Follow Along: Creare la tua proiezione personalizzata

Ci sono molte altre proiezioni oltre a quelle incluse in QGIS. Puoi anche creare le tue proiezioni.
1. Inizia una nuova mappa.
2. Carica il dataset world/oceans.shp
3. Vai in Impostazioni ► Proiezioni Personalizzate… e vedrai questa finestra di dialogo.

4. Clicca sul pulsante Aggiungi nuovo SR per creare una nuova proiezione
5. Un’interessante proiezione da utilizzare è chiamata Van der Grinten I. Inserisci il suo nome nel campo

Nome.
Questa proiezione rappresenta la terra in un campo circolare invece che rettangolare, come fanno la maggior
parte delle proiezioni.

6. In Formato, selezionaWKT (Raccomandato).
7. Aggiungi la riga seguente nel campo Parameters:

PROJCRS["unknown",
BASEGEOGCRS["unknown",

DATUM["unknown",
ELLIPSOID["unknown",6371000,0,

LENGTHUNIT["metre",1,
ID["EPSG",9001]]]],

PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],

CONVERSION["unknown",
METHOD["Van Der Grinten"],
PARAMETER["Longitude of natural origin",0,

(continues on next page)
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(continua dalla pagina precedente)
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8802]],

PARAMETER["False easting",0,
LENGTHUNIT["metre",1],
ID["EPSG",8806]],

PARAMETER["False northing",0,
LENGTHUNIT["metre",1],
ID["EPSG",8807]]],

CS[Cartesian,2],
AXIS["(E)",east,

ORDER[1],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]],
AXIS["(N)",north,

ORDER[2],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]]]

8. Clicca su OK

9. Fai clic sul pulsante SR attuale a destra della barra di stato per cambiare il SR del progetto
10. Scegli la proiezione appena definita (cerca il suo nome nel campo Filtra)
11. Applicando questa proiezione, la mappa sarà riproiettata così:
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6.1.5 In Conclusion

Proiezioni diverse sono utili per scopi diversi. Scegliendo la proiezione corretta, puoi assicurare che gli elementi sulla
mappa saranno rappresentati accuratamente.

6.1.6 Further Reading

I materiali per la sezione Avanzata in questa lezione sono stati presi da questo articolo.
Leggi ulteriori informazioni su Coordinate Reference Systems.

6.1.7 What’s Next?

Nella prossima lezione imparerai come analizzare i vettori dati usando diversi strumenti di QGIS per l’analisi dei
vettori.

6.2 Lesson: Analisi vettoriale

I dati vettoriali possono anche essere analizzati per rivelare come elementi differenti interagiscono nello spazio. Ci
sono molte funzioni relative all’analisi, quindi non le vedremo tutte. Invece, porremo una domanda e proveremo a
rispondere utilizzando gli strumenti forniti da QGIS.
Scopo della lezione: Porre una domanda e rispondere utilizzando gli strumenti di analisi.
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6.2.1 Il procedimento GIS

Prima di iniziare, è utile fare una breve introduzione sul procedimento che può essere utilizzato per risolvere un
problema. Il modo di procedere è:

1. Enunciare il problema
2. Trovare i dati
3. Analizzare il problema
4. Presentare i risultati

6.2.2 Il problema

Iniziamo il procedimento stabilendo il problema da risolvere. Per esempio, sei un agente immobiliare e stai cercando
una proprietà immobiliare in Swellendam per dei clienti con i seguenti requisiti:

1. Deve essere in Swellendam
2. Deve essere ad una distanza, in automobile, ragionevole da una scuola (diciamo 1km)
3. Deve avere una dimensione maggiore di 100m quadrati
4. Entro 50m da una strada principale
5. Entro 500m da un ristorante

6.2.3 I dati

Per rispondere a queste domande, avremo bisogno dei seguenti dati:
1. Le proprietà residenziali (edifici) nell’area
2. Le strade dentro e attorno alla città
3. La posizione di scuole e ristoranti
4. Le dimensioni degli edifici

Questi dati sono disponibili tramite OSM, e dovresti scoprire che i dati utilizzati per questo manuale possono essere
utilizzati per questa lezione.
Se vuoi scaricare i dati di un’altra area, vai a Introduction Chapter per leggere come fare.

Nota: Anche se i dati scaricati da OSM hanno campi dati consistenti, la copertura ed i dettagli variano. Se trovi che
la regione scelta non contiene informazioni sui ristoranti, per esempio, puoi dover scegliere una regione diversa.

6.2.4 Follow Along: Iniziare un progetto e prendere di dati

Prima dobbiamo caricare i dati con cui lavorare.
1. Inizia un nuovo progetto QGIS
2. Se vuoi, puoi aggiungere una mappa di sfondo. Apri il Browser e carica la mappa di sfondo OSM dal menu

XYZ Tiles.
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3. Nel database Geopackage training_data.gpkg, troverai la maggior parte dei dati che useremo in questo
capitolo:
1. buildings
2. roads
3. restaurants
4. schools

Caricali, ed anche landuse.sqlite.
4. Ingrandisci per vedere Swellendam, South Africa

Prima di procedere filtreremo il layer roads, in modo da avere solo alcuni tipi specifici di strade con cui lavorare.
Alcune strade in OSM sono indicate come unclassified, tracks, path and footway. Vogliamo
escluderle dal nostro insieme di dati e concentrarci sugli altri tipi di strade, più adatte per questo esercizio.
Inoltre, i dati OSM potrebbero non essere ovunque aggiornati, escluderemo anche i valori NULL.

5. Clicca col tasto destro sul layer roads e scegli Filtro….
6. Nel dialogo che appare filtriamo questi elementi con la seguente espressione:

"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS␣
↪→NOT NULL

La concatenazione dei due operatori NOT e IN esclude tutti gli elementi che hanno questi valori nel campo
highway.
IS NOT NULL combinato con l’operatore AND esclude le strade con nessun valore nel campo highway.

Nota l’icona indicatore vicino al layer roads. Ti aiuta a ricordare che questo layer ha un filtro attivo, così
alcuni elementi potrebbero non essere disponibili per il progetto.
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La mappa con tutti i dati dovrebbe apparire come questa:

6.2.5 Try Yourself Convertire il SR dei layer

Dato che andremo a misurare distanze all’interno dei nostri layer, dobbiamo cambiare il sistema di riferimento SR dei
layer. Per fare questo, abbiamo bisogno di selezionare ogni layer a turno, salvare il layer in uno nuovo con la nostra
nuova proiezione, poi importare quel nuovo layer nella nostra mappa.
Ci diverse opzioni, p.e. puoi esportare ogni layer come uno shapefile nel formato ESRI, puoi aggiungere i layer ad
un file GeoPackage esistente, oppure puoi creare un altro file GeoPackage e riempirlo con i nuovi layer riproiettati.
Vedremo l’ultima opzione, quindi il file training_data.gpkg rimarrà pulito. Sentiti libero di scegliere l’opzione
che preferisci.

Nota: In questo esempio, useremo il SR WGS 84 / UTM zone 34S, ma potresti usare un SR UTM più appropriato
per la tua regione.

1. Clicca col tasto destro il layer roads nel pannello Layers

2. Clicca Esporta –> Salva Elementi Come…

3. Nella finestra di dialogo Salva Vettore Come scegli il Formato GeoPackage

4. Per il Nome File clicca su…, e chiama il nuovo GeoPackage vector_analysis
5. Cambia il Nome vettore in roads_34S
6. Cambia il SR inWGS 84 / UTM zone 34S

7. Clicca su OK:
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Questo creerà il nuovo database GeoPackage e aggiungerà il layer roads_34S.
8. Ripeti questo processo per ogni layer, creando un nuovo layer nel file vector_analysis.gpkg

GeoPackage con _34S aggiunto al nome originale.
SumacOS, premi il pulsante Sostituire nella finestra di dialogo che si apre per consentire a QGIS di sovrascrivere
il GeoPackage esistente.

Nota: Quando scegli di salvare un layer in un GeoPackage esistente, QGIS aggiunge quel layer insieme ai
layer esistenti nel GeoPackage, se non esiste già un layer con lo stesso nome.

9. Rimuovi tutti i vecchi layer dal progetto
10. Una volta completato il procedimento per ogni layer, clicca col tasto destro su ogni layer e clicca su Zoom sul

layer per focalizzare la mappa sull’area di interesse.
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Ora che abbiamo converito i dati OSM ad una proiezione UTM, possiamo iniziare i nostri calcoli.

6.2.6 Follow Along: Analisi del problema: distanze da scuole e strade

QGIS ti permette di calcolare le distanze tra qualunque oggetto vettore.
1. Assicurati che solo i layer roads_34S e buildings_34S siano visibili (per semplificare la mappa mentre

ci lavoriamo)
2. Clicca su Processing► Strumenti per aprire il nucleo analitico di QGIS. Fondamentalmente, tutti gli algoritmi

(per analisi vettoriale e raster) sono disponibili in questa raccolta di strumenti.
3. Inizieremo calcolando l’area a roads_34S usando l’algoritmo Buffer. Puoi trovarlo nel gruppo Geometria

vettore.
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Oppure puoi scrivere buffer nel menu di ricerca nella parte alta della raccolta:

4. Fai doppio click su di esso per aprire il dialogo dell’algoritmo
5. Seleziona roads_34S come Layer in ingresso, imposta Distanza a 50 e usa i valori predefiniti per gli altri

parametri.
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6. L’unità di misura predefinita per Distanza è metri perché l’insieme dei dati di partenza è in un Sistema di
Coordinate Proiettate che utilizza il metro come unità di misura. Puoi usare la lista a scomparsa per scegliere
altre unità di misura come chilometri, yards, ecc.

Nota: Se stai tentando di creare un buffer su un layer con un Sistema di Coordinate Geografiche, Processing
ti avviserà e suggerirà di riproiettare il layer su un Sistema di Coordinate metriche.

7. Normalmente, Processing crea dei layer temporanei e li aggiunge al pannello Layer. Puoi aggiungere il risultato
al database GeoPackage con:
1. Cliccando sul pulsante:guilabel:… e scegliere Salva come GeoPackage…

2. Nominando il nuovo layer roads_buffer_50m
3. Salvandolo nel file vector_analysis.gpkg
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8. Clicca su Esegui, e poi chiudi il dialogo Buffer

Ora la tua mappa dovrebbe apparire come questa:
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Se il nuovo layer è in cima alla lista Layer, probabilmente oscurerà la maggior parte della mappa, ma questo ti dà
tutte le aree nella regione che sono entro 50m da una strada.
Nota che ci sono aree distinte all’interno del buffer, che corrispondono ad ogni singola strada. Per eliminare questo
problema:

1. Deseleziona il layer roads_buffer_50m e ricrea il buffer con Dissolvi il resultato abilitato.
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2. Salva il risultato come roads_buffer_50m_dissolved

3. Clicca su Esegui e chiudi il dialogo Buffer

Una volta aggiunto il layer al pannello Layers, dovrebbe apparire come questo:
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Ora non ci sono suddivisioni inutili.

Nota: La Guida breve alla destra del dialogo spiega come lavora l’algoritmo. Se vuoi maggiori informazioni, clicca
sul pulsante Aiuto nella parte bassa per aprire una guida più dettagliata dell’algoritmo.

6.2.7 Try Yourself Distanza dalle scuole

Usa l’approccio appena visto per creare un buffer per le scuole.
Deve avere un raggio di 1 km. Salva il nuovo layer nel file vector_analysis.gpkg come
schools_buffer_1km_dissolved.

Soluzione
• La tua finestra di dialogo del buffer dovrebbe assomigliare a questa:
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La Distanza del buffer è 1 chilometro.
• Il valore in Segmenti è impostato a 20. Questo è opzionale, ma è raccomandato, perché rende i buffer di uscita
più uniformi. Confronta qui:
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Per fare ciò:
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La prima immagine mostra il buffer con il valore Segmenti impostato a 5 e la seconda mostra il valore impostato a
20. Nel nostro esempio, la differenza è minima, ma si può vedere che i bordi del buffer sono più lisci con il valore
più alto.

6.2.8 Follow Along: Intersecare le aree

Ora abbiamo identificato le aree dove le strade sono a meno di 50 metri e le aree dove ci sono scuole entro 1
km (in linea d’aria, non tramite strade). Ma ovviamente, vogliamo solo le aree dove entrambi questi criteri sono
soddisfatti. Per fare questo, dobbiamo usare lo strumento Intersezione. Puoi trovarlo nel gruppo Sovrapposizione
Vettore in Strumenti di Processing.

1. Usa i due layer buffer come Layer in ingresso e Layer di sovrapposizione, scegli il GeoPackage
vector_analysis.gpkg in Intersezione con Layer name road_school_buffers_intersect.
Lascia il resto come suggerito (predefinito).
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2. Clicca su Esegui.
Nell’immagine di seguito, le aree blu sono quelle dove entrambi i criteri di distanza sono soddisfatti.
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3. Puoi rimuovere i due layer buffer e tenere solo quello che mostra dove si sovrappongono, dato che è quello che
vogliamo sapere:

6.2. Lesson: Analisi vettoriale 211



QGIS Training Manual

6.2.9 Follow Along: Estrarre gli edifici

Ora abbiamo l’area da sovrapporre agli edifici. Ora, vogliamo estrarre gli edifici in quell’area.
1. Cerca la voce di menu Selezione eettore ► Estrai per posizione in Strumenti di Processing

2. Selezionabuildings_34S in Estrai elementi da. Abilita interseca inDove gli elementi (predicato geometrico),
seleziona il layer buffer di intersezione in Rispetto agli elementi da. Salva in vector_analysis.gpkg, e
nomina il layer well_located_houses.

3. Clicca Esegui e chiudi il dialogo
4. Probabilmente troverai che non sembra cambiato molto. Se è così, muovi il layer well_located_houses in cima

alla lista dei layer e poi ingrandisci.
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Gli edifici rossi sono quelli che corrispondono ai nostri criteri, mentre gli edifici in verde non li soddisfano.
5. Ora abbiamo due layer separati e possiamo rimuovere buildings_34S dall’elenco dei layer.

6.2.10 Try Yourself Ulteriore selezione degli edifici

Ora abbiamo un layer che ci mostra tutti gli edifici entro 1km da una scuola ed entro 50m da una strada. Ora dobbiamo
ridurre questa selezione per vedere solo gli edifici entro 500m da un ristorante.
Usando il procedimento prima descritto, crea un nuovo layer chiamato houses_restaurants_500m che poi filtrerà il
layer well_located_houses per mostrare solo gli edifici entro 500m da un ristorante.

Soluzione
Per creare il nuovo layer houses_restaurants_500m, passiamo attraverso un processo in due fasi:

1. Per prima cosa, crea un buffer di 500m intorno ai ristoranti e aggiungi il layer alla mappa:
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2. Successivamente, estrai gli edifici all’interno di quell’area buffer:
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La tua mappa dovrebbe ora mostrare solo gli edifici che si trovano entro 50 m da una strada, 1 km da una scuola e
500 m da un ristorante:
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6.2.11 Follow Along: Selezionare gli edifici della giusta dimensione

Per vedere gli edifici della giusta dimensione (più di 100 metri quadrati), dobbiamo calcolarne la dimensione.

1. Seleziona il layer houses_restaurants_500m ed apri il Calcolatore di Campi cliccando sul pulsante
Apri Calcolatore di Campi nella barra strumenti principale o nella tabella attributi

2. Seleziona Crea un nuovo campo, imposta il Nome campo di uscita in AREA, scegli Numero decimale (real)
come Tipo campo in uscita, e scegli $area dal gruppo Geometria.

Il nuovo campo area conterrà l’area di ogni edificio in metri quadrati
3. Clicca OK. Il campo AREA è stato aggiunto alla fine della tabella degli attributi.

4. Clicca il pulsante Attiva Modifiche per finire la modifica, e salva quando ti viene chiesto.
5. Nella scheda Sorgente delle proprietà del layer, imposta Filtro delle geometrie della sorgente dati in "AREA"

>= 100.
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6. Clicca OK.
La mappa dovrebbe ora mostrarti quegli edifici che soddisfano i nostri criteri iniziali e che sono di dimensione
maggiore di 100 metri quadrati.

6.2.12 Try Yourself

Salva la soluzione come nuovo layer, usando lo stesso metodo imparato poco fa. Il file dovrebbe essere salvato nel
database GeoPackage, con nome solution.
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6.2.13 In Conclusion

Usando l’approccio alla soluzione dei problemi GIS assieme agli strumenti di analisi vettoriale di QGIS, sei stato in
grado di risolvere un problema con molteplici criteri in modo facile e veloce.

6.2.14 What’s Next?

Nella prossima lezione, vedremo come calcolare la distanza minore tra un punto e l’altro lungo le strade.

6.3 Lesson: Analisi di reti

Calcolare la distanza più breve fra due punti è un’operazione comune in GIS. Strumenti per eseguirla possono essere
trovati in Strumenti di Processing.
Obiettivo della lezione: imparare ad usare gli algoritmi di Analisi di reti.

6.3.1 Follow Along: Gli strumenti ed i dati

Puoi trovare tutti gli algoritmi per l’analisi di reti nel menu Processing ► Analisi di reti
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Apri il progetto exercise_data/network_analysis/network.qgz. Contiene due layer:
• network_points

• network_lines

Il layer network_lines ha già uno stile che aiuta a comprendere la rete stradale.

Lo strumento percorso più breve permette di calcolare sia il percorso più breve che il più veloce fra due punti di una
rete, dati:

• punti di inizio e fine selezionati sulla mappa
• punto di inizio selezionato sulla mappa e punto di fine preso da un layer puntuale
• punto di inizio preso da un layer puntuale e punto di fine selezionato sulla mappa

Iniziamo.

6.3.2 Calcolare il percorso più breve (da punto a punto)

Il Analisi di reti ► Percorso più breve (da punto a punto) permette di calcolare la distanza più breve fra due punti
selezionati manualmente sulla mappa.
In questo esempio calcoleremo il percorso più breve (non il più veloce) fra due punti.

1. Apri l’algoritmo Percorso più breve (da punto a punto)

2. Seleziona network_lines per Vettore che rappresenta la rete

3. Usa Più corto per Tipo di percorso da calcolare

Per l’analisi usa questi due punti come punti di inizio e fine:
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4. Fai clic sul pulsante … accanto a Punto di partenza (x, y) e sceglie la posizione contrassegnata con Punto
di partenza nell’immagine. Attiva le opzioni di aggancio per una selezione accurata. Vengono aggiunte le
coordinate del punto cliccato.

5. Fai la stessa cosa, ma scegliendo il punto indicato Ending point per Punto finale

6. Clicca sul pulsante Esegui:

7. Un nuovo layer linea viene creato rappresentante il percorso più breve fra i due punti scelti. Disattiva il layer
network_lines per vedere meglio il risultato:
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8. Apri la tabella degli attributi per il layer creato. Contiene tre campi, rappresentanti le coordinate dei punti di
inizio e fine ed il costo.
Abbiamo scelto Più corto come Tipo di percorso da calcolare, quindi il costo rappresenta la distanza,
nelle unità del layer, tra le due località.
Nel nostro caso, la distanza più breve fra i due punti scelti è di circa 1000 metri:

Ora che sai come funziona lo strumento, sei libero di provare altre località.

6.3.3 Try Yourself Percorso più veloce

Con gli stessi dati dell’esercizio precedente, prova a calcolare il percorso più veloce fra due punti.
Quanto tempo serve per andare dal punto di inizio al punto di fine?

Soluzione
1. Apri Analisi di rete ► Percorso più breve (da punto a punto) e compila la finestra di dialogo come segue:
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2. Assicurati che il Tipo di percorso da calcolare sia Più veloce.
3. Fai clic su Esegui e chiudi la finestra di dialogo.
4. Apri ora la tabella degli attributi del layer in uscita. Il campo cost contiene il tempo di viaggio tra i due punti

(come frazione di ore):

6.3.4 Follow Along: Opzioni avanzate

Esploriamo altre opzioni degli strumenti di analisi di rete. Nel previous exercise 1 abbiamo calcolato il percorso più
veloce tra due punti. Come si può immaginare, il tempo dipende dalla speed del viaggio.
Useremo gli stessi layer e gli stessi punti degli esercizi precedenti.

1. Apri l’algoritmo Percorso più breve (da punto a punto)

2. Compila Layer iniziale, Punto di inizio e Punto di fine come fatto in precedenza
3. Scegli Più veloce per Tipo di percorso da calcolare
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4. Apri il menu Parametri avanzati

5. Cambia il valore di Velocità predefinita (km/h) da 50 a 4
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6. Clicca su Esegui

7. Una volta che l’algoritmo ha finito, chiudi il dialogo e apri la tabella attributi del layer creato.
Il campo costo contiene un valore coerente con il parametro velocità che è stata scelta. Possiamo convertire il
campo costo da ore e frazioni al valore più leggibile in minuti.

8. Apri il calcolatore campi facendo clic sull’icona
9. Aggiungi un nuovo campo per memorizzare il costo del percorso in minuti.

Ecco fatto! Ora sai quanti minuti ci vorranno per andare da un punto all’altro se la velocità dell’intera rete è di 4
km/h.
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6.3.5 Percorso più breve con limiti di velocità

Gli strumenti di analisi di rete hanno altre interessanti opzioni. Guardando questa mappa:

vorremmo conoscere l’itinerario più veloce considerando i limiti di velocità per ogni strada (le etichette
rappresentano i limiti di velocità in km/h). Il percorso più breve senza considerare i limiti di velocità sarà naturalmente
il percorso viola. Ma in quella strada il limite di velocità è di 20 km/h, mentre nella strada verde si può andare a 100
km/h!
Come fatto nel primo esercizio, useremo Analisi di reti ► Percorso più breve (da punto a punto) e sceglieremo
manualmente i punti di inizio e fine.

1. Apri l’algoritmo Analisi di reti ► Percorso più breve (da punto a punto)

2. Come parametro Vettore che rappresenta la rete seleziona network_lines

3. Scegli Più veloce per Tipo di percorso da calcolare

4. Seleziona il Punto iniziale (x, y) e il Punto finale (x, y) come abbiamo fatto in precedenza.
5. Apri il menu Parametri avanzati

6. Come parametro Campo per la velocità scegli speed. Con questa opzione l’algoritmo prenderà in considerazione
i limiti di velocità di ogni strada.
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7. Clicca il pulsante Esegui
8. Disabilita il layer network_lines per vedere meglio il risultato
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Come puoi vedere l’itinerario più veloce non corrisponde con il più breve.

6.3.6 Area servita (da layer)

L’algoritmo Analisi di reti ► Service area (from layer) può rispondere alla domanda: dato un layer puntuale, quali
sono tutte le aree raggiungibili dato un valore di distanza o tempo?

Nota: Il Analisi di reti ► Area di servizio (da punto) è lo stesso algoritmo, ma permette di scegliere manualmente il
punto sulla mappa.

Data una distanza di 250 metri vogliamo sapere quanto lontano possiamo andare sulla rete da ogni punto del layer
network_points.

1. Disattiva tutti i layer tranne network_points
2. Apri l’algoritmo Analisi di reti ► Service area (from layer)

3. Scegli network_lines per Vettore che rappresenta la rete

4. Per Vettore con i punti di partenza scegli network_points
5. In Tipo di percorso da calcolare scegli Più corto

6. Per il parametro Travel cost inserisci 250
7. Clicca su :guilabel:` Esegui` e chiudi i dialogo
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Il layer risultante rappresenta il percorso massimo che puoi fare dagli elementi punto data una distanza di 250
metri:
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Forte vero?

6.3.7 In Conclusion

Ora sai come usare l’algoritmo Analisi di reti per risolvere i problemi di più breve e più veloce.
Ora siamo pronti per fare alcune statistiche spaziali sui dati di layer vettoriali. Andiamo!

6.3.8 What’s Next?

Prossimamente vedrai come eseguire algoritmi di statistiche spaziali su insiemi di dati vettoriali.

6.4 Lesson: Statistiche spaziali

Nota: Lezione sviluppata da Linfiniti e S Motala (Cape Peninsula University of Technology)

Le statistiche spaziali permettono di comprendere cosa sta succedendo in un determinato insieme di dati vettoriali.
QGIS include molti strumenti utili per l’analisi statistica.
Scopo della lezione: Comprendere come utilizzare gli strumenti QGIS in Strumenti di Processing per le statistiche
spaziali.
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6.4.1 Follow Along: Creare un insieme di dati per il test

Creeremo un insieme di punti casuali, per avere un dataset con cui lavorare
Per questo, è necessario un insieme poligonale per definire l’area in cui creare i punti.
Useremo l’area coperta da strade.

1. Inizia un nuovo progetto
2. Aggiungi il dataset roads, così come srtm_41_19 (dati di altitudine) che si trova in exercise_data/

raster/SRTM/.

Nota: Potresti trovare che il layer SRTM DEM ha un diverso SR da quello del layer roads. QGIS riproietta
entrambi i layer in un singolo SR. Per il seguente esercizio questa differenza non ha importanza, sei libero di
riproiettarli (come mostrato in questo modulo).

3. Apri gli strumenti di Processing
4. Usa lo strumento Geometria vettore ► Geometri di delimitazione minima per generare un’area che racchiuda

tutte le strade selezionando Poligono Convesso in the Tipo di geometria:

Come sai, se non specifici l’uscita, Processing crea un layer temporaneo. Sta a te salvare subito il layer o più
tardi.

Creare punti casuali

• Creeremo 100 punti casuali in questa area utilizzando lo strumento Creazione vettore ► Punti casuali
nell’estensione del layer, con una distanza minima di 0.0:
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Nota: Il segno di avviso giallo segnala che il parametro riguarda le distanze. Il layer Bounding geometry è in
un sistema di coordinate geografiche e l’algoritmo te lo sta ricordando. Per questo esempio non useremo questo
parametro perciò può essere ignorato.

Se necessario, muovi i punti generati casualmente in coma alla legenda per vederli meglio:
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Campionamento dei dati

Per creare un insieme di dati di esempio dal raster, avrai bisogno dell’algoritmo Analisi raster ► Campiona valori
raster. Questo strumento campiona il raster nelle locazioni dei punti e aggiunge i valori raster in nuovi campi in base
al numero di bande nel raster.

1. Apri la finestra di dialogo dell’algoritmo Campiona valori raster

2. Seleziona Punti casuali come layer contenente i punti da campionare, e il raster SRTM come banda da
cui prendere i valori. Il nome predefinito per il nuovo campo è rvalue_N, dove N è il numero della banda
raster. Se vuoi puoi cambiare il nome del prefisso.

3. Premi Esegui
Ora puoi controllare i dati campionati dal file raster nella tabella degli attributi del layer Punti Campionati.
Saranno in un nuovo campo con il nome che hai scelto.
Un possibile layer campionato è mostrato qui:
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I punti campionati sono classificati usando il campo rvalue_1 così che i punti rossi sono ad un’altitudine maggiore.
Useremo questo layer di esempio per il resto degli esercizi statistici.

6.4.2 Follow Along: Statistiche elementari

Ora vediamo le statistiche elementari per questo layer

1. Clicca sull’icona Mostra sintesi delle statistiche nella Barra degli strumenti attributi. Apparirà un nuovo pannello.
2. Nel dialogo che apparirà, indica il layer Punti Campionati come sorgente.
3. Seleziona il campo rvalue_1 nella lista a comparsa dei campi. Questo è il campo per cui calcoleremo le

statistiche.
4. Il pannello Statistiche si aggiornerà automaticamente con le statistiche calcolate:
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Nota: Puoi copiare i valori cliccando sul pulsante Copia Statistiche negli Appunti ed incollare i risultati in un foglio
di calcolo.

5. Quando hai fatto chiudi il pannello Statistiche

Sono disponibili molte statistiche:
Conteggio

Il numero di campioni/valori.
Somma

I valori sommati assieme.
Media

Il valore medio (media) è la somma dei valori diviso per il numero di valori.
Mediana

Se si ordinano tutti i valori dal più piccolo al più grande, il valore in mezzo (o la media dei due valori in mezzo,
se N è un numero pari) è la mediana dei valori.

Deviazione standard (popolazione)
La deviazione standard. Dà una indicazione di quanto vicino alla media sono raggruppati i valori. Più piccola
è la deviazione standard, più i valori tendono ad essere vicini alla media.

Minimo
Il valore minimo.

Massimo
Il valore massimo.

Intervallo
La differenza fra i valori minimo e massimo.

Q1
Primo quartile dei dati.

Q3
Terzo quartile dei dati.

Valori mancanti (nulli)
Il numero di valori mancanti.

6.4.3 Follow Along: Calcolo di statistiche sulle distanze fra i punti

1. Crea un nuovo layer puntuale temporaneo.
2. Entra in modalità modifica, e digitalizza tre punti in mezzo agli altri punti.

Alternativamente, usa il metodo di generazione casuale dei punti visto precedentemente, ma specifica solo tre
punti.

3. Salva il nuovo layer come distance_points nel formato che preferisci.
Per creare statistiche sulla distanza fra i punti nei due layer:

1. Apri lo strumento Vettore Strumenti di Analisi ► Matrice di distanza.
2. Seleziona il layer distance_points come layer di ingresso, e il layer Punti Campionati come layer

di uscita.
3. Impostalo come questo:
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4. Sei vuoi puoi salvare il layer di uscita come un file oppure esegui l’algoritmo e salva il layer di uscita temporaneo
più tardi.

5. Clicca su Esegui per generare il layer matrice delle distanze
6. Apri la tabella degli attributi del layer generato: i valori si riferiscono alle distanze fra gli elementi

distance_points ed i loro due punti più vicini nel layer Punti Campionati:

Con questi parametri, lo strumento Matrice di distanza calcola statistiche di distanza per ogni punto del layer di
ingresso rispetto ai punti più vicini del layer destinazione. I campi del layer di uscita contengono lamedia, la deviazione
standard, il minimo e massimo per le distanze dai punti più prossimi ai punti del layer di ingresso.
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6.4.4 Follow Along: Analisi dei vicini più prossimi (all’interno del layer)

Per analizzare il vicino più prossimi in un layer puntuale:
1. Scegli Vettore Strumenti di analisi ► Nearest neighbor analysis.
2. Nel dialogo che appare, seleziona il layer Punti casuali e clicca Esegui.
3. I risultati appariranno nel pannello Visualizzatore risultati di Processing.

4. Clicca sul collegamento in blu per aprire la pagina html con i risultati:
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6.4.5 Follow Along: Media coordiante

Per avere la media delle coordinate di un insieme di dati:
1. Scegli Vettore Strumenti di analisi ► Media Coordinata(e)

2. Nel dialogo che appare, come Layer in ingresso seleziona Punti casuali, e lascia le altre opzioni invariate.
3. Clicca su Esegui.

Confrontiamo il risultato con le coordinate centrali del poligono usato per creare punti casuali.
1. Scegli Vettore Strumenti di geometria ► Centroidi

2. Nel dialogo che appare, seleziona Bounding geometry come layer di ingresso.
Come puoi vedere, la media coordinate (punto rosa) ed il centro dell’area di studio (in verde) non necessariamente
coincidono.
Il centroide è il baricentro del layer (il baricentro di un quadrato è il centro del quadrato) mentre la media delle
coordinate rappresenta la media delle coordinate di tutti i nodi.
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6.4.6 Follow Along: Istogrammi

L’istogramma di un insieme di dati mostra la distribuzione dei suoi valori. Il modo migliore per dimostrarlo in QGIS
è tramite l’istogramma immagine, disponibile nel dialogo Proprietà Layer di qualunque layer immagine (dati raster).

1. Nel pannello Layer, clicca col tasto destro sul layer srtm_41_19
2. Seleziona Proprietà
3. Scegli la scheda Istogramma. Clicca sul pulsante Calcola l’istogramma per generare il grafico. Dovresti vedere

un grafico che mostra la distribuzione di frequenza per i valori raster.
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4. Il grafico può essere esportato come immagine con il pulsante Salava la stampa

5. Puoi vedere informazioni più dettagliate sul layer nella scheda Informazioni (i valori medio e massimo sono
stimati, potrebbero non essere esatti).

Il valore medio è 332.8 (stimato in 324.3), ed il valore massimo è 1699 (stimato in 1548)! Puoi ingrandire
l’istogramma. Dato che ci sono molti punti con valore 0, l’istogramma appare compresso verticalmente. Ingrandendo
coprendo tutto tranne il picco a 0, si vedranno maggiori dettagli:
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Nota: Se i valori medio e massimo non sono gli stessi come sopra, può dipendere dal calcolo del valore min/max.
Apri la scheda Simbologia ed espandi il menu Impostazioni dei valori di Min e Max. Scegli Min / max e clicca su
Applica.

Tieni a mente che un istogramma mostra la distribuzione dei valori, e non tutti i valori sono necessariamente visibili
sul grafico.
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6.4.7 Follow Along: Interpolazione spaziale

Mettiamo di avere un insieme di punti campione da cui vogliamo estrapolare dei dati. Per esempio, potresti aver
accesso all’insieme Punti campionati creato in precedenza, e vorremmo avere qualche idea di come appare il terreno.

1. Per iniziare, esegui lo strumento GDAL ► Analisi raster ► Grid (IDW with nearest neighbor searching) in
Strumenti di Processing.

2. Seleziona Punti campionati per Point layer
3. ImpostaWeighting power a 5.0
4. In Advanced parameters, imposta Z value from field a rvalue_1
5. Infine clicca su Esegui ed attendi la fine dell’elaborazione
6. Chiudi il dialogo

Qui trovi un confronto fra l’insieme originale (a sinistra) e quello costruito dai nostri punti campionati (a destra). Il
tuo potrà apparire diverso data la natura casuale dei punti campionati.

Come puoi vedere, 100 punti non sono abbastanza per avere un’idea dettagliata del terreno. Dà un’idea molto generica,
può essere anche fuorviante.

6.4.8 Try Yourself Metodi diversi di interpolazione

1. Usa i procedimenti visti in precedenza per creare un insieme di 10 000 punti casuali

Nota: Se il numero di punti è grande, il tempo di calcolo può essere lungo.

2. Usa questi punti per campionare il DEM originale
3. Usa lo strumento Grid (IDW with nearest neighbor searching) su questo insieme di dati.
4. Imposta Power e Smoothing a 5.0 e 2.0, rispettivamente.

I risultati (dipendentemente dalla posizione dei tuoi punti casuali) apparirà più o meno come questo:
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Questa è una rappresentazione migliore del terreno, grazie alla maggiore densità dei punti campione. Ricorda, più
sono i campioni migliori sono i risultati.

6.4.9 In Conclusion

QGIS ha numerosi strumenti per l’analisi delle proprietà statistiche spaziali degli insiemi di dati.

6.4.10 What’s Next?

Ora che abbiamo visto l’analisi vettoriale, perché non vedere cosa può essere fatto con i raster? È quello che faremo
nel prossimo modulo!
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Module: Raster

Abbiamo usato i raster per la digitalizzazione in precedenza, ma i dati raster possono anche essere utilizzati
direttamente. In questo modulo, vedrai come può essere fatto in QGIS.

7.1 Lesson: Lavorare con dati raster

I dati raster sono molto differenti dai vettoriali. I dati vettoriali hanno elementi discreti con geometrie costruite dai
loro vertici, e quindi sono connessi con linee e/o aree. I dati raster, invece, sono come un’immagine. Sebbene possano
rappresentare varie proprietà di oggetti nel mondo reale, questi oggetti non esistono come oggetti separati. Invece,
sono rappresentati utilizzando pixel con diversi valori.
In questo modulo useremo i dati raster per integrare l’analisi GIS esistente.
Obiettivo della lezione: Imparare come lavorare con i dati raster in QGIS.

7.1.1 Follow Along: Caricare dati raster

I dati raster possono essere caricati con gli stessi metodi usati per i dati vettoriali. Comunque suggeriamo di utilizzare
il pannello Browser.

1. Apri il pannello Browser ed espandi la cartella exercise_data/raster.
2. Carica tutti i dati in questa cartella:

• 3320C_2010_314_RGB_LATLNG.tif

• 3320D_2010_315_RGB_LATLNG.tif

• 3420B_2010_328_RGB_LATLNG.tif

• 3420C_2010_327_RGB_LATLNG.tif

Dovresti vedere la seguente mappa:
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Ora ce l’abbiamo - quattro immagini aeree che coprono la nostra area di studio.

7.1.2 Follow Along: Creare un raster virtuale

Come puoi vedere, il layer soluzione giace su tutte le quattro immagini. Questo significa che ogni volta dovremo
lavorare con quattro raster. Non è l’ideale. Sarebbe meglio avere un solo file con cui lavorare.
Fortunatamente, QGIS permette di fare proprio questo, e senza la necessità di creare un nuovo file raster. Possiamo
creare un raster virtuale. Questo è spesso chiamato catalogo, che spiega la sua funzione. Non è un vero raster. Invece,
è un modo per organizzare i raster esistenti in un catalogo: un solo file per facilità di accesso.
Per creare un catalogo useremo Processing ► Strumenti.

1. Apri l’algoritmo Crea raster virtuale dal GDAL ► Miscellanea Raster;
2. Nella finestra di dialogo che appare, clicca sul pulsante … vicino al parametro Input layers e seleziona tutti i

layer oppure usa il pulsante Seleziona tutto;
3. Uncheck Place each input file into a separate band. Notice the code that is generated at the bottom of the

dialog under GDAL/OGR console call. This is the command that will be executed when you click Run. The text
updates as you change different options in the dialog.

Nota: Tieni a mente che per eseguire il comando puoi copiare ed incollare il testo in OSGeo Shell (utenti
Windows) o Terminal (utenti Linux e OSX). Puoi anche creare uno script per ogni comando GDAL. Questo
è molto utile quando la procedura richiede tempi lunghi o quando vuoi pianificare dei lavori specifici. Usa il
pulsante Aiuto per avere maggiori informazioni sulla sintassi del comando.

4. Infine clicca su Esegui.

Nota: As you know from the previous modules, Processing creates temporary layers by default. To save the file, click
on the… button under Virtual.
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Ora puoi rimuovere i quattro raster originali dal pannello Layer e lasciare solo il raster catalogo virtuale.
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7.1.3 Trasformare i dati raster

Il metodo visto ci permette di assemblare virtualmente dei dataset usando un catalogo, e riproiettarli «in corsa».
Comunque, se stai impostando dei dati che userai a lungo, è più efficiente creare dei nuovi raster già assemblati e
riproiettati. Questa aumenta le prestazioni durante l’uso dei raster su una mappa, ma può richiedere del tempo per
impostare il tutto.

Riproiettare i raster.

Da GDAL ► Proiezioni del raster apri Riproiezione.
Puoi anche riproiettare raster virtuali (cataloghi), abilitare l’elaborazione parallela,ed altro.
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Fondere dei raster

Se hai bisogno di crea un nuovo layer raster e salvarlo su disco puoi utilizzare l’algoritmo di fusione.

Nota: A seconda di quanti file raster stai fondendo e dalla loro risoluzione, il nuovo file raster creato può essere
molto grande. Considera, invece, di creare un catalogo raster come descritto nella sezione Creare un raster virtuale.

1. Dal menu GDAL ► Miscellanea Raster e clicca sull’algoritmo Fondi (merge).
2. Come detto per Creare un raster virtuale, usa il pulsante… per scegliere quali layer vuoi fondere.
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Come ingresso puoi anche scegliere un raster virtuale, e tutti i raster di cui consiste saranno elaborati.
3. Se conosci la libreria GDAL, puoi anche aggiungere le tue opzioni aprendo il menu Parametri avanzati.

7.1.4 In Conclusion

QGIS rende semplice includere dati raster nei tuoi progetti.

7.1.5 What’s Next?

Prossimamente, useremo dati raster che non sono immagini aeree, e vedremo come la simbologia è utile anche del
caso dei raster.
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7.2 Lesson: Cambiare la simbologia dei raster

Non tutti i dati raster sono foto aeree. Ci sono molte altre forme di dati raster, e in molti di questi casi, è essenziale
adeguare la simbologia perché diventino appropriatamente visibili ed utili.
Obiettivo della lezione:Modificare la simbologia di un layer raster.

7.2.1 Try Yourself

1. Usa il pannello Browser per caricare srtm_41_19.tif, che si trova in exercise_data/raster/
SRTM/

2. Ingrandisci all’estensione questo layer cliccandolo col tasto destro su Layer e scegliendo Zoom sul Layer.
Questo dataset è unDigital Elevation Model (DEM). È una mappa dell’altezza (altitudine) del terreno, che ci permette,
per esempio, di vedere dove sono montagne e vallate.
Mentre ogni pixel del dataset della precedente sezione conteneva informazioni sul colore, in un DEM, ogni pixel
contiene valori di altezza.
Una volta caricato il DEM, noterai che è una rappresentazione in scala di grigi:

QGIS ha applicato automaticamente uno stiramento ai valori dei pixel dell’immagine permeglio visualizzarli, andando
avanti impareremo altro su come funziona.
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7.2.2 Follow Along: Modificare la simbologia del layer raster

Ci sono due differenti opzioni per cambiare la simbologia del raster:
1. Dal dialogo Proprietà Layer, cliccando sul layer con il tasto destro nell’albero dei layer e selezionando l’opzione

Properties. Poi vai alla scheda Symbology

2. Cliccando sul pulsante Apri il pannello Stile Layer giusto sopra il pannello Layer (scorciatoia F7). Questo aprirà

il pannello Stile layer, dove puoi andare alla scheda Simbologia.
Scegli il metodo che preferisci.

7.2.3 Follow Along: Grigio banda singola

Quando carichi un file raster, se non è una foto come nella precedente sezione, lo stile predefinito è impostato ad un
gradiente in scala di grigio.
Esploriamo alcune possibilità di questo visualizzatore.
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Il Gradiente colore è impostato Da nero a bianco, a significare che i pixel con valori bassi sono neri mentre
quelli con valori alti sono bianchi. Prova ad invertire la selezione in Da bianco a nero e vedi i risultati.
Molto importante è il parametro Miglioramento contrasto: è predefinito in Stira a MinMax a significare che i
valori dei pixel sono stirati ai valori minimo e massimo.
Osserva la differenza con il miglioramento (a sinistra) e senza (a destra):
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Ma quali sono i valori minimo e massimo da usare per lo stiramento? Quelli attualmente in Impostazioni dei valori
di Min e Max. Ci sono molti modi per calcolare i valori minimo e massimo ed usarli per lo stiramento:

1. Definito dall’utente: inserisci i valori Min e Max manualmente
2. Taglio conteggio Cumulativo: questo è utile quando ci sono valori estremamente alti o bassi. Viene tagliato

il 2% (o il valore che scegli) di questi valori
3. Min / max: i valori minimo e massimo reali o stimati del raster
4. Media +/- deviazione standard: i valori saranno calcolati secondo il valore medio e la deviazione standard

7.2.4 Follow Along: Falso colore banda singola

Le scale di grigio non sono sempre ottimali per i layer raster. Proviamo a fare il DEM più colorato.
• Cambia Tipo visualizzazione in Banda singola falso colore. Se non ti piace il colore predefinito caricato,
selezionane un altro Scala colore

• Clicca il pulsante Classifica per generare una nuova classificazione colore
• Se non è generato automaticamente clicca sul pulsante OK per applicare questa classificazione al DEM
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Vedrai il raster apparire come questo:
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È un modo interessante per vedere il DEM. Vedrai che i valori del raster sono mostrati correttamente, dal blu per le
aree più basse fino al rosso per quelle più alte.

7.2.5 Follow Along: Cambiare la trasparenza

A volte cambiare la trasparenza di un layer raster può aiutare a vedere altri layer coperti dal raster e comprendere
meglio l’area di studio.
Per cambiare la trasparenza dell’intero raster vai alla scheda Trasparenza e usa il cursore di Opacità Globale per
abbassare l’opacità.
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Più interessante è cambiare la trasparenza per alcuni valori dei pixel. Per esempio nel raster utilizzato si può vedere un
colore omogeneo agli angoli. Per impostare questi piccoli in trasparenti, vai a Opzioni di Trasparenza Personalizzate
della scheda Trasparenza.

• Cliccando sul pulsante Aggiungi valori manualmente, puoi aggiungere un campo di valori e impostare la loro
percentuale di trasparenza

• Per valori singoli è più utile il pulsante Aggiungi valori dal display

• Clicca ul pulsante Aggiungi valori dal display. Il dialogo scompare e puoi interagire con la mappa.
• Clicca sul colore omogeneo in uno degli angoli del DEM
• Vedrai che la tabella di trasparenza sarà riempita con i valori cliccati:
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• Clicca su OK per chiudere il dialogo e vedere i cambiamenti.

Visto? Gli angoli sono ora al 100% trasparenti.
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7.2.6 In Conclusion

Queste sono alcune funzioni basilari per iniziare con la simbologia raster. QGIS ti dà molte altre opzioni,
come simboleggiare un layer usando valori tavolozza/univoci, rappresentare bande diverse con colori differenti in
un’immagine multi spettrale, o creando un effetto ombreggiatura (utile solo con file raster DEM).

7.2.7 Riferimento

Il dataset SRTM è stato ottenuto da http://srtm.csi.cgiar.org/

7.2.8 What’s Next?

Ora che possiamo vedere i nostri dati rappresentati correttamente, investigheremo come possiamo analizzarli
ulteriormente.

7.3 Lesson: Analisi del terreno

Alcuni tipi di raster permettono di avere una visione più profonda del terreno che rappresentano. A questo riguardo i
Digital Elevation Models (DEM) sono particolarmente utili. In questa lezione userai degli strumenti per l’analisi del
terreno per scoprire di più dell’area di studio per lo sviluppo residenziale proposto.
Obiettivo della lezione: Usare gli strumenti di analisi del terreno per ricavare maggiori informazioni su di esso.

7.3.1 Follow Along: Calcolare un’ombreggiatura

Useremo lo stesso layer DEM della precedente lezione. Se stai iniziando questo capitolo da zero, usa il pannello
Browser e carica raster/SRTM/srtm_41_19.tif.
Il layer DEMmostra l’elevazione del terreno, ma a volta può sembrare un po” astratto. Contiene tutte le informazioni
3D necessarie, ma non sembra un oggetto 3D. Per avere una migliore impressione del terreno, è possibile calcolare
una ombreggiatura, che è un raster che mappa il terreno usando luce e ombra per creare un effetto 3D.
Useremo gli algoritmi nel menu Raster ► Analisi Raster.

1. Clicca sul menu Ombreggiatura

2. L’algoritmo permette di specificare la posizione della sorgente di luce: Azimut della luce ha valori da 0 a 360
gradi (Nord) a 90 (Est), 180 (Sud) e 270 (Ovest), mentre Altitudine della luce imposta quanto in alto si trova
la sorgente di luce (da 0 a 90 gradi).

3. Useremo i seguenti valori:
• Fattore Z a 1.0
• Azimut della luce (angolo orizzontale) a 300.0°
• Altitudine della luce a 40.0°
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4. Salva il file in una nuova cartella exercise_data/raster_analysis/ con il nome hillshade.
5. Infine clicca su Esegui

Avrai un nuovo layer chiamato hillshade simile a questo:
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Appare migliore e in 3D, ma possiamomigliorarlo? Di suo sembra un calco di gesso. Non potremmo in qualche modo
usarlo assieme ai nostri raster più colorati? Naturalmente possiamo, utilizzando l’ombreggiatura come uno strato.

7.3.2 Follow Along: Usare l’ombreggiatura come uno strato

Un’ombreggiatura può fornire un’informazione molto utile sulla luce solare ad una determinata ora del giorno. Ma
può anche essere usate a scopi estetici, perché la mappa appaia migliore. La chiave di ciò è impostare l’ombreggiatura
perché sia quasi trasparente.

1. Cambia la simbologia del layer originale srtm_41_19 in modo che utilizzi lo schema Pseudocolor come visto
nell’esercizio precedente

2. Nascondi tutti i layer tranne srtm_41_19 e hillshade
3. Nel pannello Layers clicca e trascina srtm_41_19 perché stia sotto al layer hillshade
4. Imposta il layer hillshade a trasparente cliccando sulla scheda Trasparenza nelle proprietà layer
5. Imposta Opacità Globale a 50%.

Avrai un risultato simile a questo:

6. Attiva e disattiva il layer hillshade nel pannello Layer per vedere la differenza.
Usando l’ombreggiatura a questo modo, è possibile migliorare la topografia della veduta. Se l’effetto non ti sembra
abbastanza forte, puoi cambiare la trasparenza del layer hillshade; naturalmente, più intensa sarà l’ombreggiatura, più
soffusi saranno i colori sotto di essa. Dovrai trovare un bilanciamento adatto.
Ricorda di salvare il progetto quando hai fatto.
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7.3.3 Follow Along: Trovare le zone migliori

Ripensiamo al problema dell’agente immobiliare, che abbiamo affrontato l’ultima volta nella lezione Analisi vettoriale.
Immaginiamo che gli acquirenti vogliano ora acquistare un edificio e costruire un piccolo cottage sulla proprietà.
Nell’emisfero sud, sappiamo che un terreno ideale per lo sviluppo deve avere aree che:

• sono esposte a nord
• con una pendenza inferiore a 5 gradi
• Ma se la pendenza è inferiore a 2 gradi, allora l’esposizione non ha importanza.

Troviamo le zone migliori per loro.

7.3.4 Follow Along: Calcolare la pendenza

La Pendenza informa su quanto è ripido il terreno. Se, per esempio, vuoi costruire case sul terreno, allora hai bisogno
di un terreno che sia relativamente piatto.
Per calcolare la pendenza, devi usare l’algoritmo Slope di Processing ► Analisi raster ► Pendenza.

1. Apri l’algoritmo
2. Scegli srtm_41_19 come Elevation layer

3. Mantieni il :guilabel: Fattore Z a 1.0.
4. Salva il risultato come un file di nome slope nella stessa cartella hillshade
5. Clicca su Esegui

Ora vedrai la pendenza del terreno, ogni pixel contiene il valore di pendenza corrispondente. I pixel neri mostrano un
terreno piatto e quelli bianchi un terreno ripido:
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7.3.5 Try Yourself Calcolare l’esposizione

L”esposizione è la direzione della pendenza. Un’esposizione di 0 significa che la pendenza è rivolta verso Nord, 90
rivolt verso Est, 180 Sud e 270 Ovest.
Dato che questo studio ha luogo nell’emisfero meridionale, le proprietà dovrebbero idealmente essere costruite su una
pendenza rivolta verso Nord in modo che rimangano alla luce del sole.
Usa l’algoritmo Esposizione del Processing►Analisi Raster► Esposizione per ottenere il layer esposizione salvato
insieme alla pendenza.

Saluzione
Imposta la tua finestra di dialogo Aspetto in questo modo:
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Il tuo risultato:
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7.3.6 Follow Along: Trovare l’esposizione rivolta a nord

Ora, hai dei raster che ti mostrano la pendenza e l’esposizione, ma non hai modo di sapere dove le condizioni ideali
sono soddisfatte contemporaneamente. Come si potrebbe fare questa analisi?
La risposta è nel Calcolatore Raster.
QGIS ha diversi calcolatori raster:

• Raster ► Calcolatore Raster

• In processing:
– Analisi Raster ► Raster calculator

– GDAL ► Miscellanea Raster ► Calcolatore raster

– SAGA ► Raster calculus ► Raster calculator

Ogni strumento condurrà allo stesso risultato, ma la sintassi può differire leggermente e può variare la disponibilità
di operatori.
Useremo Analisi Raster ► Raster calculator negli strumenti Processing

1. Apri lo strumento facendo doppio click su di esso.
• La parte superiore sinistra del dialogo elenca tutti i layer raster caricati come nome@N, dove nome è il
nome del layer e N è la banda.

• Nella parte superiore destra vedrai un sacco di operatori. Smetti per un momento di pensare al raster
come un’immagine. Dovresti vederlo come una matrice 2D piena di numeri.

2. Il nord si trova a 0 (zero) gradi, quindi perché il terreno sia rivolto a nord, la sua esposizione deve essere
maggiore di 270 gradi o minore di 90 gradi. Quindi la formula è:

aspect@1 <= 90 OR aspect@1 >= 270

3. Ora bisogna impostare i dettagli del raster, come la dimensione delle celle, estensione e SR. Può essere
manualmente o automaticamente scegliendo un layer di riferimento. Scegli quest’ultima opzione
cliccando sul pulsante… vicino al parametro Reference layer(s)

4. Nel dialogo, scegli il layer aspect, perché vogliamo un layer con la stessa risoluzione.
5. Salva il layer come aspect_north.

Il dialogo dovrebbe apparire come questo:
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6. Infine clicca su Esegui.
Il risultato dovrebbe essere questo:
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I valori in uscita sono 0 o 1. Cosa significa? Per ogni pixel nel raster, la formula che abbiamo scritto restituisce se
corrisponde alle condizioni o meno. Quindi il risultato finale sarà Falso (0) e Vero (1).

7.3.7 Try Yourself Ulteriori criteri

Ora che hai fatto l’esposizione, crea due nuovi layer dal DEM.
• Il primo dovrebbe identificare le aree dove la pendenza è inferiore o uguale a 2 gradi
• Il secondo è simile, ma la pendenza dovrebbe essere minore o uguale a 5 gradi.
• Salvali in exercise_data/raster_analysis come slope_lte2.tif e slope_lte5.tif.

Saluzione
• Imposta la tua finestra di dialogo :guilabel: Calcolatore Raster con:
• la seguente espressione: slope@1 <= 2

• il layer slope come Reference layer(s)
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• Per la versione a 5 gradi, sostituisci il 2 nell’espressione e nel nome del file con 5.
I tuoi risultati:

• 2 gradi:
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• 5 gradi:
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7.3.8 Follow Along: Combinare i risultati dell’analisi raster

Ora che hai generato i tre layer raster dal DEM:
• aspect_north: terreni affacciati a nord
• slope_lte2: pendenza minore o uguale a 2 gradi
• slope_lte5: pendenza minore o uguale a 5 gradi

Dove la condizione è soddisfatta, il valore del pixel è 1. Altrove, è 0. Quindi, se moltiplichi questi raster, i pixel che
hanno un valore di 1 per tutti loro avranno un valore di 1 (il resto avrà 0).
Le condizioni da soddisfare sono:

• 5 gradi o meno di pendenza, il terreno deve affacciarsi a nord
• 2 gradi di pendenza o meno, la direzione verso cui si affaccia il terreno non ha importanza.

Perciò, dobbiamo trovare delle aree dove la pendenza è cinque gradi o meno AND (e) il terreno si affaccia a nord, OR
(oppure) la pendenza è due gradi o meno. Questo terreno sarà adatto per lo sviluppo.
Per calcolare le aree che soddisfano questi criteri:

1. Apri di nuovo il Calcolatore Raster
2. Usa questa espressione in Espressione:
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( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

3. Imposta il parametro Reference layer(s) a aspect_north (non importa se ne scegli un altro - sono stati tutti
calcolati da srtm_41_19)

4. Salva l’uscita in exercise_data/raster_analysis/ come all_conditions.tif
5. Clicca Esegui

Il risultato:

Suggerimento: I passi precedenti avrebbero potuto essere semplificati utilizzando il seguente comando:

((aspect@1 <= 90 OR aspect@1 >= 270) AND slope@1 <= 5) OR slope@1 <= 2
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7.3.9 Follow Along: Semplificare il raster

Come puoi vedere dall’immagine qui sopra, l’analisi combinata ci ha lasciato molte aree molto piccole in cui le
condizioni sono soddisfatte (in bianco). Ma queste non sono davvero utili per la nostra analisi, poiché sono troppo
piccole per costruirci sopra qualcosa. Sbarazziamoci di tutte queste piccole aree inutilizzabili.

1. Apri lo strumento Filtro (GDAL ► Analisi Raster negli Strumenti Processing)
2. Imposta Raster in ingresso a all_conditions, e Filtrato a all_conditions_sieve.tif (in

exercise_data/raster_analysis/).
3. Imposta Soglia a 8 (minimo otto pixel contigui), e seleziona Use 8-connectedness.

Una volta completata l’elaborazione, sarà caricato il layer.
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Che succede? La risposta è nei metadati del nuovo file raster.
4. Guarda i metadati nella scheda Informazioni del dialogo Proprietà Layer. Guarda il valore

STATISTICS_MINIMUM:
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Questo raster, come quello da cui è derivato, dovrebbe mostrare solo valori 1 e 0, ma ha anche un valore
negativo molto grande. Analizzando i dati si vede che questo numero agisce come un valore nullo. Siccome
siamo da aree non filtrate, impostiamo tutti questi valori nulli a zero.

5. Apri il Calcolatore Raster, e costruisci questa espressione:

(all_conditions_sieve@1 <= 0) = 0

Questa conserverà tutti i valori non negativi, ed imposterà i numeri negativi a zero, lasciando tutte le aree con
valore 1 intatte.

6. Salva l’uscita in exercise_data/raster_analysis/ come all_conditions_simple.tif.
Il risultato dovrebbe essere come questo:

Questo è quello che ci aspettavamo, una versione semplificata dei risultati precedenti. Ricorda che se i risultati non
sono quelli che ti aspettavi, guardare i metadati (e gli attributi del vettore, se applicabili) può essere essenziale per
risolvere il problema.

7.3.10 Follow Along: Reclassificare il raster

Abbiamo usato il Calcolatore Raster per fare calcoli sui layer raster. C’è un altro potente strumento che possiamo
usare per estrarre informazioni dai layer esistenti.
Torniamo al layer esposizione. Sappiamo che ha valori numerici da 0 a 360. Quello che vogliamo fare è
riclassificare il layer in valori discreti (da 1 a 4), a seconda dell’esposizione.

• 1 = Nord (da 0 a 45 e da 315 a 360);
• 2 = Est (da 45 a 135)
• 3 = Sud (da 135 a 225)
• 4 = Ovest (da 225 a 315)
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Questa operazione può essere fatta con il calcolatore raster, ma la formula sarebbe molto molto lunga.
La soluzione alternativa è lo strumento Riclassifica con tabella in Analisi raster analysis degli Strumenti Processing.

1. Apri lo strumento
2. Scegli aspect as the Raster
3. Clicca su… di Tabella di riclassificazione. Apparirà un dialogo tipo tabella, dove puoi scegliere i valori minimo,

massimo e nuovi valori per ogni classe.
4. Clicca sul pulsante Aggiungi Riga ed inserisci 5 righe. Riempi ogni riga come nella figura seguente e poi clicca

OK:

Il metodo utilizzato dall’algoritmo per gestire i valori soglia di ogni classe è definito da Limiti intervallo.
5. Salva il layer come reclassified.tif nella cartella exercise_data/raster_analysis/
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6. Clicca su Esegui

Se confronti il layer originario aspect con il reclassified, non ci sono molte differenze. Ma guardando la legenda, vedrai
che i valori vanno da 1 a 4.
Diamo a questo layer un aspetto migliore.

1. Apri il pannello Stile layer

2. Invece di Banda singola grigia, scegli Valori a tavolozza/univoci
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3. Clicca sul pulsante Classifica per estrarre automaticamente i valori ed assegnargli dei colori casuali:

L’uscita dovrebbe apparire come questa (avrai colori diversi dato che sono stati generati casualmente):

7.3. Lesson: Analisi del terreno 277



QGIS Training Manual

Con questa riclassificazione e lo stile tavolozza applicato al layer, puoi immediatamente differenziare l’esposizione
delle aree.

7.3.11 Follow Along: Interrogare il raster

Diversamente da layer vettoriali, i layer raster non hanno una tabella attributi. Ogni pixel contiene uno o più valori
numerici (raster a banda singola o multipla).
Tutti i layer raster considerati in questo esercizio consistono di una sola banda. A seconda del layer, i valori dei pixel
possono rappresentare valori di altitudine, esposizione o pendenza.
Come possiamo interrogare il layer per avere il valore di un pixel? Possiamo usare il pulsante Informazioni elementi!

1. Seleziona lo strumento dalla barra degli strumenti Attributi
2. Clicca in un punto a caso del layer srtm_41_19. Apparirà Informazioni Risultati con il valore della banda al

punto cliccato:
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3. Puoi cambiare la visualizzazione del pannello Informazioni Risultati dall’attuale modalità ad albero a
tabella selezionando Tabella nel menu Vista in fondo al pannello:

Cliccare ogni pixel del raster per vederne il valore potrebbe diventare irritante. Possiamo usare il plugin Value Tool
per risolvere il problema.

1. Vai a Plugins ► Gestisci ed Installa Plugin…

2. Nella scheda Tutti, nel campo di ricerca scrivi value t

3. Seleziona il plugin Value Tool, premi Installa Plugin e poi Chiudi il dialogo.
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Apparirà il nuovo pannello Value Tool.

Suggerimento: Se chiudi il pannello puoi riaprirlo abilitandolo in Impostazioni ► Pannelli ► Value Tool o
cliccando sull’icone nella barra strumenti.

4. Per usare il plugin seleziona Enable e assicurati che nel pannello il layer srtm_41_19 sia attivo (selezionato).
5. Muovi il cursore sopra la mappa per vedere i valori dei pixel.
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6. Ma c’è di più. Il plugin Value Tool ti permette di interrogare tutti i layer raster nel pannello Layer. Imposta di
nuovo come attivi i layer aspect e slope e muovi il mouse sulla mappa:

7.3.12 In Conclusion

Hai visto come ricavare tutti i tipi di prodotti di analisi da un DEM. Questi includono i calcoli di ombreggiatura,
pendenza ed esposizione. Hai anche visto come utilizzare il calcolatore raster per analizzare e combinare ulteriormente
questi risultati. Infine hai visto come riclassificare un layer e come interrogare i risultati.

7.3.13 What’s Next?

Ora hai due analisi: l’analisi vettoriale che ti mostra i lotti potenzialmente adatti, e l’analisi raster che ti mostra i
terreni potenzialmente adatti. Come possono essere combinati per arrivare ad un risultato finale per questo problema?
È l’argomento della prossima lezione, all’inizio del prossimo modulo.
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CAPITOLO8

Module: Completamento dell’analisi

Ora hai due metà dell’analisi: una parte vettoriale ed una raster. In questo modulo, vedrai come combinarle.
Concluderai l’analisi e visualizzerai i risultati finali.

8.1 Lesson: Conversione da Raster a Vettore

La conversione fra formati raster e vettoriali permette di utilizzare sia dati raster che vettoriali per la risoluzione di
un problema GIS, oltre ad utilizzare vari metodi di analisi specifici per queste due forme di dati geografici. Questo
aumenta la flessibilità disponibile quando si devono considerare le sorgenti dei dati ed i metodi di elaborazione per la
soluzione di un problema GIS.
Per combinare le analisi vettoriali e raster, è necessario convertire un tipo di dato nell’altro. Convertiamo il risultato
raster della precedente lezione in un vettore.
Obiettivo della lezione: Ottenere il risultato raster come vettoriale da utilizzare per completare l’analisi.

8.1.1 Follow Along: Lo strumento Da Raster a Vettore

Iniziamo con la mappa dell’ultimo modulo, raster_analysis.qgs. Dovresti avere
all_conditions_simple.tif calcolato durante l’esercizio precedene.

• Clicca su Raster ► Conversione ► Poligonizzazione (da raster a vettore). Apparirà la finestra di dialogo dello
strumento.

• Impostalo come questo:
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• Cambia il nome del campo (che descrive i valori del raster) in suitable.
• Salva il layer nella cartella exercise_data/residential_development con nome
all_terrain.shp.

Ora hai un file vettoriale che contiene tutti i valori del raster, ma le sole aree a cui sei interessato sono quelle idonee;
cioè quei poligoni dove il valore di suitable è 1. Puoi cambiare lo stile di questo layer se vuoi una rappresentazione
più chiara.

8.1.2 Try Yourself

Riferendoti al modulo sull’analisi vettoriale.
• Crea un nuovo file vettoriale che contiene solo i poligoni dove suitable ha il valore di 1.
• Salva il nuovo file sotto exercise_data/residential_development/ come
suitable_terrain.shp.

Soluzione
1. Apri :guilabel:”Generatore di query” facendo clic con il pulsante destro del mouse sul layer

:guilabel:”all_terrain” nel pannello :guilabel:”Layer” e selezionando la scheda :menuselection:”Properties –>
Source”.

2. Quindi costruisci la query "suitable" = 1.
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3. Fai clic su :guilabel:”OK” per filtrare tutti i poligoni in cui questa condizione non è soddisfatta. Se viste sopra
il raster originale, le aree dovrebbero sovrapporsi perfettamente:

4. Puoi salvare questo layer cliccando con il tasto destro sul layer all_terrain nel pannello Layer e scegliendo
:guilabel: Salva come…, poi continua come da istruzioni.

8.1.3 Follow Along: Lo strumento Da Vettore a Raster

Anche se non è necessario per il nostro problema attuale, è utile conoscere la conversione opposta a quella eseguita
sopra. Convertire in raster il file vettoriale suitable_terrain.shp appena creato nel passo precedente.

• Clicca su Raster ► Conversione ► Rasterizza (da vettore a raster) per partire con lo strumento, poi impostalo
come nella schermata seguente:
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• Layer in ingresso è all_terrain.
• Il nome campo è suitable.
• Unità di misura del raster in uscita è Pixels.
• Larghezza e Altezza sono 837 e 661, rispettivamente.
• Ricava l” Estensione risultato dal layer all_terrain.
• Imposta il file in uscita :guilabel: Rasterizzato a exercise_data/residential_development/
raster_conversion.tif.

Nota: La dimensione dell’immagine è specificata qui per essere la stessa del raster originale che è stato vettorializzato.
Per vedere le dimensioni di un’immagine, apri i suoi metadati (scheda guilabel:Metadata in Proprietà Layer).

• Clicca OK sul dialogo per iniziare la conversione.
• Quando è completata verifica la validità confrontando il nuovo raster con quello originale. Devono coincidere
perfettamente, pixel per pixel.
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8.1.4 In Conclusion

La conversione fra i formati raster e vettoriali permette di ampliare le applicazioni dei dati, senza andare verso un
degrado degli stessi.

8.1.5 What’s Next?

Ora che abbiamo i risultati dell’analisi del terreno in formato vettoriale, possiamo usarli per risolvere il problema di
quali edifici dovremmo considerare per lo sviluppo residenziale.

8.2 Lesson: Combinare le analisi

Usando i risultati vettorializzati dell’analisi raster ci permette di selezionare solo gli edifici su terreni adatti.
Obiettivo della lezione: Usare i risultati vettorializzati dei terreni per selezionare i lotti adatti.

8.2.1 Try Yourself

1. Salva la tua mappa attuale (raster_analysis.qgs).
2. Apri la mappa che hai creato prima durante l’analisi vettoriale (dovresti aver salvato il file come analysis.

qgs).
3. Nel pannello Layers, abilita questi layer:

• hillshade,
• solution (o buildings_over_100)

4. Oltre a questi layer, che dovrebbero essere già caricati nella mappa da quando ci hai lavorato prima, aggiungi
anche l’insieme dei dati suitable_terrain.shp.

5. Se ti mancano alcuni layer, dovresti trovarli in exercise_data/residential_development/
6. Usa lo strumento Intersezione… (Vettore ► Strumenti di Geoprocessing) per creare un nuovo layer vettoriale

chiamato new_solution.shp che contiene solo gli edifici che intersecano il layer suitable_terrain.
Dovresti ora avere un layer che mostra alcuni edifici come soluzione, per esempio:
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8.2.2 Try Yourself Controllare i risultati

Guarda ogni edificio nel layer new_solution. Confrontali con il layer suitable_terrain cambiando la simbologia del layer
new_solution in modo che abbiano solo i bordi. Che cosa noti per alcuni edifici? Sono tutti adatti perché intersecano
il layer suitable_terrain? Perché o perché no? Quali ritieni non siano adatti?

Soluzione
Potresti notare che alcuni degli edifici nel tuo layer new_solution sono stati «affettati» dallo strumento :guilabel:
Intersezione. Questo mostra che solo una parte dell’edificio - e quindi solo una parte della proprietà - si trova sul
terreno adatto. Possiamo quindi ragionevolmente eliminare quegli edifici dal tuo insieme di dati.

8.2.3 Try Yourself Affinare l’analisi

Puoi vedere dai risultati che alcuni edifici sono stati inclusi ma non sono veramente adatti, quindi possiamo affinare
l’analisi.
Vogliamo assicurarci che la nostra analisi restituisca solo gli edifici che rientrano interamente nel layer suitable_terrain.
Come si può ottenere questo risultato? Utilizza uno o più strumenti di Analisi Vettoriale e ricorda che i nostri edifici
sono tutti di dimensioni superiori a 100m quadrati.

Soluzione
Al momento, la tua analisi dovrebbe assomigliare a questa:
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Si consideri un’area circolare, continua per 100 metri in tutte le direzioni.

Se è più grande di 100 metri di raggio, allora sottraendo 100 metri dalla sua estensione (da tutte le direzioni) si otterrà
che una parte di essa sarà lasciata al centro.
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Pertanto, puoi eseguire un buffer interno di 100 metri sul tuo layer vettoriale esistente suitable_terrain. Nel risultato
della funzione buffer, qualsiasi cosa rimanga del layer originale rappresenterà le aree in cui c’è terreno adatto oltre i
100 metri.
Per dimostrarlo:

1. Vai a :menuselection: Vettore –> Strumenti di Geoprocessing –> Buffer per aprire la finestra di dialogo Buffer.
2. Imposta in questo modo:

290 Capitolo 8. Module: Completamento dell’analisi



QGIS Training Manual

3. Usa il layer suitable_terrain con10 segmenti e una distanza del buffer di-100. (La distanza è automaticamente
in metri perché la tua mappa sta usando un SR proiettato).

4. Salva il risultato in exercise_data/residential_development/ come
suitable_terrain_continuous100m.shp.

5. Se necessario, sposta il nuovo layer sopra il tuo layer originale suitable_terrain.
I tuoi risultati saranno qualcosa di simile a questo:
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6. Ora usa lo strumento Select by Location (:menuselection: Vettore –> Strumenti di ricerca –> Seleziona per
posizione).

7. Imposta in questo modo:

8. Seleziona gli elementi in new_solution che intersecano gli elementi in suitable_terrain_continuous100m.shp.
Questo è il risultato:
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Gli edifici in giallo sono selezionati. Anche se alcuni degli edifici cadono in parte al di fuori del nuovo layer
suitable_terrain_continuous100m, essi stanno abbastanza all’interno del layer originale suitable_terrain e quindi
soddisfano tutti i nostri requisiti.

9. Salva la selezione sotto exercise_data/residential_development/ come final_answer.
shp.

8.2.4 In Conclusion

Ora hai risposto alla domanda iniziale, e puoi dare un’opinione (con motivazioni supportate da un’analisi) per una
raccomandazione su quale proprietà sviluppare.

8.2.5 What’s Next?

Di seguito esporrai questi risultati come parte del tuo secondo compito.

8.3 Compito

Utilizzando il layout di stampa, crea una nuova mappa che rappresenti i risultati della tua analisi. Includi questi layer:
• places (con le etichette),
• hillshade,
• solution (oppure new_solution),
• roads e
• oppure aerial_photos o DEM.

Scrivi un breve testo esplicativo di accompagnamento. Includi in tale testo i criteri utilizzati per valutare una casa per
l’acquisto e il successivo sviluppo, così come la spiegazione delle tue raccomandazioni su quali edifici sono adatti.
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8.4 Lesson: Esercizio supplementare

In questa lezione, sarai guidato in una analisi GIS completa con QGIS.

Nota: Lezione preparata da Linfiniti Consulting (South Africa) e Siddique Motala (Cape Peninsula University of
Technology)

8.4.1 Enunciazione del problema

Sei incaricato di trovare delle aree all’interno e nei dintorni della Cape Peninsula che abbiamo un habitat adatto
per delle rare specie di boscaglia fine. L’estensione dell’area di analisi va da Cape Town alla Cape Peninsula tra
Melkbosstrand nel nord e Strand nel sud. I botanici hanno fornito le seguenti preferenze esposte dalle specie in
questione:

• Crescono nei pendii affacciati a est
• Crescono nei pendii con inclinazione compresa fra il 15% ed il 60%
• Crescono in aree con precipitazioni annue maggiori di 1000 mm
• Possono essere trovate solo ad oltre 250m da qualsiasi insediamento umano
• L’area verde in cui si trovano deve essere di almeno 6000m2

Come studente universitario, hai accettato di cercare le piante in quattro diverse aree. Vuoi che le quattro aree siano
quelle più vicine all’università di Cape Town dove vivi. Usa le tue abilità GIS per determinare dove dovresti andare
a cercare.

8.4.2 Tracciamento della soluzione

I dati per questo esercizio possono essere trovati nella cartella exercise_data/more_analysis.
Dovrai cercare le quattro aree adatte che sono più vicine all’università di Cape Town.
La soluzione comporterà:

1. Analizzare un layer raster DEM per trovare i pendii esposti a est e i pendii con le pendenze corrette.
2. Analizzare un layer raster delle precipitazioni per individuare le aree con la quantità di precipitazioni

corrispondente
3. Analizzare un layer vettoriale di zonizzazione per trovare aree che siano lontane dagli insediamenti umani e

che abbiano le dimensioni desiderate.

8.4.3 Follow Along: Impostazione della mappa

1. Clicca sul pulsante SR Attuale nell’angolo in basso a destra dello schermo. Nella scheda SR della finestra di
dialogo che appare, usa lo strumento «Filtro» per cercare «33S». Seleziona la voce WGS 84 / UTM zone 33S
(con codice EPSG 32733).

2. Clicca su OK
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Fig. 8.1: Setting up the CRS

3. Salva il file di progetto facendo clic sul pulsante della barra degli strumenti Salva progetto o utilizzando la voce di
menu Progetto ► Salva con nome….
Salvalo in una nuova cartella chiamata Rasterprac, che dovrai creare da qualche parte nel tuo computer.
Dovrai salvare i layer che creerai in questa cartella. Salva il progetto con nome tuo_nome_fynbos.qgs.

8.4.4 Caricare i dati nella mappa

Per elaborare i dati, devi caricare i layer necessari (nomi di strade, zone, precipitazioni, DEM, distretti) nell’area di
disegno della mappa.

Per i vettori…

1. Clicca sul pulsante Apri Gestore delle sorgenti dati nella Barra degli strumenti per la gestione delle sorgenti dati, ed
abilita la scheda Vettore nel dialogo che appare, oppure usa la voce di menu Layer ► Aggiungi Layer ►

Aggiungi Vettore…

2. Assicurati che sia selezionato File

3. Clicca sul pulsante… per sfogliare i dati vettoriali
4. Nella finestra di dialogo che appare, apri la cartella exercise_data/more_analysis/Streets
5. Seleziona il file Street_Names_UTM33S.shp
6. Clicca Apri.
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Il dialogo si chiude e mostra quello originario, con il percorso del file nel campo di testo vicino a Dataset
vettoriale. Questo ti permette di controllare di aver selezionato il file corretto. È anche possibile inserire
manualmente il percorso del file, nel caso volessi farlo.

7. Clicca Aggiungi. Il layer vettoriale sarà caricato sulla mappa. I colori saranno assegnati automaticamente. Li
cambierai più tardi.

8. Rinominare il layer in Streets
1. Clicca su di esso col tasto destro nel pannello Layer (per impostazione predefinita nella parte sinistra dello

schermo)
2. Nel dialogo che appare clicca su Rinomina Layer e rinominalo, premendo il tasto Invio quando finito

9. Ripeti il processo di aggiungere un vettore, ma questa volta seleziona il file
Generalised_Zoning_Dissolve_UTM33S.shp nella cartella Zoning.

10. Rinominalo in Zoning.
11. Carica anche il layer vettoriale admin_boundaries/Western_Cape_UTM33S.shp nella tua mappa.
12. Rinominalo in Districts.

Per i raster…

1. Clicca sul pulsante Apri Gestore delle sorgenti dati e abilita la scheda Raster nella finestra di dialogo che appare,
oppure usa la voce di menu Layer ► Aggiungi Layer ► Aggiungi Raster…

2. Assicurati che sia selezionato File

3. Naviga fino al file appropriato, selezionalo e clicca su :guilabel: Apri.
4. Fai lo stesso per i due file raster seguenti, DEM/SRTM.tif e rainfall/reprojected/rainfall.

tif

5. Rinomina il raster SRTM in DEM e il raster delle precipitazioni in Rainfall (con una maiuscola iniziale)

8.4.5 Cambiare l’ordine dei layer

Clicca e trascina i layer su e giù nel pannello Layer per cambiare l’ordine in cui appaiono sulla mappa in modo che
tu possa vedere il maggior numero possibile di layer.
Ora che tutti i dati sono caricati e opportunamente visibili, l’analisi può iniziare. È meglio se l’operazione di ritaglio
viene fatta prima. Questo per evitare che la potenza di elaborazione venga sprecata per calcolare valori in aree che
non verranno comunque utilizzate.

8.4.6 Trovare i distretti giusti

Considerata la succitata area di indagine, dobbiamo limitare i nostri distretti ai seguenti:
• Bellville

• Cape

• Goodwood

• Kuils River

• Mitchells Plain

• Simon Town

• Wynberg
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1. Fai clic destro sul layer Districts nel pannello Layer`.
2. Nel menu che appare, seleziona la voce Filtro…. Appare la finestra di dialogo Costruttore di interrogazioni.
3. Ora costruirai una query per selezionare solo i distretti che sono stati scelti:

1. Nell’elenco Campi, fai doppio clic sul campo NAME_2 per farlo apparire nel campo di testo in basso
Espressione di Filtro specifica

2. Fai clic sul pulsante IN per aggiungerlo alla query SQL
3. Apri le parentesi
4. Fai clic sul pulsante Tutti sotto l’elenco (attualmente vuoto) Valori.

Dopo poco, la lista Valori sarà popolata con i valori del campo selezionato (NAME_2).
5. Fai doppio clic sul valore Bellville nella lista :guilabel: Valori` per aggiungerlo alla query SQL.
6. Aggiungi una virgola e fai doppio clic per aggiungere il distretto Cape.
7. Ripeti il procedimento precedente per i restanti distretti
8. Chiudi le parentesi

Fig. 8.2: Query builder
La query finale dovrebbe essere (l’ordine dei distretti tra le parentesi non ha importanza):

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

Nota: Puoi anche usare l’operatore OR; la query sarebbe così:

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR
"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'

1. Fai clic su OK due volte.
I distretti mostrati nella tua mappa sono ora limitati a quelli della lista qui sopra.

8.4.7 Ritagliare i Raster

Ora che hai un’area di interesse, puoi ritagliare i raster su quest’area.
1. Apri la finestra di dialogo di ritaglio selezionando la voce di menu Raster ► Estrazione ► Ritaglia il raster con

maschera…:
2. Nell’elenco a discesa :guilabel:”Input layer”, seleziona il layer “”DEM””
3. Nell’elenco a discesa :guilabel:”Mask layer”, selezionare il layer “”Districts””
4. Scorri verso il basso e specifica una destinazione in uscita nel campo di testo Ritagliato (maschera) cliccando

il pulsante… e scegliendo :guilabel: Salva su file…

1. Vai alla cartella Rasterprac
2. Inserisci un nome di file - DEM_clipped.tif
3. Salva

5. Assicurati che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” è
selezionato
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6. Clicca Esegui
Al termine dell’operazione di ritaglio, lascia aperta la finestra di dialogo :guilabel:”Clip Raster by Mask Layer”
per poter riutilizzare l’area di ritaglio

7. Seleziona il layer raster “”Rainfall”” nell’elenco a discesa :guilabel:”Layer in ingresso” e salva l’output come
:file:”Rainfall_clipped.tif”

8. Non cambiare nessun’altra opzione. Lascia tutto come prima e clicca su :guilabel: Esegui
9. Dopo che la seconda operazione di ritaglio è stata completata, puoi chiudere la finestra di dialogo Ritagliare

raster con layer maschera

10. Salva la mappa

Fig. 8.3: Map view with filtered vector, clipped raster and reordered layers

Allinea i raster

Per la nostra analisi abbiamo bisogno che i raster abbiano lo stesso SR e che siano allineati.
Per prima cosa cambiamo la risoluzione dei nostri dati sulle precipitazioni a 30 metri (dimensione dei pixel):

1. Nel pannello :guilabel:”Layer”, assicurati che “”Rainfall_clipped”” sia il livello attivo (cioè, è evidenziato dopo
aver fatto clic su)

2. Fai clic sulla voce di menu :menuselection:”Raster –> Proiezioni –> Trasformazione (Riproiezione)…” per
aprire la finestra di dialogo :guilabel:”Trasformazione (Riproiezione)”

3. Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu
4. Imposta Risoluzione del file in uscita espressa in unità di mappa del SR di destinazione a 30.
5. Scorri fino a Riproiettato e salva il risultato nella cartella rainfall/reprojected come Rainfall30.

tif.
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6. Assicurati che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” è
selezionato

Fig. 8.4: Wrap (Reproject) Rainfall_clipped

Poi allineiamo il DEM:
1. Nel pannello :guilabel:”Layer”, assicurati che “”DEM_clipped”” sia il layer attivo (cioè, è evidenziato dopo

aver fatto clic su)
2. Fai clic sulla voce di menu :menuselection:”Raster –> Proiezioni –> Trasformazione (Riproiezione)…” per

aprire la finestra di dialogo :guilabel:”Trasformazione (Riproiezione)”
3. In :guilabel:”Target CRS”, seleziona :guilabel:”Project CRS: EPSG:32733 - WGS 84 / UTM zone 33S” dal

menu a discesa
4. Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu
5. Imposta Risoluzione del file in uscita espressa in unità di mappa del SR di destinazione a 30.
6. Scroll down to Georeferenced extents of output file to be created. Use the button to the right of the text box to

select Calculate from Layer ► Rainfall30.
7. Scorri fino a Riproiettato e salva il risultato nella cartella DEM/reprojected come DEM30.tif.
8. Assicurati che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” è

selezionato
Per vedere bene cosa stia avvenendo, la simbologia dei layer deve essere cambiata.

8.4.8 Cambiare la simbologia dei layer vettoriali

1. Nel pannello Layer, clicca con il tasto destro sul layer Streets.
2. Seleziona Proprietà dal menu che appare
3. Passa alla scheda :guilabel:”Simbologia” nella finestra di dialogo visualizzata
4. Fai clic sulla voce :guilabel: Linea nel widget superiore.
5. Seleziona un simbolo nell’elenco sottostante o impostatene uno nuovo (colore, trasparenza, …).
6. Fai clic su :guilabel:”OK” per chiudere la finestra di dialogo :guilabel:”Proprietà layer”. Questo cambierà il

rendering del layer :guilabel:”Streets”.
7. Segui una procedura simile per il layer :guilabel:”Zoning” e scegli un colore appropriato per esso

8.4.9 Cambiare la simbologia dei layer raster

La simbologia dei layer raster è un pò diversa.
1. Apri la finestra di dialogo :guilabel:”Proprietà” per il layer raster :guilabel:”Rainfall30”
2. Passa alla scheda :guilabel:”Simbologia”. Noterai che questa finestra di dialogo è molto diversa dalla versione

utilizzata per i layer vettoriali.
3. Expand Min/Max Value Settings

4. Assicurati che il pulsante :guilabel:”Media +/- deviazione standard” sia selezionato
5. Assicurati che il valore nella casella associata sia “”2.00””
6. For Contrast enhancement, make sure it says Stretch to MinMax

7. For Color gradient, change it toWhite to Black
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8. Clicca su OK

Fig. 8.5: Raster symbology

The Rainfall30 raster, if visible, should change colors, allowing you to see different brightness values for
each pixel

9. Ripeti questo processo per il layer “”DEM30””, ma imposta le deviazioni standard utilizzate per l’allungamento
su “”4.00””

8.4.10 Ripulire la mappa

1. Rimuovi i layer originali “”Rainfall”” e “”DEM””, così come “”Rainfall_clipped”” e “”DEM_clipped”” dal
pannello :guilabel:”Layer”:

• Fai clic con il pulsante destro del mouse su questi layer e seleziona :guilabel:”Rimuovi”.

Nota: Questo non rimuoverà i dati dal tuo dispositivo di memorizzazione, li toglierà semplicemente dalla
tua mappa.

2. Salva la mappa
3. Ora puoi nascondere i layer vettoriali deselezionando la casella accanto a loro nel pannello Layer. Questo

renderà il processo di visualizzazione della mappa più veloce e ti farà risparmiare un po” di tempo.

8.4.11 Creare l’ombreggiatura

Per creare l’ombreggiatura, dovrai utilizzare un algoritmo che è stato scritto per questo scopo.
1. Nel pannello :guilabel:”Layer”, assicurati che “”DEM30”” sia il layer attivo (cioè, è evidenziato dopo aver fatto

clic su)
2. Fai clic sulla voce di menu :menuselection:”Raster –> Analysis –> Hillshade…” per aprire la finestra di dialogo

:guilabel:”Hillshade”
3. Scroll down to Hillshade and save the output in your Rasterprac directory as hillshade.tif
4. Assicurati che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” è

selezionato
5. Clicca Esegui
6. Attendi che finisca l’elaborazione.

Fig. 8.6: Raster analysis Hillshade

Il nuovo layer “”hillshade”” è visibile nel pannello :guilabel:”Layer”.
1. Fai clic con il pulsante destro del mouse sul layer “”hillshade”” nel pannello :guilabel:”Layer” e visualizza la

finestra di dialogo :guilabel:”Proprietà”
2. Fai clic sulla scheda :guilabel:”Trasparenza” e imposta il dispositivo di scorrimento :guilabel:”Opacità globale”

su “”20%””
3. Clicca su OK
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4. Nota l’effetto quando l’hillshade trasparente viene sovrapposta alla DEM ritagliata. Potrebbe essere necessario
modificare l’ordine dei livelli o fare clic sul layer «Rainfall30» per vedere l’effetto.

8.4.12 Pendenza

1. Fai clic sulla voce di menu :menuselection:”Raster –> Analysis –> Slope…” per aprire la finestra di dialogo
dell’algoritmo :guilabel:”Slope”

2. Seleziona DEM30 come Input layer

3. Check Slope expressed as percent instead of degrees. Slope can be expressed in different units (percent or
degrees). Our criteria suggest that the plant of interest grows on slopes with a gradient between 15% and 60%.
So we need to make sure our slope data is expressed as a percent.

4. Definisci un nome di file appropriato e una posizione per il tuo risultato.
5. Assicurati che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” è

selezionato
6. Clicca Esegui

Fig. 8.7: Raster analysis Slope

L’immagine della pendenza è stata calcolata e aggiunta alla mappa. Come al solito, è visualizzata in scala di grigi.
Cambia la simbologia con una più colorata:

1. Apri la finestra di dialogo layer :guilabel:”Proprietà” (come al solito, tramite il menu di scelta rapida del layer)
2. Click on the Symbology tab
3. Where it says Singleband gray (in the Render type dropdown menu), change it to Singleband pseudocolor

4. Choose Mean +/- standard deviation x for Min / Max Value Settings with a value of 2.0
5. Seleziona una adatta :guilabel:”Rampa di colore”
6. Clicca Esegui

8.4.13 Try Yourself Esposizione

Utilizza lo stesso approccio utilizzato per il calcolo della pendenza, scegliendo :guilabel:”Aspetto…” nel menu
:menuselezione:”Raster –> Analisi”.
Ricordati di salvare il progetto periodicamente.

8.4.14 Riclassificare i raster

1. Choose Raster ► Raster calculator…

2. Specify your Rasterprac directory as the location for the Output layer (click on the… button), and save it
as slope15_60.tif

3. Assicurati che la casella :guilabel:”Apri file di output dopo l’esecuzione dell’algoritmo” sia selezionata.
Nell’elenco :guilabel:”Raster bands” a sinistra, vedrai tutti i layer raster nel tuo pannello :guilabel:”Layer”. Se
il tuo layer Slope si chiama :guilabel:”slope”, verrà elencato come “”slope@1””. Indicazione della banda 1 del
raster di pendenza.

4. The slope needs to be between 15 and 60 degrees.
Usando gli elementi della lista e i pulsanti dell’interfaccia, costruisci la seguente espressione:
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(slope@1 > 15) AND (slope@1 < 60)

5. Imposta il campo :guilabel:”Output layer” su una posizione e un nome di file appropriati.
6. Click Run.

Fig. 8.8: Raster calculator Slope

Now find the correct aspect (east-facing: between 45 and 135 degrees) using the same approach.
1. Costruisci la seguente espressione:

(aspect@1 > 45) AND (aspect@1 < 135)

You will know it worked when all of the east-facing slopes are white in the resulting raster (it’s almost as if they are
being lit by the morning sunlight).
Trova la pioggia corretta (maggiore di “”1000”” mm) allo stesso modo. Utilizzare la seguente espressione:

Rainfall30@1 > 1000

Now that you have all three criteria each in separate rasters, you need to combine them to see which areas satisfy all
the criteria. To do so, the rasters will be multiplied with each other. When this happens, all overlapping pixels with a
value of 1 will retain the value of 1 (i.e. the location meets the criteria), but if a pixel in any of the three rasters has
the value of 0 (i.e. the location does not meet the criteria), then it will be 0 in the result. In this way, the result will
contain only the overlapping areas that meet all of the appropriate criteria.

8.4.15 Combining rasters

1. Apri Calcolatore Raster (:menuselection:”Raster –> Calcolatore Raster…”)
2. Crea l’espressione seguente (con i nomi appropriati per i layer):

[aspect45_135] * [slope15_60] * [rainfall_1000]

3. Imposta il percorso di output nella directory :file:”Rasterprac”
4. Name the output raster aspect_slope_rainfall.tif
5. Verifica che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” sia

selezionata
6. Clicca Esegui

The new raster now properly displays the areas where all three criteria are satisfied.
Salva il progetto

Fig. 8.9: Map view where all three criteria are satisfied

The next criterion that needs to be satisfied is that the area must be 250 m away from urban areas. We will satisfy
this requirement by ensuring that the areas we compute are inside rural areas, and are 250 m or more from the edge
of the area. Hence, we need to find all rural areas first.
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8.4.16 Trovare le aree rurali

1. Nascondi tutti i layer nel pannello Layer

2. Deseleziona il layer vettoriale Zoning.
3. Fai clic con il pulsante destro del mouse su di esso e visualizza la finestra di dialogo :guilabel:”Attribute Table”.

Nota i molti modi diversi in cui la terra è suddivisa in zone qui. Vogliamo isolare le zone rurali. Chiudi la
tabella Attributo.

4. Fai clic con il pulsante destro del mouse sul livello “”Zoning”” e seleziona :guilabel:”Filter…” per visualizzare
la finestra di dialogo :guilabel:”Query Builder”

5. Costruisci la seguente query:

"Gen_Zoning" = 'Rural'

Vedi le istruzioni precedenti se sei in difficoltà.
6. Fai clic su :guilabel:”OK” per chiudere la finestra di dialogo :guilabel:”Generatore di query”. La query deve

restituire una funzionalità.

Query builder Zoning
Dovresti vedere i poligoni rurali dal layer «Zoning». Dovrai salvarli.

1. Nel menu di scelta rapida per “”Zoning””, seleziona :menuselection:”Export –> Save Features As… `.
2. Salva il tuo layer nella cartella Rasterprac.
3. Nome del file in uscita rural.shp
4. Clicca su OK

5. Salva il progetto
Now you need to exclude the areas that are within 250m from the edge of the rural areas. Do this by creating a
negative buffer, as explained below.

8.4.17 Creazione di un buffer negativo

1. Fai clic sulla voce di menu :menuselection:”Vector –> Geoprocessing Tools –> Buffer…”
2. Nella finestra di dialogo visualizzata, seleziona il layer “”rurale”” come layer vettoriale di input (:guilabel:”Solo

feature selezionate” non deve essere selezionato)
3. Imposta :guilabel:”Distanza” su “”-250””. Il valore negativo indica che il buffer sarà un buffer interno. Assicurati

che le unità siano metri nel menu a discesa.

4. Check Dissolve result

5. In Buffered, place the output file in the Rasterprac directory, and name it rural_buffer.shp
6. Fai clic su Salva

7. Fai clic su :guilabel:”Esegui” e attendi il completamento dell’elaborazione
8. Chiudi la finestra di dialogo Buffer.

Assicurati che il buffer funzioni correttamente notando come il layer «rural_buffer» sia diverso dal layer
«rurale». Potrebbe essere necessario modificare l’ordine di disegno per osservare la differenza.

9. Rimuovi layer ``rural`
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10. Salva il progetto

Fig. 8.10: Map view with rural buffer

Ora devi combinare il tuo layer vettoriale «rural_buffer» con il raster «aspect_slope_rainfall». Per combinarli,
dovremo cambiare il formato dei dati di uno dei layer. In questo caso, vettorializzerai il raster, poiché i layer vettoriali
sono più convenienti quando vogliamo calcolare le aree.

8.4.18 Vettorializzare il raster

1. Fai clic sulla voce di menu :menuselection:”Raster –> Conversion –> Polygonize (Raster to Vector)…”
2. Seleziona il raster :file:”aspect_slope_rainfall” come :guilabel:”Input layer”
3. Set Name of the field to create to suitable (the default field name is DN - Digital number data)
4. Salva l’output. In :guilabel:”Vectorized”, selezionare :guilabel:”Save file as”. Imposta il percorso su

:file:”Rasterprac” e denomina il file :file:”aspect_slope_rainfall_all.shp”.
5. Verifica che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” sia

selezionata
6. Clicca Esegui
7. Chiudi la finestra di dialogo quando l’elaborazione è terminata.
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Fig. 8.11: Raster to Vector

All areas of the raster have been vectorized, so you need to select only the areas that have a value of 1 in the
suitable field. (Digital Number.

1. Apri la finestra di dialogo :guilabel:”Query Builder” (fai clic con il pulsante destro del mouse -
:guilabel:”Filter…”) per il nuovo layer vettoriale

2. Costruisci questa query:

"suitable" = 1

3. Clicca su OK

4. Dopo esserti assicurato che la query sia stata completata (e che siano visibili solo le aree che soddisfano tutti e
tre i criteri, cioè con un valore di 1), crea un nuovo file vettoriale dai risultati, usando il comando Esporta ►
Salva elementi con nome… nel menu tasto destro del mouse del layer.

5. Salva il file nella directory :file:”Rasterprac”
6. Denomina il file :file:`aspect_slope_rainfall_1.shp
7. Rimuovi il layer aspect_slope_rainfall_all dalla tua mappa
8. Salva il tuo progetto

When we use an algorithm to vectorize a raster, sometimes the algorithm yields what is called «Invalid geometries»,
i.e. there are empty polygons, or polygons with mistakes in them, that will be difficult to analyze in the future. So, we
need to use the «Fix Geometry» tool.
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8.4.19 Fixing geometry

1. In the Processing Toolbox, search for «Fix geometries», and Execute… it
2. Per :guilabel:”Input layer”, seleziona “”aspect_slope_rainfall_1””
3. In :guilabel:”Geometrie fisse”, seleziona :guilabel:”Salva file con nome”, quindi salva l’output in

:file:”Rasterprac” e denomina il file :file:”fixed_aspect_slope_rainfall.shp”.
4. Verifica che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” sia

selezionata
5. Clicca Esegui
6. Chiudi la finestra di dialogo quando l’elaborazione è terminata.

Ora che hai vettorializzato il raster e fissato la geometria risultante, puoi combinare i criteri di aspetto,
pendenza e pioggia con la distanza dai criteri di insediamento umano trovando l’intersezione del layer
«fixed_aspect_slope_rainfall» e del layer «rural_buffer».

8.4.20 Determining the Intersection of vectors

1. Fai clic sulla voce di menu :menuselection:”Vector –> Geoprocessing Tools –> Intersection…”
2. Nella finestra di dialogo visualizzata, seleziona il layer “”rural_buffer”” come :guilabel:”Livello di input”
3. Per :guilabel:”Overlay layer”, seleziona il layer “”fixed_aspect_slope_rainfall””
4. In :guilabel:”Intersection”, inserisci il file di output nella directory :file:”Rasterprac”
5. Name the output file rural_aspect_slope_rainfall.shp
6. Fai clic su Salva

7. Fai clic su :guilabel:”Esegui” e attendi il completamento dell’elaborazione
8. Chiudi la finestra di dialogo :guilabel:”Intersezione”.

Make sure that your intersection worked correctly by noting that only the overlapping areas remain.
9. Salva il progetto

The next criteria on the list is that the area must be greater than 6000m2. You will now calculate the polygon areas
in order to identify the areas that are the appropriate size for this project.

8.4.21 Calcolare l’area per ogni poligono

1. Apri il menu di scelta rapida del nuovo layer vettoriale
2. Select Open attribute table

3. Fai clic sull”|modificaModifica| :sup:”Attiva/disattiva il pulsante di modifica” nell’angolo in alto a sinistra della
tabella oppure premi :kbd:”Ctrl+e”

4. Fai clic sul campo |calcola| :sup:Pulsante “Apri calcolatrice campo” nella barra degli strumenti lungo la parte
superiore della tabella, oppure premi :kbd:”Ctrl+i”

5. Nella finestra di dialogo visualizzata, assicurati che | casella di controllo| :guilabel:”Crea nuovo campo” sia
selezionato e imposta :guilabel:”Nome campo di output” su “”area”” Il tipo di campo di output deve essere un
numero decimale (reale). Impostare :guilabel:”Precision” su “”1”” (un decimale).

6. Nell’area :guilabel:”Expression” digitare:

$area
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Ciò significa che il calcolatore di campi calcolerà l’area di ciascun poligono nel layer vettoriale e quindi popolerà
una nuova colonna intera (chiamata “”area””) con il valore calcolato.

Fig. 8.12: Field Calculator

7. Clicca su OK

8. Fai la stessa cosa per un altro nuovo campo chiamato “”id””. In :guilabel:”Field calculator expression”, digita:

$id

This ensures that each polygon has a unique ID for identification purposes.
9. Fai clic su |modificamodifica| :sup:”Attiva/disattiva di nuovo la modifica” e salva le modifiche se richiesto
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Fig. 8.13: Attribute table with area and id columns

8.4.22 Selecting areas of a given size

Now that the areas are known:
1. Build a query (as usual) to select only the polygons that are larger than 6000m2. The query is:

"area" > 6000

2. Salvare la selezione nella directory :file:”Rasterprac” come nuovo layer vettoriale denominato
:file:”suitable_areas.shp”.

Ora hai le aree adatte che soddisfano tutti i criteri di habitat per la rara pianta di fynbos, da queste sceglierai le quattro
aree più vicine all’Università di Città del Capo.

8.4.23 Digitalizza l’Università di Città del Capo

1. Crea un nuovo layer vettoriale nella directory :file:”Rasterprac” come prima, ma questa volta usa
:guilabel:”Point” come :guilabel:”Geometry type” e assegnagli un nome :file:”university.shp”

2. Assicurati che sia nel SR corretto (Progetto CRS:EPSG:32733 - WGS 84 / zona UTM 33S)
3. Termina la creazione del nuovo layer (clicca su OK)
4. Nascondi tutti i layer tranne il nuovo layer university e il layer Streets.
5. Aggiungi una mappa di sfondo (OSM):

1. Go to the Browser panel and navigate to XYZ Tiles ► OpenStreetMap

2. Trascina e rilascia la voce “”OpenStreetMap”” nella parte inferiore del pannello :guilabel:”Layer”
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Using your internet browser, look up the location of the University of Cape Town. Given Cape Town’s unique
topography, the university is in a very recognizable location. Before you return to QGIS, take note of where
the university is located, and what is nearby.

6. Assicurati che il layer «Strade» sia stato cliccato e che il layer «università» sia evidenziato nel pannello
:guilabel:»Layer»

7. Passa alla voce di menu :menuselection:”View –> Toolbars” e assicuratii che :guilabel:”Digitalizzazione” sia
selezionato. Dovresti quindi vedere un’icona della barra degli strumenti con una matita su di essa ( :sup:
“Toggle editing”). Questo è il pulsante Attiva/disattiva modifica.

8. Fai clic sul pulsante :guilabel:”Toggle editing” per accedere a edit mode. Ciò consente di modificare un layer
vettoriale

9. Fai clic sul :sup:Pulsante “Aggiungi caratteristica punto”, che dovrebbe trovarsi vicino al :sup:Pulsante
“Attiva/disattiva modifica”

10. With the Add feature tool activated, left-click on your best estimate of the location of the University of Cape
Town

11. Immetti un numero intero arbitrario quando viene richiesto l’id
12. Clicca su OK

13. Fai clic sul | Salva Modifiche| :sup:Pulsante “Salva modifiche livello”
14. Click the Toggle editing button to stop your editing session
15. Salva il progetto

8.4.24 Trova i luoghi più vicini all’Università di Città del Capo

1. Go to the Processing Toolbox, locate the Join Attributes by Nearest algorithm (Vector general ► Join Attributes
by Nearest) and execute it

2. Input layer should be university, and Input layer 2 suitable_areas

3. Imposta una posizione e un nome di output appropriati (:guilabel:”Livello unito”)
4. Imposta :guilabel:”Massimo vicini più vicini” su “”4””
5. Verifica che | casella di controllo| :guilabel:”Apri il file di output dopo l’esecuzione dell’algoritmo” sia

selezionata
6. Lascia i parametri rimanenti con i loro valori predefiniti
7. Clicca Esegui

Il layer di punti risultante conterrà quattro elementi: avranno tutti la posizione dell’università e i suoi attributi e, inoltre,
gli attributi delle aree adatte vicine (incluso l’id) e la distanza da quella posizione.

1. Apri la tabella degli attributi del risultato del join
2. Prendi nota dell’id delle quattro aree adatte più vicine, quindi chiudi la tabella degli attributi
3. Apri la tabella degli attributi del layer “”suitable_areas””
4. Build a query to select the four suitable areas closest to the university (selecting them using the id field)

Questa è la risposta finale alla quesito posto.
Per l’invio, crea un layout completamente etichettato che includa il layer hillshade semitrasparente su un raster
accattivante di tua scelta (come il DEM o il raster di pendenza, ad esempio). Includi anche l’università e il layer
«suitable_areas», con evidenziate le quattro aree adatte più vicine all’università. Segui tutte le best practice per la
cartografia nella creazione della tua mappa di output.
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CAPITOLO9

Module: Plugin

I plugin permettono di estendere le funzionalità che QGIS offre. In questo modulo, ti sarà mostrato come attivare e
utilizzare i plugin.

9.1 Lesson: Installare e Gestire i Plugin

Per iniziare ad usare i plugin, devi sapere come scaricarli, installarli e attivarli. Per fare questo, imparerai ad usare
Installazione Plugin e :guilabel: Gestione Plugin.
Obiettivo di questa lezione: Capire e usare il sistema di plugin di QGIS.

9.1.1 Follow Along: Gestione Plugin

1. Per aprire il :guilabel: Gestore dei plugin, clicca sulla voce di menu Plugin ► Gestisci ed installa Plugin….
2. Nella finestra di dialogo che si apre, cerca il plugin Processing:
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3. Clicca nella casella accanto a questo plugin e deselezionala per disattivarlo.
4. Fai clic su Chiudi.
5. Guardando il menu, noterai che il menu Processing è sparito. Questo significa che molte delle funzioni di

elaborazione che hai usato prima sono scomparse! Per esempio guarda i menu Vettore ► e Raster ►. Questo
perché fanno parte del plugin Processing, che deve essere attivato per usarli.

6. Apri di nuovo il Gestore dei plugin e riattiva il plugin Processing cliccando sulla casella di controllo accanto ad
esso.

7. Chiudi la finestra di dialogo. Il menu e le funzioni di Processing dovrebbero essere nuovamente disponibili.

9.1.2 Follow Along: Installare Nuovi Plugin

L’elenco dei plugin che puoi attivare e disattivare deriva dai plugin che hai attualmente installati. Per installare nuovi
plugin:

1. Seleziona l’opzione Non installati I plugin disponibili per l’installazione saranno elencati qui. Questo elenco
varia a seconda della configurazione del tuo sistema.
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2. Trova informazioni sul plugin selezionandolo nella lista

3. Installa quello o quelli che ti interessano cliccando sul pulsante Installa Plugin sotto il pannello delle
informazioni del plugin.

Nota: se il plugin ha qualche errore sarà elencato nella scheda Non valido. Puoi quindi contattare il proprietario del
plugin per risolvere il problema.
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9.1.3 Follow Along: Configurazione di Repository Aggiuntivi di Plugin

I plugin che sono disponibili per l’installazione dipendono dai repository di plugin per i quali hai impostazioni di
utilizzo configurate.
I plugin di QGIS sono memorizzati online in repository. Per impostazione predefinita, solo official repository è attivo,
il che significa che puoi accedere solo ai plugin che sono pubblicati lì. Data la grande varietà di strumenti disponibili,
questo repository dovrebbe soddisfare la maggior parte delle tue esigenze.
È possibile, tuttavia, provare più plugin di quelli predefiniti. Per prima cosa, è necessario configurare ulteriori
repository. Per fare questo:

1. Apri la scheda :guilabel: Impostazioni nella finestra di dialogo Gestore dei plugin

2. Fai clic su Aggiungi… per cercare e aggiungere un nuovo repository.
3. Apri la scheda Impostazioni nella finestra di dialogo :guilabel: Gestore dei plugin. Fornisci un Nome e un URL

per il nuovo repository che vuoi configurare e assicurati che la casella di controllo Abilitato sia selezionata.
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4. Ora vedrai il nuovo repo di plugin elencato nella lista dei repository di plugin configurati

5. Puoi anche selezionare l’opzione per visualizzare i plugin sperimentali selezionando la casella di controllo
:guilabel: Mostra anche plugin sperimentali.

6. Se ora torni alla scheda Not installati, vedrai che altri plugin sono disponibili per l’installazione.
7. Per installare un plugin, clicca su di esso nella lista e poi sul pulsante Installa Plugin.

9.1. Lesson: Installare e Gestire i Plugin 315



QGIS Training Manual

9.1.4 In Conclusion

L’installazione di plugin in QGIS è semplice ed efficiente!

9.1.5 What’s Next?

Di seguito ti presenteremo come esempi alcuni plugin utili.

9.2 Lesson: Plugin di QGIS utili

Ora che sai installare, attivare e disattivare i plugin, vediamo come questo può aiutarti nella pratica guardando alcuni
esempi di plugin utili.
Obiettivo di questa lezione: Familiarizzare con l’interfaccia dei plugin e conoscere alcuni plugin utili.

9.2.1 Follow Along: Il plugin QuickMapServices

Il plugin QuickMapServices è un plugin semplice e facile da usare che aggiunge mappe di base al tuo progetto QGIS.
Ha molte opzioni e impostazioni diverse. Iniziamo a esplorare alcune delle sue funzionalità.

1. Avvia una nuova mappa e aggiungi il layer roads dal Geopackage training_data.
2. Installa il plugin QuickMapServices.
3. Fai clic su Web ► QuickMapServices. Il primo menu elenca diversi fornitori di mappe (OSM, NASA) con le

mappe disponibili.
4. Fai clic su una voce e caricherai la mappa base nel tuo progetto.

Bello! Ma uno dei principali punti di forza di QMS è quello di fornire l’accesso a molti fornitori di dati. Vediamoli
insieme.

1. Fai clic suWeb ► QuickMapServices ► Settings.
2. Vai alla scheda Più servizi.
3. Leggi attentamente il messaggio di questa scheda e se sei d’accordo clicca sul pulsante Get Contributed pack.
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4. Fai clic su Salva.
5. Riapri il menuWeb ► QuickMapServices vedrai che sono disponibili altri fornitori.

6. Scegli quello più adatto alle tue esigenze e carica i dati nel progetto!
È anche possibile effettuare una ricerca tra i fornitori di dati ora disponibili

1. Apri la scheda di ricerca del plugin facendo clic suWeb►QuickMapServices► Search QMS. Questa opzione del
plugin ti consente di filtrare lemappe base disponibili in base all’estensione attuale della dellamappa visualizzata
o utilizzando una parola di ricerca.

2. Fai clic su Filter by extent e dovresti vedere un servizio disponibile. Se non si trova alcun servizio, ingrandisci
e fai una panoramica del mondo (o della propria posizione) o cerca con una parola chiave.

3. Fai clic sul pulsante Aggiungi accanto a un set di dati restituito per caricarlo.
4. La mappa base verrà caricata e avrai uno sfondo per la mappa.
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9.2.2 Follow Along: Il Plugin QuickOSM

Con un’incredibile interfaccia semplice, il plugin QuickOSM permette di scaricare i dati di OpenStreetMap.
1. Avvia un nuovo progetto vuoto e aggiungi il layer roads dal training_data GeoPackage.
2. Installa il plugin QuickOSM. Il plugin aggiunge due nuovi pulsanti nella barra degli strumenti di QGIS ed è

accessibile nel menu Vector ► QuickOSM.
3. Apri la finestra di dialogo QuickOSM. Il plugin ha molte schede diverse: noi useremo quella Richiesta rapida.
4. Puoi scaricare funzionalità specifiche selezionando una generica :guilabel:”Chiave” o essere più specifico e

scegliere una coppia specifica :guilabel:”Chiave” e :guilabel:”Valore”.

Suggerimento: se non hai familiarità con il sistema :guilabel:”Chiave” e :guilabel:”Valore”, fai clic sul pulsante
:guilabel:”Guida su chiave/valore”. Si aprirà una pagina web con una descrizione completa di questo concetto
di OpenStreetMap.

5. Cerca :guilabel:”railway” nel menu :guilabel:”Chiave” e lascia che :guilabel:”Valore” sia vuoto: quindi stai
scaricando tutte le funzionalità di :guilabel:”railway” senza specificare alcun valore.

6. Seleziona :guilabel:”Estensione layer” nel menu a discesa successivo e scegli :guilabel:”roads”.
7. Fai clic sul pulsante :guilabel:”Esegue la richiesta”.
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Dopo alcuni secondi il plugin scaricherà tutti gli elementi etichettati in OpenStreetMap come railway e li caricherà
direttamente nella mappa.
Niente di più! Tutti i layer sono caricati nella legenda e sono mostrati nella area di visualizzazione della mappa.

Avvertimento: QuickOSM crea dei layer temporanei quando scarica i dati. Se vuoi salvarli permanentemente,
clicca sull’icona accanto al layer e scegli le opzioni che preferisci. In alternativa puoi aprire il menu
Avanzato di QuickOSM e scegliere dove salvare i dati nel menu Directory.

9.2.3 Follow Along: Il motore di ricerca di QuickOSM

Il modo più veloce per scaricare i dati dal plugin QuickOSM è usare la scheda Richiesta rapida e impostare alcuni
piccoli parametri. Ma se hai bisogno di dati più specifici?
Se sei un esperto di richieste su OpenStreetMap puoi usare il plugin QuickOSM anche con le tue richieste personali.
QuickOSMha un incredibile analizzatore di dati che, insieme al fantasticomotore di richieste di Overpass, ti permette
di scaricare dati con le tue esigenze specifiche.
Per esempio: vogliamo scaricare le vette delle montagne che appartengono a una specifica area di montagna conosciuta
come Dolomites.
Non puoi raggiungere questo obiettivo con la scheda Richiesta rapida, devi essere più specifico e scrivere la tua
richiesta. Proviamo a farlo.

1. Avvia un nuovo progetto.
2. Avvia il plugin QuickOSM e clicca sulla scheda Richiesta.
3. Copia e incolla il codice seguente nella finestra della richiesta:

<!--
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
-->
<osm-script output="json">
<!-- search the area of the Dolomites -->
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area -->
<query type="node">

(continues on next page)
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(continua dalla pagina precedente)
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->
<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Nota: Questa richiesta è scritta in un linguaggio simile all’xml. Se sei più abituato al Overpass QL puoi
scrivere la richiesta in questo linguaggio.

4. E clicca su Esegue la richiesta:

Il layer delle vette delle montagne sarà scaricato e mostrato in QGIS:
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Puoi scrivere richieste complesse usando il linguaggio di query Overpass. Dai un’occhiata a qualche esempio e prova
ad esplorare il linguaggio di richiesta.

9.2.4 Follow Along: Il Plugin DataPlotly

Il plugin DataPlotly consente di creare grafici D3 di dati di attributi vettoriali grazie alla libreria plotly.
1. Inizia un nuovo progetto
2. Carica il layer :guilabel:”sample_points” dalla cartella :file:”exercise_data/plugins”
3. Installa il plugin seguendo le linee guida descritte in ��� Passo dopo passo: Installare Nuovi Plugin cercando

Data Plotly.
4. Apri il plugin cliccando sulla nuova icona nella barra degli strumenti o nel menu :menuselection:`Plugins –>

Data Plotly
Nel seguente esempio stiamo creando un semplice Scatter Plot di due campi del layer sample_points`. Nel
pannello DataPlotly:

1. Scegli :guilabel:”sample_points” e in Filtra elementi :guilabel:”cl” per il campo :guilabel:”X” e :guilabel:”mg”
per il campo :guilabel:”Y”:
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2. Se vuoi puoi cambiare i colori, il tipo di simbolo, la trasparenza e molte altre impostazioni: prova a cambiare
alcuni parametri per creare il grafico sottostante.
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3. Once you have set all the parameters, click on the Create Plot button to create the plot.
La rappresentazione è interattiva: questo significa che è possibile utilizzare tutti i pulsanti superiori per ridimensionare,
spostare o ingrandire il grafico. Inoltre, ogni elemento del grafico è interattivo: cliccando o selezionando uno o più
punti sul grafico, il punto o i punti corrispondenti saranno selezionati nel grafico.

Puoi salvare il grafico come immagine statica png o come file html cliccando sul pulsante o sul pulsante
nell’angolo inferiore destro della schermata.
C’è di più. A volte può essere utile avere due (o più) diagrammi che mostrano diversi tipi di grafici con variabili
diverse sulla stessa pagina. Facciamolo!

1. Torna alla scheda principale delle impostazioni del grafico cliccando sul pulsante «Simbologia» nell’angolo in
alto a sinistra del pannello del plugin

2. Cambia Plot Type in Box Plot.
3. Scegli group come Gruppo e ph come Y Field.
4. Nella parte inferiore del pannello, cambia Tipo di grafico da Singolo grafico a Multi grafico e lascia selezionata

l’opzione predefinita Grafico in righe.
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5. Una volta fatto clic sul pulsante Crea grafico per disegnare il grafico

Ora sia lo scatter plot che il box plot sono mostrati nella stessa pagina. Hai ancora la possibilità di cliccare su ogni
elemento del grafico e selezionare gli elementi corrispondenti nella mappa.
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Suggerimento: Ogni grafico ha la sua pagina di manuale disponibile nella scheda . Prova ad esplorare tutti i tipi
di grafico e a vedere tutte le altre impostazioni disponibili.

9.2.5 In Conclusion

Ci sono molti utili plugin disponibili per QGIS. Usando gli strumenti incorporati per installare e gestire questi plugin,
puoi trovare nuovi plugin e farne un uso ottimale.

9.2.6 What’s Next?

Di seguito vedremo come utilizzare in tempo reale i layer che sono ospitati su server remoti.
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CAPITOLO10

Module: Risorse Online

Quando consideriamo una sorgente dati per una mappa, non c’è la necessità di essere vincolati a quelli salvati sul
computer con cui stai lavorando. Ci sono sorgenti di dati online da cui puoi caricare dati finché sei connesso ad
internet.
In questo modulo, copriremo due tipologie di servizi GIS online: Web Mapping Services (WMS) e Web Feature
Services (WFS).

10.1 Lesson: Web Mapping Services

Un Web Mapping Service (WMS) è un servizio ospitato su un server remoto. Simile a un sito Web, è possibile
accedervi se si dispone di una connessione al server. Con QGIS, è possibile caricare un WMS direttamente nella
vostra mappa.
Nell’esercitazione sui plugin è stata spiegata come caricare una nuova immagine raster da Google. Tuttavia, questa è
una operazione una tantum: una volta scaricata l’immagine, non ci saranno eventuali aggiornamenti futuri. Il caso del
WMS è diverso in quanto si tratta di un servizio in tempo reale, che si aggiorna automaticamente.
Obiettivo di questa lezione: Come usare un WMS e i suoi limiti.

10.1.1 Follow Along: Caricare un raster WMS

Per questo esercizio, puoi usare la mappa di base che hai fatto all’inizio del corso, o semplicemente iniziare una
nuova mappa e caricarvi alcuni layer esistenti. Per questo esempio, abbiamo usato una nuova mappa e caricato i layer
originali places, landuse e protected_areas e abbiamo modificato la simbologia:

327



QGIS Training Manual

1. Carica questi vettori su una mappa nuova o esistente, con solo questi vettori visibili:
2. Prima di iniziare ad aggiungere il layer WMS, disattiva la proiezione «al volo» (Progetto ► Proprietà… ► SR,

seleziona Nessun Sistema di Coordinate (o proiezione sconosciuta/non terrestre). Questo potrebbe causare che i
layer non si sovrappongano più correttamente, ma non preoccuparti: lo sistemeremo più tardi.

3. Per aggiungere layer WMS, clicca sul pulsante per aprire la finestra di dialogo Gestore delle Sorgenti Dati

e attiva la scheda WMS/WMTS.
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Ricorda come ti sei connesso a un database SpatiaLite o GeoPackage all’inizio del corso. I layer landuse,
buildings, e roads sono memorizzati in un database. Per usare questi layer, devi prima connetterti al database.
Usare un WMS è simile, con l’eccezione che i layer sono su un server remoto.

4. Per creare una nuova connessione a un WMS, fai clic sul pulsante Nuovo.
Per continuare hai bisogno di un indirizzo WMS. Su Internet sono disponibili diversi server WMS gratuiti.
Uno di questi è terrestris, che utilizza il dataset di OpenStreetMap.

5. Per utilizzare questo WMS, impostalo nella tua finestra di dialogo corrente, in questo modo:
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• Il valore del campo Nome deve essere terrestris.
• Il valore del campo URL deve essere https://ows.terrestris.de/osm/service.

6. Fai clic su OK. Dovresti vedere il nuovo server WMS elencato:
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7. Fai clic su Connetti. Nell’elenco sottostante, ora dovresti vedere queste nuove voci caricate:
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Questi sono tutti i layer ospitati da questo server WMS
8. Fai clic una volta sul layer OSM-WMS. Questo mostrerà il Sistema di Riferimento delle Coordinate predefinito

in uso e il numero di Sistemi di Riferimento delle Coordinate supportati dal dataset:
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Dal momento che non stiamo usando «EPSG:4326 -WGS 84» per la nostra mappa, cerchiamo uno che soddisfi
le nostre esigenze.

1. Fai clic sul pulsante Seleziona SR. Vedrai una finestra di dialogo standard Seleziona SR che mostra tutti i
SR con cui i dati sono pubblicati.

2. Vogliamo un SR proiettato, quindi scegliamo WGS 84 / Pseudo-Mercator con EPSG:3857. Puoi
utilizzare il widget Filtro in alto.
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1. Fai clic su OK. Il sistema di riferimento delle coordinate assegnato alla voce viene modificato.
9. Clicca Aggiungi per caricare il layer nel tuo progetto utilizzando Nome layer` (impostato di default su

OpenStreetMap WMS - di terrestris).
10. Chiudi la finestra di dialogo Gestore delle sorgenti dati, se non è avvenuto automaticamente.
11. Nel pannello Layer, fai clic e trascinalo in fondo all’elenco.
12. Riduci lo zoom per ottenere una vista globale dei layer. Noterai che i layer non sono posizionati correttamente

(vicino all’ovest dell’Africa). Questo perché la proiezione «al volo» è disabilitata.
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13. Abilitiamo di nuovo la riproiezione, ma usando la stessa proiezione del layer OpenStreetMap WMS, che èWGS
84 / Pseudo Mercator.
1. Apri la scheda Progetto ► Proprietà… ► SR

2. Deseleziona Nessun SR (o proiezione sconosciuta/non terrestre).
3. ScegliWGS 84 / Pseudo Mercator dall’elenco.
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4. Fai clic su OK.
14. Ora fai clic con il pulsante destro del mouse su uno dei tuoi layer nel pannello Layer e fai clic su Zoom sul(i)

layer. Dovresti vedere l’area Swellendam:
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Nota come le strade del layer WMS e le nostre strade si sovrappongono. Questo è un buon segno!

Caratteristiche e limiti del WMS

A questo punto avrai notato che questo layer WMS ha effettivamente molti elementi al suo interno. Ha strade, fiumi,
riserve naturali e così via. Inoltre, anche se sembra essere composto da vettori, sembra essere un raster, ma non si
può cambiare la sua simbologia. Perché questo?
Ecco come funziona un WMS: è una mappa, simile a una normale mappa su carta, che si riceve come immagine.
Quello che succede di solito è che hai dei layer vettoriali, che QGIS rende come una mappa. Ma usando un WMS,
quei layer vettoriali sono sul server WMS, che li rende come una mappa e te li invia come immagine. QGIS può
visualizzare questa immagine, ma non può cambiare la sua simbologia, perché tutto ciò è gestito sul server.
Questo ha diversi vantaggi, perché non è necessario preoccuparsi della simbologia. È già elaborata e dovrebbe essere
bella da vedere su qualsiasi WMS progettato in modo adeguato.
D’altra parte, non puoi cambiare la simbologia se non ti piace, e se le cose cambiano sul server WMS, allora
cambieranno anche sulla tua mappa. Questo è il motivo per cui a volte vuoi usare un Web Feature Service (WFS),
che ti dà i layer vettoriali in modo separato, e non come parte di una mappa in formato WMS.
Questo sarà trattato nella prossima lezione, però. Prima, aggiungiamo un altro layer WMS.

10.1.2 Try Yourself

1. Aggiungi il server WMS eAtlas con questo URL: https://maps.eatlas.org.au/maps/wms
2. Carica un layerWorld: Hillshading nella mappa.
3. Potresti voler impostare il suo Formato su JPEG e l’opzione Dimensione tassello su 200 per 200, in modo che

carichi più velocemente.
4. La tua mappa dovrebbe apparire così (potrebbe essere necessario riordinare i layer e applicare un po” di

trasparenza):
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Soluzione
1. Vai al Gestore delle fonti dati, scheda WMS / WMTS e crea una nuova voce di connessione

2. Usa la casella di testo per filtrare l’elenco dei layer e selezionare il layer corrispondente
3. Ricorda di verificare / trasformare il suo SR in EPSG:3857 - WGS 84 / Pseudo Mercator come il resto della

mappa.

4. Dopo che il layer è stato caricato, puoi modificare il suo valore di Opacità (nella scheda delle proprietà di
Trasparenza)

10.1.3 Try Yourself

Una parte della difficoltà nell’utilizzo del WMS consiste nel trovare un buon server (libero).
• Trova un nuovo WMS su directory.spatineo.com (o altrove online). Non deve avere canoni o restrizioni
associate e deve avere una copertura sull’area di studio Swellendam.
Ricorda che per utilizzare un WMS devi solo avere il suo URL (e preferibilmente una sorta di descrizione).

Soluzione
Spatineo è uno dei tanti luoghi in cui puoi cercare dati OGC. Digita nell’area di testo un nome, una parola chiave,
una posizione di tuo interesse per vedere se ottieni dei risultati funzionanti. Per questa lezione, potresti voler filtrare
i risultati per includere solo WMS.
Potrai notare che molti server WMS non sono sempre disponibili. A volte è temporaneo, altre volte è
permanente. Un esempio di server WMS che funzionava al momento della stesura è il Server di Dimostrazione di
MapServer WMS su https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&REQUEST=
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GetCapabilities. Non richiede tariffe né ha restrizioni di accesso ed è globale. Pertanto, soddisfa i requisiti. Tuttavia,
tenete presente che questo è solo un esempio. Ci sono molti altri server WMS tra cui scegliere.

10.1.4 Try Yourself

• Aggiungi il layer bluemarble dal MapServer Demonstration Server. È un dataset adatto per la nostra area di
studio?

Soluzione
1. Nascondi tutti gli altri layer WMS per evitare che vengano visualizzati inutilmente in background.
2. Usa lo stesso approccio precedente per aggiungere il nuovo server e il layer appropriato come ospitato su tale

server:

3. Se ingrandisci l’area Swellendam, noterai che questo dataset ha una bassa risoluzione:
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Pertanto, è meglio non utilizzare questi dati per la mappa attuale. I dati Blue Marble sono più adatti a scale
globali o nazionali.

10.1.5 In Conclusion

Utilizzando un WMS, ti sarà possibile aggiungere mappe inattive come sfondo per i dati cartografici esistenti.

10.1.6 Further Reading

• Spatineo Directory
• OpenStreetMap.org list of WMS servers

10.1.7 What’s Next?

Ora che hai aggiunto una mappa inattiva come sfondo, sarai felice di sapere che è anche possibile aggiungere elementi
(come gli altri layer vettoriali aggiunti in precedenza). L’aggiunta di elementi da server remoti è possibile utilizzando
un Web Feature Service (WFS). Questo è l’argomento della prossima lezione.
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10.2 Lesson: Web Feature Services

Un Web Feature Service (WFS) fornisce ai suoi utenti dati GIS in formati che possono essere caricati direttamente
in QGIS. A differenza di un WMS, che fornisce solo una mappa che non può essere modificata, un WFS dà accesso
agli elementi stessi.
Obiettivo di questa lezione: Utilizzare un WFS e capire come si differenzia da un WMS.

10.2.1 Follow Along: Caricare un Layer WFS

1. Avvia una nuova mappa. Questa è a scopo dimostrativo e non verrà salvata.

2. Fai clic sul pulsante Gestore delle Sorgenti Dati.

3. Attiva la scheda WFS / OGC API - Features.
4. Fai clic sul pulsante :guilabel: Nuovo.
5. Nella finestra di dialogo che appare, inserisci Nome come nsidc.org e URL come https://nsidc.

org/cgi-bin/atlas_south?version=1.1.0.

6. Fai clic su OK e la nuova connessione apparirà nella tua Connessioni Server.
7. Fai clic su Connetti. Verrà visualizzato un elenco dei layer disponibili:
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8. Deseleziona l’opzione Solo le geometria sovrapposte all’estensione della vista sotto l’elenco dei layer, poiché la
tua mappa attuale potrebbe non coprire l’area di interesse: Antartide.

9. Trova il layer antarctica_country_border. Puoi utilizzare la casella Filtro in alto.
10. Fai clic sul layer per selezionarlo:
11. Trova e seleziona anche il layer south_poles_wfs. Potresti aver bisogno di tenere premuto Ctrl.
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12. Fai clic su Aggiungi.
Il caricamento dei layer potrebbe richiedere un po” di tempo. Una volta caricati, appariranno nella mappa,
mostrando i contorni dell’Antartide e alcuni punti sovrastanti.
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In che modo questo è diverso dall’avere un layer WMS?
13. Seleziona uno qualsiasi dei layer e noterai che gli strumenti di selezione degli elementi e di tabella degli attributi

sono abilitati. Si tratta di layer vettoriali.
14. Seleziona il layer south_poles_wfs e apri la tabella degli attributi. Dovresti vedere questo:

Dal momento che i punti hanno degli attributi, siamo in grado di etichettarli e di modificarne la simbologia.
Ecco un esempio:
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Differenze rispetto ai layer WMS

Un Web Feature Service restituisce il layer stesso, non solo una mappa visualizzata su di esso. Ciò ti consente di
accedere direttamente ai dati, modificandone la simbologia ed eseguendo funzioni di analisi. Tuttavia, ciò comporta la
trasmissione di molti più dati. Questo è particolarmente evidente se i layer che stai caricando hanno forme complicate,
molti attributi o molte elementi; o anche se si stanno caricando molti layer. Il caricamento dei layer WFS richiede in
genere tempi molto lunghi.

10.2.2 Follow Along: Interrogare un layer WFS

Sebbene sia possibile interrogare un layer WFS dopo averlo caricato, spesso è più efficiente interrogarlo prima di
caricarlo. In questo modo, si richiedono solo le funzionalità desiderate e si utilizza molta meno larghezza di banda.
Ad esempio, sul server WFS che stiamo usando, c’è un layer chiamato countries (excluding Antarctica).
Supponiamo di voler sapere dove si trova il Sudafrica rispetto al layer south_poles_wfs (e forse anche al layer
antarctica_country_border) che è già stato caricato.
Ci sono due modi per farlo. Puoi caricare l’intero layer countries … e poi costruire una query come al solito una volta
caricato. Tuttavia, trasmettere i dati di tutti i paesi del mondo e poi usare solo quelli del Sudafrica sembra un po”
uno spreco di banda. A seconda della connessione, questo insieme di dati può richiedere diversi minuti per essere
caricato.
L’alternativa è costruire la query come filtro prima ancora di caricare layer dal server.

1. Attiva la schedaWFS / OGC API Features nella finestra di dialogo Gestore delle Sorgenti Dati.
2. Connettiti al server usato in precedenza e dovresti vedere l’elenco dei layer disponibili.
3. Individua e fai doppio clic sul layer countries (excluding Antarctica). Il nome del layer è

country_borders_excluding_antarctica. Puoi anche selezionare il layer e premere il pulsante
Crea interrogazione in fondo alla finestra di dialogo:
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4. Nella finestra di dialogo visualizzata, digita la seguente query SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'
nella casella Istruzione SQL`.

5. Fai clic su OK.
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6. L’espressione utilizzata apparirà come valore Sql del layer di destinazione:

7. Fai clic su Aggiungi con il layer selezionato come sopra. Solo il paese con il valore Countryeng di South
Africa verrà caricato da quel layer:
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Hai notato l’icona accanto al layer country_borders_excluding_antarctica? Indica che il
layer caricato è filtrato e non visualizza nel progetto tutti i suoi elementi.

8. Non è obbligatorio, ma se hai provato entrambi i metodi, noterai che è molto più veloce che caricare tutti i
paesi prima di filtrarli!

Note sulla disponibilità di WFS

È raro trovare un WFS che ospiti gli elementi di cui hai bisogno, se le esigenze sono molto specifiche. Il motivo
per cui i Web Feature Services sono relativamente rari è la grande quantità di dati che devono essere trasmessi per
descrivere un intero elemento. Pertanto, non è molto conveniente ospitare un WFS piuttosto che un WMS, che invia
solo immagini.
Il tipo più comune di WFS che troverai sarà quindi probabilmente su una rete locale o sul tuo computer, piuttosto
che su Internet.

10.2.3 In Conclusion

I layer WFS sono preferibili ai layer WMS se si ha bisogno di accedere direttamente agli attributi e alle geometrie
dei layer. Tuttavia, considerando la quantità di dati da scaricare (che comporta problemi di velocità e la mancanza di
server WFS pubblici facilmente disponibili), non è sempre possibile utilizzare un WFS al posto di un WMS.
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10.2.4 What’s Next?

Successivamente, vedrai come utilizzare QGIS Server per fornire servizi OGC.
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CAPITOLO11

Module: QGIS Server

Contributo di Tudor Bărăscu.
In questo capitolo vedrei come installare e utilizzare QGIS Server.
Per saperne di più su QGIS Server, leggi il QGIS-Server-manual.

11.1 Lesson: Installare QGIS Server

L’obiettivo di questa lezione: Imparare come installareQGIS Server su Debian Stretch. Con variazioni trascurabili
si può anche seguirla per qualsiasi distribuzione basata su Debian come Ubuntu e le sue derivate.

Nota: In Ubuntu puoi usare il tuo normale utente, aggiungendo sudo ai comandi che richiedono permessi di
amministrazione. In Debian puoi lavorare come amministratore (root), senza usare sudo.

11.1.1 Follow Along: Installa da pacchetti

In questa lezione faremo solo l’installazione da pacchetti come mostrato here .
Installa QGIS Server con:

apt install qgis-server --no-install-recommends --no-install-suggests

# if you want to install server plugins, also:
apt install python3-qgis

QGIS Server dovrebbe essere usato in produzione senza che QGIS Desktop (con il relativo X Server) sia installato
sulla stessa macchina.
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11.1.2 Follow Along: QGIS Server eseguibile

L’eseguibile di QGIS Server è qgis_mapserv.fcgi. Puoi verificare dove è stato installato con find /
-name 'qgis_mapserv.fcgi' che dovrebbe rispondere qualcosa di simile /usr/lib/cgi-bin/
qgis_mapserv.fcgi.
Eventualmente, se vuoi eseguire un test da riga di comando in questo momento, puoi eseguire il comando /usr/
lib/cgi-bin/qgis_mapserv.fcgi --version, che dovrebbe restituire un risultato simile:

QGIS 3.21.0-Master 'Master' (1c70953f1e)
QGIS code revision 1c70953f1e
Qt version 5.15.2
Python version 3.9.5
GDAL/OGR version 3.2.2
PROJ version 7.2.1
EPSG Registry database version v10.008 (2020-12-16)
GEOS version 3.9.0-CAPI-1.16.2
SQLite version 3.34.1
OS Ubuntu 21.04

Vedremo più avanti come effettuare richieste WMS.

11.1.3 Configurazione HTTP del server

Per accedere al server QGIS installato da un browser Internet abbiamo bisogno di usare un server HTTP. Il processo
di installazione del server HTTP Apache è dettagliato nella sezione httpserver.

Nota: Se hai installato QGIS Server senza eseguire un X Server (incluso in Linux Desktop) e se vuoi usare anche il
comando GetPrint, allora dovresti installare un fake X Server e dire a QGIS Server di usarlo. Puoi farlo seguendo
il Xvfb installation process.

11.1.4 Follow Along: Crea un altro virtual host

Crea un altro host virtuale Apache che punta a QGIS Server. Puoi scegliere il nome che preferisci (coco.bango,
super.duper.training, example.com, etc.) ma per semplicità userai myhost.

• Impostiamo il nome myhost per puntare all’IP localhost aggiungendo 127.0.0.1 x al /etc/hosts`
con il seguente comando: sh -c "echo '127.0.0.1 myhost' >> /etc/hosts" o modificando
manualmente il file con gedit /etc/hosts.

• Puoi controllare che myhost punti a localhosteseguendo nel terminale ping myhost che dovrebbe
produrre:

qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms

• Puoi accedere a QGIS Server dal sito myhost eseguendo: curl http://myhost/cgi-bin/
qgis_mapserv.fcgi accedendo all’URL dal tuo browser di Debian. Probabilmente otterrai:

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>
<hr>

(continues on next page)
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(continua dalla pagina precedente)
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

• Apache non sa che deve rispondere alle richieste che puntano al server chiamato myhost. Per
configurare l’host virtuale il modo più semplice sarebbe fare un file myhost.conf nella cartella /etc/
apache2/sites-available` che ha lo stesso contenuto di qgis.demo.conf` tranne per la linea
ServerName che dovrebbe essereServerName myhost. Potresti anche cambiare dove vanno i log perché
altrimenti i log per i due host virtuali sarebbero condivisi, ma questo è opzionale.

• Abilitiamo ora l’host virtuale con a2ensite myhost.conf e poi ricarichiamo il servizio Apache con
service apache2 reload.

• Se provi di nuovo ad accedere all’URL http: //myhost/cgi-bin/qgis_mapserv.fcgi noterai che tutto sta
funzionando!

11.1.5 In Conclusion

Hai imparato come installare diverse versioni di QGIS Server dai pacchetti, come configurare Apache con QGIS
Server, su distribuzioni Linux basate su Debian.

11.1.6 What’s Next?

Ora che hai installato QGIS Server ed è accessibile attraverso il protocollo HTTP, abbiamo bisogno di imparare come
accedere ad alcuni dei servizi che può offrire. L’argomento della prossima lezione è imparare come accedere ai servizi
WMS di QGIS Server.

11.2 Lesson: Server WMS

I dati usati per questo esercizio sono disponibili nella sottocartella qgis-server-tutorial-data del training
data che hai scaricato. Per comodità e per evitare possibili problemi di permessi, assumeremo che questi file siano
memorizzati nella cartella /home/qgis/projects. Quindi, adatta le seguenti istruzioni al tuo percorso.
I dati demo contengono un progetto QGIS denominato world.qgs che è già pronto per essere usato
con QGIS Server. Se vuoi utilizzare un tuo progetto o vuoi imparare come prepararlo, consulta la sezione
Creatingwmsfromproject.

Nota: Questo modulo ti presenta gli URL in modo che possa facilmente distinguere i parametri e i valori dei
parametri. Mentre il formato normale è:

...&field1=value1&field2=value2&field3=value3

questa esercitazione usa:

&field1=value1
&field2=value2
&field3=value3

Incollarli in Mozilla Firefox funziona correttamente, ma altri navigatori come Chrome potrebbero aggiungere spazi
indesiderati tra le coppie field:parameter. Quindi, se si verifica questo problema, puoi usare Firefox o
modificare gli URL in modo che siano in un formato di linea.

Facciamo una richiesta WMS GetCapabilities nel navigatore o con curl:
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http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

Nella configurazione di Apache della lezione precedente la variabile QGIS_PROJECT_FILE imposta il progetto
predefinito su /home/qgis/projects/world.qgs. Tuttavia, nella richiesta sopra hai fatto uso del parametro
map permostrarlo. Se si elimina il parametromap dalla richiesta precedente, QGIS Server emetterà la stessa risposta.
Indirizzando qualsiasi client WMS all’URL GetCapabilities, il client ottiene in risposta un documento XML
con metadati delle informazioni di WMS, ad es. quali layer, la copertura geografica, in quale formato, quale versione
di WMS, ecc.
Poiché QGIS è anche a ogc-wms, puoi creare una nuova connessione al server WMS con l’aiuto dell’url di
GetCapabilities precedente. Vedi la sezione Lezione: Web Mapping Service oppure ogc-wms-servers su come
eseguirla.
Aggiungendo il layer WMS countries al tuo progetto QGIS dovresti ottenere un’immagine come quella sotto:

Fig. 11.1: QGIS Desktop che utilizza il servizio WMS QGIS Server del layer countries
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Nota: QGIS Server serve i layer definiti nel progetto world.qgs. Aprendo il progetto con QGIS puoi vedere che
ci sono più stili per il livello countries. Anche QGIS Server ne è consapevole e puoi scegliere lo stile desiderato nella
richiesta. Lo stile classified_by_population è stato scelto nell’immagine sopra.

11.2.1 Registri

Quando imposti un server, i registri sono sempre importanti in quanto ti mostrano cosa sta succedendo. Hai installato
nel file *.conf i seguenti registri:

• Registri di QGIS Server in /logs/qgisserver.log
• Registri di accesso Apache qgisplatform.demo in qgisplatform.demo.access.log
• Registri di errore Apache qgisplatform.demo in qgisplatform.demo.access.log

I file di registro sono semplicemente file di testo e puoi utilizzare un editor di testo per controllarli. Puoi anche usare
il comando tail in un terminale: sudo tail -f /logs/qgisserver.log.
Questo mostrerà nel terminale ciò che è scritto in quel file di registro. Puoi anche avere tre terminali aperti per
ciascuno dei file di registro in questo modo:
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Fig. 11.2: Uso del comando tail per visualizzare i registri di QGIS Server

Se usi QGIS Desktop per utilizzare i servizi WMS di QGIS Server, vedrai visualizzate tutte le richieste che QGIS
invia al server nel registro di accesso, gli errori di QGIS Server nel registro di QGIS Server, ecc.

Nota:
• Se guardi i registri nelle seguenti sezioni dovresti capire meglio cosa sta succedendo.
• RiattivandoApachementre guardi nel registro di QGIS Server, puoi trovare alcuni suggerimenti su come lavora.
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11.2.2 Richieste GetMap

Per visualizzare il layer countries, QGIS Desktop, come qualsiasi altro clientWMS, utilizza le richieste GetMap.
Una semplice richiesta assomiglia a:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpeg

La richiesta dovrebbe produrre l’immagine seguente:
Figura: semplice richiesta GetMap a QGIS Server

Fig. 11.3: Risposta di Qgis Server dopo una semplice richiesta GetMap
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11.2.3 Try Yourself Modificare i parametri immagine e layer

In base alla richiesta di cui sopra, sostituisci il layer countries con un altro.
Per vedere quali altri livelli sono disponibili, puoi aprire il progetto world.qgs in QGIS e guardarne il contenuto.
Tieni a mente che i client WMS non hanno accesso al progetto QGIS, ma guardano solo al contenuto del documento
capabilities.
Inoltre, esiste un’opzione di configurazione in modo che alcuni dei layer esistenti nel progetto QGIS vengano ignorati
da QGIS quando attivo il servizio WMS.
Quindi, puoi vedere l’elenco dei layer quando QGIS Desktop punta all’URL GetCapabilities o puoi provare a
trovare altri nomi di layer nella risposta GetCapabilities XML.
Uno dei nomi dei layer che è possibile trovare è countries_shapeburst. Potresti trovarne altri, ma tieni
presente che alcuni potrebbero non essere visibili a una scala così ridotta in modo da ottenere un’immagine vuota
come risposta.
Puoi anche provare con altri parametri , come cambiare il tipo di immagine restituito in image/png.

11.2.4 Follow Along: Usare i parametri Filtro, Opacità e Stili

Facciamo un’altra richiesta che aggiunge un altro layer, alcuni basic parameters, FILTER e OPACITIES”, ma
utilizza anche il parametro standard STYLES.

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpeg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,blue
&OPACITIES=255,30
&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

La richiesta dovrebbe produrre l’immagine seguente:
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Fig. 11.4: Risposta ad una richiesta GetMap con parametri FILTER e OPACITIES

Come puoi vedere dall’immagine qui sopra, tra l’altro hai detto a QGIS Server di visualizzare solo Germany e Italy
dal layer countries.

11.2.5 Follow Along: Usare REDLINING

Eseguiamo un’altra richiesta GetMap che fa uso della funzione redlining e del parametro SELECTION descritto
nella sezione Basics:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpeg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000␣
↪→6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
↪→<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter␣

(continues on next page)
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(continua dalla pagina precedente)
↪→name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
↪→SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
↪→LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial
&HIGHLIGHT_LABELSIZE=30
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=3
&SELECTION=countries:171,65

Incolla la richiesta nel navigatore che dovrebbe produrre l’immagine seguente:

Fig. 11.5: Risposta a una richiesta con la funzione REDLINING e il parametro SELECTION

Puoi vedere dall’immagine sopra che i paesi con gli ID 171 e 65 sono stati evidenziati in giallo (Romania e Francia)
utilizzando il parametro SELEZIONE e abbiamo utilizzato la funzione REDLINING per sovrapporre un rettangolo
con l’etichetta QGIS Tutorial.
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11.2.6 Richieste GetPrint

Una caratteristica molto interessante di QGIS Server è che utilizza i layout di stampa di QGIS Desktop. Puoi
approfondire l’argomento nella sezione wms_getprint.
Se apri il progetto world.qgs con QGIS Desktop troverai un layout di stampa chiamato Population
distribution. Una richiesta semplificata di GetPrint che esemplifica questa fantastica funzionalità è:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0&
REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries

Fig. 11.6: Mostra i risultati pdf della richiesta GetPrint

Naturalmente, è difficile scrivere le richieste GetMap, GetPrint, ecc.
QGIS Web Client or QWC è un progetto client Web che può funzionare insieme a QGIS Server in modo che sia
possibile pubblicare i propri progetti sul Web o aiutare a creare richieste QGIS Server per una migliore comprensione
delle possibilità.
puoi installarlo così:

• Come utente qgis vai nella cartella cd /home/qgis.
• Scarica il progetto QWC da qui e decomprimilo.
• Crea un collegamento simbolico alla cartela /var/www/html in quanto è DocumentRoot che
abbiamo configurato nell’host virtuale. Se hai decompresso l’archivio sotto //home/qgis/Downloads/
QGIS-Web-Client-master puoi farlo con sudo ln -s /home/qgis/Downloads/
QGIS-Web-Client-master /var/www/html/.

• Accedi a http://qgisplatform.demo/QGIS-Web-Client-master/site/qgiswebclient.html?map=/home/qgis/
projects/world.qgs dal tuo navigatore.

Ora dovresti essere in grado di vedere la mappa come nella seguente figura:
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Fig. 11.7: QGIS Web Client che utilizza il progetto world.qgs

Se clicchi sul pulsante Stampa in QWC, puoi creare richieste interattive GetPrint. Puoi anche cliccare sull’icona
? nel QWC per accedere all’aiuto disponibile in modo da poter scoprire meglio le possibilità di QWC.

11.2.7 In Conclusion

Hai imparato come utilizzare QGIS Server per fornire i servizi WMS.

11.2.8 What’s Next?

Vedrai come usare QGIS come interfaccia per GRASS GIS.
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CAPITOLO12

Module: GRASS

GRASS (Geographic Resources Analysis Support System) è un noto GIS open source con una vasta gamma di utili
funzioni GIS. È stato rilasciato nel 1984 e da allora ha visto molti miglioramenti e funzionalità aggiuntive. QGIS ti
consente di utilizzare direttamente i potenti strumenti GIS di GRASS.

12.1 Lesson: Impostazione GRASS

Usare GRASS in QGIS richiede di pensare all’interfaccia in un modo leggermente diverso. Ricordati che non stai
lavorando in QGIS direttamente, ma lavori in GRASS via QGIS. Quindi, assicurati di aver installato QGIS Desktop
con il supporto di Grass.

Per aprire una sessione QGIS con GRASS disponibile su Windows devi fare clic sull’icona QGIS Desktop
with GRASS

Obiettivo di questa lezione: Iniziare un progetto GRASS in QGIS.

12.1.1 Follow Along: |Iniziare una nuova sessione GRASS

Per avviare GRASS da QGIS, devi attivarlo come un qualsiasi altro plugin:
1. Per prima cosa, apri un nuovo progetto QGIS.
2. In Gestisci ed Installa Plugin…, attiva GRASS nell’elenco:
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Appariranno la barra degli strumenti e il pannello di GRASS:

Fig. 12.1: Barra degli strumenti GRASS
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Fig. 12.2: Pannello GRASS

Il pannello GRASS non è attivo perché, prima di poter utilizzare GRASS, devi creare un Mapset. GRASS lavora
sempre in un ambiente di database, il che significa che devi importare tutti i dati che vuoi utilizzare in un database
GRASS.
Il database di GRASS ha una struttura semplice, anche se a prima vista sembra molto complicata. La cosa più
importante che devi sapere è che il livello superiore del database è la Locazione. Ogni Locazione può contenere
diversi Mapset: in ogni Mapset si trova il Mapset PERMANENT perché viene creato di default da GRASS. Ogni
Mapset contiene i dati (raster, vettoriali, ecc.) in una struttura particolare, ma non preoccuparti, GRASS se ne
occuperà per te.
Si ricordi che Location contiene Mapset che contiene i dati. Per ulteriori informazioni visitate il sito web di
GRASS.
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Fig. 12.3: Struttura del database di GRASS (dalla documentazione di GRASS)

12.1.2 Follow Along: Avviare un Nuovo Progetto GRASS

1. Fai clic sul menu Plugins ► GRASS ► New Mapset:

Ti verrà chiesto di scegliere la posizione del database di GRASS.
2. Impostala come cartella che verrà utilizzata da GRASS per configurare il suo database:
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3. Fai clic su Successivo.
GRASS ha bisogno di creare una Location, che descrive l’estensione massima dell’area geografica in cui lavorerai,
nota anche come Grass Region.

Nota: La Region è estremamente importante per GRASS perché descrive l’area in cui tutti i layer verranno presi in
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considerazione da GRASS. Tutto ciò che si trova all’esterno non verrà considerato. Non preoccuparti, puoi sempre
modificare l’estensione della Regione di GRASS dopo che la Location è stata creata.

1. Denomina la nuova location SouthAfrica:

2. Fai clic su Successivo.
3. Lavoreremo con WGS 84, quindi cerca e seleziona questo SR:
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4. Fai clic su Successivo.
5. Ora seleziona la regione South Africa dal menu a tendina e fai clic su Imposta:
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6. Fai clic su Successivo.
7. Crea un mapset, ovvero il file della mappa con cui lavorerai.
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Non appena terminato, ti si presenta una finestra di dialogo con un riepilogo di tutte le informazioni immesse.
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8. Fai clic su Fine.
9. Fai clic su OK nella finestra di dialogo successiva.

Vedrai che il Pannello GRASS diventerà attivo e potrai iniziare a usare tutti gli strumenti di GRASS. Fai clic su OK
nella finestra di dialogo successiva.
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12.1.3 Follow Along: Caricare Dati Vettoriali in GRASS

Ora hai una mappa vuota e prima di poter iniziare a utilizzare tutti gli strumenti di GRASS devi caricare i dati nel
database di GRASS, in particolare nel Mapset. Non puoi utilizzare gli strumenti di GRASS con i layer che non sono
stati caricati in un Mapset di GRASS.
Esistono diversi modi per caricare i dati nel database di GRASS. Cominciamo con il primo.

Follow Along: Caricare i dati utilizzando il Browser QGIS

Nella sezione ��� Il Panello Browser abbiamo visto che il modo più semplice e veloce per caricare i dati in QGIS è
il pannello Browser.
I dati GRASS vengono riconosciuti dal Browser QGIS come dati GRASS reali e lo si nota perché si vede l’icona

GRASS accanto al Mapset GRASS. Inoltre, si vedrà l’icona accanto al Mapset aperto.

Nota: Vedrai una replica della Location GRASS come normale cartella: i dati GRASS Mapset sono quelli contenuti
nella cartella .

Puoi trascinare e rilasciare facilmente i layer da una cartella al Mapset di GRASS.
Proviamo a importare il layer roads nel Mapset grass_mapset della Location SouthAfrica.
Vai nel Browser e trascina semplicemente il layer roads dal file training_data.gpkgGeoPackage nel Mapset
grass_mapset.
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Ecco fatto! Se espando il Mapset, si vedrà il layer importato roads. Ora puoi caricare in QGIS il layer importato
come tutti gli altri layer.

Suggerimento: Puoi anche caricare i layer dal pannello Legenda layer a Mapset nel pannello Browser. Questo
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velocizzerà incredibilmente il tuo flusso di lavoro!

Follow Along: Caricare i dati utilizzando il Pannello GRASS

Utilizzeremo ora il metodo più lungo per caricare il layer rivers.shp nello stesso Mapset.
1. Carica i dati in QGIS come di consueto. Utilizzare il dataset rivers.shp (che si trova nella cartella

exercise_data/shapefile/).
2. Dopo averlo caricato, fai clic sulla casella Filtro del pannello GRASS e individua lo strumento di importazione

vettoriale inserendo il termine v.in.ogr.qgis:

Avvertimento: Esistono 2 strumenti simili: v.in.ogr.qgis e v.in.ogr.qgis.loc. Stiamo cercando il primo.

La v sta per vettore, in indica una funzione per importare i dati nel database di GRASS, ogr è la libreria software
utilizzata per leggere i dati vettoriali e qgis significa che lo strumento cercherà un vettore tra quelli già caricati
in QGIS.

3. Una volta trovato questo strumento, fai clic su di esso per visualizzare lo strumento stesso. Scegli il layer rivers
nel riquadro Layer caricato e scrivilo e denominalo g_fiumi per evitare confusione:
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Nota: Nota le opzioni di importazione aggiuntive fornite in Opzioni avanzate. Queste includono la possibilità
di aggiungere una clausola WHERE per la query SQL utilizzata per importare i dati.

4. Fai clic su Esegui per avviare l’importazione.
5. Al termine, fai clic sul pulsante Visualizza output per visualizzare il layer GRASS appena importato nella

mappa.
6. Chiudi prima lo strumento di importazione (fai clic sul pulsante Chiudi all’immediata destra di Visualizza

output), quindi chiudi la finestra Strumenti GRASS.
7. Rimuovi il layer originale rivers.

Ora ti rimane solo il layer GRASS importato e visualizzato nella mappa di QGIS.
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12.1.4 Follow Along: Caricare dati raster in GRASS

Puoi importare un layer raster nello stesso modo in cui abbiamo importato i layer vettoriali.
Importeremo nel Mapset di GRASS il layer srtm_41_19_4326.tif.

Nota: il layer raster è già nel SR corretto, WGS 84. Se hai layer in SR diversi, devi riproiettarli nello stesso SR del
Mapset di GRASS.

1. Carica il layer srtm_41_19_4326.tif in QGIS
2. Apri nuovamente la finestra di dialogo Strumenti GRASS.
3. Fai clic sulla scheda Elenco moduli.
4. Cerca r.in.gdal.qgis e fai doppio clic sullo strumento per aprire la finestra di dialogo.
5. Impostalo in modo che il layer di input sia srtm_41_19_4326.tif e l’output sia g_dem.
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6. Fai clic su Esegui.
7. Al termine del processo, fai clic su Visualizza output.
8. Chiudi la scheda corrente e quindi Chiudi l’intera finestra di dialogo.
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9. Puoi ora rimuovere il layer originale srtm_41_19_4326.tif.

12.1.5 Try Yourself Aggiungere layer a Mapset

Prova a importare nel Mapset di GRASS i layer vettoriali water.shp e places.shp dalla cartella
exercise_data/shapefile/. Come abbiamo fatto per rivers, rinominare i layer importati come
g_water e g_places per evitare confusione.

Soluzione
Puoi aggiungere layer (sia vettoriali che raster) in un Mapset di GRASS trascinandoli nel Browser (vedi ��� Passo
dopo passo: Caricare dati utilizzando il QGIS Browser) o usando i comandi v.in.gdal.qgis per i layer vettoriali
e r.in.gdal.qgis per quelli raster.

12.1.6 Aprire un Mapset GRASS esistente

Se hai un Mapset GRASS esistente, puoi facilmente riaprirlo in un’altra sessione di QGIS.
Hai diversi metodi per aprire Mapset di GRASS, vediamone alcuni.
Chiudiamo il Mapset facendo clic sul pulsante Chiudi Mapset della finestra di dialogo Strumenti GRASS.

Follow Along: Utilizzare il plugin GRASS

1. Fai clic sul menu Plugins –> GRASS –> Apri Mapset accanto al menu Plugins –> GRASS –> Nuovo Mapset che
abbiamo visto nella sezione precedente.

2. Naviga fino alla cartella del database di GRASS: attenzione! Devi scegliere la cartella principale, non quella
delle mappe di GRASS. Infatti GRASS leggerà tutte le ``Location”” del database e tutti i ``Mapset”” di ogni
``Location””:
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3. Scegli la Location SouthAfrica e il Mapset grass_mapset che abbiamo creato in precedenza.
Ecco fatto! Il Pannello GRASS diventerà attivo, il che significa che il Mapset è stato aperto correttamente.

Follow Along: Usare il Browser di QGIS

Ancora più veloce e semplice è aprire un Mapset utilizzando il Browser di QGIS:
1. Chiudi il Mapset (se è aperto) facendo clic sul pulsante Chiudi Mapset della finestra Strumenti GRASS.
2. Nel Browser QGIS, naviga nella cartella del database di GRASS.

3. Fai clic con il tasto destro del mouse sul Mapset (ricordati che il Mapset ha l’icona di GRASS accanto).
Vedrai visualizzate alcune opzioni.

4. Fai clic su Apri Mapset:
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Il Mapset è ora aperto e pronto all’uso!

Suggerimento: Facendo clic con il tasto destro del mouse su un Mapset GRASS, puoi trovare molte impostazioni
diverse. Prova a esplorarle e a vedere tutte le opzioni utili.
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12.1.7 In Conclusion

Il flusso di lavoro di GRASS per l’inserimento dei dati è leggermente diverso dal metodo di QGIS, perché GRASS
carica i dati in una struttura di database spaziale. Tuttavia, utilizzando QGIS come interfaccia, puoi semplificare
l’impostazione di mapset GRASS utilizzando i layer esistenti in QGIS come fonti di dati per GRASS.

12.1.8 What’s Next?

Ora che i dati sono stati importati in GRASS, possiamo vedere le operazioni di analisi avanzate che GRASS offre.

12.2 Lesson: Strumenti GRASS

In questa lezione presenteremo una selezione di strumenti per dare un’idea delle potenzialità di GRASS.

12.2.1 Follow Along: Creare una mappa di esposizione

1. Apri la scheda Strumenti GRASS.
2. Carica il layer raster g_dem dal Mapset :guilabel:`grass_mapset
3. Carica il raster g_dem Cerca il modulo r.aspect cercandolo nel campo Filtro della scheda Elenco moduli del

Mapset grass_mapset.
4. Apri lo strumento, impostalo in questo modo e fai clic sul pulsante Esegui:
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5. Al termine del processo, fai clic su Visualizza risultato per caricare il layer risultante nell’area di disegno della
mappa:
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Il layer g_aspect è memorizzato all’interno del Mapset grass_mapset, così puoi rimuovere il layer dalla
visualizzazione mappa e ricaricarlo quando vuoi.

12.2.2 Follow Along: Ottenere la statistica di base del layer raster

Vogliamo conoscere alcune statistiche di base del layer raster g_dem.
1. Apri la scheda Strumenti GRASS.
2. Carica il layer raster g_dem dal Mapset :guilabel:`grass_mapset
3. Look for the r.infomodule by searching for it in the Filter field of theCerca il modulo :guilabel:`r.info cercandolo

nel campo Filtro della scheda Elenco moduli.
4. Imposta lo strumento in questo modo e fai clic su Esegui:
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5. Nella scheda Risultato vengono stampate alcune informazioni raster, come il percorso del file, il numero di
righe e colonne e altre informazioni utili:
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12.2.3 Follow Along: Lo strumento di riclassificazione

Riclassificare un layer raster è un’operazione molto utile. Abbiamo appena creato il layer g_aspect da quello
g_dem. L’intervallo di valori va da 0 (Nord) a 90 (Est), 180 (Sud), 270 (Ovest) e infine a 360 (di nuovo Nord).
Possiamo riclassificare il layer g_aspect in modo da avere solo 4 categorie che seguono regole specifiche (Nord
= 1, Est = 2, Sud = 3 e Ovest = 4).
Lo strumento di riclassificazione di Grass accetta un file txt con regole definite. Scrivere le regole è molto semplice
e il Manuale di GRASS contiene un’ottima descrizione.

Suggerimento: Ogni strumento di GRASS ha una propria scheda Manuale. Leggi la descrizione dello strumento
che stai utilizzando per non perdere alcuni parametri utili.

1. Carica il layer g_aspect o, se non l’hai creato, torna alla sezione ��� Seguire: Creare una Mappa di
Esposizione.
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2. Cerca il modulo r.reclass cercandolo nel campo :guilabel: Filtro della scheda Elenco moduli.
3. Apri lo strumento e configuralo come nell’immagine seguente. Il file contenente le regole si trova nella cartella

exercise_data/grass/, con il nome reclass_aspect.txt.
4. Fai clic su Esegui e aspetta che il processo sia terminato:

5. Fai clic su Visualizza risultato per caricare il raster riclassificato nell’area di disegno della mappa.
Il nuovo layer è composto da soli 4 valori (1, 2, 3 e 4) ed è più facile da gestire ed elaborare.
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Suggerimento: Apri il file reclass_aspect.txt con un editor di testo per vedere le regole e iniziare ad
abituarti ad esse. Inoltre, dai un’occhiata approfondita al manuale di GRASS: sono indicati molti esempi diversi.

12.2.4 Try Yourself Riclassificare con le tue regole

Prova a riclassificare il layer g_dem in 3 nuove categorie:
• da 0 a 1000, nuovo valore = 1
• da 1000 a 1400, nuovo valore = 2
• da 1400 al valore massimo del raster, nuovo valore = 3

Soluzione
Per scoprire il valore massimo del raster, esegui lo strumento r.info: nella console si vedrà che il valore massimo
è 1699. Ora sei pronto a scrivere le regole.

1. Apri un editor di testo e aggiungi le seguenti regole:

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

2. Salva il file come my_rules.txt e chiudi l’editor di testo.
3. Esegui lo strumento r.reclass: scegli il layer g_dem e carica il file contenente le regole appena salvate.
4. Fai clic su Esegui e poi suVisualizza risultato. Puoi modificare i colori e il risultato finale dovrebbe essere simile

all’immagine seguente:
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12.2.5 Follow Along: Lo Strumento Mapcalc

Lo strumento Mapcalc è simile al Calcolatore Raster di QGIS. Puoi eseguire operazioni matematiche su uno o più
layer raster e il risultato finale sarà un nuovo layer con i valori calcolati.
L’obiettivo del prossimo esercizio è estrarre i valori superiori a 1000 dal layer raster g_dem.

1. Cerca il modulo r.mapcalc cercandolo nel campo Filtro della scheda Elenco moduli.
2. Avvia lo strumento.

La finestra di dialogoMapcalc ti permette di costruire una sequenza di analisi da eseguire su un raster o su un
insieme di raster. Utilizza questi strumenti per farlo:

In sequenza, sono:
• Aggiungi mappa: Aggiunge un file raster dall’attuale mapset di GRASS.
• Aggiungi un valore costante: Aggiunge un valore costante da utilizzare nelle funzioni, 1000 in questo caso
• Aggiungi un operatore o una funzione: Aggiunge un operatore o una funzione da collegare agli ingressi e
alle uscite; useremo l’operatore greater equals than.

• Aggiungi connessione: Collega gli elementi. Con questo strumento, fai clic e trascina dal punto rosso di un
elemento al punto rosso di un altro elemento. I punti collegati correttamente a una linea di connessione
diventano grigi. Se la linea o il punto sono rossi, non sono collegati correttamente!

• Seleziona elemento: Seleziona un elemento e sposta gli elementi selezionati.
• Elimina l’elemento selezionato: Rimuove l’elemento selezionato dal foglio mapcalc corrente, ma non dal
mapset (se si tratta di un raster esistente).

• Apri: Apre un file esistente con l’operazione definita
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• Salva: Salva tutte le operazioni in un file
• Salva come: Salva tutte le operazioni come un nuovo file sul disco.

3. Utilizzando questi strumenti, costruisci il seguente algoritmo:

4. Fai clic su Esegui e poi su Visualizza risultato per vedere il risultato visualizzato nella tua mappa:
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Questo mostra tutte le aree in cui il terreno è più alto di 1000 metri.

Suggerimento: Puoi anche salvare la formula creata e caricarla in un altro progetto QGIS facendo clic sull’ultimo
pulsante della barra degli strumenti di GRASS Mapcalc.

12.2.6 In Conclusion

In questa lezione abbiamo trattato solo alcuni dei numerosi strumenti offerti da GRASS. Per esplorare da soli le
potenzialità di GRASS, apri la finestra di dialogo Strumenti GRASS e scorri la Elenco dei moduli. Oppure, per un
approccio più strutturato, guarda nella scheda Albero dei moduli, che organizza gli strumenti per tipo.
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CAPITOLO13

Module: Valutazione

Usa i tuoi dati per questa sezione. Avrai bisogno di:
• un insieme di dati vettoriali puntuali fatto di punti di interesse, con i nomi dei punti e categorie multiple
• un dataset vettoriale lineare delle strade
• un dataset vettoriale poligonale dell’uso del suolo (utilizzando i confini delle proprietà)
• un’immagine con lo spettro visivo (come una foto aerea)
• un DEM (scaricabile da CGIAR-CSI <http://srtm.csi.cgiar.org/> _ se non ne hai uno tuo)

13.1 Crea una mappa di base

Prima di fare qualsiasi analisi di dati, ti servirà una mappa di base, che ti fornirà il risultato della tua analisi nel
contesto.

13.1.1 Aggiungi il layer puntuale

• Prendi il layer puntuale. In base al livello in cui stai facendo il corso, fai solo quello che è elencato nella sezione
appropriata sotto:

• Etichetta i punti secondo un solo attributo, come il nome del luogo. Usa un carattere piccolo e mantieni
le etichette in maniera discreta. L’informazione deve essere disponibile, ma non dovrebbe essere l’elemento
principale della mappa.

• Classifica i punti con differenti colori basati su una categoria. Ad esempio, le categorie potrebbero includere
«destinazione turistica», «stazione di polizia» e «centro della città».
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• Fai lo stesso della sezione
• Classifica la dimensione dei punti per importanza: più un elemento è significativo, più deve essere largo il suo
punto. Comunque non superare la dimensione dei punti 2.00.

• Per gli elementi che non sono localizzati in un punto singolo (ad esempio, nomi di province/regioni, o nomi di
città ad una scala ampia), non assegnare nessun punto.

• Non usare i simboli puntuali per la simbolizzazione del layer. Invece, usa etichette centrate al di sopra dei punti;
i simboli dei punti stessi non devono avere una dimensione.

• Usa Impostazioni definite dei dati per disegnare le etichette in categorie significative.
• Aggiungi le colonne degli attributi appropriate se necessario. Quando fai questo non creare dati inventati -
piuttosto, usa il Calcolatore di campi per popolare le nuove colonne, basate su valori appropriati esistenti nel
dataset.

13.1.2 Aggiungi il layer di linee

• Aggiungi il layer delle strade e cambia la sua simbologia. Non etichettare le strade.

• Cambia la simbologia delle strade in un colore lineare con una linea ampia. Dagli anche una trasparenza.

• Crea un simbolo con i layer a simboli multipli. Il simbolo risultante dovrebbe somigliare ad una strada reale. Tu
puoi usare un simbolo semplice per questo; ad esempio, una linea nera con una linea continua bianca posta al
centro di quella nera. Può essere anche più elaborata, ma la mappa risultante non deve essere troppo occupata.

• Se il tuo dataset ha un’alta densità di strade alla scala che tu vuoi mostrare nella mappa, dovresti avere due layer
delle strade: un simbolo simile alle strade elaborato e un simbolo più semplice per la scala più piccola. (Usa la
visibilità basata sulla scala per fargli cambiare simbologia in base alla scala appropriata.)

• Tutti i simboli dovrebbero avere layer con simboli multipli. Usa i simboli per visualizzarli correttamente.

• Fai lo stesso come nella sezione sopra .
• In più, le strade dovrebbero venir classificaate. Quando si usano simboli realistici delle strade, ogni tipo di
strada dovrebbe avere un simbolo appropriato; ad esempio, per una autostrada dovrebbero apparire due corsie
per le due direzioni.
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13.1.3 Agiungi il vettore di poligoni

• Aggiungi il vettore dell’uso del suolo e modifica la sua simbologia.

• Classifica il layer secondo l’uso del suolo. Usa colori pieni.

• Classifica il layer secondo l’uso del suolo. Dove appropriato, incormpora i vettori dei simboli, diversi tipi di
simboli, ecc. Conserva i risultati che sembrano attenuati ed uniformi. Tieni in mente che questo sarà parte di
uno sfondo!

• Usa una classificazione basata su regole per classificare l’uso del suolo in categorie generali, quali «urbano»,
«rurale», «riserva naturale», ecc.

13.1.4 Crea lo sfondo raster

• Crea una ombreggiatura dal DEM ed usala in sovrapposizione per una versione classificata dello stesso DEM.
Tu puoi anche usare il plugin Rilievo (come mostrato nella nezione sui plugin).

13.1.5 Completa la mappa di base

• Usando le risorse di cui sopra, crea una mappa di base usando alcuni o tutti i layers. Questa mappa dovrebbe
includere tutte le informazioni di base necessarie per orientare l’utente, così come per essere unificate / semplici.

13.2 Analizza i dati

• Stai cercaundo una proprietà che soddisfi alcuni criteri.
• Puoi decidere sulla base dei tuoi criteri, quelli che devi documentare.
• Ci sono alcune linee guida per questi criter:

– la proprietà di destinazione dovrebbe avere un certo tipo di uso del suolo
– dovrebbe essere ad una certa distanza dalle strade o dovrebbe essere attraversata da una strada
– dovrebbe essere ad una certa distanza daalcune categorie di punti, quale un ospedale ad esempio

13.2.1 /

• Includi l’analisi raster nei tuoi risultati. Considera almeno una caratteristica derivata dal raster, come
l’esposizione o la pendenza.
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13.3 Mappa finale

• Usa Print Layout per creare una mappa finale, che incorpora i tuoi risultati dell’analisi.
• Includi questa mappa in un documento insieme con i tuoi criteri attestati. Se la mappa è diventata troppo piena
visualmente per via dei layer aggiunti, deseleziona il(i) layer che tu pensi siano strettamente necessari.

• La tua mappa deve includere un titolo ed una legenda.
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CAPITOLO14

Module: Applicazioni nel settore forestale

Nei moduli da 1 a 13, hai imparato molto su QGIS e il suo utilizzo. Se sei interessato ad imparare alcune applicazioni
GIS nel settore forestale, questo modulo ti darà la possibilità di applicare ciò che hai imparato e ti mostrerà alcuni
strumenti utili.

Lo sviluppo di questo modulo è stato sponsorizzato dall” Unione Europea.

14.1 Lesson: Presentazione del modulo forestale

All’interno di questo modulo dedicato alle applicazioni forestali verranno richieste nozioni imparate via via nei moduli
da 1 a 11 di questo manuale di esercizi. Gli esercizi contenuti nelle prossime lezioni prevedono che tu conosca già
molte delle operazioni di base in QGIS e verranno approfonditi solo gli strumenti che non sono mai stati usati in
precedenza.
Ciò nonostante, il modulo manterrà un livello base in tutte le lezioni in modo che, se hai già una precedente esperienza
con QGIS, puoi molto probabilmente seguire le istruzioni senza problemi.
Nota che per questo modulo è necessario scaricare un pacchetto di dati aggiuntivo.
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14.1.1 Dati di esempio per Selvicoltura

Nota: I dati di esempio usati in questo modulo fanno parte dell’insieme di dati del manuale di formazione e sono
disponibili nella cartella :file:`exercise_dataforestry.

I dati campione relativi alla silvicoltura (mappa forestale, dati forestali), sono stati forniti dalla scuola forestale EVO-
HAMK <https://www.hamk.fi/campuses-and-maps/evo/?lang=en>`_. I dataset sono stati modificati per adattarsi
alle esigenze delle lezioni.
I dati di esempio generali (immagini aeree, dati LiDAR, mappe) sono stati ottenuti dal National Land Survey of
Finland open data service e adattati ai fini delle esercitazioni. Puoi accedere al servizio per scaricare i file di dati in
inglese qui.

Avvertimento: Come per il resto del manuale di addestramento, questo modulo include istruzioni su come
aggiungere, eliminare e modificare i dati GIS. A tale scopo abbiamo fornito specifici dati per il training. Prima di
utilizzare le tecniche descritte qui sui dati, assicurati sempre di disporre salvataggi adeguati!

14.2 Lesson: Georeferenziazione di una Mappa

Un problema comune nel settore forestale può essere l’aggiornamento delle informazioni per un’area forestale. È
possibile che le informazioni precedenti per quell’area risalgano a diversi anni fa e siano state raccolte in modo
analogico (cioè su carta) o forse sono state digitalizzate ma tutto ciò che rimane è la versione cartacea di quei dati di
inventario.
Molto probabilmente vorresti usare quelle informazioni nel tuo GIS, per esempio, per confrontare successivamente
con inventari più recenti. Questo significa che avrai bisogno di digitalizzare le informazioni a portata di mano usando
il tuo software GIS. Ma prima di iniziare la digitalizzazione, c’è un primo passo importante da fare, la scansione e la
georeferenziazione della mappa cartacea.
Obiettivo di questa lezione: Imparare ad usare lo strumento Georeferenziatore in QGIS.

14.2.1 Scansionare la mappa

Il primo passo che dovrai fare è quello di scansionare la tua mappa. Se la tua mappa è troppo grande, allora puoi
scansionarla in diverse parti, ma tieni presente che dovrai ripetere i passi di pre-elaborazione e georeferenziazione
per ogni parte. Quindi, se possibile, scansiona la mappa nel minor numero di parti possibile.
Se vuoi usare una mappa diversa da quella fornita con questo manuale, usa il tuo scanner per scansionare la mappa
come file immagine, una risoluzione di 300 DPI andrà bene. Se la tua mappa ha dei colori, scansiona l’immagine a
colori in modo che tu possa poi usare quei colori per separare le informazioni dalla tua mappa in diversi layer (per
esempio, popolamenti forestali, curve di livello, strade…).
Per questo esercizio si utilizzerà una mappa precedentemente scansionata, che si trova come rautjarvi_map.
tif nella cartella dati exercise_data/forestry.
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14.2.2 Follow Along: Georeferenziazione della mappa scansionata

1. Apri QGIS e imposta il SR del progetto su EPSG:3067 - ETRS89 / TM35FIN (E,N) in Progetto ►
Proprietà… ► SR, che è il SR correntemente utilizzato in Finlandia.

2. Salva il progetto QGIS come map_digitizing.qgs.
Utilizzerai lo strumento di georeferenziazione di QGIS denominato Georeferenziatore…. Per georeferenziare la
mappa:

1. Apri lo strumento di georeferenziazione, Layer –gt; :menuselection: “Georeferenziatore…`.
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2. Aggiungi il file immagine della mappa, rautjarvi_map.tif, come immagine da georeferenziare, File►
Apri raster….

3. Fai clic su OK.
Poi devi definire le impostazioni di trasformazione per la georeferenziazione della mappa:

1. Apri Impostazioni ► Impostazioni di Trasformazione….
2. Imposta ilTipo di trasformazione suLineare e ilMetodo di ricampionamento suVicino più Prossimo.

3. Premi il tasto Seleziona SR accanto all’opzione SR di destinazione e seleziona il SR EPSG:2392 - KKJ /
Finlandia zona 2; si tratta del SR utilizzato in Finlandia nel 1994, quando è stata creata questa mappa.

4. Fai clic sull’icona accanto alla casella Raster in uscita, vai alla cartella e crea la cartella exercise_data\
forestrydigitizing e denomina il file come rautjarvi_georef.tif.

5. Seleziona Carica in QGIS una volta eseguito

6. Lascia gli altri parametri come predefiniti.
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7. Fai clic su OK.
La mappa contiene diverse crocette che contrassegnano le coordinate nella mappa, le useremo per georeferenziare
questa immagine. Puoi usare gli strumenti di zoom e panning come fai di solito in QGIS per esplorare l’immagine
nella finestra del Georeferenziatore.

1. Ingrandisci nell” angolo inferiore sinistro della mappa e nota che c’è un mirino con una coppia di coordinate,
X e Y, che come detto prima sono in SR KKJ / Finlandia zona 2. Questo punto verrà utilizzato come
primo punto di controllo a terra per la georeferenziazione della mappa.

2. Seleziona lo strumento Aggiunge un nuovo punto e clicca nell’intersezione delle crocette (pan e zoom nel modo
necessario).

3. Nella finestra di dialogo Inserisci Coordinate Mappa scrivi le coordinate che appaiono nella mappa (X: 2557000
e Y: 6786000) e il loro SR (EPSG:2392 - KKJ / Finlandia zona 2).

4. Fai clic su OK.
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Il primo punto per la georeferenziazione è ora pronto.
5. Cerca altri crocicchi neri nell’immagine, distanti 1000 metri l’uno dall’altro sia in direzione Nord che Est.

Dovresti essere in grado di calcolare le coordinate di questi punti rispetto al primo.
6. Ingrandisci l’immagine e spostati a destra o in alto fino a trovare un altro mirino e stima di quanti chilometri ti

sei spostato. Cerca di inserire i punti di controllo a terra il più lontano possibile l’uno dall’altro.
7. Digitalizza almeno altri tre punti di controllo del terreno nello stesso modo in cui hai fatto per il primo. Il

risultato dovrebbe essere simile a questo:

Con almeno tre punti di controllo a terra digitalizzati puoi vedere l’errore di georeferenziazione come una linea
rossa che esce dai punti. L’errore in pixel può essere visualizzato anche nella Tabella GCP nelle colonne dX[pixel] e
dY[pixel]. L’errore in pixel non dovrebbe essere superiore a 10 pixel. In caso contrario, è necessario rivedere i punti
digitalizzati e le coordinate inserite per individuare il problema. Si può usare l’immagine qui sopra come guida.
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Una volta che sei soddisfatto dei tuoi punti di controllo, puoi salvarli per un uso successivo:
1. Vai a File ► Salva Punti GCP come.
2. Nella cartella exercise_data\forestry\digitizing, denomina il file rautjarvi_map.tif.

points.
Infine, georeferenzia la tua mappa:

1. Vai a File ► Avvia georeferenziazione.
2. Nota che il file è già stato nominato come rautjarvi_georef.tif quando si sono modificate le

impostazioni del georeferenziatore.
Ora puoi vedere lamappa nel progettoQGIS come raster georeferenziato. Nota che il raster sembra leggermente
ruotato, ma questo è semplicemente dovuto al fatto che i dati sono in KKJ / Finlandia zona 2 e il tuo
progetto è in ETRS89 / TM35FIN (E,N).

3. Per verificare che i tuoi dati siano correttamente georeferenziati, puoi
1. Aprire l’immagine aerea nella cartella exercise_data\forestry, denominata

rautjarvi_aerial.tif.
2. La tua mappa e questa immagine dovrebbero corrispondere abbastanza bene: imposta la trasparenza della

mappa al 50% e confrontala con l’immagine aerea.
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4. Salva le modifiche al tuo progetto QGIS, continuerai da questo punto per la prossima lezione.
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14.2.3 In Conclusion

Hai ora georeferenziato una mappa cartacea, rendendo possibile il suo utilizzo come layer di mappa in QGIS.

14.2.4 What’s Next?

Nella prossima lezione, digitalizzerai i popolamenti forestali nella tua mappa come poligoni e aggiungerai i dati
dell’inventario ad essi.

14.3 Lesson: Digitalizzazione dei boschi

A meno che non tu non voglia usare la tua mappa georeferenziata come semplice immagine di sfondo, il passo
successivo è quello di digitalizzare gli elementi da essa. Lo hai già fatto negli esercizi sulla creazione di dati vettoriali
in Lezione: Creare un Nuovo Insieme di Dati Vettoriali, quando hai digitalizzato i campi della scuola. In questa lezione,
digitalizzerai i confini dei popolamenti forestali che appaiono nella mappa come linee verdi, ma invece di usare
un’immagine aerea, userai la tua mappa georeferenziata.
Obiettivo di questa lezione Imparare una tecnica per facilitare il lavoro di digitalizzazione, digitalizzando i
popolamenti forestali e aggiungendovi infine i dati inventariali.

14.3.1 Follow Along: Ricavare i confini dei popolamenti forestali

Apri il progetto QGIS map_digitizing.qgs, salvato nella lezione precedente.
Una volta scansionata e georeferenziata la tua mappa, puoi iniziare a digitalizzare direttamente guardando l’immagine
come guida. Questa è probabilmente la strada da seguire se l’immagine da cui si intende digitalizzare è, ad esempio,
una fotografia aerea.
Se quella che stai utilizzando per la digitalizzazione è una buona mappa, come nel nostro caso, è probabile che le
informazioni siano chiaramente visualizzate come linee con colori diversi per ogni tipo di elemento. Questi colori
possono essere estratti con relativa facilità come immagini singole utilizzando un software di elaborazione delle
immagini come GIMP. Tali immagini separate possono essere utilizzate per aiutare la digitalizzazione, come potrai
vedere di seguito.
Il primo passo sarà quello di utilizzare GIMP per ottenere un’immagine che contenga solo i popolamenti forestali,
cioè tutte quelle linee verdastre che puoi individuare nella mappa originale scannerizzata:

1. Apri GIMP (se non lo hai ancora installato, scaricalo da Internet o rivolgiti al tuo insegnante).
2. Apri l’immagine originale della mappa, File ► Apri, rautjarvi_map.tif nella cartella

exercise_data/forestry. Nota che i popolamenti forestali sono rappresentati come linee verdi
(con il numero del popolamento anch’esso in verde all’interno di ogni poligono).
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3. Ora puoi selezionare i pixel dell’immagine che costituiscono i bordi dei popolamenti forestali (i pixel verdastri):
1. Apri lo strumento Selezione ► Per colore.
2. Con lo strumento attivo, ingrandisci l’immagine (Ctrl + rotella del mouse) in modo che la linea di un

popolamento forestale sia sufficientemente vicina per distinguere i pixel che la formano. Vedi l’immagine
di sinistra qui sotto.

3. Fai clic e trascina il cursore del mouse al centro della linea in modo che lo strumento raccolga i valori di
colore di diversi pixel.

4. Rilascia il clic del mouse e attendi qualche secondo. I pixel che corrispondono ai colori raccolti dallo
strumento verranno selezionati nell’intera immagine.

5. Ingrandisci per vedere come i pixel verdastri sono stati selezionati in tutta l’immagine.
6. Se il risultato non è soddisfacente, ripeti l’operazione di clic e trascinamento.
7. La tua selezione dei pixel dovrebbe assomigliare all’immagine di destra qui sotto.
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4. Una volta che hai completato la selezione, devi copiare questa selezione come nuovo livello e salvarla come file
immagine separato:
1. Copy (Ctrl+C or Edit ► Copy) the selected pixels.
2. And paste the pixels directly as a new layer (Edit► Paste as► New Layer). GIMP will display the pasted

pixels as a new layer (Pasted Layer) in the Layers panel.
3. Fa clic sull’icona «occhio» accanto al livello dell’immagine originale per spegnerla, inmodo che sia visibile

solo il Livello incollato:
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5. Finally, select File► Export As…, set Select File Type (By Extension) as a TIFF image, select the digitizing
folder and name it rautjarvi_map_green.tif. Select no compression when asked.

Potresti eseguire lo stesso processo con altri elementi dell’immagine, ad esempio estraendo le linee nere che
rappresentano le strade o quelle marroni che rappresentano le curve di livello del terreno. Ma per noi sono sufficienti
i popolamenti forestali.

14.3.2 Try Yourself Georeferenziare l’immagine dei pixel verdi

Come nella lezione precedente, devi georeferenziare questa nuova immagine per poterla utilizzare con il resto dei
tuoi dati.
Nota che per quanto riguarda lo strumento Georeferenziatore non devi digitalizzare i punti di controllo del terreno
perché questa immagine è fondamentalmente la stessa immagine della mappa originale. Di seguito sono riportate
alcune cose che dovresti ricordare:

• Anche questa immagine si trova, ovviamente, nel SR KKJ / Finland zone 2.
• Devi utilizzare i punti di controllo del terreno salvati, File ► Carica punti GCP….
• Ricordati di rivedere le Impostazioni di Trasformazione.
• Denomina il raster in uscita come rautjarvi_green_georef.tif nella cartella digitizing.

Verifica che il nuovo raster si adatti bene alla mappa originale.

14.3.3 Follow Along: Creazione di Punti di Supporto per la Digitalizzazione

Tenendo conto degli strumenti di digitalizzazione di QGIS, potresti già pensare che sarebbe utile agganciarsi a quei
pixel verdi durante la digitalizzazione. È proprio questo il prossimo passo: creare punti da questi pixel per utilizzarli
successivamente per seguire i confini dei popolamenti forestali durante la digitalizzazione, utilizzando gli strumenti
di aggancio disponibili in QGIS.

1. Utilizza lo strumento Raster ► Conversione ► Poligonizza (da raster a vettore)… per vettorializzare le linee
verdi in poligoni. Se non ricordi come si fa, puoi rivederlo in Lezione: Conversione da Raster a Vettore.

2. Salva come rautjarvi_green_polygon.shp all’interno della cartella digitizing.
3. Ingrandisci e visualizza come appaiono i poligoni. Si otterrà qualcosa di simile a questo:
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4. La prossima opzione per ottenere punti da questi poligoni è ottenere i loro centroidi:
1. Apri Vettore ► Strumenti di Geometria ► Centroidi….
2. Imposta Layer in ingresso a |poligonLayer| rautjarvi_green_polygon (il layer poligonale appena creato).
3. Imposta il risultato :guilabel: Centroidi sul file green_centroids.shp all’interno della cartella

digitizing

4. Seleziona Apri il file risultante dopo l’esecuzione dell’algoritmo.
5. Premi Esegui. In questo modo i centroidi dei poligoni vengono calcolati come un nuovo layer e aggiunti

al progetto.
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5. Ora puoi rimuovere il layer rautjarvi_green_polygon dalla TOC.
6. Modifica la simbologia del layer dei centroidi come segue:

1. Apri le Proprietà Layer per green_centroids.
2. Vai alla scheda Simbologia.
3. Imposta Dimensione a 1.00 e scegli :menuselection: Unità di mappa.

Non è necessario differenziare i punti l’uno dall’altro, è sufficiente che siano presenti affinché gli strumenti di aggancio
li utilizzino. Ora puoi utilizzare questi punti per seguire le linee originali molto più facilmente che senza di essi.
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14.3.4 Follow Along: Digitalizzare i boschi

Ora sei pronto per iniziare il lavoro di digitalizzazione vero e proprio. Devi iniziare creando un file vettoriale di
Tipo di geometria Poligono, ma per questo esercizio è disponibile uno shapefile con parte dell’area di interesse già
digitalizzata. Si finirà di digitalizzare la metà dei popolamenti forestali rimasti tra le strade principali (ampie linee
rosa) e il lago:
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1. Vai alla cartella digitizing utilizzando il tuo browser file manager.
2. Trascina il file vettoriale forest_stands.shp sulla tua mappa.
3. Modifica la simbologia del nuovo layer in modo che sia più facile vedere i poligoni che hai già digitalizzato.

1. Imposta Colore di riempimento su verde e modifica Opacità su 50%.
2. Seleziona Riempimento semplice e imposta Spessore tratto su 1,00 mm.

Ora, se ti ricordi i moduli precedenti, dobbiamo impostare e attivare le opzioni di aggancio:
1. Vai a Progetto ► Opzioni di Aggancio…

2. Premi Abilita Aggancio e seleziona Segui Configurazione Avanzata.
3. Seleziona i layer green_centroids e forest_stands.
4. Imposta Tipo per ogni layer a Vertice.
5. Imposta la Tolleranza per ogni layer a 10.
6. Imposta Unità per ogni layer a pixel.

7. Seleziona Evita Sovrapposizione per il layer forest_stands.

8. Premi Modifica Topologica

9. Scegli Segui Configurazione Avanzata

10. Chiudi la finestra a comparsa

Con queste impostazioni di aggancio, ogni volta che digitalizzi e ti avvicini a uno dei punti del layer dei centroidi
o a un qualsiasi vertice dei poligoni digitalizzati, apparirà un quadrato rosa sul punto a cui verrà agganciato.

11. Infine, disattiva la visibilità di tutti i layer tranne forest_stands e rautjarvi_georef. Assicurati che l’immagine
della mappa non abbia più trasparenza.

Alcune cose importanti da notare prima di iniziare la digitalizzazione:
• Non cercare di essere troppo preciso nella digitalizzazione dei bordi.
• Se un bordo è una linea retta, digitalizzalo con due soli nodi. In generale, digitalizza utilizzando il minor numero
possibile di nodi.

• Esegui lo zoom a distanze ravvicinate solo se ritieni necessario essere preciso, ad esempio in corrispondenza di
alcuni angoli o quando vuoi che un poligono si colleghi a un altro poligono in corrispondenza di un determinato
nodo.

• Usa il tasto centrale del mouse per ingrandire/ridurre e per spostarti durante la digitalizzazione.
• Digitalizza solo un poligono alla volta.
• Dopo aver digitalizzato un poligono, scrivi l’id del popolamento forestale che puoi vedere dalla mappa.

Ora puoi iniziare la digitalizzazione:
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1. Individua il numero del popolamento forestale ``357”” nella finestra mappa.
2. Seleziona il layer forest_stands.

3. Fai clic sul pulsante Attiva Modifiche per abilitare la modifica.

4. Seleziona lo strumento Aggiungi Elemento Poligonale.
5. Inizia a digitalizzare il popolamento ``357”” collegando alcuni punti. Nota le croci rosa che indicano l’aggancio.

Quando hai finito:
1. Fai clic con il pulsante destro del mouse per terminare la digitalizzazione del poligono.
2. Immetti il popolamento forestale ID all’interno del modulo (in questo caso 357).
3. Fai clic su OK.

Se il modulo non appare al termine della digitalizzazione del poligono, vai in Impostazioni►Opzioni►Digitalizzazione
e assicurati che l’opzione Non aprire il modulo dopo la creazione di ogni elemento non sia selezionata.
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Il tuo poligono digitalizzato si presenterà più o meno così:

Ora, per il secondo poligono, seleziona il popolamento numero 358. Assicurati che Evita Sovrapposizione
sia selezionata per il layer forest_stands (come mostrato sopra). Questa opzione assicura che i poligoni non si
sovrappongano. Pertanto, se digitalizzi sopra un poligono esistente, il nuovo poligono sarà tagliato per incontrare
il bordo dei poligoni esistenti. Puoi utilizzare questa opzione per ottenere automaticamente un confine comune.

1. Inizia la digitalizzazione del popolamento 358 in uno degli angoli comuni con il popolamento 357.
2. Continua normalmente fino a raggiungere l’altro angolo comune a entrambi i popolamenti.
3. Infine, digitalizza alcuni punti all’interno del poligono 357 assicurandoti che il bordo comune non sia intersecato.

Vedi l’immagine di sinistra qui sotto.
4. Fai clic con il pulsante destro del mouse per terminare la modifica del popolamento forestale 358.
5. Immetti l” ID come 358.
6. Fai clic su OK. Il nuovo poligono dovrebbe avere un bordo comune con il popolamento 357, come puoi vedere

nell’immagine sottostante.
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La parte del poligono che si sovrapponeva al poligono esistente è stata automaticamente tagliata e hai ottenuto un
confine comune, come volevi che fosse.

14.3.5 Try Yourself Terminare la digitalizzazione dei popolamenti forestali

Ora hai due popolamenti forestali pronti. E una buona base di partenza su come procedere. Continua a digitalizzare
da solo fino a quando non avrai digitalizzato tutti i popolamenti forestali limitati dalla strada principale e dal lago.
Potrebbe sembrare un lavoro impegnativo, ma presto ti impratichirai con la digitalizzazione dei popolamenti forestali.
Dovresti impiegare circa 15 minuti.
Durante la digitalizzazione potrebbe potresti avere la necssità di modificare o eliminare nodi, dividere o unire poligoni.
Gli strumenti necessari sono stati illustrati in Lezione: Topologia Elemento, ora è probabilmente un buon momento
per rileggerli.
Ricordati che l’attivazione di Abilita la modifica topologica consente di spostare i nodi comuni a due poligoni in modo
che il bordo comune venga modificato contemporaneamente per entrambi i poligoni.
Il tuo risultato apparirà simile a questo:
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14.3.6 Follow Along: Unire i dati dei popolamenti forestali

È possibile che i dati dell’inventario forestale in tuo possesso per la tua mappa siano anche in formato cartaceo.
In questo caso, dovrai prima riportare i dati in un file di testo o in un foglio di calcolo. Per questo esercizio, le
informazioni dell’inventario del 1994 (lo stesso inventario della mappa) sono pronte in un file di testo separato da
virgole (csv).

1. Apri il file rautjarvi_1994.csv dalla cartella exercise_data\forestry in un editor di testo
e nota che il file dei dati dell’inventario ha un attributo chiamato ID che contiene i numeri dei popolamenti
forestali. Questi numeri corrispondono agli id dei popolamenti forestali inseriti per i poligoni e possono essere
usati per collegare i dati dal file di testo al file vettoriale. I metadati di questo inventario sono riportati nel file
rautjarvi_1994_legend.txt nella stessa cartella.
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2. Ora aggiungi questo file al progetto:

1. Utilizza lo strumento Aggiungi Layer Testo Delimitato. Vi si accede tramite Layer ► Aggiungi Layer ►
Aggiungi Layer Testo Delimitato….

2. Imposta i dettagli nella finestra di dialogo come segue:

3. Premi :guilabel: “Aggiungi” per caricare il file formattato :file: “csv” nel progetto.
3. Per collegare i dati del file .csv con i poligoni digitalizzati, crea un join tra i due layer:

1. Apri le Proprietà Layer per il layer forest_stands.
2. Vai alla scheda Join.
3. Fai clic su |simbologyAdd| Aggiungi nuova unione nella parte inferiore della finestra di dialogo.
4. Seleziona rautjarvi_1994.csv come Vettore di join.
5. Imposta Campo unione a ID.
6. Imposta Campo destinazione a ID.
7. Fai clic su OK due volte.

I dati del file di testo dovrebbero ora essere collegati al file vettoriale. Per vedere cosa è successo, seleziona il layer
forest_stands e usa Apri Tabella Attributi. Puoi vedere che tutti gli attributi del file di dati dell’inventario sono
ora collegati al layer vettoriale digitalizzato.
Noterai che i nomi dei campi sono preceduti da rautjarvi_1994_. Per modificare ciò:

1. Apri le Proprietà Layer per il layer forest_stands.
2. Vai alla scheda Join.
3. Seleziona Vettore di join rautjarvi_1994

4. Fai clic sul pulsante Modifica unione selezionata per abilitare la modifica.
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5. In Prefisso del nome del campo personalizzato rimuovi il prefisso del nome

I dati del file .csv sono solo collegati al tuo file vettoriale. Per rendere questo collegamento permanente, in modo
che i dati siano effettivamente registrati nel file vettoriale, devi salvare il layer forest_stands come un nuovo
file vettoriale. Per farlo:

1. Fai clic con il pulsante destro del mouse sul layer forest_stands.
2. Scegli Esporta ► Salva Con Nome….
3. Imposta Formato a ESRI Shapefile
4. Imposta il nome del file su forest_stands_1994.shp nella cartella forestry.

5. Per includere il nuovo file come layer nel progetto, seleziona Aggiungi il file salvato alla mappa.
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14.3.7 Try Yourself Aggiungere Area e Perimetro

Per completare le informazioni relative a questi popolamenti forestali, potresti calcolare l’area e il perimetro dei
popolamenti. Hai calcolato le aree dei poligoni in Lezione: Esercizi supplementari. Se necessario, torna a quella lezione
e calcola le aree dei popolamenti forestali. Nomina il nuovo attributo Area e assicurati che i valori calcolati siano in
ettari. Si può fare lo stesso per il perimetro.
Ora il layer forest_stands_1994 è pronto e contiene tutte le informazioni disponibili.
Salva il tuo progetto per conservare i layer della mappa corrente, nel caso in cui tu abbia bisogno di tornarci in un
secondo momento.
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14.3.8 In Conclusion

Sono bastati pochi clic del mouse per avere i dati del vecchio inventario in formato digitale e pronti per essere utilizzati
in QGIS.

14.3.9 What’s Next?

Potresti iniziare a fare diverse analisi con il tuo insieme di dati nuovo di zecca, ma potresti essere più interessato
a eseguire analisi in un insieme di dati più aggiornato. L’argomento della prossima lezione sarà la creazione di
popolamenti forestali utilizzando le foto aeree attuali e l’aggiunta di alcune informazioni rilevanti al tuo insieme
di dati.

14.4 Lesson: Aggiornamento dei popolamenti forestali

Ora che hai digitalizzato le informazioni dalle vecchie mappe di inventario e aggiunto le informazioni corrispondenti
alle aree forestali, il passo successivo è creare l’inventario dello stato attuale della foresta.
Digitalizzerai nuove aree forestali utilizzando una foto aerea. Come nella lezione precedente, userai una fotografia
aerea infrarosso a colori (CIR). Questo tipo di immagine, in cui la luce infrarossa viene registrata invece della luce
blu, è ampiamente utilizzato per lo studio delle aree vegetate.
Dopo aver digitalizzato i popolamenti forestali, aggiungerei informazioni come i nuovi vincoli imposti dalle norme
di conservazione.
L’obiettivo di questa lezione: Digitalizzare un nuovo insieme di popolamenti forestali dalle fotografie aeree CIR e
aggiungere informazioni da altri set di dati.

14.4.1 Confrontare i Vecchi Popolamenti Forestali con le Fotografie Aeree
Attuali

Il National Land Survey of Finland ha una politica di dati aperti che ti consente di scaricare una varietà di dati
geografici come immagini aeree, mappe topografiche tradizionali, DEM, dati LiDAR, ecc. Il servizio può essere
accessibile in inglese qui https://tiedostopalvelu.maanmittauslaitos.fi/tp/kartta?lang=en. L’immagine aerea utilizzata
in questo esercizio è stata creata da due immagini CIR ortorettificate scaricate da quel servizio (M4134F_21062012
e M4143E_21062012).

1. Apri QGIS e imposta il SR del progetto su ETRS89 / ETRS-TM35FIN in Progetto ► Proprietà… ► SR

2. Aggiungi l’immagine CIR rautjarvi_aerial.tif al progetto.
1. Vai alla cartella exercise_data\forestry\ utilizzando il tuo browser del gestore di file.
2. Trascina e rilascia il file rautjarvi_aerial.tif sul tuo progetto

3. Salva il progetto QGIS come digitizing_2012.qgs
Le immagini CIR sono del 2012. Puoi confrontare i popolamenti creati nel 1994 con la situazione di quasi 20 anni
dopo.

1. Aggiungi il layer forest_stands_1994.shp creato nella lezione precedente.
1. Vai alla cartella exercise_data\forestry\ utilizzando il tuo browser del gestore di file.
2. Trascina e rilascia il file forest_stands_1994.shp sul tuo progetto.

2. Imposta la simbologia per il layer in modo da poter vedere attraverso i tuoi poligoni.
1. Fai clic destro su forest_stands_1994

2. Seleziona Proprietà
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3. Vai alla scheda Simbologia

4. Imposta Colore di riempimento a riempimento trasparente
5. Imposta Colore tratto a viola
6. Imposta Spessore tratto a 0.50 mm

3. Esamina come i vecchi popolamenti forestali seguono (o meno) ciò che visivamente si potrebbe interpretare
come una foresta omogenea.

4. Zooma e fai una panoramica dell’area. Probabilmente noterai che alcuni dei vecchi popolamenti forestali
potrebbero essere ancora corrispondenti all’immagine, mentre altri non lo sono.
Questa è una situazione normale, poiché sono trascorsi circa 20 anni e sono state effettuate diverse operazioni
forestali (raccolta, diradamento…). È anche possibile che le formazioni forestali sembrassero omogenee nel
1992 alla persona che le ha digitalizzate, ma col passare del tempo alcune foreste si sono sviluppate in modi
diversi. È anche possibile che le priorità dell’inventario forestale di allora fossero diverse da quelle di oggi.

Successivamente, creerai nuovi popolamenti forestali per questa immagine senza utilizzare quelli vecchi. In seguito
potrai confrontarli per vedere le differenze.

14.4.2 Interpretare l’immagine CIR

Digitalizziamo la stessa area coperta dal vecchio inventario, limitata dalle strade e dal lago. Non è necessario
digitalizzare l’intera area, poiché nell’esercizio precedente si può partire da un file vettoriale che contiene già la
maggior parte dei popolamenti forestali.

1. Rimuovi il layer forest_stands_1994

2. Aggiungi il file exercise_data\forestry\forest_stands_2012.shp al progetto
3. Imposta lo stile di questo layer in modo che i poligoni non abbiano riempimento e i bordi siano visibili

1. Apri la finestra di dialogo Proprietà del layer «forest_stands_2012».

2. Vai alla scheda Simbologia

3. Imposta Colore di riempimento a riempimento trasparente
4. Imposta Colore tratto su verde
5. Imposta Spessore tratto a 0.50 mm
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Puoi vedere che la sezione settentrionale dell’area di inventario è ancora mancante. Il tuo compito è digitalizzare le
porzioni di foresta mancanti.
Prima di iniziare, dedica del tempo a esaminare le zone forestali già digitalizzate e la foresta corrispondente
nell’immagine. Cerca di farti un’idea su come vengono decisi i confini delle zone, ti può essere utile avere qualche
conoscenza forestale.
Alcuni punti da considerare:

• Quali foreste hanno specie decidue (in Finlandia queste sono principalmente le foreste di betulla) e quali hanno
conifere (in questa zona queste sono pini o abeti)? Nelle immagini CIR, le specie decidue di solito appaiono
con un colore rosso brillante mentre le conifere appaiono con un colore verde scuro.
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• Quanti anni ha la foresta? Le dimensioni delle chiome degli alberi possono essere identificate nell’immagine.
• Quanto sono densi i diversi boschi? Un bosco in cui è stata recentemente effettuata un’operazione di
diradamento mostrerebbe spazi tra le chiome degli alberi e dovrebbe essere facile da differenziare dagli altri
boschi circostanti.

• Le aree bluastre indicano terreni brulli, strade e aree urbane, coltivazioni che non hanno ancora iniziato a
crescere, ecc.

• Non utilizzare zoom troppo vicini all’immagine quando si cerca di identificare le aree boschive. Una scala tra
1:3 000 e 1:5 000 dovrebbe essere sufficiente per questa immagine. Vedi l’immagine qui sotto (scala 1:4000):

14.4.3 Try Yourself 14.4.3 - Prova tu a digitalizzare i popolamenti forestali da
immagini CIR

Quando digitalizzi le aree forestali, dovresti cercare di ottenere aree forestali il più omogenee possibile per quanto
riguarda le specie arboree, l’età della foresta, la densità delle piante… Non essere troppo dettagliato però, altrimenti
finirai per creare centinaia di piccole aree forestali - e questo non sarebbe affatto utile. Dovresti cercare di ottenere
aree significative nel contesto della selvicoltura, non troppo piccole (almeno 0,5 ettari) ma nemmeno troppo grandi
(non più di 3 ettari).
Con questi punti in mente, ora puoi digitalizzare le aree boschive mancanti.

1. Imposta le opzioni di aggancio e topologia:
1. Vai a Progetto ► Opzioni di Aggancio…

2. Premi Abilita Aggancio e seleziona Segui Configurazione Avanzata.
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3. Seleziona il layer forest_stands_2012

1. Imposta Tipo a :guilabel: Vertice
2. Imposta Tolleranza a 10
3. Imposta Unità a px
4. Seleziona la casella Evita sovrapposizione del layer attivo

5. Premi Modifica Topologica

6. Scegli Segui Configurazione Avanzata

7. Chiudi la finestra a comparsa

2. Seleziona il layer forest_stands_2012 nell’elenco dei layer

3. Fai clic sul pulsante Attiva Modifiche per abilitare la modifica.
4. Inizia la digitalizzazione utilizzando le stesse tecniche della precedente lezione. L’unica differenza è che non

hai alcun layer di punti a cui agganciarti. Per questa area dovresti ottenere circa 14 nuovi boschi. Durante la
digitalizzazione, compila il campo «StandID» con numeri a partire da «901».

5. Una volta terminato, il tuo layer dovrebbe avere un aspetto simile a:
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Ora hai un nuovo insieme di poligoni che mostrano le diverse aree boschive nel 2012 - come interpretato dalle
immagini CIR. Tuttavia, ti mancano i dati dell’inventario forestale. Per questo dovrai visitare la foresta e ottenere
alcuni dati campione che utilizzerai per stimare gli attributi forestali per ciascuna delle aree boschive. Vedrai come
fare questo nella prossima lezione.
Puoi aggiungere ulteriori informazioni sulle normative di conservazione che devono essere prese in considerazione
per questa area.

14.4.4 Follow Along: 14.4.4 - Aggiornamento dei popolamenti forestali con
Informazioni sulla Conservazione

Per l’area in cui stai lavorando, ci sono alcune regolamentazioni sulla conservazione che devono essere prese in
considerazione durante la pianificazione forestale.

• Sono state identificate due località in cui si trova una specie protetta di scoiattolo volante siberiano (Pteromys
volans). Secondo il regolamento, un’area di 15 metri intorno ai punti deve essere lasciata intatta.

• Una foresta ripariale di particolare interesse che sta crescendo lungo un corso d’acqua nella zona deve essere
protetta. Durante una visita sul campo, è stato riscontrato che devono essere protetti 20 metri da entrambi i lati
del corso d’acqua.

Hai un file vettoriale che contiene le informazioni sulla posizione degli scoiattoli e un altro che contiene il corso
d’acqua digitalizzato che si estende dalla zona Nord al lago.
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1. Dalla cartella exercise_data\forestry\, aggiungi i file squirrel.shp e stream.shp al
progetto.

2. Utilizza lo strumento Apri tabella attributi per visualizzare il layer «squirrel».
Puoi notare che ci sono due località definite come scoiattolo volante siberiano e che l’area da proteggere è
indicata da una distanza di 15 metri dalle località.

Delimitiamo con maggiore precisione l’area da proteggere. Creeremo un buffer attorno alle posizioni dei punti,
utilizzando la distanza di protezione.

1. Apri Vettore ► Strumenti di Geoprocessing ► Buffer.

2. Imposta :guilabel: Layer in ingresso a :guilabel: squirrel.
3. Imposta Distanza a 15 metri.
4. Imposta Risultato da operazioni di buffer a exercise_data\forestry\squirrel_15m.shp

5. Seleziona Apri il file risultante dopo l’esecuzione dell’algoritmo

6. Clicca Esegui
7. Una volta completato il processo, clicca su Chiudi
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Se ingrandisci la posizione nella parte settentrionale dell’area, noterai che l’area di buffer si estende su due popolamenti
vicini. Ciò significa che ogni volta che si verifica un’operazione forestale in quel popolamento, la zona protetta
dovrebbe essere presa in considerazione.

Per la protezione dei luoghi in cui si trovano gli scoiattoli, stai per aggiungere un nuovo attributo (colonna) ai tuoi nuovi
boschi che conterrà informazioni sulle zone che devono essere protette. Queste informazioni saranno poi disponibili
ogni volta che viene pianificata un’operazione forestale e il team sul campo sarà in grado di segnalare l’area che deve
essere lasciata intatta prima dell’inizio dei lavori.
Per collegare le informazioni sugli scoiattoli ai tuoi popolamenti forestali, puoi utilizzare l’algoritmo Unisci attributi
per posizione:

1. Apri :menuselection:`Vettore –> Strumenti di Gestione Dati –> Unisci attributi per posizione… `.

2. Imposta Unisci gli elementi in a forest_stands_2012

3. In Elementi che (predicato geometrico), seleziona Intersect

4. Imposta Confrontando con a squirrel_15m

5. Imposta Tipo di unione come Prendi solamente gli attributi del primo elemento corrispondente (uno-a-uno).
6. Lascia deselezionato Scarta i record che non possono essere uniti.
7. Imposta Joined layer a exercise_data\forestry\stands_squirrel.shp

8. Seleziona Apri il file risultante dopo l’esecuzione dell’algoritmo

9. Clicca Esegui
10. Una volta completato il processo, puoi fare clic su Chiudi nella finestra di dialogo.
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Ora hai un nuovo layer di foresta, stands_squirrel.shp che mostra le informazioni sulla protezione dello
scoiattolo volante siberiano.

1. Apri la tabella degli attributi del layer «stands_squirrel»
2. Ordina la tabella cliccando sul campo point_pr nell’intestazione della tabella.
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Puoi vedere che ci sono alcuni boschi che hanno le informazioni sui luoghi di protezione. Le informazioni
nei dati dei boschi indicheranno al responsabile del bosco che ci sono informazioni di protezione da tenere in
considerazione. Quindi lui o lei può ottenere la posizione dal dataset «squirrel» e visitare l’area per segnare il
corrispondente buffer intorno alla posizione in modo che gli operatori sul campo possano evitare di disturbare
l’ambiente delle scoiattoli.

14.4.5 Try Yourself Aggiornare i popolamenti forestali con la distanza dal
torrente

Seguendo lo stesso approccio utilizzato per le località protette degli scoiattoli, ora puoi aggiornare le aree del tuo
bosco con informazioni di protezione relative al corso d’acqua. Alcuni punti:

• Ricorda che il buffer è di 20 metri intorno al corso d’acqua.
• Vuoi avere tutte le informazioni di protezione nello stesso file vettoriale, quindi usa stands_squirrel.
shp come layer di base.

• Nome del tuo output come forest_stands_2012_protect.shp
Una volta completato il processo, apri la tabella degli attributi del layer di output e conferma di avere tutte le
informazioni di protezione per le aree forestali ripariali associate al corso d’acqua.
Quando sei soddisfatto dei risultati, salva il tuo progetto QGIS.

14.4.6 In Conclusion

Hai visto come interpretare le immagini CIR per digitalizzare i popolamenti forestali. Naturalmente ci vorrà un po”
di pratica per ottenere popolamenti più accurati e di solito l’uso di altre informazioni, come le mappe del suolo, darà
risultati migliori, ma ora conosci le basi per questo tipo di attività. E l’aggiunta di informazioni da altri set di dati si
è rivelata un’operazione piuttosto banale.
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14.4.7 What’s Next?

I popolamenti forestali digitalizzati saranno utilizzati in futuro per la pianificazione delle operazioni forestali, ma è
ancora necessario ottenere ulteriori informazioni sulla foresta. Nella prossima lezione si vedrà come pianificare una
serie di aree di campionamento per inventariare l’area forestale appena digitalizzata e ottenere una stima complessiva
dei parametri forestali.

14.5 Lesson: Campionamento sistematico

Hai già digitalizzato una serie di poligoni che rappresentano i popolamenti forestali, ma non hai ancora informazioni
sulla foresta. A tal fine devi progettare un’indagine per inventariare l’intera area forestale e quindi stimarne i parametri.
In questa lezione creerai un insieme sistematico di aree di campionamento.
Quando inizi a pianificare l’inventario forestale è importante definire chiaramente gli obiettivi, i tipi di aree di
campionamento che verranno utilizzati e i dati che verranno raccolti per raggiungere gli obiettivi. Per ogni singolo
caso, questi dipendono dal tipo di bosco e dallo scopo della sua gestione e devono essere attentamente pianificati da
una persona con conoscenze forestali. In questa lezione si realizzerà un inventario teorico basato su un progetto di
campionamento sistematico di aree.
Obiettivo di questa lezione: creare un progetto di campionamento sistematico di aree per il rilevamento dell’area
forestale.

14.5.1 Inventariare la foresta

Esistono diversi metodi per inventariare le foreste, ognuno dei quali si adatta a scopi e condizioni diverse. Ad esempio,
un modo molto accurato per inventariare una foresta (se si considerano solo le specie arboree) sarebbe quello di
visitare la foresta e fare un elenco di tutti gli alberi e delle loro caratteristiche. Come si può immaginare, questo non
è comunemente applicabile, tranne che per alcune piccole aree o per alcune situazioni particolari.
Il modo più comune per acquisire informazioni su una foresta è quello di campionarla, cioè di effettuare misurazioni
in diversi punti della foresta e di generalizzare tali informazioni all’intera foresta. Queste misurazioni sono spesso
effettuate in lotti campione, ovvero aree forestali più piccole che possono essere facilmente misurate. I lotti campione
possono essere di qualsiasi dimensione (ad esempio 50 m2 , 0,5 ha) e forma (ad esempio circolare, rettangolare, di
dimensioni variabili) e possono essere collocati nella foresta in modi diversi (ad esempio in modo casuale, sistematico,
lungo linee). Le dimensioni, la forma e l’ubicazione dei lotti di campionamento sono solitamente decise in base a
considerazioni statistiche, economiche e pratiche. Se non hai conoscenze forestali, potresti essere interessato a leggere
questo articolo di Wikipedia https://en.wikipedia.org/wiki/Forest_inventory..

14.5.2 Follow Along: I14.5.2 - Realizzazione di un Progetto di campionamento
sistematico a lotti

Per la foresta su cui stai lavorando, il gestore ha deciso che un progetto di campionamento sistematico è il più
appropriato per questa foresta e ha deciso che una distanza fissa di 80 metri tra le piazzole e le linee di campionamento
darà risultati affidabili (per questo caso, +- 5% di errore medio con una probabilità del 68%). Per questo inventario si
è deciso che i lotti di dimensioni variabili sono il metodo più efficace per i popolamenti in crescita e maturi, mentre
per i popolamenti di giovani piante si utilizzerà un raggio fisso di 4 metri.
In pratica, è necessario che tu rappresenti i lotti campione come punti che saranno utilizzati dalle squadre sul campo
in seguito:

1. Apri il tuo progetto digitizing_2012.qgs della lezione precedente.
2. Rimuovi tutti i layer tranne forest_stands_2012.
3. Salva ora il tuo progetto con il nome di forest_inventory.qgs

Ora devi creare una griglia rettangolare di punti distanti 80 metri l’uno dall’altro:
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1. Apri Vettore ► Strumenti di Ricerca Punti regolari….
2. Premi il pulsante a discesa accanto al campo Estensione in ingresso e dal menu Calcola da layer seleziona

forest_stands_2012.
3. Nelle impostazioni Spaziatura punti/conteggio, inserisci 80 `` metri``.
4. Seleziona la casella Usa spaziatura fra i punti per indicare che il valore rappresenta la distanza tra i punti.
5. In Punti regolari, salva l’output come systematic_plots.shp nella cartella forestry\sampling\.
6. Seleziona Apri il file risultante dopo l’esecuzione dell’algoritmo.
7. Premi Esegui.

Nota: Il valore suggerito per Punti regolari crea i punti sistematici a partire dall’angolo superiore sinistro
dell’estensione del layer del poligono selezionato. Se vuoi aggiungere un po” di casualità a questi punti regolari, puoi
usare un numero calcolato a caso tra 0 e 80 (80 è la distanza tra i nostri punti), e poi scriverlo come parametro poi
scriverlo come parametro Inset iniziale da angolo (alto sx) nella finestra di dialogo dello strumento.

Nota che lo strumento ha utilizzato l’intera estensione del layer stand per generare una griglia rettangolare di punti. Ma
a te interessano solo i punti che si trovano effettivamente all’interno dell’area forestale (vedi le immagini sottostanti):

1. From the Processing toolbox, open GDAL ► Geoprocessing sui vettori ► Ritagliare un vettore tramite una
maschera layer di selezione.

2. Seleziona systematic_plots come Layer in ingresso.
3. Imposta forest_stands_2012 come Layer Maschera.
4. Salva il risultato Ritagliato (da maschera) come systematic_plots_clip.shp nella cartella

forestry\sampling\.
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5. Seleziona Apri il file risultante dopo l’esecuzione dell’algoritmo.
6. Premi Esegui.

Ora disponi dei punti che le squadre sul campo utilizzeranno per dirigersi verso le posizioni dei lotti di campionamento
progettati. Puoi comunque predisporre questi punti in modo che siano più utili per il lavoro sul campo. Devi
quantomeno aggiungere nomi significativi per i punti ed esportarli in un formato che possa essere utilizzato nei loro
dispositivi GPS.
Cominciamo con la denominazione dei lotti campione. Se controlli la Tabella Attributi per i lotti all’interno
dell’area forestale, puoi vedere che hai il campo id predefinito generato automaticamente dallo strumento Punti
regolari. Etichetta i punti per vederli nella mappa e valuta se è possibile utilizzare questi numeri come parte della
denominazione dei lotti campione:

1. Apri Layer Proprietà… ► Etichette per il layer systematic_plots_clip.
2. Seleziona il menu superiore in Etichette singole.
3. Per la voce Valore, seleziona l” id del campo.
4. Passa alla scheda Buffer, seleziona la casella Disegna buffer del testo e imposta la Dimensione del buffer su

1.
5. Fai clic su OK.

Ora guarda le etichette sulla mappa. Puoi notare che i punti sono stati creati e numerati prima da Ovest a Est e poi
da Nord a Sud. Se guardi di nuovo la tabella degli attributi, noterai che anche l’ordine nella tabella segue questo
schema. A meno che non ci sia un motivo per nominare i punti campione in modo diverso, la denominazione di
Ovest-Est/Nord-Sud segue un ordine logico ed è una buona opzione.
Tuttavia, i valori numerici nel campo id non vanno bene. Sarebbe meglio se la denominazione fosse qualcosa come
p_1, p_2.... Puoi creare una nuova colonna per il layer systematic_plots_clip:

1. Vai alla Tabella Attributi di systematic_plots_clip.

2. Attiva la modalità Attiva modifiche.

3. Apri il Calcolatore di Campi:
1. Seleziona Crea un nuovo campo

2. Inserisci Plot_id come Nome campo in uscita

3. Imposta il Tipo campo in uscita su Testo (string).
4. Nel campo Espressione, scrivi, copia o costruisci questa formula concat('P_', @rownum ).

Ricordati che puoi anche fare doppio clic sugli elementi all’interno Lista funzioni. La funzione concat
si trova sotto Stringa e @rownum sotto il gruppo Variabili e valori.

4. Fai clic su OK.
5. Disattiva la modalità di modifica e salva le modifiche.

Ora hai una nuova colonna con nomi di lotti significativi per l’utente. Per il layer systematic_plots_clip,
cambia il campo utilizzato per l’etichettatura con il nuovo campo Plot_id.
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14.5.3 Follow Along: Esportazione dei lotti campione in formato GPX

Le squadre sul campo utilizzeranno probabilmente un dispositivo GPS per localizzare i punti di campionamento
pianificati. Il passo successivo è esportare i punti creati in un formato leggibile dal GPS. QGIS consente di salvare i
dati vettoriali dei punti e delle linee in GPS eXchange Format (GPX) https://en.wikipedia.org/wiki/GPS_Exchange_
Format, un formato di dati GPS standard che può essere letto dalla maggior parte dei software specializzati. Devi
prestare attenzione alla selezione del SR quando salvi i dati:

1. Fai clic con il tasto destro del mouse sul layer ``systematic_plots_clip``e seleziona :menuselection:`Esporta –>
Salva Elementi come… `.

2. In Formato seleziona GPS eXchange Format [GPX].
3. Salva il Nome file in uscita come plots_wgs84.gpx nella cartella forestry\sampling\.
4. In SR seleziona Seleziona SR.
5. Cerca EPSG:4326 - WGS 84.

Nota: Il formato GPX https://gdal.org/drivers/vector/gpx.html accetta solo questo SR; se selezioni un SR
diverso, QGIS non darà alcun errore ma si otterrà un file vuoto.

6. Fai clic su OK.
7. INella finestra di dialogo che si apre, seleziona solo il layer dei waypoints (il resto dei layer è vuoto).

Le aree campione dell’inventario sono ora in un formato standard che può essere gestito dalla maggior parte dei
software GPS. Le squadre sul campo possono ora caricare le posizioni dei lotti campione sui loro dispositivi. Questo
può essere fatto utilizzando il software specifico del dispositivo e il file plots_wgs84.gpx che hai appena salvato.
Un’altra opzione potrebbe essere quella di utilizzare il plugin GPS Tools ma molto probabilmente si tratterebbe di
impostare lo strumento in modo che funzioni con il dispositivo GPS specifico. Se stai lavorando con i tuoi dati e vuoi
vedere come funziona lo strumento, puoi trovare informazioni al riguardo nella sezione Lavorare con i dati GPS del
Manuale d’uso di QGIS.
Salva ora il tuo progetto QGIS.
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14.5.4 In Conclusion

Hai appena visto come sia possibile creare facilmente un progetto di campionamento sistematico da utilizzare in
un inventario forestale. La creazione di altri tipi di progetti di campionamento richiederà l’uso di strumenti diversi
all’interno di QGIS, di fogli di calcolo o di scripting per calcolare le coordinate dei lotti di campionamento, ma l’idea
generale rimane la stessa.

14.5.5 What’s Next?

Nella prossima lezione vedrai come utilizzare le funzionalità dell’Atlante di QGIS per generare automaticamente
mappe dettagliate che le squadre sul campo utilizzeranno per navigare verso i lotti di campionamento loro assegnati.

14.6 Lesson: Creazione di Mappe Dettagliate con lo Strumento
Atlante

Il progetto di campionamento sistematico è pronto e le squadre sul campo hanno caricato le coordinate GPS nei loro
dispositivi di navigazione. Hanno anche un modulo di dati sul campo dove raccoglieranno le informazioni misurate
in ogni lotto di campionamento. Per trovare più facilmente la loro strada verso ogni lotto di campionamento, hanno
richiesto un certo numero di mappe di dettaglio dove alcune informazioni sul terreno possono essere viste chiaramente
insieme a un sottoinsieme più piccolo dei lotti di campionamento e alcune informazioni sull’area della mappa. Puoi
usare lo strumento Atlas per generare automaticamente una serie di mappe con un formato comune.
Obiettivo di questa lezione: Imparare ad usare lo strumento Atlante in QGIS per generare mappe dettagliate
stampabili per assisterti nel lavoro di catalogazione sul campo.

14.6.1 Follow Along: Preparare il Layout di Stampa

Prima di poter automatizzare le mappe dettagliate dell’area forestale e dei nostri lotti di campionamento, dobbiamo
creare un modello di mappa con tutti gli elementi che consideriamo utili per il lavoro sul campo. Naturalmente il
più importante sarà uno stile adeguato ma, come hai visto prima, dovrai anche aggiungere molti altri elementi che
completeranno la mappa stampata.

1. Apri il progetto QGIS della lezione precedente forest_inventory.qgs. Dovresti avere almeno i
seguenti layer:

• forest_stands_2012 (con una trasparenza del 50%, riempimento verde e linee di confine verdi più scure)
• systematic_plots_clip

• rautjarvi_aerial

2. Salva il progetto con un nuovo nome, map_creation.qgs.
Per creare una mappa stampabile, ricordati di usare il Gestore dei Layout:

1. Apri Progetto ► :guilabel: Gestore dei Layout….
2. Nella finestra di dialogo Gestore dei Layout:

1. Sotto Nuovo da Modello, premi il pulsante Crea… accanto alla voce :guilabel: “Layout vuoto”.
2. Nomina il layout di stampa forest_map.
3. Premi OK. Viene creato e aperto un nuovo layout di stampa con un foglio bianco.

3. Nella finestra Layout di stampa, verifica che le proprietà siano impostate per un foglio A4:
1. Clic con il pulsante destro del mouse sul foglio e seleziona Proprietà pagina. Il pannello Proprietà pagina

si apre sul lato destro del layout.
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2. Verifica che Formato sia A4.
3. Verifica che Orientamento sia Orizzontale.

4. Attiva la scheda Layout accanto al pannello Proprietà pagina e imposta Risoluzione di esportazione su 300
dpi.

La composizione di una mappa è più semplice se si utilizza il reticolo nell” area di disegno per posizionare i diversi
elementi. Esamina le impostazioni della reticolo del layout:

1. Nella scheda Layout espandi la sezione Guide e Reticolo.
2. Verifica che :guilabel: Spaziatura reticolo sia impostata su 10 mm e che :guilabel: Tolleranza di aggancio sia

impostata su 5 px.
Devi attivare l’uso del reticolo:

1. Apri il menu Visualizza.
2. Seleziona Mostra Reticolo.
3. Seleziona Aggancia al Reticolo.
4. Nota che le opzioni per l’uso di Guide sono selezionate per impostazione predefinita, il che consente di vedere

le linee guida quando si spostano gli elementi nel layout.
5. Ora puoi iniziare ad aggiungere oggetti al tuo layout. Aggiungi innanzitutto un oggetto mappa, in modo da

poter esaminare l’aspetto dell’area di disegno della mappa, dal momento che si modificherà la simbologia dei
layer:

1. Fai clic sul pulsante Aggiungi Mappa.
2. Fai clic e trascina un riquadro sull’area di disegno in modo che la mappa ne occupi la maggior parte.

Nota come il cursore del mouse si agganci alla griglia dell’area di disegno. Utilizza questa funzione quando aggiungi
altri oggetti. Se vuoi una maggiore precisione, puoi modificare l’impostazione del reticolo Spaziatura reticolo. Se per
qualche motivo non vuoi che il cursore del mouse si agganci al reticolo, puoi selezionarlo o deselezionarlo nel menu
Visualizza.
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14.6.2 Follow Along: Aggiungere Mappa di Sfondo

Lascia il layout aperto, ma torna alla mappa. Aggiungi alcuni dati di sfondo e crea alcuni stili in modo che il contenuto
della mappa sia il più chiaro possibile.

1. Aggiungi il raster di sfondo basic_map.tif che puoi trovare nella cartella :file:`exercise_data\forestry`.
2. Se richiesto, seleziona il SR ETRS89 / ETRS-TM35FIN per il raster.

Come puoi vedere, la mappa di sfondo è già stilizzata. Questo tipo di cartografia raster pronta all’uso è molto
comune. Viene creata a partire da dati vettoriali, stilizzato in un formato standard e memorizzato come raster,
in modo da non doversi preoccupare di stilizzare diversi layer vettoriali e per ottenere un buon risultato.

3. Ora ingrandisci i tuoi grafici campione, in modo da vedere solo quattro o cinque righe di grafici.
Lo stile attuale delle aree campione non è dei migliori:

Mentre durante le ultime esercitazioni il buffer bianco andava bene sopra l’immagine aerea, ora che l’immagine
di sfondo è prevalentemente bianca si vedono a malapena le etichette. Ma come appare nel layout di stampa?
Verifichiamo:

1. Passa alla finestra del layout di stampa.

2. Usa il pulsante Seleziona/Sposta oggetto per selezionare l’oggetto mappa nel layout.
3. Vai alla scheda Proprietà oggetto.

4. Fai clic su Imposta Estensione della Mappa Uguale all’Estensione della Map Canvas.

5. Se ti è richiesto di aggiornare l’oggetto, fai clic su Aggiorna Anteprima Mappa.
Ovviamente questo non è sufficiente; devi fare in modo che i numeri dei lotti siano il più chiaramente possibile visibili
per le squadre sul campo.

14.6.3 Try Yourself Cambiare la simbologia dei Layer

Hai lavorato in Modulo: Creare ed Esplorare una Mappa di Base con la simbologia e in Modulo: Classificare i Dati
Vettoriali con l’etichettatura. Torna a questi moduli se hai bisogno di rinfrescare alcune delle opzioni e degli strumenti
disponibili. L’obiettivo è far sì che le posizioni degli appezzamenti e il loro nome siano il più possibile chiaramente
visibili, consentendo sempre di vedere gli elementi della mappa di sfondo. Puoi prendere spunto da questa immagine:
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In seguito utilizzerai lo stile verde del layer forest_stands_2012. Per mantenerlo e avere una visualizzazione
che mostri solo i bordi delle alberature:

1. Fai clic con il pulsante destro del mouse su forest_stands_2012 e seleziona Duplica Layer.
2. Ottieni un nuovo layer chiamato forest_stands_2012 copy che puoi usare per definire uno stile

diverso, ad esempio senza riempimento e con i bordi rossi.
Ora hai due diverse visualizzazioni dei popolamenti forestali e puoi quindi decidere quale visualizzare per la
tua mappa di dettaglio.

3. Torna spesso alla finestra del layout di stampa per vedere l’aspetto della mappa. Ai fini della creazione di mappe
dettagliate, cerca una simbologia che appaia bene non alla scala dell’intera area forestale (immagine di sinistra in
basso), ma a una scala più ravvicinata (immagine di destra in basso). Ricordati di usare Aggiorna Anteprima Mappa

e Imposta Estensione della Mappa Uguale all’Estensione della Map Canvas ogni volta che cambi lo zoom
nella tua mappa o il layout.
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14.6.4 Try Yourself Creare un Modello Mappa di Base

1. Una volta definita una simbologia di cui sei soddisfatto, sei pronto ad aggiungere altre informazioni alla tua
mappa da stampare. Aggiungi almeno i seguenti oggetti:

• Titolo.
• Una barra di scala.
• Cornice reticolo per la tua mappa.
• Coordinate sui lati del reticolo.

2. Hai già creato un layout simile in Modulo: Stampare le Mappe. Torna a quel modulo quando ne hai bisogno.
Puoi guardare questa immagine di esempio come riferimento:

3. Esporta la mappa come immagine e guardala.
1. Layout ► Esporta come Immagine….
2. Utilizza ad esempio il formato JPG.

Ecco come apparirà una volta stampato.

14.6.5 Follow Along: Aggiungere altri elementi al Layout di Stampa

Come probabilmente hai notato nelle immagini del modello di mappa suggerito, c’è molto spazio sul lato destro della
mappa. Vedi cos’altro potrebbe essere inserito. Per gli scopi della tua mappa, una legenda non è realmente necessaria,
ma una mappa panoramica e alcune caselle di testo potrebbero aggiungere valore alla mappa.
La mappa panoramica aiuterà le squadre sul campo a posizionare la mappa di dettaglio all’interno dell’area forestale
complessiva:

1. Aggiungi un altro elemento all’area di disegno della mappa, proprio sotto il testo del titolo.
2. Nella scheda Proprietà dell’oggetto, apri il menu a tendina Panoramica.
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3. Imposta la Cornice panoramica su Mappa 0. Questo crea un rettangolo ombreggiato sulla mappa più piccola
che rappresenta l’estensione visibile nella mappa più grande.

4. Controlla anche l’opzione :guilabel: “Cornice” con un colore nero e uno Spessore di ``0,30””.

Nota che la mappa panoramica non fornisce una visione d’insieme dell’area forestale, che è ciò che vuoi.
Vuoi che questa mappa rappresenti l’intera area forestale e che mostri solo la mappa di sfondo e il layer
forest_stands_2012, senza visualizzare le aree di campionamento. Inoltre, vuoi bloccare la visualizzazione
in modo che non cambi ogni volta che modifichi la visibilità o l’ordine dei layer.

1. Torna alla mappa, ma non chiudere il Layout di stampa.
2. Fai clic con il pulsante destro del mouse sul layer forest_stands_2012 e fai clic su Zoom to Layer Extent.
3. Disattiva tutti i layer tranne basic_map e forest_stands_2012.
4. Espandi lo strumento Gestione Temi Mappa nel pannello Layer e seleziona Aggiungi vista.
5. Nominalo basic_overview.
6. Torna al layout di stampa.
7. Con la mappa piccola selezionata, fai clic sul pulsante Imposta Estensione della Mappa Uguale all’Estensione

della Map Canvas per impostare l’estensione della mappa in base a quella visibile nella finestra della mappa.
8. Blocca la vista per la mappa panoramica selezionando Segui tema mappa e selezionando basic_overview

sotto Proprietà principali.
Ora la tua mappa panoramica è più simile a quella che ti aspettavi e la sua visualizzazione non cambierà più. Ma,
naturalmente, ora la mappa di dettaglio non mostra più i confini dello studio né i lotti campione. Risolviamo il
problema:

1. Vai di nuovo alla finestra della mappa e seleziona i layer che vuoi che siano visibili
(plot_sistematico_clip, forest_stands_2012 copy e Basic_map).

2. Esegui nuovamente lo zoom per rendere visibili solo alcune righe di aree di campionamento.
3. Torna alla finestra Layout di Stampa.
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4. Seleziona la mappa più grande nel layout.
5. In Proprietà oggetto fai clic su Aggiorna Anteprima Mappa e Imposta Estensione della Mappa Uguale

all’Estensione della Map Canvas.
Nota che solo la mappa più grande visualizza la visualizzazione corrente della mappa, mentre la mappa piccola
mantiene la stessa visualizzazione che si aveva quando è stata bloccata.
Nota inoltre che la panoramica mostra un riquadro ombreggiato per l’estensione mostrata nella mappa di dettaglio.

Il tuo modello di mappa è quasi pronto. Aggiungi ora due caselle di testo sotto la mappa, una contenente il testo
«Zona mappa dettagliata: « e l’altra «Osservazioni: «. Posizionale come si vede nell’immagine qui sopra.
Puoi inoltre aggiungere una freccia Nord alla mappa panoramica:

1. Seleziona lo strumento Aggiungi Freccia Nord.
2. Fai clic e trascina un rettangolo nell’angolo superiore destro della mappa panoramica.
3. In Proprietà dell’oggetto scegli Immagine SVG

4. Sfoglia Browser SVG ► Gruppi SVG per trovare l’immagine di una freccia.
5. In Rotazione Immagine, seleziona Sincronizza con la mappa e seleziona Mappa 1 (la mappa panoramica).
6. Ridimensiona l’immagine della freccia in modo che sia ben visibile sulla mappa piccola.

Il layout della mappa di base è pronto, ora vuoi utilizzare lo strumento Atlante per generare tutte le mappe di dettaglio
in questo formato che ritieni necessarie.
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14.6.6 Follow Along: Creazione di una Copertura Atlante

La copertura dell’Atlante è solo un layer vettoriale che verrà utilizzato per generare le mappe di dettaglio, una mappa
per ogni elemento della struttura. Per avere un’idea di ciò che si farà in seguito, ecco una serie completa di mappe di
dettaglio per l’area forestale:

La copertura può essere un qualsiasi layer esistente, ma di solito ha più senso crearne uno per lo scopo specifico.
Creiamo una quadrettatura di poligoni che copra l’area della foresta:

1. Nella visualizzazione della mappa di QGIS, apri :menuselection:Vettore –> Strumenti di Ricerca –> |vectorGrid|
:menuselection: `Crea reticolo….

2. Imposta lo strumento come mostrato in questa immagine:
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3. Salva il risultato come atlas_coverage.shp.
4. Stilizza il nuovo layer atlas_coverage in modo che i poligoni non siano riempiti.

I nuovi poligoni coprono l’intera area della foresta e ti danno un’idea di ciò che ognimappa (creata da ciascun poligono)
conterrà.
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14.6.7 Follow Along: Impostazione dello strumento Atlante

L’ultimo passo consiste nell’impostare lo strumento Atlante:
1. Torna al layout di stampa.
2. Nel pannello a destra, vai alla scheda Genera un atlante.
3. Impostare le opzioni come segue:

444 Capitolo 14. Module: Applicazioni nel settore forestale



QGIS Training Manual

Ciò indica allo strumento Atlante di utilizzare gli elementi (poligoni) all’interno di atlas_coverage come
focus per ogni mappa di dettaglio. Verrà prodotta una mappa per ogni elemento del layer. L’opzione Layer di
copertura nascosto indica all’Atlante di non mostrare i poligoni nelle mappe risultanti.

Occorre fare un’altra cosa. Devi indicare allo strumento Atlante quale oggetto mappa deve essere aggiornato per ogni
mappa prodotta. A questo punto, probabilmente puoi intuire che la mappa da modificare per ogni elemento è quella
che hai preparato per contenere le visualizzazioni di dettaglio delle aree di campionamento, cioè la mappa più grande
dell’area di disegno:

1. Seleziona l’oggetto mappa più grande (Map 0).
2. Vai alla scheda Proprietà oggetto.
3. Nell’elenco, seleziona Controllato da atlante.
4. E imposta Margine attorno all’elemento su 10%. L’estensione delle visualizzazioni sarà più grande del 10%

rispetto ai poligoni, il che significa che le mappe di dettaglio avranno una sovrapposizione del 10%.
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Ora puoi utilizzare lo strumento di anteprima per le mappe dell’Atlante per vedere come appariranno le tue mappe:

1. Attiva le anteprime dell’Atlante usando il pulsante o, se la barra degli strumenti dell’Atlante non è visibile,
tramite Atlante ► Anteprima Atlante.

2. Puoi utilizzare le frecce nella barra degli strumenti dell’Atlante o nel menu Atlante per spostarti tra le mappe
che verranno create.

Nota che alcune di esse coprono aree che non sono interessanti. Fai qualcosa e salva qualche albero evitando di
stampare queste mappe inutili.

14.6.8 Follow Along: Modifica del Layer di Copertura

Oltre a rimuovere i poligoni per le aree non interessanti, puoi personalizzare le etichette di testo della mappa,
generandole con il contenuto della Tabella degli attributi del layer di copertura:

1. Torna alla vista mappa.
2. Abilita la modifica del layer atlas_coverage.
3. Seleziona i poligoni che sono selezionati (in giallo) nell’immagine sottostante.
4. Elimina i poligoni selezionati.
5. Disattiva la modalità di modifica e salva le modifiche.
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Puoi tornare al layout di stampa e verificare che le anteprime dell’Atlante utilizzino solo i poligoni che hai lasciato
nel layer.
Il layer di copertura che si sta utilizzando non contiene ancora informazioni utili da utilizzare per personalizzare il
contenuto delle etichette nella mappa. Il primo passo è crearle: si può aggiungere, ad esempio, un codice di zona per
le aree poligonali e un campo con alcune osservazioni che le squadre sul campo devono tenere in considerazione:

1. Apri la Tabella degli attributi per il layer atlas_coverage.
2. Abilita la modalità di modifica.

3. Utilizza il calcolatore per creare e popolare i due campi seguenti.
4. Crea un campo chiamato Zone di tipo Numero intero (intero).
5. Nella casella :guilabel: Espressione scrivere/copiare/costruire $rownum.
6. Crea un altro campo chiamato Remarks, di tipo Text (stringa) e con una larghezza di 255.
7. Nella casella Espressione scrivi No remarks.'. In questo modo si imposterà il valore predefinito per tutti i

poligoni.
Il gestore della foresta avrà alcune informazioni sull’area che potrebbero essere utili quando si visita la zona. Ad
esempio, l’esistenza di un ponte, di una palude o la posizione di una specie protetta. Il layer atlas_coverage è
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probabilmente ancora inmodalità di modifica, aggiungi il seguente testo nel campoRemarks ai poligoni corrispondenti
( fai doppio clic sulla cella per modificarla):

• Per la Zone 2: Bridge to the North of plot 19. Siberian squirrel between p_13
and p_14.

• Per la Zone 6: Difficult to transit in swamp to the North of the lake.`

• Per la Zone 7: Siberian squirrel to the South East of p_94.

• Disattiva la modalità di modifica e salva le tue modifiche.
Quasi completato, ora devi dire allo strumento Atlante che vuoi che alcune delle etichette di testo usino le informazioni
della tabella degli attributi del layer atlas_coverage.

1. Torna al Layout di Stampa.
2. Seleziona l’etichetta di testo contenente Detailed map....
3. Imposta la dimensione del Carattere a 12.
4. Imposta il cursore alla fine del testo dell’etichetta.
5. Nella scheda Proprietà oggetto, all’interno di Proprietà principali fai clic su Inserire o modificare

un’espressione….
6. Nella Lista funzioni fai doppio clic sul campo Zone sotto Campo e valori.
7. Fai clic su OK.
8. Il testo all’interno della casella nelle Proprietà dell’elemento dovrebbe mostrare Detail map inventory

zone: [% "Zone" %]. Nota che il valore [% "Zone" %] sarà sostituito dal valore del campo Zone per
il corrispondente elemento del layer atlas_coverage.

9. Verifica il contenuto dell’etichetta osservando le diverse mappe di anteprima dell’Atlante.
10. Fai lo stesso per le etichette con il testo Osservazioni: utilizzando il campo con le informazioni sulla zona. Puoi

lasciare una linea di interruzione prima di inserire l’espressione. Il risultato dell’anteprima della zona 2 è visibile
nell’immagine seguente:
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11. Utilizza l’anteprima dell’Atlante per visualizzare tutte le mappe che creerai a breve e divertiti!

14.6.9 Follow Along: Stampare la Mappa

Infine, la stampa o l’esportazione delle mappe in file immagine o PDF. Puoi utilizzare i comandi Atlante ► Esporta
Atlante come immagini… o :menuselection:``Atlante –> Esporta Atlante come PDF…`. Attualmente il formato di
esportazione SVG non funziona correttamente e dà un risultato inadeguato.
Consente di stampare le mappe in un unico PDF da inviare all’ufficio di zona per la stampa:

1. Vai alla scheda Genera un atlante sul pannello destro.
2. Sotto Risultato seleziona Esporta su file singolo quando possibile. In questo modo tutte le mappe saranno riunite

in un file PDF; se questa opzione non è selezionata, otterrai un file per ogni mappa.
3. Apri Layout ► Esporta come PDF….
4. Salva il file PDF come inventory_2012_maps.pdf nella cartella

exercise_data\forestrysampligmap_creation\.
5. Apri il file PDF per verificare che tutto sia andato come previsto.
6. Potresti creare immagini separate per ogni mappa (ricordati di deselezionare la creazione di un unico file); qui

puoi vedere le miniature delle immagini che verrebbero create:
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7. Nel Layout di Stampa, premi :sup: Salva per salvare le modifiche al layout di stampa nel progetto. In questo
modo si salva anche il file di progetto. Puoi riaprire il progetto in qualsiasi momento ed eseguire o modificare
l’atlante.
È anche possibile salvare la mappa come modello di layout come forestry_atlas.qpt nella cartella
exercise_data\forestrymap_creation`. Utilizza :menuselection:`Layout -->
Salva come Modello.... Questo modello potrà essere utilizzato più volte in altri progetti.

8. Chiudi il Layout di stampa e il progetto.

14.6.10 In Conclusion

Sei riuscito a creare un modello di mappa che può essere utilizzato per generare automaticamente mappe di dettaglio
da usare sul campo per orientarsi nelle diverse zone. Come hai notato, non è stato un compito facile, ma i vantaggi
arriveranno quando dovrai creare mappe simili per altre regioni e potrai utilizzare il modello appena salvato.

14.6.11 What’s Next?

Nella prossima lezione vedrai come utilizzare i dati LiDAR per creare un DEM e poi usarlo per migliorare la visibilità
dei tuoi dati e delle tue mappe.

14.7 Lesson: Calcolo dei parametri forestali

Stimare i parametri della foresta è l’obiettivo dell’inventario forestale. Continuando l’esempio della lezione precedente,
userai le informazioni dell’inventario raccolte sul campo per calcolare i parametri della foresta, prima per l’intera
foresta e poi per i popolamenti che hai digitalizzato in precedenza.
Obiettivo di questa lezione: Calcolare i parametri forestali a livello generale e di popolamento.
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14.7.1 Follow Along: Aggiungere i Risultati dell’Inventario

Le squadre sul campo hanno visitato la foresta e, con l’aiuto delle informazioni da te fornite, hanno raccolto
informazioni sulla foresta in ogni lotto campione.
Il più delle volte le informazioni vengono raccolte sul campo in moduli cartacei e poi digitate in un foglio di calcolo.
Le informazioni sui lotti campione sono state raccolte in un file .csv che può essere facilmente aperto in QGIS.
Continua con il progetto QGIS dalla lezione sulla progettazione dell’inventario, probabilmente lo hai chiamato
forest_inventory.qgs.
Per prima cosa, aggiungi le misurazioni dei lotti campione al tuo progetto QGIS:

1. Vai a Layer ► Aggiungi Layer ► Aggiungi Layer testo delimitato….
2. Cerca il file systematic_inventory_results.csv che so trova in exercise_data/

forestry/results/.
3. Assicurati che l’opzione Coordinate del punto sia selezionata.
4. Imposta i campi per le coordinate sui campi Campo X e Campo Y.
5. Fai clic su OK.
6. Quando viene richiesto, seleziona ETRS89 / ETRS-TM35FIN come SR.
7. Apri la :guilabel: `Tabella Attributi” del nuovo layer e dai un’occhiata ai dati.

Puoi leggere il tipo di dati contenuti nelle misurazioni dei lotti campione nel file di testo
legend_2012_inventorydata.txt situato nella cartella exercise_data/forestry/results/.
Il layersystematic_inventory_results appena aggiunto è in realtà solo una rappresentazione virtuale delle
informazioni testuali contenute nel file .csv. Prima di continuare, converti i risultati dell’inventario in un insieme di
dati spaziali reali:

1. Fai clic con il pulsante destro del mouse sul layer systematic_inventory_results.
2. Vai alla cartella exercise_data/forestry/results/.
3. Denomina il file sample_plots_results.shp.
4. Seleziona Aggiungi il file salvato alla mappa.
5. Rimuovi il layer systematic_inventory_results dal progetto.

14.7.2 Follow Along: Stima dei Parametri per l’intera Foresta

Dai risultati dell’inventario puoi calcolare le medie per l’intera area forestale per alcuni parametri interessanti, come il
volume e il numero di alberi per ettaro. Poiché i lotti campione sistematici rappresentano aree uguali, puoi calcolare
direttamente le medie dei volumi e del numero di alberi per ettaro dal layer sample_plots_results nella
cartella exercise_data/forestry/results/.
Puoi calcolare la media di un campo in un layer vettoriale utilizzando lo strumento Statistiche di base sui campi…:

1. Apri Vettore ► Strumenti di Analisi ► Statistiche di base sui campi….
2. Seleziona sample_plots_results come :guilabel: Layer in ingresso`.
3. Seleziona Vol come Campo su cui calcolare le statistiche.
4. Fai clic su OK.

Il volume medio della foresta è di 135,2 m3/ha.
Puoi calcolare la media del numero di alberi nello stesso modo, 2745 alberi/ha.
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14.7.3 Follow Along: Stimare i Parametri

Puoi utilizzare gli stessi lotti campione sistematici per calcolare le stime per i diversi popolamenti forestali digitalizzati
in precedenza. Alcuni popolamenti forestali non hanno ricevuto alcun lotto di campionamento e per questi non
si otterranno informazioni. Avresti potuto pianificare alcuni lotti di campionamento extra quando hai pianificato
l’inventario sistematico, in modo che le squadre sul campo avrebbero misurato alcuni lotti di campionamento extra
per questo scopo. Oppure potresti inviare una squadra sul campo in un secondo momento per ottenere le stime dei
popolamenti forestali mancanti per completare l’inventario dei popolamenti. In ogni caso, otterrai informazioni per
un buon numero di popolamenti utilizzando solo i lotti pianificati.
Vuoi ottenere le medie dei lotti campione che ricadono all’interno di ciascun popolamento forestale. Per combinare
le informazioni in base alla loro posizione relativa, utilizza un join spaziale:

1. Apri lo strumento Vettore ► Strumenti di Gestione Dati ► Unire gli attributi per luogo….
2. Imposta forest_stands_2012 come Layer Base. Il layer per il quale si desidera ottenere i risultati.
3. Imposta sample_plots_results come Join layer. Il layer dal quale vuoi calcolare le stime.
4. Seleziona Interseca nel Predicato geometrico.
5. Seleziona calcolare solo la Media.
6. Denomina il risultato come forest_stands_2012_results.shp e salvalo nella cartella

exercise_data/forestry/results/.
7. Infine, selezionaMantieni tutti i record…, in modo da poter controllare in seguito quali lotti non hanno ricevuto

informazioni.
8. Fai clic su OK.
9. Accetta di aggiungere il nuovo layer al progetto quando ti viene richiesto.
10. Chiudi lo strumento Unire gli attributi per luogo….

Apri la Tabella Attributi di forest_stands_2012_results ed esamina i risultati ottenuti. Nota che alcuni popolamenti
forestali hanno NULL come valore per i calcoli, ovvero quelli che non hanno lotti campione. Selezionali tutti e
visualizzali nella mappa: sono alcuni dei popolamenti più piccoli:
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Calcoliamo ora le stesse medie per l’intera foresta come fatto in precedenza, solo che questa volta utilizzeremo
le medie ottenute per i popolamenti come base per il calcolo. Ricordati che nella situazione precedente ogni area
campione rappresentava un popolamento teorico di 80x80 m. Ora invece bisogna considerare l’area di ogni singolo
popolamento. In questo modo, ancora una volta, i valori medi dei parametri, ad esempio in m3/ha per i volumi,
vengono convertiti in volumi totali per i popolamenti.
Devi innanzitutto calcolare le aree di ciascun popolamento, quindi calcolare i volumi totali e il numero di alberi per
ciascuno di essi:

1. Nella Tabella Attributi attiva modifiche.
2. Apri il Calcolatore di Campi.
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3. Crea un nuovo campo area.
4. Imposta il Tipo campo in uscita a Numeri decimali (reali).
5. Imposta la Precisione a 2.
6. Nella casella Espressione, scrivi $area / 10000. In questo modo si calcolerà l’area dei popolamenti forestali

in ettari.
7. Fai clic su OK.

Calcola ora un campo con i volumi totali e il numero di alberi stimati per ogni popolamento:
1. Denomina i campi s_vol e s_stem.
2. I campi possono essere numeri interi o numeri reali.
3. Utilizza le espressioni "area" * "MEANVol" e "area" * "MEANStems" per i volumi totali e gli

alberi totali, rispettivamente.
4. Salva le modifiche quando hai finito.
5. Disattiva lo stato di modifica.

Nella situazione precedente, le aree rappresentate da ogni lotto di campionamento erano le stesse, quindi era sufficiente
calcolare la media dei lotti di campionamento. Ora, per calcolare le stime, è necessario dividere la somma dei volumi
dei popolamenti o del numero di alberi per la somma delle aree dei popolamenti contenenti informazioni.

1. Nella Tabella Attributi per il layer forest_stands_2012_results, seleziona tutti gli popolamenti che
contengono informazioni.

2. Apri Vettore ► Strumenti di Analisi ► Statistiche di base sui campi….
3. Seleziona il forest_stands_2012_results come Layer in ingresso.
4. Seleziona area come Campo su cui calcolare le statistiche`.
5. Seleziona l’opzione Solo elementi selezionati.
6. Fai clic su OK.
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Come puoi vedere, la somma totale delle aree dei popolamenti è di 66,04 ha. Da notare che l’area dei popolamenti
forestali mancanti è solo di circa 7 ha.
Allo stesso modo, puoi calcolare che il volume totale di questi popolamenti è di 8908 m3/ha e il numero totale di
alberi è di 179594 alberi.
Utilizzando le informazioni provenienti dai popolamenti forestali, invece di utilizzare direttamente quelle provenienti
dai lotti campione, si ottengono le seguenti stime medie:

• 184.9 m3/ha e
• 2719 alberi/ha.

Salva il tuo progetto QGIS, forest_inventory.qgs.

14.7.4 In Conclusion

Sei riuscito a calcolare le stime forestali per l’intera foresta utilizzando le informazioni provenienti dai tuoi lotti
campione sistematici, prima senza considerare le caratteristiche della foresta e poi utilizzando l’interpretazione
dell’immagine aerea in popolamenti forestali. Inoltre, hai ottenuto alcune informazioni preziose su determinati
popolamenti, che potrebbero essere utilizzate per pianificare la gestione della foresta negli anni a venire.
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14.7.5 What’s Next?

Nella lezione che segue, creerai dapprima uno sfondo ombreggiatura da un insieme di dati LiDAR che utilizzerai per
preparare una presentazione cartografica con i risultati forestali appena calcolati.

14.8 Lesson: DEM da dati LiDAR

Puoi migliorare l’aspetto delle tue mappe utilizzando diverse immagini di sfondo. Puoi utilizzare la mappa di base o
l’immagine aerea che hai utilizzato prima, ma in alcune situazioni sarà meglio un raster di ombreggiatura del terreno.
Puoi usare LAStools per ricavare un DEM da un insieme di dati LiDAR e quindi creare un raster di ombreggiatura
da utilizzare nella tua mappa.
Obiettivo di questa lezione: Installare LAStools e costruire un DEM da dati LiDAR e un raster di ombreggiatura.

14.8.1 Follow Along: Installare Lastools

La gestione dei dati LiDAR in QGIS è possibile utilizzando il framework Processing e gli algoritmi forniti da
LAStools.
Puoi ottenere un modello digitale di elevazione (DEM) da una nuvola di punti LiDAR e quindi creare un raster
di ombreggiatura che è visivamente più intuitivo per le presentazioni. Innanzitutto dovrai impostare lo strumento
Processing per funzionare correttamente con LAStools:

• Se è aperto, chiudi QGIS.
• Un vecchio lidar plugin potrebbe essere installato di default nel tuo sistema nella cartella C:/Program
Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.

• Se disponi di una cartella denominata lidar, eliminala. Questo è valido per alcune installazioni di QGIS 2.2
e 2.4.
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• Vai alla cartella exercise_data\forestrylidar`, dove puoi trovare il file
:file:`QGIS_2_2_toolbox.zip. Aprirlo ed estrai la cartella lidar per sostituire quella appena
eliminata.

• Se stai utilizzando una versione diversa di QGIS, puoi vedere altre istruzioni per l’installazione in questo tutorial.
Ora devi installare LAStools sul tuo computer. Procurati la versione più recente di lastools qui ed estrai il contenuto
del file lastools.zip in una cartella di sistema, ad esempio C:lastools}. Il percorso della
cartella :file:`lastools non può contenere spazi o caratteri speciali.

Nota: Leggi il file LICENSE.txt dentro la cartella lastools. Alcuni dei LAStools sono open source e altri
sono closed source e richiedono di licenza per l’uso commerciale e governativo. Ai fini educativi o di valutazione
puoi usare e provare LAStools quanto è necessario.

Il plugin e gli algoritmi sono ora installati nel tuo computer e quasi pronto per l’uso, è sufficiente impostare lo strumento
Processing per iniziare a utilizzarli:

• Apri un nuovo progetto in QGIS
• Imposta SR del progetto come ETRS89 / ETRS-TM35FIN.
• Salva il progetto come forest_lidar.qgs.

Per configurare LAStools in QGIS
• Vai a Processing ► Opzioni….
• Nella finestra Opzioni di Processing vai a Programmi`e poi a :guilabel:`Strumenti per i dati LiDAR.
• Spunta Attiva.
• Per cartella LAStools scegli c:\lastools\ (o la cartella dove hai estratto LAStools).
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14.8.2 Follow Along: Costruire un DEM con LAStools

Hai già utilizzato lo strumento Processing in: doc:` ../ vector_analysis / spatial_statistics` per eseguire algoritmi SAGA.
Ora lo userai per eseguire programmi LAStools:

• Apri Processing ► Strumenti.
• Nel menu a tendina in basso seleziona: Advanced interface.
• Dovresti vedere la categoira :guilabel::Strumenti per dati LiDAR
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• Espandi per vedere gli strumenti a disposizione, e espandi anche la sottocategoria LAStools (il numero di
algoritmi possono variare).

• Scorri fino a trovare l’algoritmo lasview, fai doppio clic su di esso per aprirlo.
• In File LAS/LAZ di input, sfoglia exercise_dataforestrylidar` e seleziona il file
:file:`rautjarvi_lidar.laz.

• Click Run.
Ora puoi vedere i dati LiDAR nella finestra di dialogo just a little LAS and LAZ viewer.
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Ci sono molte cose che puoi fare con questo visualizzatore, ma per ora puoi fare clic su di esso per muovere la nuvola
di punti LiDAR.

Nota: Se vuoi conoscere ulteriori dettagli sul funzionamento di LAStool, puoi leggere i file di testo README relativi a
ciascuno strumento, nella cartella :file:`C:\\lastools\bin\`. Tutorial e altro materiale sono disponibili alla pagina
web `Rapidlasso <https://rapidlasso.com/>`_.

• Chiudi il visualizzatore quando hai finito.
Puoi creare un DEM con LAStools in due fasi: la prima classifica la nuvola di punti in ground e no ground e la
seconda calcola il DEM utilizzando solo i punti ground.

• Torna a Strumenti di Processing.
• Segna su Cerca… lasground.
• Fai dopio click per aprire la finestra lasground tool e compilala come nell’immagine:
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• Il file in uscita viene salvato nella stessa cartella in cui si trova rautjarvi_lidar.laz e si chiama
rautjarvi_lidar_1.las.

Puoi aprirlo con lasview per il controllo.
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I punti marroni sono quelli classificati come terreno e quelli grigi sono gli altri; puoi fare clic sulla lettera g per
visualizzare solo i punti del terreno o sulla lettera u per vedere solo i punti non classificati. Fai clic sulla lettera a
per visualizzare nuovamente tutti i punti. Per ulteriori comandi, consulta il file lasview_README.txt. Se sei
interessato, anche questo tutorial sulla modifica manuale dei punti LiDAR ti mostrerà diverse operazioni all’interno
del visualizzatore.

• Chiudi il visualizzatore.
• In Strumenti di Processing, cerca per las2dem.
• Apri la finestra las2dem tool e compilala come nell’immagine:
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Il DEM che ne risulta è aggiunto alla mappa con il nome generico Output raster file.

Nota: I moduli lasground e las2dem tools richiedono la licenza. Puoi utilizzare lo strumento come indicato nel file
di licenza e comunque puoi apprezzarne i risultati

14.8.3 Follow Along: Creare un’ombreggiatura del suolo

Ai fini della visualizzazione, un ombreggiamento generato da un DEM dà una migliore
visualizzazione del terreno:

• Apri Raster ► Analisi ► DEM (Analisi morfologica).
• Come Layer in uscita, sfoglia exercise_data\forestrylidar` e denomina il file
:file:`hillshade.tif.

• Lascia gli altri parametri con le impostazioni predefinite.
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• Scegli ETRS89 / ETRS-TM35FIN come SR quando richiesto.
Nonostante le linee diagonali che rimangono nel risultato di ombreggiamento del raster, puoi vedere un rilievo preciso
della zona. Puoi anche vedere i diversi canali di scolo dei terreni che sono stati scavati nelle foreste.
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14.8.4 In Conclusion

L’uso di dati LiDAR per ottenere un DEM, specialmente in aree boschive, dà buoni risultati con poco sforzo. Puoi
anche utilizzare DEM derivati da LiDAR già pronti o altre fonti come i DEM SRTM a risoluzione 9m`<https:
//srtm.csi.cgiar.org/srtmdata/>`_. . In ogni caso, Puoi utilizzarli per creare un raster hillshade da utilizzare nelle
rappresentazioni delle mappe.
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14.8.5 What’s Next?

Nella prossima e ultima lezione di questo modulo userai l’ombreggiamento raster e i risultati dell’inventario forestale
per creare una mappa di presentazione dei risultati.

14.9 Lesson: Presentazione della mappa

Nelle lezioni precedenti hai importato un vecchio inventario forestale come progetto GIS, lo hai aggiornato alla
situazione attuale, hai progettato un inventario forestale, hai creato mappe per il lavoro sul campo e hai calcolato i
parametri forestali a partire dalle rilevazioni sul campo.
Spesso è importante creare mappe con i risultati di un progetto GIS. Una mappa che presenti i risultati dell’inventario
forestale renderà più facile per chiunque avere una buona idea dei risultati in un rapido sguardo, senza consultare i
numeri specifici.
Obiettivo di questa lezione: Creare una mappa per presentare i risultati dell’inventario utilizzando un raster di
ombreggiatura come sfondo.

14.9.1 Follow Along: Preparazione dei dati mappa

Apri il progetto QGIS della lezione sui calcoli dei parametri, forest_inventory.qgs. Lascia almeno i seguenti
layer:

• forest_stands_2012_results.
• basic_map.
• rautjarvi_aerial.
• lakes (se non è presente, aggiungilo dalla cartella :kbd:`exercise_data\aforestry).

Vuoi rappresentare i volumi medi dei popolamenti forestali in una mappa. Se apri la Tabella Attributi per il layer
forest_stands_2012_results, puoi vedere i valori NULL per i popolamenti senza informazioni. Per poter
inserire anche questi popolamenti nella simbologia, devi cambiare i valori NULL in, ad esempio, -999, sapendo che
questi numeri negativi significano che non ci sono dati per tali poligoni.
Per il layer forest_stands_2012_results:

• Apri la Tabella Attributi e abilita le modifiche.
• Seleziona i poligoni con valori NULL.
• Utilizza il calcolatore per aggiornare i valori del campo MEANVol a -999 solo per gli elementi selezionati.
• Disattiva la modalità di modifica e salva.

Ora puoi usare uno stile salvato per questo layer:
• Vai alla scheda Simbologia.
• Fai clic su Stile ► Carica stile….
• Seleziona forest_stands_2012_results.qml dalla cartella exercise_data\forestry\
results\.

• Click OK.
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La tua mappa dovrebbe apparire come questa:

14.9. Lesson: Presentazione della mappa 467



QGIS Training Manual

14.9.2 Try Yourself Provare diverse modalità di fusione

Lo stile che hai caricato:
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sta usando la modalità Luce intensa per la modalitàModalità di fusione dei layer. Nota che le diverse modalità
applicano filtri diversi combinando i livelli sottostanti e sovrastanti, in questo caso il raster ombreggiatura e i
popolamenti forestali. Puoi approfondire queste modalità nella User Guide.
Prova diverse modalità e guarda le differenze nella tua mappa. Poi scegli quella che ti piace di più per la tua mappa
finale.

14.9.3 Try Yourself Utilizzare un modello di layout per generare la
rappresentazione della mappa

Utilizza un modello preparato in anticipo per la presentazione dei risultati. Il modello forest_map.qpt si trova
nella cartella exercise_data\forestryresults`. Caricalo utilizzando la finestra di
dialogo :menuselection: `Progetto --> Gestione dei Layout....
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Apri il layout di stampa e modifica la mappa finale per ottenere un risultato di cui sei soddisfatto.
Il modello di mappa che stai utilizzando produrrà una mappa simile a questa:
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Salva il progetto QGIS per futuri utilizzi.
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14.9.4 In Conclusion

In questo modulo hai visto come è possibile pianificare e presentare un inventario forestale di base con QGIS. Molte
altre analisi forestali sono possibili grazie alla varietà di strumenti a cui è possibile accedere, ma si spera che questo
manuale ti abbia fornito un buon punto di partenza per comprendere come ottenere i risultati specifici di cui hai
bisogno.

472 Capitolo 14. Module: Applicazioni nel settore forestale



CAPITOLO15

Module: Nozioni sui database con PostgreSQL

I database relazionali sono una parte importante di qualsiasi sistema GIS. In questo modulo, imparerai i concetti
relativi al sistema di gestione dei database relazionali (RDBMS) e userai PostgreSQL per creare un nuovo database
per memorizzare i dati come per conoscere altre funzioni tipiche di RDBMS.

15.1 Lesson: Introduzione ai database

Prima di usare PostgreSQL, assicuriamoci di conoscere la teoria generale dei database. Non avrai bisogno di inserire
codice; è solo a scopo illustrativo.
Obiettivo di questa lezione: Comprendere i concetti fondamentali dei database.

15.1.1 Cos’è un database?

Un database consiste in una raccolta organizzata di dati per uno o più usi. - Wikipedia

Un sistema di gestione del database (DBMS) è costituito da un software che gestisce i database, fornendo spazio di
archiviazione, accesso, sicurezza, backup e altri servizi. - Wikipedia

15.1.2 Tabelle

Nei database relazionali e nei database di file flat, una tabella è un insieme di elementi di dati (valori) organizzati
utilizzando un modello di colonne verticali (identificate dal loro nome) e righe orizzontali. Una tabella ha un numero
specificato di colonne, ma può avere un numero qualsiasi di righe. Ogni riga è identificata dai valori che appaiono in
un particolare sottoinsieme di colonne che è stato identificato come una chiave univoca. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

Nei database SQL una tabella è anche nota come relazione.
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15.1.3 Colonne / Campi

Una colonna è un insieme di valori di dati di un particolare tipo, uno per ogni riga della tabella. Le colonne forniscono
la struttura in base alla quale sono composte le righe. Il termine campo viene spesso utilizzato in modo intercambiabile
con colonna, anche se molti ritengono più corretto utilizzare campo (o valore del campo) per fare riferimento in modo
specifico al singolo elemento esistente all’intersezione tra una riga e una colonna. - Wikipedia

Una colonna:

| name |
+-------+
| Tim |
| Horst |

Un campo:

| Horst |

15.1.4 Record

Un record è l’informazione memorizzata in una riga della tabella. Ogni record avrà un campo per ciascuna delle
colonne nella tabella.

2 | Horst | 88 <-- one record

15.1.5 Tipi di dati

Il tipo di dato limita il tipo di informazioni che possono essere archiviate in una colonna. - Tim e Horst

Ci sono diversi tipi di dato. Concentriamoci sui più comuni:
• String - per memorizzare dati di testo
• Integer - per memorizzare numeri interi
• Real - per memorizzare i numeri decimali
• Data - per memorizzare il compleanno di Horst, in modo che nessuno lo dimentichi.
• Boolean - per memorizzare valori di vero/falso

Puoi dire al database di permetterti di non memorizzare nulla in un campo. Se non c’è nulla in un campo, allora il
contenuto del campo viene definito come un valore null”:

insert into person (age) values (40);

select * from person;

Risultato:

id | name | age
---+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Ci sono molti altri tipi di dati che puoi usare - controlla il manuale di PostgreSQL `<https://www.postgresql.org/
docs/current/datatype.html> `_
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15.1.6 Creazione di un database di indirizzi

Usiamo un semplice caso di studio per vedere come viene costruito un database. Vogliamo creare un database di
indirizzi.

Try Yourself

Scriviamo le proprietà che costituiscono un indirizzo semplice e che vorremo memorizzare nel nostro database.

Soluzione
Per la nostra teorica tabella degli indirizzi, potremmo voler memorizzare le seguenti proprietà:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

Quando creiamo la tabella per rappresentare un oggetto indirizzo, creiamo colonne per rappresentare ciascuna di
queste proprietà e le nominiamo con nomi conformi a SQL e possibilmente abbreviati:

house_number
street_name
suburb
city
postcode
country

Struttura indirizzi

Le proprietà di ogni indirizzo sono espresse nelle colonne. Il tipo di informazioni memorizzate in ogni colonna è
il suo tipo di dati. Nella prossima sezione analizzerai la nostra tabella degli indirizzi concettuali per vedere come
migliorarla!

15.1.7 Teoria dei database

Il processo di creazione di un database implica la creazione di un modello del mondo reale; prendendo i concetti del
mondo reale e rappresentandoli nel database come entità.

15.1.8 Normalizzazione

Una delle idee principali in un database è quella di evitare la duplicazione/ridondanza dei dati. Il processo di rimozione
della ridondanza da un database è chiamato Normalizzazione.
La normalizzazione è un modo sistematico per garantire che una struttura di database sia adatta per l’interrogazione
e priva di determinati e indesiderabili caratteristiche - inserimento, aggiornamento e anomalia di cancellazione - che
potrebbero portare a una perdita dell’integrità dei dati. - Wikipedia

Ci sono diversi tipi di «forme» di normalizzazione.
Guarda un semplice esempio:
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Table "public.people"

Column | Type | Modifiers
----------+------------------------+------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
---+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Immagina di avere molti amici con lo stesso nome di via o città. Ogni volta che questi dati vengono duplicati, viene
consumato spazio. Peggio ancora, se il nome di una città cambia, devi fare un sacco di lavoro per aggiornare il tuo
database.

15.1.9 Try Yourself

Riprogetta la tabella teorica people di cui sopra per ridurre la duplicazione e normalizzare la struttura dei dati.
Puoi leggere di più sulla normalizzazione del database qui <https://en.wikipedia.org/wiki/Database_normalization> _

Soluzione
Il problema principale della tabella people è che c’è un solo campo indirizzo che contiene l’intero indirizzo di una
persona. Pensando alla nostra teorica tabella address di prima in questa lezione, sappiamo che un indirizzo è composto
da molte proprietà diverse. Memorizzando tutte queste proprietà in un solo campo, rendiamo molto più difficile
aggiornare e interrogare i nostri dati. Abbiamo quindi bisogno di dividere il campo indirizzo nelle varie proprietà.
Questo ci darebbe una tabella che ha la seguente struttura:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

Nella prossima sezione, imparerai le relazioni Chiavi Esterne che potrebbero essere usate in questo esempio per
migliorare ulteriormente la struttura del nostro database.
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15.1.10 Indici

Un indice di database è una struttura di dati che migliora la velocità delle operazioni di recupero dei dati su una tabella
di database. - Wikipedia

Immagina di leggere un libro e di cercare la spiegazione di un concetto - e il libro non ha un indice! Dovrai iniziare a
leggere dalla prima pagina e poi proseguire per tutto il libro fino a trovare l’informazione di cui hai bisogno. L’indice
sul retro di un libro ti aiuta a saltare rapidamente alla pagina con le informazioni pertinenti:

create index person_name_idx on people (name);

Ora le ricerche sul nome saranno più veloci:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Sequenze

Una sequenza è un generatore di numeri univoco. Viene normalmente utilizzato per creare un identificativo univoco
per una colonna in una tabella.
In questo esempio, id è una sequenza: il numero viene incrementato ogni volta che un record viene aggiunto alla
tabella:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Diagramma Entità Relazione

In un database normalizzato, si hanno tipicamente molte relazioni (tabelle). Il diagramma entità-relazione (ER
Diagram) è usato per disegnare le dipendenze logiche tra le relazioni. Considera la nostra tabella non normalizzata
people nella lezione precedente:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Con poco lavoro possiamo dividerlo in due tabelle, eliminando la necessità di ripetere il nome della via per le persone
che vivono nella stessa strada:
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select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

e:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

Possiamo quindi collegare le due tabelle usando le “chiavi” streets.id e people.streets_id.
Se disegnassimo un diagramma ER per questi due tabelle, sarebbe simile a questo:

Il diagramma ER ci aiuta ad esprimere relazioni “da uno a molti”. In questo caso il simbolo della freccia indica che
una strada può avere molte persone che vivono su di essa.

Try Yourself

Il nostro modello “people” ha ancora alcuni problemi di normalizzazione: prova a vedere se puoi normalizzarlo
ulteriormente e mostrarlo per mezzo di un diagramma ER.

Soluzione
La nostra tabella people attualmente assomiglia a questa:

id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

La colonna street_id rappresenta una relazione “uno a molti” tra l’oggetto people e il relativo oggetto street, che si
trova nella tabella streets.
Un modo per normalizzare ulteriormente la tabella è quello di sudividere il campo nome in nome e cognome:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

Possiamo anche creare tabelle separate per il nome della città e del paese, collegandole alla nostra tabella people
tramite relazioni “uno a molti”:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

Un diagramma ER per rappresentare questo sarebbe il seguente:
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15.1.13 Vincoli, chiavi primarie e chiavi esterne

Un vincolo di database è utile per assicurare che i dati in una relazione corrispondano a come tali dati devono essere
memorizzati. Ad esempio un vincolo sul tuo codice postale potrebbe garantire che il numero sia tra 1000 e 9999.
Una chiave Primaria è uno o più valori di campo che rendono un record univoco. Di solito la chiave primaria è
chiamata id ed è una sequenza.
Una chiave Esterna viene utilizzata per fare riferimento a un record univoco su un’altra tabella (utilizzando la chiave
primaria di quell’altra tabella).
Nel diagramma ER, il collegamento tra tabelle è normalmente basato su chiavi Esterne che si collegano a chiavi
Primarie.
Se guardiamo all’esempio people, la definizione della tabella mostra che la colonna street è una chiave esterna che fa
riferimento alla chiave primaria nella tabella streets:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)
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15.1.14 Transazioni

Quando aggiungi, modifichi o elimini dati in un database, è sempre importante che il database sia lasciato in buono
stato. La maggior parte dei database fornisce una funzionalità chiamata supporto per le transazioni. Le transazioni
consentono di creare una posizione di rollback a cui è possibile tornare se le modifiche al database non sono state
eseguite come pianificato.
Considera uno scenario in cui hai un sistema di contabilità. Devi trasferire fondi da un account e aggiungerli a un
altro. La sequenza di passaggi sarebbe come questa:

• remove R20 from Joe
• add R20 to Anne

Se qualcosa andasse storto durante il processo (ad esempio un’interruzione dell’alimentazione), la transazione verrà
ripristinata.

15.1.15 In Conclusion

I database ti consentono di gestire i dati in modo strutturato utilizzando semplici strutture di codice.

15.1.16 What’s Next?

Ora che abbiamo visto come i database funzionano in teoria, creiamo un nuovo database per implementare la teoria
trattata.

15.2 Lesson: Realizzazione del Modello Dati

Ora dopo aver trattato tutta la teoria, crea un nuovo database. Questo database verrà utilizzato per gli esercizi delle
lezioni che seguiranno.
Obiettivo di questa lezione: Installare il software richiesto e utilizzarlo per realizzare il database di esempio.

15.2.1 Installare PostgreSQL

Nota: Puoi trovare i pacchetti PostgreSQL e le istruzioni di installazione per il tuo sistema operativo su https:
//www.postgresql.org/download/. Da notare che la documentazione presuppone che gli utenti eseguano QGIS sotto
Ubuntu.

Sotto Ubuntu:

sudo apt install postgresql-9.1

Dovresti avere un messaggio come questo:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1

(continues on next page)
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(continua dalla pagina precedente)
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Premi S e Enter e aspetta la fine dell’installazione.

15.2.2 Guida

PostgreSQL ha un’ottima documentazione online.

15.2.3 Crea un utente del database

Sotto Ubuntu:
Al termine dell’installazione, esegui questo comando per diventare utente postgres e quindi creare un nuovo utente
del database:

sudo su - postgres

Digita la normale password di accesso quando richiesto (è necessario disporre dei diritti sudo).
Ora, al prompt di sistema dell’utente postgres, crea l’utente del database. Assicurati che il nome utente corrisponda al
tuo nome utente unix: renderà la tua vita molto più semplice, poiché postgres ti autenticherà automaticamente quando
avrai effettuato l’accesso come tale utente:

createuser -d -E -i -l -P -r -s qgis

Immetti una password quando richiesto. È necessario utilizzare una password diversa per la password di accesso.
Cosa significano queste opzioni?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Ora dovresti lasciare l’ambiente shell bash dell’utente postgre digitando:

exit

15.2.4 Verifica il nuovo account

psql -l

Dovrebbe restituire qualcosa del genere:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)
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Premi Q per uscire.

15.2.5 Crea un database

Puoi usare il comando``createdb`` per creare un nuovo database. Dovrebbe essere eseguito dal prompt della shell bash:

createdb address -O qgis

Puoi verificare l’esistenza del nuovo database utilizzando questo comando:

psql -l

Che dovrebbe tornare qualcosa di simile:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
(4 rows)

Premi Q per uscire.

15.2.6 Avvio di una sessione shell del database

Puoi connetterti facilmente al tuo database in questo modo:

psql address

Per uscire dalla shell del database psql, digita:

\q

Per informazioni sull’utilizzo della shell, digita:

\?

Per informazioni sull’utilizzo dei comandi SQL, digita:

\help

Per ottenere aiuto su un comando specifico, digita (ad esempio):

\help create table

Vedi anche il Psql cheat sheet.
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15.2.7 Crea tabelle in SQL

Inizia a fare alcune tabelle! Usa il diagramma ER come guida. Innanzitutto, connettiti al database address:

psql address

Then create a streets table:

create table streets (id serial not null primary key, name varchar(50));

serial e varchar sono tipi di dato. serial dice a PostgreSQL di iniziare una sequenza di interi
(autoincrementale) automaticamente su id per ogni nuovo record. varchar(50) dice a PostgreSQL di creare
un campo di testo lungo 50 caratteri.
Noterai che il comando termina con un ; ; - tutti i comandi SQL dovrebbero essere terminati in questo modo. Quando
premi Enter, psql Invio, psql riporterà qualcosa del genere:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

CREATE TABLE

Ciò significa che la tua tabella è stata creata correttamente, con una chiave primaria streets_pkey usando
streets.id.
Nota: se se non iserisci un ;, otterrai una richiesta come questa: address-#. Questo perché PG si aspetta che tu
inserisca altro. Inserisci ; per eseguire il tuo comando.
Per vedere lo schema della tabella:

\d streets

Dovrebbe mostrarti qualcosa di simile:

Table "public.streets"
Column | Type | Modifiers
--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('streets_id_seq'::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

Per vedere il contenuto della tabella:

select * from streets;

Dovrebbe mostrarti qualcosa di simile:

id | name
---+------
(0 rows)

Come puoi vedere, la tabella è attualmente vuota
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Try Yourself

Usa l’approccio mostrato sopra per creare una tabella chiamata people:
Aggiungi campi come numero di telefono, indirizzo di casa, nome, ecc. (Questi non sono tutti nomi validi: cambiali
per renderli validi). Assicurati di dare alla tabella una colonna ID con lo stesso tipo di dati di cui sopra.

Soluzione
L’SQL necessario per creare la tabella people corretta è:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

Lo schema per la tabella (enter \\d people) si presenta così:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

A scopo illustrativo, abbiamo volutamente omesso il vincolo fkey.

15.2.8 Crea chiavi in SQL

Il problema ora è che il database non sa che people e streets hanno una relazione logica. Per esprimere questa relazione,
dobbiamo definire una chiave esterna che punta alla chiave primaria della tabella streets.

Puoi farlo in due modi:
• Add the key after the table has been created
• Define the key at time of table creation

La tabella è già stata creata, quindi fallo nel primo modo:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Questo indica alla tabella people che il campo street_id deve corrispondere a id della tabella streets.
Il modo più usuale per creare una relazione è farlo quando crei la tabella:
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create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

Dopo aggiunto il vincolo lo schema della tabella appare ora così:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Crea indici in SQL

Vuoi ricerche veloci sui nomi delle persone. Per fare ciò, puoi creare un indice sulla colonna del nome della nostra
tabella people:

create index people_name_idx on people(name);

\d people

Che risulta:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | ('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)
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15.2.10 Elimina tabelle in SQL

Se vuoi sbarazzarti di una tabella puoi usare il comando drop:

drop table streets;

Nel nostro esempio attuale, il comando di cui sopra non funzionerebbe. Perché no?

Soluzione
Il motivo per cui il comandoDROP non funzionerebbe in questo caso è perché la tabella people ha un vincolo di chiave
esterna alla tabella streets. Ciò significa che eliminare (o eliminare) la tabella streets lascerebbe la tabella people con
riferimenti a dati streets inesistenti.
È possibile «forzare» la tabella streets ad essere eliminata usando il comando CASCADE, ma questo eliminerebbe
anche people e qualsiasi altra tabella che ha una relazione con la tabella streets. Usate con cautela!

Se hai usato lo stesso comando drop table sulla tabella people, sarebbe riuscito:

drop table people;

Nota: Se hai inserito quel comando ed eliminato la tabella people, ora sarebbe il momento giusto per ricostruirlo,
poiché ne avrai bisogno nei prossimi esercizi.

15.2.11 Una parola su pgAdmin III

Ti mostriamo i comandi SQL dal prompt di psql perché è un modo molto utile per conoscere i database. Tuttavia, ci
sono modi più rapidi e semplici per fare molto di quello che ti stiamo mostrando. Installa pgAdmin III e puoi creare,
eliminare, modificare le tabelle etc usando le operazioni in una GUI.
Sotto Ubuntu, puoi installarlo così:

sudo apt install pgadmin3

pgAdmin III sarà trattato in maggior dettaglio in un altro modulo.

15.2.12 In Conclusion

Ora hai visto come creare un nuovo database, iniziando completamente da zero.

15.2.13 What’s Next?

Adesso imparerai come usare il DBMS per aggiungere nuovi dati.
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15.3 Lesson: Aggiungere Dati al Modello

Gli esempi che hai creato ora dovranno essere popolati con i dati necessari.
Obiettivo di questa lezione: Imparare a inserire nuovi dati nel database di esempio.

15.3.1 Inserire dati

Come aggiungi i dati a una tabella? L’istruzione sql INSERT fornisce le funzionalità per questo:

insert into streets (name) values ('High street');

Alcune cose da segnalare:
• After the table name (streets), you list the column names that you will be populating (in this case only the
name column).

• Dopo il comando values, posiziona l’elenco dei valori dei campi.
• Strings should be quoted using single quotes.
• Note that we did not insert a value for the id column; this is because it is a sequence and will be auto-generated.
• Se imposti manualmente id, puoi causare gravi problemi all’integrità del database.

Dovresti vedere INSERT 0 1 se effettuato l’inserimento.
Puoi vedere il risultato della tua azione di inserimento selezionando tutti i dati nella tabella:

select * from streets;

Risultato:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself

Usa il comando INSERT per aggiugngere una nuova via alla tabella streets.

Soluzione
Il comando SQL che dovresti usare assomiglia a questo (puoi sostituire il nome della strada con un nome di tua scelta):

insert into streets (name) values ('Low Road');
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15.3.2 Aggiunta di dati rispettando i vincoli

15.3.3 Try Yourself

Prova ad aggiungere una persona alla tabella people con i seguenti attributi:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

Nota: Ricorda che in questo esempio abbiamo definito i numeri di telefono come stringhe e non come numeri interi.

A questo punto, dovresti avere un rapporto di errore se provi a farlo senza prima creare un record per Main Street
nella tabella streets.
Dovresti aver notato che:

• Non puoi aggiungere una strada usando il nome
• Non puoi aggiungere un id della strada prima di avavrla creata nella tabella streets

Ricorda che le due tabelle sono collegate tramite una coppia di chiavi primaria/esterna. Ciò significa che nessuna
persona può essere inserita senza che vi sia anche un record di strada corrispondente.
Usa queste informazioni per aggiungere una nuova persona al database.

Soluzione
Ecco l’istruzione SQL corretta:

insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no)

values ('Joe Smith',55,2,'072 882 33 21');

Se guardi di nuovo la tabella delle strade (usando un’istruzione select come prima), vedrai che il id per la voce Main
Road è 2.
Ecco perché potremmo semplicemente inserire il numero 2 sopra. Anche se non vediamo Main Road scritto
completamente nella voce di cui sopra, il database sarà in grado di associarlo al valore street_id di 2.
Se hai già aggiunto un nuovo oggetto strada, potresti scoprire che la nuova Main Road ha un id di 3 e non 2.

15.3.4 Selaziona dati

Hai già visto la sintassi per la selezione dei record. Dai un’occhiata ad altri esempi:

select name from streets;

select * from streets;

select * from streets where name='Main Road';

Nelle sessioni successive approfondirai come selezionare e filtrare i dati.
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15.3.5 Agggiorna dati

Come fare per cambiare alcuni dati esistenti? per esempio cambiare il nome di una strada:

update streets set name='New Main Road' where name='Main Road';

Sta molto attento a usare il comando update - se più di un record corrisppondesse alla condizione WHERE allora
verrebbero tutti aggiornati!
Una soluzione migliore è utilizzare la chiave primaria della tabella per fare riferimento al record da modificare:

update streets set name='New Main Road' where id=2;

Dovrebbe ritornare UPDATE 1.

Nota: L’istruzione WHERE è sensibile alle maiuscole Main Road non è lo stesso di Main road

15.3.6 Cancella dati

Riguardo a cancellare un oggetto della tabella, usa il comando DELETE:

delete from people where name = 'Joe Smith';

Dai un’occhiata alla tabelle people:

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)

15.3.7 Try Yourself

Usa le competenze apprese per aggiungere alcuni nuovi amici al tuo database:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Ora sai come aggiungere nuovi dati agli esempi che hai creato in precedenza. Ricorda che se vuoi aggiungere nuovi
tipi di dati, potresti modificare e/o creare nuovi esempi per contenere tali dati.
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15.3.9 What’s Next?

Ora che hai aggiunto qualche dato, imparerai come usare le interrogazioni per accedere a questi dati in diverse
maniere.

15.4 Lesson: Query

Quando scrivi un comando SELECT ... è comunemente conosciuto come una query - stai interrogando il database
per informazioni.
Obiettivo di questa lezione: Imparare a creare query che restituiscano informazioni utili.

Nota: Se non l’hai fatto nella lezione precedente, aggiungi i seguenti oggetti people alla tua tabella people. Se
ricevi qualche errore relativo ai vincoli di chiave esterna, dovrai prima aggiungere l’oggetto “Main Road” alla tua
tabella streets

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45');

insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35');

insert into people (name,house_no, street_id, phone_no)
values ('Roger Jones',33,1,'072 832 31 38');

insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32');

15.4.1 Riordinare i risultati

Otteniamo una lista di persone ordinate in base al loro numero civico:

select name, house_no from people order by house_no;

Risultato:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

Puoi ordinare i risultati per i valori di più di una colonna:

select name, house_no from people order by name, house_no;

Risultato:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)
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15.4.2 Attivare filtri

Spesso non vuoi vedere ogni singolo record nel database - specialmente se ci sono migliaia di record e sei interessato
a vederne solo uno o due.
Ecco un esempio di un filtro numerico che restituisce solo gli oggetti il cui house_no è inferiore a 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Puoi combinare i filtri (definiti usando la clausola WHERE) con l’ordinamento (definito usando la clausola ORDER
BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Puoi anche filtrare in base ai dati di tipo testuale:

select name, house_no from people where name like '%s%';

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Qui abbiamo usato la clausola LIKE per trovare tutti i nomi che contengono una s. Noterai che questa query è
case-sensitive, quindi la voce Sally Norman non è stata restituita.
Se vuoi cercare per una stringa di lettere indipendentemente dal maiuscolo/minuscolo, puoi fare una ricerca case
in-sensitive usando la clausola ILIKE:

select name, house_no from people where name ilike '%r%';

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Questa query ha restituito ogni oggetto people con un r o R nel loro nome.
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15.4.3 Join

E se vuoi vedere i dettagli della persona e il nome della sua strada invece dell’ID? Per farlo, devi unire le due tabelle
in un’unica query. Vediamo un esempio:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Nota: Con i join, dovrai indicare sempre le due tabelle da cui provengono le informazioni, in questo caso people e
streets. Devi anche specificare quali due chiavi devono corrispondere (chiave esterna e chiave primaria). Se non lo
specifichi, otterrai una lista di tutte le possibili combinazioni di persone e strade, ma nessun modo di sapere chi vive
effettivamente in quale strada!

Ecco come sarà l’output corretto:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

Rivisiteremo le join quando creeremo query più complesse in seguito. Basta ricordare che forniscono un modo
semplice per combinare le informazioni di due o più tabelle.

15.4.4 Sub-Select

Le sottoselezioni ti permettono di selezionare oggetti da una tabella in base ai dati di un’altra tabella che è collegata
tramite una relazione di chiave esterna. Nel nostro caso, vogliamo trovare le persone che vivono in una specifica
strada.
Per prima cosa, facciamo una piccola modifica ai nostri dati:

insert into streets (name) values('QGIS Road');
insert into streets (name) values('OGR Corner');
insert into streets (name) values('Goodle Square');
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Diamo una rapida occhiata ai nostri dati dopo queste modifiche: possiamo riutilizzare la nostra query dalla sezione
precedente:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Risultato:

name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)
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Ora mostriamo una sotto-selezione su questi dati. Vogliamo mostrare solo le persone che vivono in street_id
numero 1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Risultato:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Anche se questo è un esempio molto semplice e non necessario con i nostri piccoli insiemi di dati, illustra quanto
utili e importanti possano essere le sotto-selezioni quando si interrogano insiemi di dati grandi e complessi.

15.4.5 Query di aggregazione

Una delle potenti caratteristiche di un database è la sua capacità di riassumere i dati delle sue tabelle. Queste sintesi
sono chiamate query aggregate. Ecco un tipico esempio che ci dice quanti oggetti persone ci sono nella nostra tabella
persone:

select count(*) from people;

Risultato:

count
-------

4
(1 row)

Se vuoi che i conteggi siano riepilogati per nome di strada, puoi fare così:

select count(name), street_id
from people
group by street_id;

Risultato:

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

Nota: Poiché non abbiamo usato una clausola ORDER BY, l’ordine dei tuoi risultati potrebbe non corrispondere a
quello mostrato qui.
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Try Yourself

Riepiloga le persone per nome di strada e mostra i nomi reali delle strade invece degli street_id.

Soluzione
Ecco l’istruzione SQL corretta che dovreste usare:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Risultato:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Noterai che abbiamo anteposto i nomi dei campi ai nomi delle tabelle (per esempio people.name e streets.name).
Questo deve essere fatto ogni volta che il nome del campo è ambiguo (cioè non è univoco in tutte le tabelle del
database).

15.4.6 In Conclusion

Hai visto come usare le query per restituire i dati nel tuo database in un modo che ti permette di estrarre informazioni
utili da esso.

15.4.7 What’s Next?

Poi vedrai come creare delle viste dalle query che hai scritto.

15.5 Viste

Quando scrivi una query, devi spendere molto tempo e sforzo per formularla. Con le viste, puoi salvare la definizione
di una query SQL in una «tabella virtuale» riutilizzabile.
L’obiettivo di questa lezione: Salvare una query come una vista.

15.5.1 Creare una Vista

Puoi considerare una vista proprio come un tabella, ma i suoi dati sono recuperati da una query. Cerchiamo di fare
una una semplice vista basata sull’esempio soprastante:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;
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Come puoi vedere l’unico cambiamento è la parte create view roads_count_v as all’inizio. Ora possiamo
selezionare i dati da quella vista:

select * from roads_count_v;

Risultato:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

15.5.2 Modificare una Vista

Una vista non è bloccata e non contiene «dati reali». Questo significa che puoi facilmente cambiarla senza avere un
impatto sui dati del tuo database:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Questo esempio mostra anche come migliore prassi la convenzione di usare il MAIUSCOLO per tutte le parole
chiave SQL).
Vedrai che abbiamo aggiunto una clausola ORDER BY in modo che le righe della nostra vista siano ben ordinate:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

15.5.3 Eliminare una Vista

Se non hai più bisogno di una vista, puoi eliminarla in questo modo:

drop view roads_count_v;

15.5.4 In Conclusion

Usando le viste, puoi salvare una query e accedere ai suoi risultati come se fosse una tabella.
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15.5.5 What’s Next?

A volte, quando si cambiano i dati, si vuole che le modifiche abbiano effetti altrove nel database. La prossima lezione
ti mostrerà come farlo.

15.6 Lesson: Regole

Le regole permettono di riscrivere l“«albero delle query» di una query in ingresso. Un uso comune è quello di
implementare le viste, inclusa la vista aggiornabile. - Wikipedia

Obiettivo di questa lezione: Imparare a creare nuove regole per il database.

15.6.1 Creare una regola di log

Diciamo che vuoi registrare ogni cambiamento di phone_no nella tua tabella delle persone in una tabella people_log.
Quindi crei una nuova tabella:

create table people_log (name text, time timestamp default NOW());

Nel passo successivo, crea una regola che registra ogni cambiamento di un phone_no nella tabella people nella tabella
people_log:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Per verificare che la regola funzioni, modifichiamo un numero di telefono:

update people set phone_no = '082 555 1234' where id = 2;

Controlla che la tabella people sia stata aggiornata correttamente:

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Ora, grazie alla regola che abbiamo creato, la tabella people_log sarà come questa:

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Nota: Il valore del campo time dipenderà dalla data e dall’ora correnti.
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15.6.2 In Conclusion

Le regole ti permettono di aggiungere o cambiare automaticamente i dati nel tuo database per rispecchiare i
cambiamenti in altre parti del database.

15.6.3 What’s Next?

Il prossimo modulo ti introdurrà a Spatial Database usando PostGIS, che si basa su questi concetti di database e li
applica ai dati GIS.
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CAPITOLO16

Module: Nozioni Database Spaziali con PostGIS

I database spaziali ti consentono l’archiviazione della geometria in un database e forniscono funzioni per il recupero
dei record utilizzando queste geometrie. In questo modulo utilizzerai PostGIS, un’estensione di PostgreSQL, per
imparare come configurare un database spaziale, importare dati nel database e utilizzare le funzioni geografiche
offerte da PostGIS.
Mentre lavori in questa sezione, potresti voler conservare una copia del cheat sheet di PostGIS disponibile
presso Boston GIS user group https://www.bostongis.com/postgis_quickguide.bqg. Un’altra risorsa utile è la
documentazione online di PostGIS.
There are also some more extensive tutorials on PostGIS and Spatial Databases created by Boundless that are now
hosted on the PostGIS’s website:

• Introduzione a PostGIS https://postgis.net/workshops/postgis-intro/
• Suggerimenti e consigli per il database PostGIS https://postgis.net/documentation/tips/

Vedi anche PostGIS In Action.

16.1 Lesson: Configurazione PostGIS

L’impostazione delle funzionalità di PostGIS consente di accedere alle funzioni spaziali in PostgreSQL.
Obiettivo di questa lezione: Installare funzioni spaziali e dimostrarne gli effetti.

Nota: In questo esercizio si presuppone l’uso di PostGIS versione 2.1 o più recente. L’installazione e la configurazione
del database sono diverse per le versioni precedenti, ma il resto del materiale di questo modulo funzionerà comunque.
Per informazioni sull’installazione e sulla configurazione del database, consultare la documentazione relativa alla
propria piattaforma.

499

https://www.bostongis.com/postgis_quickguide.bqg
https://postgis.net/workshops/postgis-intro/
https://postgis.net/documentation/tips/
https://www.postgis.us


QGIS Training Manual

16.1.1 Installare su Ubuntu

Postgis è facilmente installabile da apt.

$ sudo apt install postgresql
$ sudo apt install postgis

Effettivamente, è così facile…

Nota: Le versioni specifiche che verranno installate dipendono dalla versione di Ubuntu in uso e
dai repository configurati. Dopo l’installazione puoi verificare la versione eseguendo una query select
PostGIS_full_version(); con psql o un altro strumento.

Per installare una versione specifica (per esempio, PostgreSQL versione 13 e PostGIS 3), puoi usare i seguenti
comandi.

$ sudo apt install wget ca-certificates
$ sudo lsb_release -a
$ wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-
↪→key add -
$ sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt/ `lsb_release -cs`-
↪→pgdg main" >> /etc/apt/sources.list.d/pgdg.list'
$ sudo apt-get update
$ sudo apt install postgis postgresql-13-postgis-3

16.1.2 Installare su Windows

L’installazione suWindows può essere fatta da pacchetti binari usando una normale finestra di dialogo di installazione
di Windows.
Prima visita la pagina di download <https://www.postgresql.org/download/>`_. Poi segui this guide.
Puoi trovare più informazioni sul sito PostGIS.

16.1.3 Installare su altre piattaforme

PostGIS website download ha informazioni sull’installazione su altre piattaforme, incluso macOS e su altre
distribuzioni Linux.

16.1.4 Configurare i database per usare PostGIS

Una volta installato PostGIS, avrai bisogno di configurare il database per utilizzare le estensioni. Se hai installato
PostGIS versione> 2.0, basta eseguire il seguente comando con psql utilizzando il database degli indirizzi del nostro
esercizio precedente.

$ psql -d address -c "CREATE EXTENSION postgis;"

Nota: A seconda della tua versione, potresti trovare altre istruzioni su come abilitare spazialmente un database su
https://postgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Esaminare le funzioni di PostGIS installate

Puoi pensare a PostGIS come a una raccolta di funzioni del database che estendono le funzionalità di base di
PostgreSQL in modo che possa trattare con i dati spaziali. Con “trattare con”, intendi memorizzare, recuperare,
interrogare e manipolare. Per fare questo, un certo numero di funzioni sono installate nel database.
Il database PostgreSQL address è ora abilitato ad operare come geospaziale, grazie a PostGIS. Approfondirai
meglio nelle prossime sezioni, ma puoi avere un piccolo assaggio. Vuoi creare un punto dal testo. Per prima cosa usa
il comando psql per trovare le funzioni relative al punto. Se non sei già connesso al database address, fallo ora.
Quindi esegui:

\df *point*

Questo è il comando che cerchhi: st_pointfromtext. Per sfogliare l’elenco, usa la freccia giù, quindi premi Q
per tornare alla shell di psql.
Prova a eseguire questo comando:

select st_pointfromtext('POINT(1 1)');

Risultato:

st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Nota tre cose:
• Definisci u punto nella posizione 1,1 (è assunto EPSG:4326) usando POINT(1 1),
• Hai eseguito un’istruzione SQL, ma non su alcuna tabella, solo sui dati immessi dal prompt SQL,
• The resulting row does not make much sense.

La riga risultante è nel formato OGC chiamato “Well Known Binary” (WKB). Vedrai questo formato in dettaglio
nella prossima sezione.
Per ottenere i risultati come testo, puoi fare una rapida scansione attraverso l’elenco delle funzioni per qualcosa che
restituisce il testo:

\df *text

La query che stai cercando ora è st_astext. Combinalo con l’interrogazione precedente:

select st_astext(st_pointfromtext('POINT(1 1)'));

Risultato:

st_astext
------------

POINT(1 1)
(1 row)

Hai inserito la stringa POINT(1,1), l’hai trasformata in un punto usando st_pointfromtext(), e l’hai
ritrasformata in un formato leggibile con st_astext(), che ti ha ritornato la stringa originale.
Un ultimo esempio prima di entrare nel dettaglio dell’utilizzo di PostGIS:

select st_astext(st_buffer(st_pointfromtext('POINT(1 1)'),1.0));

Cosa hai fatto? Hai creato un buffer di 1 grado attorno al punto e hai il risultato come testo.
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16.1.6 Sistemi di riferimento spaziale

Oltre alle funzioni PostGIS, l’estensione contiene una raccolta di definizioni del sistema di riferimento spaziale (SRS)
come definito dall’European Petroleum Survey Group (EPSG). Questi vengono utilizzati durante operazioni come le
conversioni del sistema di riferimento di coordinate (CRS).
Puoi verificare queste definizioni SRS nel database così come sono memorizzate nelle normali tabelle del database.
Dapprima esamina lo schema della tabella immettendo il seguente comando nel terminale di psql:

\d spatial_ref_sys

Il risultato dovrebbe essere questo:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
Indexes:

"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

Puoi utilizzare interrogazioni SQL predefinite (come hai appreso nelle sezioni introduttive), per visualizzare e
manipolare questa tabella, anche se non è una buona idea aggiornare o eliminare qualsiasi record a meno che non si
sappia cosa si sta facendo.
Un SRID a cui potresti essere interessato è EPSG: 4326 - il sistema di riferimento geografico / lat lon che utilizza
l’ellissoide WGS 84. Dai un’occhiata a questo:

select * from spatial_ref_sys where srid=4326;

Risultato:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

Il srtext è la definizione della proiezione in well known text (pui riconoscerlo nei file .prj degli shapefile).

16.1.7 In Conclusion

Ora hai installato le funzioni di PostGIS nella tua copia di PostgreSQL. A questo punto sarai in grado di utilizzare le
numerose funzioni spaziali di PostGIS.
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16.1.8 What’s Next?

Di seguito imparerai come gli elementi spaziali vengono rappresentati in un database.

16.2 Lesson: Il modello Simple Feature

Come puoi memorizzare o rappresentare delle entità geografiche in un database? In questa lezione tratteremo di uno
dei possibili approcci, il Modello delle entità di base definito da OGC.
Obiettivo di questa lezione: Imparare cosa è il modello SFS e come usarlo.

16.2.1 Cos’è OGC

Open Geospatial Consortium (OGC) è un’organizzazione internazionale no-profit, basata sul consenso volontario, che
si occupa di definire specifiche tecniche per i servizi geospaziali e di localizzazione (location based). OGC è formato
da oltre 370 membri (governi, industria privata, università) con l’obiettivo di sviluppare ed implementare standard
per il contenuto, i servizi e l’interscambio di dati geografici (GIS - Sistema informativo geografico) che siano «aperti
ed estensibili». Le specifiche definite da OGC sono pubbliche (PAS) e disponibili gratuitamente. - Wikipedia

16.2.2 Cos’è il modello SFS

Il modelle delle entità di base per SQL (SFS) è un modo non-topologico per l’uso di dati geospaziali in un database e
definisce le funzioni per l’accesso, il funzionamento e la costruzione di questi dati.

Il modello definisce dati geospaziali provenienti da vettori di punti, linee e poligoni (e aggregazioni multioggetto).
Per ulteriori informazioni, consultare lo standard OGC Simple Feature for SQL.
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16.2.3 Aggiungi un campo geometria alla tavola

Aggiungi un campo punto alla tabella people:

alter table people add column the_geom geometry;

16.2.4 Aggiungi un vincolo in base al tipo di geometria

Noterai che il tipo di campo della geometria non specifica in modo implicito quale tipo di geometria per il campo -
per questo abbiamo bisogno di un vincolo:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(the_geom) = 'ST_Point'::text
OR the_geom IS NULL);

Questo aggiunge un vincolo alla tabella in modo che accetterà solo una geometria punto o un valore nullo.

16.2.5 Try Yourself

Crea una nuova tabella denominata cities e inserisci alcune colonne appropriate, tra cui un campo geometry per
poligoni (i confini della città). Assicurarti che esiste un vincolo per rispettare geometrie poligoni.

Soluzione

create table cities (id serial not null primary key,
name varchar(50),
the_geom geometry not null);

alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = 'ST_Polygon'::text );

16.2.6 Compila la tabella geometry_columns

A questo punto dovresti aggiungere nella tabella geometry_columns:

insert into geometry_columns values
('','public','people','the_geom',2,4326,'POINT');

Perché? geometry_columns viene utilizzato da alcune applicazioni per sapere quali tabelle del database
contengono dati geometrici.

Nota: Se la precedente istruzione INSERT causa un errore, esegui prima questa interrogazione:

select * from geometry_columns;

Se la colonna f_table_name contiene il valore people, allora questa tabella è già stata registrata e non è
necessario fare altro.

Il valore 2 si riferisce al numero di dimensioni; in questo caso, due: X e Y.
Il valore 4326 si riferisce alla proiezione che stai utilizzando; in questo caso, WGS 84, riferita con il numero 4326
(vedere la precedente discussione sul EPSG).
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Try Yourself

Aggiung un’appropriata geometry_columns per il tuo vettore new cities

Soluzione

insert into geometry_columns values
('','public','cities','the_geom',2,4326,'POLYGON');

16.2.7 Aggiungi una riga alla tabella usando SQL

Ora che le tabelle sono spazialmente abilitate, puoi archiviare le geometrie in esse:

insert into people (name,house_no, street_id, phone_no, the_geom)
values ('Fault Towers',

34,
3,
'072 812 31 28',
'SRID=4326;POINT(33 -33)');

Nota: Nei nuovi dati inseriti, dovrai specificare la proiezione (SRID) che desideri utilizzare. Questo è perché hai
inserito la geometria del nuovo punto utilizzando una stringa di testo semplice ma che non aggiunge automaticamente
le informazioni di proiezione corrette. Ovviamente, il nuovo punto deve utilizzare lo stesso SRID come i dati aggiunti,
quindi devi specificarlo.
Se a questo punto staI utilizzando una interfaccia grafica, per esempio, specificando la proiezione per ciascun punto
dovrebbe essere automatico. In altre parolenon ti preoccupererai di usare la proiezione corretta per ogni punto che
desideri aggiungere, se lo hai già specificato.

Adesso apri QGIS e prova a vedere la tua tabella people. Puoi modificare/aggiungere/cancellare righe e interrogare
il database per vedere come è cambiato.
Per caricare un layer PostGIS in QGIS usa l’opzione dal menu Layer ► Add PostGIS Layers oppure l’icona:

Queesto aprirà la finestra di dialogo:
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Scegli New per aprire questa finestra:
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Quindi definisci una nuova connessione, per esempio:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

Per vedere se QGIS ha trovato il database address e che il tuo username e password sono corretti, scegli Test
Connect. Se funziona scegli Save Username e Save Password. Quindi scegli OK per creare questa connessione.
Torna alla finestra Add PostGIS Layers , scegli Connect e aggiungi i layer al tuo progetto.
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Try Yourself

Formulate un’interrogaazione che mostre il nome di una persona, la strada e la posizione (da the-geom coloumn)
come testo

Soluzione

select people.name,
streets.name as street_name,
st_astext(people.the_geom) as geometry

from streets, people
where people.street_id=streets.id;

Risultato:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

Come puoi vedere, il nostro vincolo consente di aggiungere i nulli nel database.

16.2.8 In Conclusion

hai visto come aggiungere oggetti spaziali database e visualizzarli nel GIS.

16.2.9 What’s Next?

Nel prossimo vedrai come importare ed esportare i dati da e per il database.

16.3 Lesson: Importare ed esportare

Certamente, un database senza un modo semplice per trasferirere i dati da e per esso non sarebbe di grande utilità.
Fortunatamente, ci sono numerosi strumenti che ti permetteranno di spostare facilmente i dati da e verso PostGIS.

16.3.1 shp2pgsql

shp2pgsql è uno strumento da riga di comando per importare Shapefile ESRI nel database. Sotto Unix, puoi usare il
seguente comando per importare un nuovo tabella PostGIS:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Sotto Windows, devi eseguire l’importazione in due passaggi:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

Puoi incontrare questo errore:
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ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

Si tratta di un problema noto che riguarda la creazione in situ di un indice spaziale per i dati che si stanno importando.
Per evitare l’errore, escludere il parametro ``-I””. In questo modo non verrà creato direttamente alcun indice spaziale
e sarà necessario crearlo nel database dopo l’importazione dei dati. (La creazione di un indice spaziale sarà trattata
nella prossima lezione).

16.3.2 pgsql2shp

pgsql2shp è uno strumento a riga di comando per esportare le tabelle, le viste o le interrogazioni SQL di PostGIS.
Per fare ciò con Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

Per esportare i dati utilizzando un’interrogazione:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr è uno strumento molto potente per convertire i dati in e da PostGIS in molti formati di dati. ogr2ogr fa parte
della libreria GDAL e deve essere installato separatamente. Per esportare una tabella da PostGIS a GML, puoi usare
questo comando:

ogr2ogr -f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 DB Manager

Potresti aver notato un’altra opzione nel menu Database menu etichettato DB Manager. Questo è uno strumento che
fornisce un’interfaccia unica per interagire con database spaziali tra cui PostGIS. Ti permette anche di importare
ed esportare da database ad altri formati. Dato che il prossimo modulo è largamente dedicato all’utilizzo di questo
strumento, lo faremo solo brevemente qui.

16.3.5 In Conclusion

L’importazione e l’esportazione di dati da e verso il database può essere eseguita in molti modi diversi. Soprattutto
se usi fonti di dati diverse, farai uso di queste funzioni (o altre come loro) su base regolare.

16.3.6 What’s Next?

Ora vedrai come interrogare i dati che hai creato in precedenza.
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16.4 Interrogazioni spaziali

Le interrogazioni spaziali non sono diverse dalle altre interrogazioni del database. Puoi usare la colonna della
geometria come qualsiasi altra colonna del database. Con l’installazione di PostGIS nel nostro database, abbiamo
funzioni aggiuntive per interrogare il nostro database.
L’obiettivo di questa lezione: Vedere come le funzioni spaziali vengono applicate in modo simile alle funzioni
«normali» non spaziali.

16.4.1 Operatori spaziali

Se vuoi sapere quali punti sono entro una distanza di 2 gradi da un punto (X, Y) puoi farlo con:

select *
from people
where st_distance(the_geom,'SRID=4326;POINT(33 -34)') < 2;

Risultato:

id | name | house_no | street_id | phone_no | the_geom
----+--------------+----------+-----------+---------------+---------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Nota: Il valore di the_geom sopra è stato troncato per ragioni di spazio in questa pagina. Se vuoi vedere il punto in
coordinate leggibili dall’uomo, prova qualcosa di simile a quello che hai fatto nella sezione precedente «Visualizza
un punto come WKT».

Come sappiamo che l’interrogazione fatta restituisce tutti i punti entro 2 gradi? Perché non 2 metri? O qualsiasi altra
unità?

Soluzione
Le unità utilizzate dalla query di esempio sono i gradi, perché il SR utilizzato dal layer è il WGS 84. Si tratta di un
SR geografico, il che significa che le sue unità sono in gradi. Un SR proiettato, come le proiezioni UTM, è in metri.
Ricorda che quando scrivi una query, devi conoscere le unità in cui si trova il SR del layer. In questo modo potrai
scrivere una query che restituisca i risultati attesi.

16.4.2 Indici spaziali

Puoi anche definire indici spaziali. Un indice spaziale rende le interrogazioni spaziali molto più veloci. Per creare un
indice spaziale sulla colonna della geometria, usa:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);

\d people

Risultato:
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Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = 'ST_Point'::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Try Yourself

Modifica la tabella cities in modo che la sua colonna della geometria sia spazialmente indicizzata.

Soluzione

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

16.4.4 Dimostrazione delle funzioni spaziali postGIS

Per dimostrare le funzioni spaziali di PostGIS, creerai un nuovo database contenente alcuni dati (fittizi).
Per iniziare, crea un nuovo database (esci prima dalla console di psql):

createdb postgis_demo

Ricordati di installare le estensioni PostGIS:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Quindi, importa i dati forniti nella cartella exercise_data/postgis/. Fai riferimento alla lezione precedente
per le istruzioni, ma ricorda che dovrai creare una nuova connessione PostGIS al nuovo database. È possibile importare
dal terminale o tramite DB Manager. Importa i file nelle seguenti tabelle del database:

• points.shp in building
• lines.shp in road
• polygons.shp in region

LivelliLivelliCarica questi tre vettori del database in QGIS tramite la finestra di dialogo Aggiungi layer PostGIS ,
come al solito. Quando apri le tabelle degli attributi, noterai che hanno sia un campo id che un campo gid creati
dall’importazione PostGIS.
Ora che le tabelle vengono importate, puoi usare PostGIS per interrogare i dati. Torna al tuo terminale (riga di
comando) e inserisci il terminale di psql eseguendo:
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psql postgis_demo

Vedrai alcune di queste dichiarazioni creando delle viste, in modo da poterle aprire in QGIS e vedere i risultati.

Seleziona per posizione

Ottieni tutti gli edifici nella regione di KwaZulu:

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';

Risultato:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Oppure, se crei una vista:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b

WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';

Aggiungi la vista come un vettore e visualizzalo in QGIS:
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Seleziona vicino

Mostra un elenco di tutti i nomi delle regioni adiacenti alla regione di Hokkaido:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

Risultato:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

Come vista:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

In QGIS:

Nota la regione mancante (Queensland). Ciò potrebbe essere dovuto a un errore di topologia. Fatti come questo
possono avvisarti di potenziali problemi nei dati. Per risolverlo senza rimanere intrappolati nelle anomalie che i dati
potrebbero avere, potremmo invece utilizzare un buffer intersecato:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom

(continues on next page)
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(continua dalla pagina precedente)
FROM region

WHERE name = 'Hokkaido';

Questo crea un buffer di 100 metri attorno alla regione di Hokkaido.
L’area più scura è il buffer:

Seleziona usando il buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
AND b.name != 'Hokkaido';

In questa interrogazione, la vista del buffer originale viene utilizzata come qualsiasi altra tabella. Viene assegnato
l’alias a, e il suo campo di geometria,:kbd:a.the_geom, viene utilizzato per selezionare qualsiasi poligono nella tabella
region (alias b) che lo interseca. Tuttavia, Hokkaido stesso è escluso da questa affermazione di selezione, perché
non lo vogliamo; vogliamo solo le regioni adiacenti.
In QGIS:
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Puoi anche selezionare tutti gli oggetti all’interno di una data distanza, senza il passo aggiuntivo di creare un buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

Raggiungendo lo stesso risultato, senza necessità del passaggio del buffer temporaneo:
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Seleziona valori unici

Mostra un elenco di nomi di città unici per tutti gli edifici nella regione del Queensland:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'Queensland';

Risultato:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Ulteriori esempi …

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) as text,
ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) as text,
ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM road a

WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM region a

WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER(a.the_geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA(a.the_geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;
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CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

Hai visto come interrogare oggetti spaziali usando le nuove funzioni del database di PostGIS.

16.4.6 What’s Next?

Ora esaminerai le strutture di geometrie più complesse e come crearle utilizzando PostGIS.

16.5 Lesson: Costruzione delle Geometrie

In questa sezione approfondirai come puoi costruire semplici geometrie con SQL. In realtà userai un GIS come QGIS
per creare geometrie complesse con gli strumenti di digitalizzazione; tuttavia, capire come li puoi formulre può essere
utile per scrivere interrogazioni e capire come è costruito il database.
L’obiettivo di questa lezione: Capire meglio come creare entità spaziali direttamente in PostgreSQL/PostGIS.

16.5.1 Crea linee

Torna al database address, fai in modo che la tabella delle strade corrisponda alle altre; cioè, avendo un vincolo
sulla geometria, un indice e una voce nella tabella geometry_columns.

16.5.2 Try Yourself

• Modificare la tabella streets in modo che abbia una colonna geometry di tipo ST_LineString.
• Don’t forget to do the accompanying update to the geometry columns table!
• Also add a constraint to prevent any geometries being added that are not LINESTRINGS or null.
• Create a spatial index on the new geometry column

Soluzione

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = 'ST_LineString'::text OR the_geom IS NULL);
insert into geometry_columns values ('','public','streets','the_geom',2,4326,

'LINESTRING');
create index streets_geo_idx

on streets
using gist
(the_geom);

Inserisci una linea nella tabella streets. In questo caso aggiornerai un record di strada esistente:
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update streets
set the_geom = 'SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)'
where streets.id=2;

Dai un’occhiata ai risultati in QGIS. (Potresti aver bisogno di fare clic-destro del mouse sul vettore streets nel pannello
“Layers” e scegliere “Zoom sul layer”.)
Ora crea altre voci per le strade: alcune in QGIS e altre dalla riga di comando.

16.5.3 Crea poligoni

Creare poligoni è altrettanto facile. Una cosa da ricordare è che, per definizione, i poligoni hanno almeno quattro
vertici, con l’ultimo e il primo essere coincidenti:

insert into cities (name, the_geom)
values ('Tokyo', 'SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))');

Nota: Un poligono richiede doppie parentesi attorno alla sua lista di coordinate; questo per consentire di aggiungere
poligoni complessi con più aree non connesse. Per esempio

insert into cities (name, the_geom)
values ('Tokyo Outer Wards',

'SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))'

);

Se hai seguito questo passaggio, puoi verificare cosa ha fatto caricando l’insieme di dati della città in QGIS, aprendo
la sua tabella degli attributi e selezionando la nuova voce. Nota come i due nuovi poligoni si comportano come un
poligono.

16.5.4 Esercizio: Collega delle città alle persone

Per questo esercizio dovresti fare quanto segue:
• Cancella tutti i dati dalla tabella people.
• Add a foreign key column to people that references the primary key of the cities table.
• Usa QGIS per inserire qualche città.
• Usa SQL per inserire qualche nuovo record in people, assicurandoti che ognuno abbia una via e una città
associata

Il tuo schema aggiornato dovrebbe assomigliare a qualcosa come questo:

\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null

(continues on next page)
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(continua dalla pagina precedente)
Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) =

'ST_Point'::text OR the_geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Soluzione

delete from people;
alter table people add column city_id int not null references cities(id);

(acquisizione città in QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('Faulty Towers',

34,
3,
'072 812 31 28',
1,
'SRID=4326;POINT(33 33)');

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('IP Knightly',

32,
1,
'071 812 31 28',
1,F
'SRID=4326;POINT(32 -34)');

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('Rusty Bedsprings',

39,
1,
'071 822 31 28',
1,
'SRID=4326;POINT(34 -34)');

Se stai riscontrando il seguente messaggio di errore:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

significa che mentre si sperimenta la creazione di poligoni per la tabella delle città, devi averne cancellati alcuni e
ricominciare da capo. Controlla le voci della tabella delle città e utilizza tutti gli id che sono esistenti.
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16.5.5 Guarda lo schema

Adesso lo schema dovrebbe assomigliare a questo:

16.5.6 Try Yourself

Crea limiti di città calcolando il minimopoligono convesso di tutti gli indirizzi per quella città e calcolando un buffer
attorno a quell’area.

16.5.7 Accedi agli oggetti

Con le funzioni del modello SFS, hai una vasta gamma di opzioni per accedere agli oggetti di Geometrie SFS. Se
vuoi selezionare il primo vertice di ogni poligono nella tabella myPolygonTable, devi fare in questo modo:

• Trasforma il policono di confine in una linea:

select st_boundary(geometry) from myPolygonTable;

• Seleziona il primo vertice della linea risultante:

select st_startpoint(myGeometry)
from (

select st_boundary(geometry) as myGeometry
from myPolygonTable) as foo;

16.5.8 Elaborazione

PostGIS supporta tutte le funzioni conformi agli standard OGC SFS/MM. Tutte queste funzioni iniziano ST_.

16.5.9 Ritaglio

Per ritagliare una parte dei ati puoi usare la funzione ST_INTERSECT(). Per evitare geometrie vuote usa:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))
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select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),

b.the_geom));

16.5. Lesson: Costruzione delle Geometrie 521



QGIS Training Manual

16.5.10 Costruisci geometrie da altre geometrie

Da una determinata tabella di punti, vuoi generare una linea. L’ordine dei punti è definito dal loro id. Un altro
metodo per ordinare potrebbe essere una tabella oraria, come quello che si ottiene quando si acquisiscono punti con
un ricevitore GPS.

Per creare una linea da un vettore punti chiamato “points”, puoi eseguire il seguente comando:

select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from (

select the_geom
from points
order by id

) as foo;

Per vedere come funziona senza creare un nuovo livello, è possibile eseguire questo comando anche sul livello
“people”, anche se ovviamente sarebbe poco consueto.
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16.5.11 Pulire la geometria

Puoi ottenere maggiori informazioni su questo argomento in this blog entry.

16.5.12 Differenze tra tabelle

Per rilevare la differenza tra due tabelle con la stessa struttura, è possibile utilizzare la parola PostgreSQL EXCEPT:

select * from table_a
except
select * from table_b;

Come risultato, otterrai tutti i record di table_a che non sono memorizzati in table_b.
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16.5.13 Archiviazione delle tabelle

Puoi definire dove postgres deve memorizzare i propri dati su disco creando tablespaces:

CREATE TABLESPACE homespace LOCATION '/home/pg';

Se crei un database puoi allora specificare quale spazio di archiviazione usare ad esempio:

createdb --tablespace=homespace t4a

16.5.14 In Conclusion

Hai imparato come creare geometrie più complesse usando le istruzioni PostGIS. Tieni presente che questo è per
migliorare la tua conoscenza quando lavori con database spaziali tramite un GIS. Di solito non è necessario inserire
queste affermazioni manualmente, ma avere un’idea generale della loro struttura ti aiuterà quando utilizzi un GIS,
specialmente se incontri errori che altrimenti sembrerebbero incomprensibili.
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CAPITOLO17

La guida di Processing di QGIS

Questo modulo è stato realizzato da Victor Olaya e Paolo Cavallini.
Contenuti:

17.1 Introduzione

Questa guida descrive come usare l’ambiente Processing di QGIS. Non si presuppone precedente conoscenza
dell’ambiente di Processing o di qualunque altra applicazione ad esso collegata. Si presuppone una conoscenza di
base di QGIS. I capitoli riguardanti lo scripting danno per scontato che tu abbia conoscenze di base di Python e delle
API Python di QGIS.
Questa guida è pensata per l’autoapprendimento o per essere utilizzata in un workshop su processing.
Gli esempi in questa guida utilizzano QGIS 3.4. Possono non funzionare o non essere disponibili per versioni diverse
da questa.
Questa guida comprende un insieme di piccoli esercizi a difficoltà crescente. Se non hai mai usato l’ambiente di
Processing, dovresti cominciare dall’inizio. Se hai già una qualche esperienza precedente, sentiti libero di saltare
alcune lezioni. Esse sono più omeno indipendenti le une dalle altre, e ognuna introduce alcuni concetti nuovi o qualche
nuovo elemento, i quali sono indicati nel titolo del capitolo e nella breve introduzione all’inizio di ogni capitolo. Ciò
dovrebbe rendere semplice individuare le lezioni che riguardano un particolare argomento.
Per una descrizione sistematica di tutti i componenti dell’ambiente e del loro utilizzo, è fortemente consigliato
controllare il capitolo corrispondente nel manuale di QGIS. Usalo come testo di supporto durante questa guida.
Tutti gli esercizi in questa guida usano dati liberamente scaricabili usati tramite il manuale di formazione e si
riferiscono alla sezione Dati. Il file zip da scaricare contiene diverse cartelle che corrispondono a ciascuna delle
lezioni di questa guida. In ognuna di esse troverai un file di progetto di QGIS. Semplicemente, aprilo e sarai pronto
per iniziare la lezione.
Buon divertimento!
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17.2 Una raccomandazione importante prima di iniziare

Proprio come il manuale di un elaboratore di testi non vi insegna a scrivere un romanzo o una poesia, o un tutorial
CAD non vi mostra come calcolare le dimensioni di una trave per un edificio, questa guida non vi insegnerà l’analisi
spaziale. Invece, vi mostrerà come usare il framework QGIS Processing, un potente strumento per eseguire l’analisi
spaziale. Sta a voi imparare i concetti necessari per capire questo tipo di analisi. Senza di essi, non ha senso usare il
framework e i suoi algoritmi, anche se potreste essere tentati di provarci.
Mostriamo questo più chiaramente con un esempio.
Dato un insieme di punti e un valore di un determinato valore in ogni punto, è possibile elaborare un layer raster da
essi utilizzando il geoalgoritmo Kriging. La finestra di dialogo dei parametri per questo modulo è simile alla seguente.

Sembra complesso, vero?
Leggendo questo manuale, imparerai cose come l’uso di questo modulo, come eseguirlo in un processo batch per
creare layer raster da centinaia di layer di punti in una singola esecuzione, o cosa succede se il layer di input ha alcuni
punti selezionati. Tuttavia, i parametri stessi non sono spiegati. Un analista esperto con una buona conoscenza della
geostatistica non avrà problemi a capire questi parametri. Se non siete uno di loro e sill, range, o nugget non sono
concetti familiari per te, allora non dovresti usare il modulo Kriging. Inoltre, siete lontani dall’essere pronti ad usare il
modulo Kriging, poiché richiede l’apprendimento di concetti come l’autocorrelazione spaziale o i semivariogrammi,
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che probabilmente non hai mai sentito prima, o almeno non hai studiato abbastanza a lungo. Dovresti prima studiarli
e capirli, e poi tornare su QGIS per eseguirli effettivamente ed eseguire l’analisi. Ignorare questo porterà a risultati
sbagliati e ad analisi scadenti (e molto probabilmente inutili).
Anche se non tutti gli algoritmi sono complessi come il kriging (ma alcuni sono anche più complessi!), quasi tutti
richiedono la comprensione delle nozioni fondamentali di analisi su cui si basano. Senza questa conoscenza, usarli
porterà molto probabilmente a risultati scadenti.
Usare i geoalgoritmi senza avere una buona base di analisi spaziale è come cercare di scrivere un romanzo senza
sapere nulla di grammatica o sintassi, e non avere alcuna conoscenza della narrazione. Potreste ottenere un risultato,
ma è probabile che non abbia alcun valore. Per favore, non illudetevi e pensate che dopo aver letto questa guida siate
già in grado di eseguire l’analisi spaziale e ottenere risultati validi. Avete bisogno di studiare anche l’analisi spaziale.
Qui ci sono dei riferimenti che puoi leggere per imparare di più sull’analisi spaziale.
Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley
È disponibile online qui

17.3 Impostazione del framework Processing

La prima cosa da fare prima di usare il framework di Processing è configurarlo. Non c’è molto da configurare, quindi
questo è un compito facile.
Più avanti mostreremo come configurare le applicazioni esterne che sono usate per estendere la lista degli algoritmi
disponibili, ma per ora lavoreremo solo con il framework stesso.
Il framework di Processing è un plugin di base di QGIS, il che significa che dovrebbe essere già installato nel tuo
sistema, dato che è incluso in QGIS. Nel caso sia attivo, dovresti vedere un menu chiamato Processing nella tua barra
dei menu. Lì puoi accedere a tutti i componenti del framework.

Se non trovi questo menu, devi abilitare il plugin andando nel gestore dei plugin e attivarlo.
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L’elemento principale con cui lavoreremo è la casella degli strumenti. Clicca sulla voce di menu corrispondente e
vedrai la casella degli strumenti agganciata al lato destro della finestra di QGIS.
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La casella degli strumenti contiene una lista di tutti gli algoritmi disponibili, divisi in gruppi chiamati Sorgenti
dati. I fornitori di algoritmi possono essere (dis)attivati in Impostazioni ► Opzioni… ► Processing ► Sorgenti dati.
Discuteremo questa finestra di dialogo più avanti in questo manuale.
Per impostazione predefinita, solo i fornitori di algoritmi che non si basano su applicazioni di terze parti (cioè, quelli
che richiedono solo elementi QGIS per essere eseguiti) sono attivi. Gli algoritmi che richiedono applicazioni esterne
potrebbero richiedere una configurazione aggiuntiva. La configurazione dei fornitori di algoritmi è spiegata in un
capitolo successivo di questo manuale.
Se hai raggiunto questo punto, ora sei pronto ad usare i geoalgoritmi. Non c’è bisogno di configurare nient’altro per
ora. Possiamo già eseguire il nostro primo algoritmo, che faremo nella prossima lezione.
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17.4 Esecuzione del nostro primo algoritmo. La casella degli
strumenti

Nota: In questa lezione eseguiremo il nostro primo algoritmo e ne otterremo il primo risultato.

Come abbiamo già detto, il framework di processing può eseguire algoritmi da altre applicazioni, ma contiene anche
algoritmi nativi che non hanno bisogno di software esterno per essere eseguiti. Per iniziare ad esplorare il framework
di processing, eseguiremo uno di questi algoritmi nativi. In particolare, calcoleremo i centroidi di un insieme di
poligoni.
Per prima cosa, apri il progetto QGIS corrispondente a questa lezione. Esso contiene solo un singolo layer con due
poligoni

Ora vai alla casella di testo in cima alla casella degli strumenti. Questa è la casella di ricerca, e se ci scrivi del testo,
filtrerà l’elenco degli algoritmi inmodo damostrare solo quelli che contengono il testo inserito. Se ci sono algoritmi che
corrispondono alla tua ricerca ma appartengono a un provider che non è attivo, verrà mostrata un’etichetta aggiuntiva
nella parte inferiore della casella degli strumenti.
Digita centroidi e dovresti vedere qualcosa di simile a questo.
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La casella di ricerca è un modo molto pratico per trovare l’algoritmo che stai cercando. Nella parte inferiore
della finestra di dialogo, un’etichetta aggiuntiva mostra che ci sono algoritmi che corrispondono alla tua ricerca ma
appartengono a un provider che non è attivo. Se clicchi sul link in quell’etichetta, l’elenco degli algoritmi includerà
anche i risultati di quei provider inattivi, che saranno mostrati in grigio chiaro. Viene mostrato anche un link per
attivare ogni provider inattivo. Vedremo più avanti come attivare altri provider.

Per eseguire un algoritmo, basta fare doppio clic sul suo nome nella casella degli strumenti. Quando fai doppio clic
sull’algoritmo Polygon centroids, vedrai la seguente finestra di dialogo.
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Tutti gli algoritmi hanno un’interfaccia simile, che fondamentalmente contiene parametri di input che devi riempire,
e output per i quali devi selezionare dove memorizzare. In questo caso, l’unico input che abbiamo è un layer vettoriale
con poligoni.
Seleziona il layer Polygons come input. L’algoritmo ha un solo output, che è il layer dei centroidi. Ci sono due opzioni
per definire dove viene salvato l’output dei dati: inserire un percorso del file o salvarlo in un nome di file temporaneo
Nel caso tu voglia impostare una destinazione e non salvare il risultato in un file temporaneo, il formato dell’output
è definito dall’estensione del nome del file. Per selezionare un formato, basta selezionare l’estensione del file
corrispondente (o aggiungerla se invece stai digitando direttamente il percorso del file). Se l’estensione del percorso del
file inserito non corrisponde a nessuna di quelle supportate, un’estensione predefinita (di solito .dbf per le tabelle, .
tif per i livelli raster e .shp per quelli vettoriali) verrà aggiunta al percorso del file e il formato di file corrispondente
a quell’estensione verrà usato per salvare il layer o la tabella.
In tutti gli esercizi di questa guida, salveremo i risultati in un file temporaneo, poiché non c’è bisogno di salvarli per
un uso successivo. Sentiti libero di salvarli in una posizione permanente se vuoi.

Avvertimento: I file temporanei vengono cancellati una volta chiuso QGIS. Se crei un progetto con un output
che è stato salvato come output temporaneo, QGIS protesterà quando cercherai di riaprire il progetto in seguito,
poiché quel file di output non esisterà.

Una volta configurata la finestra di dialogo dell’algoritmo, premi Esegui per eseguire l’algoritmo.
Otterrai il seguente output.
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L’output ha lo stesso SR dell’input. Geoalgoritmi assumono che tutti i layer di input condividano lo stesso SR e non
eseguono alcuna riproiezione. Tranne nel caso di alcuni algoritmi speciali (per esempio, quelli di riproiezione), anche
le uscite avranno lo stesso SR. Vedremo presto di più su questo aspetto.
Prova tu stesso a salvarlo usando diversi formati di file (usa, per esempio, shp e geojson come estensioni). Inoltre,
se non vuoi che il layer sia caricato in QGIS dopo che è stato generato, puoi spuntare la casella di controllo che si
trova sotto la casella del percorso di output.

17.5 Altri algoritmi e tipologie di dati

Nota: In questa lezione eseguiremo altri tre algoritmi, impareremo ad usare altri tipi di input e configureremo gli
output da salvare automaticamente in una data cartella.

Per questa lezione avremo bisogno di una tabella e di un layer poligonale. Creeremo un layer di punti basato sulle
coordinate della tabella, e poi conteremo il numero di punti in ogni poligono. Se apri il progetto QGIS corrispondente
a questa lezione, troverai una tabella con le coordinate X e Y, ma non troverai un layer poligonale. Non preoccuparti,
lo creeremo usando un geoalgoritmo di processing.
La prima cosa che faremo è creare un layer puntuale dalle coordinate nella tabella, usando l’algoritmo Creare layer
puntuale da tabella. Ora sai come usare la casella di ricerca, quindi non dovrebbe essere difficile per te trovarlo. Fai
doppio clic su di essa per eseguirla e arrivare alla seguente finestra di dialogo.
Questo algoritmo, come quello della lezione precedente, genera un solo output e ha tre ingressi:

• Table: la tabella con le coordinate. Dovresti selezionare qui la tabella dai dati della lezione.
• Campi X e Y : questi due parametri sono legati al primo. Il selettore corrispondente mostrerà il nome di quei
campi che sono disponibili nella tabella selezionata. Seleziona il campoXCOORD per il parametroX e il campo
YYCOORD per il parametro Y.

• SR: Poiché questo algoritmo non ha layer in ingresso, non può assegnare un SR al layer di uscita basato su
di essi. Invece, ti chiede di selezionare manualmente il SR che è utilizzato dalle coordinate nella tabella. Fai
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clic sul pulsante sul lato sinistro per aprire il selettore SR di QGIS e seleziona EPSG:4326 come SR in uscita.
Stiamo usando questo SR perché le coordinate nella tabella sono in quel SR.

La tua finestra di dialogo dovrebbe assomigliare a questa.

Ora premi il pulsante Esegui per ottenere il seguente layer (potresti aver bisogno di zoomare al massimo per far
rientrare nella mappa i punti appena creati):
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La prossima cosa di cui abbiamo bisogno è il layer poligonale. Creeremo una griglia regolare di poligoni usando
l’algoritmo Creare reticoli, che ha la seguente finestra di dialogo dei parametri.
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Avvertimento: Le opzioni sono più semplici nelle ultime versioni di QGIS; basta inserire min e max per X e Y
(valori suggeriti: -5.696226,-5.695122,40.24742,40.248171)

Gli input richiesti per creare il reticolo sono tutti numerici. Quando devi inserire un valore numerico, hai due opzioni:
digitarlo direttamente nella casella corrispondente o cliccare il pulsante sulla destra per arrivare a una finestra di
dialogo come quella mostrata qui accanto.
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La finestra di dialogo contiene una semplice calcolatrice, così puoi digitare espressioni come 11 * 34.7 + 4.6,
e il risultato sarà calcolato e messo nella casella di testo corrispondente nella finestra dei parametri. Inoltre, contiene
costanti che puoi usare e valori di altri layer disponibili.
In questo caso, vogliamo creare un reticolo che copra l’estensione del layer puntuale in ingresso, quindi dovremmo
usare le sue coordinate per calcolare la coordinata centrale della griglia e la sua larghezza e altezza, poiché questi
sono i parametri che l’algoritmo richiede per creare il reticolo. Con un po” di matematica, provate a farlo voi stessi
usando la finestra di dialogo della calcolatrice e le costanti del layer puntuale in input.
Seleziona Rettangolo (poligono) nel campo Tipo reticolo.
Come nel caso dell’ultimo algoritmo, anche qui dobbiamo inserire il SR. Seleziona EPSG:4326 come SR di
destinazione, come abbiamo fatto prima.
Alla fine, dovresti avere una finestra di dialogo dei parametri come questa:
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(Meglio aggiungere una spaziatura sulla larghezza e l’altezza: spaziatura orizzontale: 0.0001, Spaziatura verticale:
0.0001, Larghezza: 0.001004, Altezza: 0.000651, Centro X: -5.695674, Centro Y: 40.2477955) Il caso del centro X
è un po” difficile, vedi: -5.696126+(( -5.695222+ 5.696126)/2)
Premi Esegui e otterrai il layer del reticolo.
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L’ultimo passo è contare i punti in ognuno dei rettangoli di tale reticolo. Useremo l’algoritmoConta i punti nel poligono.

Ora abbiamo il risultato che stavamo cercando.
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Prima di finire questa lezione, ecco un consiglio veloce per renderti la vita più facile nel caso tu voglia salvare in
modo costante i tuoi dati. Se vuoi che tutti i tuoi file di output siano salvati in una data cartella, non devi digitare il
nome della cartella ogni volta. Invece, vai al menu di processing e seleziona la voce Opzioni. Si aprirà la finestra di
configurazione.

Nella voce Cartella dei risultati che troverai nel gruppo Generale, digita il percorso della tua cartella di destinazione.
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Ora, quando esegui un algoritmo, usa semplicemente il nome del file invece del percorso completo. Per esempio, con
la configurazione mostrata sopra, se inserisci reticolo.shp come percorso di uscita per l’algoritmo che abbiamo
appena usato, il risultato sarà salvato in C:/user/matti/download/reticolo.shp. Puoi comunque
inserire un percorso completo nel caso tu voglia che il risultato sia salvato in una cartella diversa.
Prova tu stesso l’algoritmo Creare reticoli con diverse dimensioni del reticolo, e anche con diverso tipo di reticolo.

17.6 SR. Riproiezione

Nota: In questa lezione parleremo di come Processing tratta i SR. Vedremo anche algoritmomolto utile: riproiezione.

I SR sono una grande fonte di confusione per gli utenti di QGIS Processing, per cui ecco alcune regole generali su
come sono maneggiati dai geoalgoritmi quando si crea un nuovo vettore.

• Se ci sono vettori in ingresso, sarà utilizzato il SR del primo vettore. Si presuppone che tale SR sia quello
di tutti i vettori in ingresso, siccome dovrebbe essere lo stesso per tutti. Se utilizzi vettori con SR che non
corrispondono, QGIS te lo notificherà. Nota che il SR dei vettori in ingresso è mostrato insieme al suo nome
nella finestra di dialogo dei parametri.

• Se non ci sono layer in ingresso, userà il SR del progetto, a meno che l’algoritmo non contenga un campo SR
specifico (come è successo nell’ultima lezione con l’algoritmo del reticolo)
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Apri il progetto corrispondente a questa lezione: noterai due vettori denominati 23030 e 4326. Entrambi contengono
gli stessi punti, ma in SR differenti (EPSG:23030 e EPSG:4326). Essi appaiono nella stessa posizione perché QGIS
sta riproiettando al volo nel SR del progetto (EPSG:4326), ma in realtà non rappresentano lo stesso vettore.
Apri l’algoritmo Esporta/Aggiungi colonne geometriche.

Questo algoritmo aggiunge nuove colonne alla tabella degli attributi di un vettore. Il contenuto delle colonne dipende
dal tipo di geometria del vettore. Nel caso di punti, aggiunge nuove colonne con le coordinate X e Y di ogni punto.
Nella lista dei vettori disponibili che troverai nel campo del vettore in ingresso, vedrai ognuno di essi con il SR
corrispondente. Ciò significa che, sebbene appaiano nella stessa posizione sulla mappa, saranno trattati diversamente.
Selezione il vettore 4326.
L’altro parametro dell’algoritmo permette di definire come l’algoritmo utilizza le coordinate per calcolare il nuovo
valore che sarà aggiunto al vettore risultante. La maggior parte degli algoritmi non ha un’opzione simile, e usa
direttamente le coordinate. Seleziona l’opzione SR del vettore per usare le coordinate così come sono. Questo è il
modo con cui funzionano quasi tutti gli algoritmi.
Dovresti ottenere un nuovo vettore con gli stessi identici punti degli altri due vettori. Se fai clic con il tasto destro sul
nome del vettore e apri le sue proprietà, vedrai che ha lo stesso SR del vettore in ingresso, che è EPSG:4326. Quando
il vettore è caricato all’interno di QGIS, non ti sarà chiesto di inserire il SR del vettore poiché QGIS già lo conosce.
Se apri la tabella degli attributi del nuovo vettore, vedrai che conterrà due nuovi campi con le coordinate X e Y di
ogni punto.
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Questi valori di coordinate sono forniti dal SR del layer, poiché abbiamo scelto questa opzione. Tuttavia, anche se
scegli un’altra opzione, il SR in uscita del layer sarebbe stato lo stesso, poiché il SR in ingresso viene usato per
impostare il SR del layer in uscita. Se si sceglie un’altra opzione, i valori saranno diversi, ma non il punto risultante
da modificare o il SR del layer in uscita sarà diverso dal SR di quello d’ingresso.
Ora esegui la stessa operazione utilizzando l’altro vettore. Dovresti trovare il vettore risultante rappresentato
esattamente nella stessa posizione degli altri, e avrà l’EPSG:23030 come SR, poiché era questo quello del vettore
in ingresso.
Se vai alla sua tabella degli attributi, vedrai valori diversi rispetto a quelli nel primo vettore che abbiamo creato.

Ciò perché i dati originali sono diversi (usano un SR diverso), e le coordinate sono ricavate da essi.
Cosa dovresti imparare da questo? L’idea principale dietro questi esempi è che i geoalgoritmi usano il vettore così
come si trova nella sua fonte originale dei dati, e ignorano completamente le riproiezioni cheQGIS potrebbe fare prima
di rappresentarli. In altre parole, non fidarti di quello che vedi nella mappa, ma tieni sempre in mente che saranno
utilizzati i dati originali. Ciò non è così importante in questo caso poiché stiamo utilizzando un solo vettore per volta,
ma in un algoritmo che ne utilizza di diversi (come un algoritmo di ritaglio), i vettori che sembrano combaciare o
sovrapporsi possono essere molto lontani tra loro poiché possono avere SR differenti.
Gli algoritmi non eseguono la riproiezione (tranne l’algoritmo di riproiezione che vedremo dopo), per cui devi essere
tu ad assicurarti che i vettori abbiano lo stesso SR.
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Un modulo interessante che ha a che fare con i SR è quello di riproiezione. Esso rappresenta un caso particolare
poiché ha un vettore in ingresso (quello da riproiettare), ma non utilizza il suo SR per quello in uscita.
Apri l’algoritmo Riproietta vettore.

Seleziona in ingresso un qualunque vettore, e seleziona EPSG:23029 come SR di destinazione. Eseguendo l’algoritmo
otterrai un nuovo vettore, identico a quello in ingresso, ma con un SR diverso. Apparirà nella stessa regione della
mappa, come gli altri, poiché QGIS lo riproietterà al volo, ma le sue coordinate di partenza sono diverse. Puoi notare
ciò eseguendo l’algoritmoEsporta/Aggiungi colonne geometriche usando questo nuovo vettore in ingresso, e verificando
che le coordinate aggiunte siano diverse rispetto a quelle nella tabella degli attributi di entrambi i vettori che abbiamo
elaborato prima.

17.7 Selezione

Nota: In questa lezione vedremo come gli algoritmi di processig gestiscono le selezioni nei layer vettoriali che sono
usati come input, e come creare una selezione usando un particolare tipo di algoritmo.

A differenza di altri plugin di analisi in QGIS, non troverai nel processing dei geoalgoritmi nessuna casella di controllo
«Usa solo gli elementi selezionati» o simili. Il comportamento relativo alla selezione è impostato per l’intero plugin
e tutti i suoi algoritmi, e non per ogni esecuzione dell’algoritmo. Gli algoritmi seguono le seguenti semplici regole
quando usano un layer vettoriale.

• Se il layer ha una selezione, vengono usati solo elementi selezionati
• Se non c’è alcuna selezione, vengono usate tutti gli elementi.
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Nota che puoi cambiare questo comportamento deselezionando la relativa opzione nel menu Processing► Opzioni►
Generale.
Puoi provarlo tu stesso selezionando alcuni punti in uno qualsiasi dei layer che abbiamo usato nell’ultimo capitolo, ed
eseguendo l’algoritmo di riproiezione su di essi. Il layer riproiettato che si otterrà conterrà solo i punti che sono stati
selezionati, a meno che non ci sia stata nessuna selezione, il che farà sì che il layer risultante contenga tutti i punti del
layer originale.
Per fare una selezione, puoi utilizzare uno qualsiasi dei metodi e strumenti disponibili in QGIS. Tuttavia, puoi anche
usare un geoalgoritmo per farlo. Gli algoritmi per creare una selezione si trovano nella casella degli strumenti sotto
Vettore/Selezione.

Apri l’algoritmo Selezione casuale.

Lasciando i valori predefiniti, selezionerà 10 punti dal layer corrente.
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Noterai che questo algoritmo non produce alcun risultato, ma modifica il layer in ingresso (non il layer stesso, ma
la sua selezione). Questo è un comportamento insolito, poiché tutti gli altri algoritmi producono nuovi layer e non
modificano i layer in ingresso.
Dato che la selezione non fa parte dei dati stessi, ma qualcosa che esiste solo all’interno di QGIS, questi algoritmi di
selezione devono essere usati solo selezionando un layer che è aperto in QGIS, e non con l’opzione di selezione del
file che si trova nella casella dei valori dei parametri corrispondenti.
La selezione che abbiamo appena fatto, come la maggior parte di quelle create dal resto degli algoritmi di selezione,
può essere fatta anche manualmente da QGIS, quindi ti starai chiedendo che senso ha usare un algoritmo per questo.
Anche se ora questo potrebbe non avere molto senso per te, vedremo in seguito come creare modelli e script. Se vuoi
fare una selezione nel mezzo di un modello (che definisce un flusso di lavoro di elaborazione), solo un geoalgoritmo
può essere aggiunto a un modello, e altri elementi e operazioni di QGIS non possono essere aggiunti. Questo è il
motivo per cui alcuni algoritmi di elaborazione duplicano funzionalità che sono disponibili anche in altri componenti
di QGIS.
Da ora in poi, basta ricordare che le selezioni possono essere fatte usando i geoalgoritmi di processing, e che gli
algoritmi useranno solo gli elementi selezionati se esiste una selezione, o altrimenti tutti gli elementi.

17.8 Eseguire un algoritmo esterno

Nota: In questa lezione vedremo come utilizzare algoritmi che dipendono da un’applicazione di terze parti, in
particolare SAGA, che è uno dei principali fornitori di algoritmi.

Tutti gli algoritmi che abbiamo eseguito finora fanno parte del processing framework. Cioè, sono algoritmi nativi
implementati nel plugin ed eseguiti da QGIS proprio come viene eseguito il plugin stesso. Tuttavia, una delle
maggiori caratteristiche del processing framework è che può utilizzare algoritmi di applicazioni esterne ed estendere
le possibilità di tali applicazioni. Tali algoritmi sono impacchettati e inclusi nel toolbox, in modo da poterli usare
facilmente da QGIS, e utilizzare i dati di QGIS per eseguirli.
Alcuni degli algoritmi che vedi nella vista semplificata richiedono applicazioni di terze parti da installare nel tuo
sistema. Un fornitore di algoritmi di particolare interesse è SAGA (System for Automated Geospatial Analysis).
Per prima cosa, dobbiamo configurare tutto in modo che QGIS possa chiamare correttamente SAGA. Questo non
è difficile, ma è importante capire come funziona. Ogni applicazione esterna ha la sua configurazione, e più avanti
in questo stesso manuale parleremo di alcune delle altre, ma SAGA sarà il nostro backend principale, quindi ne
parleremo qui.
Se sei inWindows, il modomigliore per lavorare con algoritmi esterni è quello di installare QGIS usando il programma
di installazione standalone. Si prenderà cura di installare tutte le dipendenze necessarie, incluso SAGA, quindi se lo
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avete usato, non c’è altro da fare. Puoi aprire la finestra delle impostazioni e andare al gruppo Strumenti di Processing
SAGA.

Il percorso di SAGA dovrebbe essere già configurato e puntare alla cartella dove è installato SAGA.
Se hai installato QGIS non usando il programma di installazione standalone, allora lì devi inserire il percorso della
tua installazione di SAGA (che devi aver installato separatamente). La versione richiesta è SAGA 2.1 [questo cambia
a seconda delle versioni di SAGA].
Se stai usando Linux, non devi impostare il percorso della tua installazione di SAGA nella configurazione di
processing. Invece, devi installare SAGA e assicurarti che la cartella SAGA sia in PATH, in modo che possa essere
chiamata dalla console (basta aprire una console e digitare saga_cmd per controllare). Sotto Linux, la versione di
destinazione per SAGA è anche la 2.1, ma in alcune installazioni (come l’OSGeo Live DVD) potresti avere solo la
2.0.8 disponibile. Ci sono alcuni pacchetti 2.1 disponibili, ma non sono comunemente installati e potrebbero avere
alcuni problemi, quindi se preferisci usare la più comune e stabile 2.0.8, puoi farlo abilitando la compatibilità 2.0.8
nella finestra di configurazione, sotto il gruppo SAGA.
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Una volta che SAGA è installato, puoi lanciare un algoritmo SAGA facendo doppio clic sul suo nome, come con
qualsiasi altro algoritmo. Dato che stiamo usando l’interfaccia semplificata, non sai quali algoritmi sono basati
su SAGA o in un’altra applicazione esterna, ma se ti capita di fare doppio clic su uno di essi e l’applicazione
corrispondente non è installata, vedrai qualcosa come questo.

Nel nostro caso, e supponendo che SAGA sia installato e configurato correttamente, non dovresti vedere questa
finestra, e arriverai invece alla finestra di dialogo dei parametri.
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Proviamo con un algoritmo basato su SAGA, quello chiamato Split shapes layer randomly.

Usa come input il layer puntuale nel progetto corrispondente a questa lezione, e i valori dei parametri di default, e
otterrai qualcosa di simile a questo (la divisione è casuale, quindi il tuo risultato potrebbe essere diverso).

Il layer in ingresso è stato diviso in due layer, ognuno con lo stesso numero di punti. Questo risultato è stato calcolato
da SAGA, e poi preso da QGIS e aggiunto al progetto QGIS.
Se tutto va bene, non noterai alcuna differenza tra questo algoritmo basato su SAGA e uno degli altri che abbiamo
eseguito in precedenza. Tuttavia, SAGA potrebbe, per qualche ragione, non essere in grado di produrre un risultato
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e non generare il file che QGIS si aspetta. In questo caso, ci saranno problemi nell’aggiungere il risultato al progetto
QGIS, e verrà mostrato un messaggio di errore come questo.

Questo tipo di problemi può accadere, anche se SAGA (o qualsiasi altra applicazione che stiamo chiamando dal
framework di elaborazione) è installato correttamente, ed è importante sapere come affrontarli. Produciamo uno di
questi messaggi di errore.
Apri l’algoritmo Creare reticoli e usa i seguenti valori.
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Stiamo usando valori di larghezza e altezza maggiori dell’estensione specificata, quindi SAGA non può produrre alcun
output. In altre parole, i valori dei parametri sono sbagliati, ma non vengono controllati finché SAGA non li riceve
e cerca di creare il reticolo. Poiché non può crearlo, non produrrà il layer previsto, e vedrai il messaggio di errore
mostrato sopra.

Nota: In SAGA >= 2.2.3, il comando regolerà automaticamente i dati di ingresso errati, quindi non avrai un errore.
Per provocare un errore, usa valori negativi per la divisione.

Capire questo tipo di problemi ti aiuterà a risolverli e a trovare una spiegazione a ciò che sta accadendo. Come
puoi vedere nel messaggio di errore, viene eseguito un test per controllare che la connessione con SAGA funzioni
correttamente, indicandoti che potrebbe esserci un problema nel modo in cui l’algoritmo è stato eseguito. Questo vale
non solo per SAGA, ma anche per altre applicazioni esterne.
Nella prossima lezione introdurremo il log di processing, dove sono conservate le informazioni sui comandi eseguiti
da geoalgoritmi, e vedrai come ottenere maggiori dettagli quando appaiono problemi come questo.
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17.9 Il log di processing

Nota: Questa lezione descrive il log di processing.

Tutte le analisi eseguite con il framework di processing sono registrate nel sistema di log di QGIS. Questo permette
di sapere di più su ciò che è stato fatto con gli strumenti di processing, di risolvere i problemi quando accadono, e
anche di rieseguire operazioni precedenti, dato che il sistema di log implementa anche una certa interattività.
Per aprire il log, clicca sul fumetto in basso a destra, sulla barra di stato di QGIS. Alcuni algoritmi potrebbero lasciare
qui informazioni sulla loro esecuzione. Per esempio, quegli algoritmi che chiamano un’applicazione esterna di solito
registrano il risultato della console di quell’applicazione in questa voce. Se dai un’occhiata, vedrai che il risultato
dell’algoritmo SAGA che abbiamo appena eseguito (e che non è stato eseguito perché i dati in ingresso non erano
corretti) è memorizzato qui.
Questo è utile per capire cosa sta succedendo. Gli utenti avanzati saranno in grado di analizzare il risultato per scoprire
perché l’algoritmo è fallito. Se non sei un utente avanzato, questo sarà utile agli altri per aiutarti a diagnosticare il
problema che stai avendo, che potrebbe essere un problema nell’installazione del software esterno o un problema con
i dati che hai fornito.
Anche se l’algoritmo potrebbe essere eseguito, alcuni algoritmi potrebbero lasciare degli avvisi nel caso in cui il
risultato potrebbe non essere corretto. Per esempio, quando si esegue un algoritmo di interpolazione con una quantità
molto piccola di punti, l’algoritmo può essere eseguito e produrrà un risultato, ma è probabile che non sia corretto,
poiché dovrebbero essere usati più punti. È una buona idea controllare regolarmente questo tipo di avvisi se non si è
sicuri di qualche aspetto di un dato algoritmo.
Dal menu Processing, sotto la sezione Storico, troverai Algoritmi. Tutti gli algoritmi che vengono eseguiti, anche
se vengono eseguiti dalla GUI e non dalla console (cosa che verrà spiegata più avanti in questo manuale) vengono
memorizzati in questa sezione come una chiamata da console. Ciò significa che ogni volta che si esegue un algoritmo,
un comando da console viene aggiunto al log, e si ha la storia completa della propria sessione di lavoro. Ecco come
appare questo storico:
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Questo può essere molto utile quando si inizia a lavorare con la console, per imparare la sintassi degli algoritmi. Lo
useremo quando parleremo di come eseguire comandi di analisi dalla console.
Lo storico è anche interattivo, e si può rieseguire qualsiasi algoritmo precedente semplicemente facendo doppio clic
sulla sua voce. Questo è un modo semplice per replicare il lavoro che abbiamo già fatto prima.
Per esempio, prova quanto segue. Apri i dati corrispondenti al primo capitolo di questo manuale ed esegui l’algoritmo
ivi spiegato. Ora vai alla finestra di dialogo dei log e individua l’ultimo algoritmo nella lista, che corrisponde
all’algoritmo che hai appena eseguito. Fai doppio clic su di esso e dovrebbe essere prodotto un nuovo risultato, proprio
come quando lo esegui usando la finestra di dialogo normale e chiamandolo dalla casella degli strumenti.

17.9.1 Livello avanzato

Puoi anchemodificare l’algoritmo. Basta copiarlo, aprire laPlugins►Python console, cliccare su Import class► Import
Processing class, quindi incollarlo per eseguire nuovamente l’analisi; cambiare il testo a piacere. Per visualizzare il file
risultante, digitaiface.addVectorLayer('/path/filename.shp', 'Layer name in legend',
'ogr'). Altrimenti, puoi usare processing.runandload.
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17.10 Il calcolatore raster. Valori no-data

Nota: In questa lezione vedremo come usare il calcolatore raster per eseguire alcune operazioni sui layer raster.
Spiegheremo anche cosa sono i valori no-data e come il calcolatore e altri algoritmi li trattano

Il calcolatore raster è uno degli algoritmi più potenti che puoi trovare. È un algoritmo molto flessibile e versatile che
può essere usato per molti calcoli diversi, e che diventerà presto una parte importante della tua cassetta degli attrezzi.
In questa lezione eseguiremo alcuni calcoli con il calcolatore raster, la maggior parte dei quali sono piuttosto semplici.
Questo ci permetterà di vedere come viene utilizzato e come affronta alcune situazioni particolari che potrebbe
trovare. Capire questo è importante per ottenere in seguito i risultati attesi quando si usa il calcolatore, e anche
per capire alcune tecniche che vengono comunemente applicate con esso.
Apri il progetto QGIS corrispondente a questa lezione e vedrai che contiene diversi layer raster.
Ora apri la cassetta degli strumenti e apri la finestra di dialogo corrispondente al calcolatore raster.

Nota: L’interfaccia è diversa nelle versioni più recenti.

La finestra di dialogo contiene 2 parametri.
• I layer da utilizzare per l’analisi. Si tratta di un input multiplo, il che significa che è puoi selezionare tutti i layer
che vuoi. Fai clic sul pulsante a destra e seleziona i layer che vuoi usare nella finestra di dialogo che apparirà.

• La formula da applicare. La formula utilizza i layer selezionati nel paragrafo precedente, denominati con lettere
dell’alfabeto (a, b, c...) o g1, g2, g3... come nomi di variabili. In altre parole, la formula a +
2 * b è uguale a g1 + 2 * g2 e calcolerà la somma del valore del primo layer più due volte il valore del
secondo layer. L’ordine dei layer è lo stesso che si vede nella finestra di dialogo di selezione.
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Avvertimento: Il calcolatore è sensibile alle maiuscole e alle minuscole.

Per cominciare, cambieremo le unità di misura del DEM da metri a piedi. La formula necessaria è la seguente:

h' = h * 3.28084

Seleziona il DEM nel campo dei layer e digita a * 3,28084 nel campo della formula.

Avvertimento: Per gli utenti non inglesi: usare sempre «.», non «,».

Fai clic su Esegui per eseguire l’algoritmo. Si otterrà un layer che ha lo stesso aspetto del layer in ingresso, ma con
valori diversi. Il layer in ingresso che abbiamo utilizzato ha valori validi in tutte le sue celle, quindi l’ultimo parametro
non ha alcun effetto.
Eseguiamo ora un altro calcolo, questa volta sul layer accflow. Questo layer contiene i valori del flusso accumulato,
un parametro idrologico. Contiene tali valori solo all’interno dell’area di un determinato bacino idrografico, senza
valori al di fuori di esso. Come si può vedere, la visualizzazione non è molto informativa, a causa del modo in cui
i valori sono distribuiti. Utilizzando il logaritmo dell’accumulo di flusso si otterrà una rappresentazione molto più
significativa. È possibile calcolarlo utilizzando il calcolatore di raster.
Apri nuovamente la finestra di dialogo dell’algoritmo, seleziona il layer accflow come unico layer in ingresso e inserisci
la seguente formula: log(a).
Ecco il layer che otterrai.

Se si selezioni lo strumento Informazioni elementi per conoscere il valore di un layer in un determinato punto, seleziona
il layer appena creato e fai clic su un punto all’esterno del bacino, vedrai che contiene un valore senza dati.
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Per il prossimo esercizio utilizzeremo due layer invece di uno e otterremo un DEM con valori di elevazione validi
solo all’interno del bacino definito nel secondo layer. Apri la finestra di dialogo del calcolatore e seleziona entrambi i
layer del progetto nel campo dei layer in ingresso. Inserisci la seguente formula nel campo corrispondente:

a/a * b

a'' si riferisce a layer di flusso accumulato (poiché è il primo a comparire
nell'elenco) e ``b'' si riferisce al DEM. La prima parte della formula consiste
nel dividere il layer di flusso accumulato per se stesso, ottenendo così un
valore di 1 all'interno del bacino e un valore senza dati all'esterno. Poi
si moltiplica per il DEM, per ottenere il valore di elevazione nelle celle
all'interno del bacino (``DEM * 1 = DEM) e il valore senza dati all’esterno (DEM * no_data =
no_data).
Ecco il layer risultante.
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Questa tecnica è usata frequentemente per realizzare una maschera sui valori in un layer raster ed è utile quando
vuoi eseguire calcoli per una regione diversa da una mascheratura rettangolare arbitraria usata dal layer raster. Ad
esempio, un istogramma di elevazione di un layer raster non ha molto significato. Se invece viene calcolato utilizzando
solo i valori corrispondenti a un bacino (come nel caso precedente), il risultato che si ottiene è significativo e fornisce
informazioni sulla configurazione del bacino.
Ci sono altre cose interessanti in questo algoritmo che abbiamo appena eseguito, a parte i valori senza dati e il modo
in cui vengono gestiti. Se osservi le estensioni dei layer che abbiamo moltiplicato (puoi farlo facendo doppio clic sui
nomi dei layer nell’indice e guardando le loro proprietà), vedrai che non sono uguali, poiché l’estensione coperta dal
layer di accumulo del flusso è più piccola dell’estensione del DEM completo.
Ciò significa che questi layer non corrispondono e che non possono essere moltiplicati direttamente senza
omogeneizzare le dimensioni e le estensioni ricampionando uno o entrambi i layer. Tuttavia, non abbiamo fatto nulla.
QGIS si occupa di questa situazione e ricampiona automaticamente i layer in ingresso quando necessario. L’estensione
in uscita è l’estensione minima di copertura calcolata dai layer in ingresso e la dimensione minima delle loro celle.
In questo caso (e nella maggior parte dei casi), si ottengono i risultati desiderati, ma è necessario essere sempre
consapevoli delle operazioni aggiuntive che si stanno svolgendo, poiché potrebbero influenzare il risultato. Nei casi
in cui questo comportamento potrebbe non essere quello desiderato, è necessario applicare preventivamente un
ricampionamento manuale. Nei capitoli successivi, vedremo meglio il comportamento degli algoritmi quando si
utilizzano più layer raster.
Concludiamo questa lezione con un altro esercizio di mascheramento. Calcoleremo la pendenza in tutte le aree con
una elevazione compresa tra 1000 e 1500 metri.
In questo caso, non abbiamo un layer da usare come maschera, ma possiamo crearlo usando il calcolatore.
Utilizza il calcolatore utilizzando il DEM come unico layer in ingresso e la seguente formula

ifelse(abs(a-1250) < 250, 1, 0/0)

Come puoi vedere, possiamo usare il calcolatore non solo per fare semplici operazioni algebriche, ma anche per
eseguire calcoli più complessi che coinvolgono frasi condizionali, come quella sopra.
Il risultato ha un valore di 1 all’interno dell’intervallo con cui vogliamo lavorare e nessun dato nelle celle al di fuori
di esso.

Il valore no-data proviene dall’espressione 0/0. Poiché si tratta di un valore indeterminato, SAGA aggiungerà un
valore NaN (Not a Number), che viene effettivamente gestito come un valore senza dati. Con questo piccolo trucco
puoi impostare un valore senza dati senza dover conoscere il valore senza dati della cella.
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Ora devi solamente moltiplicarlo per il layer di pendenza incluso nel progetto e otterrai il risultato desiderato.
Tutto ciò può essere fatto in un’unica operazione con il calcolatore. Lo lasciamo come esercizio per il lettore.

17.11 Calcolatore Campi per i Vettori

Nota: In questa lezione vedremo come aggiungere nuovi attributi ad un layer vettoriale basato su un’espressione
matematica, usando il calcolatore campi per i vettori.

Sappiamo già come usare il calcolatore raster per creare nuovi layer raster usando espressioni matematiche. Un
algoritmo simile è disponibile per i layer vettoriali e genera un nuovo layer con gli stessi attributi del layer in ingresso,
più uno aggiuntivo con il risultato dell’espressione inserita. L’algoritmo si chiama Calcolatore Campi e ha la seguente
finestra di dialogo dei parametri.

Nota: Nelle versioni più recenti di Processing l’interfaccia è cambiata considerevolmente, è più potente e più facile
da usare.

Ecco alcuni esempi di utilizzo di questo algoritmo.
Per prima cosa, calcoliamo la densità di popolazione bianca in ogni poligono, che rappresenta un censimento. Abbiamo
due campi nella tabella degli attributi che possiamo usare per questo, cioè WHITE e SHAPE_AREA. Dobbiamo solo
dividerli e moltiplicarli per un milione (per avere la densità per km quadrato), quindi possiamo usare la seguente
formula nel campo corrispondente
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( "WHITE" / "SHAPE_AREA" ) * 1000000

La finestra di dialogo dei parametri dovrebbe essere riempita come mostrato qui sotto.

Questo genererà un nuovo campo chiamato WHITE_DENS.
Ora calcoliamo il rapporto tra i campi MALES e FEMALES per crearne uno nuovo che indichi se la popolazione
maschile è numericamente predominante su quella femminile.
Inserisci la seguente formula

"MALES" / "FEMALES"

Questa volta la finestra di dialogo dei parametri dovrebbe assomigliare a questa prima di premere il pulsante OK.
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Nella versione precedente, poiché entrambi i campi sono di tipo intero, il risultato sarebbe troncato a un intero. In
questo caso la formula dovrebbe essere: 1.0 * "MALES" / "FEMALES", per indicare che vogliamo un risultato
in virgola mobile.
Possiamo usare le funzioni condizionali per avere un nuovo campo con stringhe di testo male o female al posto
di quei valori di rapporto, usando la seguente formula:

CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END

La finestra di dialogo dei parametri dovrebbe assomigliare a questa.
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Un calcolatore di campi python è disponibile nel Calcolatore di campi Python avanzato, che non sarà dettagliato qui
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17.12 Definire le estensioni

Nota: In questa lezione vedremo come definire le estensioni, che sono necessarie per alcuni algoritmi, specialmente
quelli raster.

Alcuni algoritmi richiedono un’estensione per definire l’area che deve essere trattata dall’analisi che eseguono, e di
solito per definire l’estensione del layer risultante.
Quando un’estensione è necessaria, può essere definita manualmente inserendo i quattro valori che la definiscono (min
X, min Y, max X, max Y), ma ci sono anche altri modi più pratici e più interessanti per farlo. Li vedremo tutti in
questa lezione.
Per prima cosa, apriamo un algoritmo che richiede la definizione di un’estensione. Apriamo l’algoritmo Rasterizzare
(da vettore a raster), che crea un layer raster da un layer vettoriale.
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Tutti i parametri, eccetto gli ultimi due, sono usati per definire quale layer deve essere rasterizzato, e configurare come
il processo di rasterizzazione dovrebbe funzionare. Gli ultimi due parametri, invece, definiscono le caratteristiche del
layer in uscita. Ciò significa che definiscono l’area coperta (che non è necessariamente la stessa area coperta dal layer
vettoriale in ingresso), e la risoluzione/dimensione delle celle (che non può essere dedotta dal layer vettoriale, poiché
i layer vettoriali non hanno una dimensione delle celle).
La prima cosa da fare è digitare i 4 valori di definizione spiegati prima, separati da virgole.

Questo non ha bisogno di ulteriori spiegazioni. Mentre questa è l’opzione più flessibile, è anche la meno pratica in
alcuni casi, ed è per questo che sono state implementate altre opzioni. Per accedervi, dovete cliccare sul pulsante a
destra della casella di testo dell’estensione.

Vediamo cosa fa ognuno di loro.
La prima opzione è Usa l’estensione della mappa, che mostrerà la finestra di dialogo di selezione mostrata qui sotto.
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Qui puoi selezionare l’estensione della mappa (l’estensione coperta dallo zoom corrente), o l’estensione di uno qualsiasi
dei layer disponibili. Selezionalo e clicca su OK, e la casella di testo sarà automaticamente riempita con i valori
corrispondenti.
La seconda opzione è Select extent on canvas. In questo caso, la finestra di dialogo dell’algoritmo scompare e si può
cliccare e trascinare sulla tela QGIS per definire l’estensione desiderata.

Una volta che rilasci il pulsante del mouse, la finestra di dialogo riapparirà e la casella di testo avrà già i valori
corrispondenti all’estensione definita.
L’ultima opzione èUse min covering extent from input layers, che è l’opzione predefinita. Questa calcolerà l’estensione
minima di copertura di tutti i layer usati per eseguire l’algoritmo, e non c’è bisogno di inserire alcun valore nella casella
di testo. Nel caso di un singolo layer in ingresso, come nell’algoritmo che stiamo eseguendo, la stessa estensione può
essere ottenuta selezionando quello stesso layer in ingresso nel campoCalcola da layer che abbiamo già visto. Tuttavia,
quando ci sono più layer in ingresso, l’estensione minima di copertura non corrisponde a nessuna delle estensioni dei
layer in ingresso, poiché viene calcolata da tutti loro insieme.
Useremo quest’ultimo metodo per eseguire il nostro algoritmo di rasterizzazione.
Riempi la finestra di dialogo dei parametri come mostrato di seguito, e premi OK.
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Nota: In questo caso, meglio usare un Integer (1 byte) invece di un Floating point (4 byte), poiché il NOME è un
intero con valore massimo=64. Questo si tradurrà in una dimensione minore del file e in calcoli più veloci.

Otterrai un layer rasterizzato che copre esattamente l’area coperta dal layer vettoriale originale.
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In alcuni casi, l’ultima opzione, Calcola da layer, potrebbe non essere disponibile. Questo accadrà in quegli algoritmi
che non hanno layer in ingresso, ma solo parametri di altro tipo. In questo caso, dovrai inserire il valore manualmente
o usare una delle altre opzioni.
Nota che, quando esiste una selezione, l’estensione del layer è quella dell’intero insieme di elementi, e la selezione
non viene usata per calcolare l’estensione, anche se la rasterizzazione viene eseguita solo sugli elementi selezionati.
In questo caso, si potrebbe voler creare effettivamente un nuovo layer dalla selezione, e poi usarlo come input.

17.13 Risultati HTML

Nota: In questa lezione impareremo come QGIS maneggia i risultati nel formato HTML, i quali sono utilizzati per
produrre risultati di testo e grafici.

Tutti i risultati che abbiamo prodotto finora erano layer (raster o vettori). Ad ogni modo, alcuni algoritmi generano
risultati sotto forma di testo e di grafici. Tutti questi risultati sono contenuti in file HTML e mostrati nel cosiddetto
Visualizzatore risultati, che è un altro elemento dell’ambiente Processing.
Vediamo uno di questi algoritmi per capire come funzionano.
Apri il progetto con il dati da utilizzare in questa lezione e poi avvia l’algoritmo Statistiche di base per campi numerici.
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L’algoritmo è piuttosto semplice e tu devi solo selezionare il vettore da utilizzare e uno dei suoi campi (un campo
numerico). Il risultato è del tipo HTML, ma il riquadro corrispondente funziona esattamente come quello che puoi
trovare nel caso di un risultato del tipo raster o vettore. Puoi inserire un percorso file o lasciarlo in bianco per salvare
un file temporaneo. In questo caso, comunque, solo le estensioni html e htm sono permesse, per cui non è possibile
alterare il formato del risultato usandone un’altra.
Esegui l’algoritmo selezionando in ingresso l’unico vettore nel progetto e il campo POP2000, e apparirà una nuova
finestra di dialogo come quella mostrata di seguito una volta che l’algoritmo è stato eseguito e la finestra di dialogo
dei parametri è stata chiusa.
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Questo è il Visualizzatore risultati. Esso contiene tutti i risultati HTML generati durante la sessione corrente,
facilmente accessibili, per cui puoi controllarli rapidamente qualora ne avessi bisogno. Così come succede per i vettori,
se hai salvato il risultato in un file temporaneo, esso sarà cancellato una volta chiuso QGIS. Se lo hai salvato in un
percorso non temporaneo, il file continuerà ad esistere, ma non apparirà più nel Visualizzatore risultati la prossima
volta che aprirai QGIS.
Alcuni algoritmi generano testo che non può essere suddiviso in altri output più dettagliati. È il caso, ad esempio,
dell’algoritmo che cattura il testo in uscita da un processo esterno. In altri casi, l’output viene presentato come testo,
ma internamente è suddiviso in diversi output più piccoli, solitamente sotto forma di valori numerici. L’algoritmo
appena eseguito è uno di questi. Ciascuno di questi valori viene gestito come un singolo output e memorizzato in una
variabile. Questo non ha alcuna importanza ora, ma quando passeremo alla progettazione del modello, vedrai che ti
permetterà di usare questi valori come input numerici per altri algoritmi.
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17.14 Primo esempio di analisi

Nota: In questa lezione eseguiremo alcune analisi reali usando solo il toolbox, in modo che possiate acquisire
maggiore familiarità con gli elementi del framework di processing.

Ora che tutto è configurato e possiamo usare algoritmi esterni, abbiamo uno strumento molto potente per eseguire
analisi spaziali. È il momento di fare un esercizio più ampio con alcuni dati del mondo reale.
Useremo il ben noto set di dati che John Snow usò nel 1854, nel suo lavoro rivoluzionario (https://en.wikipedia.
org/wiki/John_Snow_%28physician%29), e otterremo alcuni risultati interessanti. L’analisi di questo set di dati è
abbastanza ovvia e non c’è bisogno di sofisticate tecniche GIS per finire con buoni risultati e conclusioni, ma è un
buonmodo per mostrare come questi problemi spaziali possono essere analizzati e risolti utilizzando diversi strumenti
di processing.
Il set di dati contiene shapefile con le morti di colera e le posizioni delle fontanelle, e una mappa visualizzata da OSM
in formato TIFF. Apri il progetto QGIS corrispondente a questa lezione.

La prima cosa da fare è calcolare il diagramma di Voronoi (ovvero i poligoni di Thiessen) del layer delle fontanelle,
per ottenere la zona di influenza di ogni fontanella. L’algoritmo Voronoi Diagram può essere usato per questo.
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Piuttosto semplice, ma ci darà già informazioni interessanti.
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È evidente che la maggior parte dei casi si trova all’interno di uno dei poligoni
Per ottenere un risultato più quantitativo, possiamo contare il numero di morti in ogni poligono. Poiché ogni punto
rappresenta un edificio in cui si sono verificati dei decessi, e il numero di morti è memorizzato in un attributo, non
possiamo semplicemente contare i punti. Abbiamo bisogno di un conteggio ponderato, quindi useremo lo strumento
Conta i punti nel poligono (pesato).
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Il nuovo campo sarà chiamatoDEATHS, e usiamo il campoCOUNT come campo di ponderazione. La tabella risultante
riflette chiaramente che il numero di morti nel poligono corrispondente alla prima fontanella è molto più elevato degli
altri.
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Un altro buon modo di visualizzare la dipendenza di ogni punto nel layer Cholera_deaths con un punto nel
layer Pumps è di tracciare una linea verso il più vicino. Questo può essere fatto con lo strumento Distanza dal punto
centrale più vicino, e usando la configurazione mostrata qui di seguito.
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Il risultato si presenta così:
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Anche se il numero di linee è più grande nel caso della fontanella centrale, non bisogna dimenticare che questo
non rappresenta il numero di morti, ma il numero di località dove sono stati trovati casi di colera. È un parametro
rappresentativo, ma non considera che alcune località potrebbero avere più casi di altre.
Un layer di densità ci darà anche una visione molto chiara di ciò che sta accadendo. Possiamo crearlo con l’algoritmo
Mappa di concentrazione (Stima Densità Kernel). Usando il layer Cholera_deaths, il suo campo COUNT come campo
peso, con un raggio di 100, l’estensione e la dimensione delle celle del layer raster streets, otteniamo qualcosa del
genere.
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Ricorda che, per ottenere l’estensione dell’output, non è necessario digitarla. Clicca sul pulsante a destra e seleziona
Usa l’estensione del layer/mappa.
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Seleziona il layer raster delle strade e la sua estensione sarà automaticamente aggiunta al campo di testo. Devi fare lo
stesso con la dimensione della cella, selezionando anche la dimensione della cella di quel layer.
Combinando con lo strato delle fontanelle, vediamo che c’è una fontanella chiaramente nell’hotspot dove si trova la
massima densità di casi di morte.

17.15 Tagliare e unire raster

Nota: In questa lezione vedremo un altro esempio di preparazione di dati spaziali, per continuare a utilizzare
geoalgoritmi in scenari reali.

Per questa lezione, andremo a calcolare un raster delle pendenze per una zona intorno a un’area cittadina, che è fornita
in un vettore costituito da un singolo poligono. Il DEM di base è diviso in due raster che, insieme, coprono un’area
molto più estesa di quella attorno alla città con cui vogliamo lavorare. Se apri il progetto corrispondente a questa
lezione, vedrai qualcosa del genere.
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Questi raster hanno due problemi:
• Coprono un’area che troppo estesa per i nostri scopi (ci interessa solo una zona più piccola intorno al centro
cittadino)

• Si trovano in due file diversi (i confini cittadini si trovano all’interno di un solo raster, ma, come si è già detto,
vogliamo avere dello spazio aggiuntivo attorno ad esso).

Entrambi i problemi sono facilmente risolvibili con i geoalgoritmi appropriati.
Innanzitutto, creiamo un rettangolo che definisca l’area di cui abbiamo bisogno. Per fare ciò, creiamo un vettore
contenente il perimetro di delimitazione del vettore con i confini dell’area cittadina, e in seguito eseguiamo un buffer
su di esso, in modo da avere un raster che si estenda un po” oltre lo spazio minimo necessario.
Per il calcolare il perimetro di delimitazione, possiamo usare l’algoritmo Poligono dall’estensione del layer
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Per eseguire il buffer, usiamo l’algoritmo Buffer a distanza fissa, con i seguenti parametri.
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Avvertimento: La sintassi è cambiata nelle ultime versioni; imposta .25 sia per Distanza che per Vertice dell’arco.

Ecco il perimetro di delimitazione risultante ottenuto utilizzando i parametri sopra mostrati.

Si tratta di un riquadro arrotondato, ma possiamo ottenere facilmente il riquadro equivalente con angoli retti
eseguendo l’algoritmo Poligono dall’estensione del layer su di esso. Avremmo potuto eseguire prima il buffer sui
confini della città, e dopo calcolare il rettangolo dell’estensione, risparmiando un passaggio.

Noterai che i raster hanno una proiezione differente rispetto al vettore. Dovremmo pertanto riproiettarli prima di
procedere oltre, utilizzando lo strumento Riproiezione.
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Nota: Le ultime versioni hanno un’interfaccia più complessa. Assicurati che sia selezionato almeno un metodo di
compressione.

Con questo vettore che contiene il perimetro di delimitazione del raster che vogliamo ottenere, possiamo tagliare
entrambi i raster, utilizzando l’algoritmo Taglia raster con poligono.
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Una volta che i layer sono stati ritagliati, possono essere uniti usando l’algoritmo SAGA Mosaic raster layers.
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Nota: Puoi risparmiare del tempo prima unendo e poi tagliando, evitando di richiamare due volte l’algoritmo di
ritaglio. Comunque, se ci sono diversi raster da unire ed essi hanno una dimensione piuttosto elevata, otterrai un raster
esteso che sarà successivamente difficile da procesare. In tal caso, potrebbe essere necessario lanciare l’algoritmo di
ritaglio diverse volte, il che potrebbe essere dispendioso in termini di tempo, ma non preoccuparti, presto vedremo
che esistono strumenti aggiuntivi per automatizzare tale operazione. In questo esempio abbiamo solo due raster, per
cui al momento non dovresti preoccuparti di ciò.

Così facendo, otteniamo il DEM finale desiderato.

Adesso è il momento di creare il raster delle pendenze.
Un raster delle pendenze può essere calcolato con l’algoritmo **Pendenza, Esposizione, Curvatura*, ma il DEM
ottenuto nell’ultimo passaggio non è adatto come file di ingresso, dal momento che i valori di elevazione sono in metri
ma la dimensione della cella non è espressa inmetri (il raster utilizza un CRS con coordinate geografiche). È necessaria
una riproiezione. Per riproiettare un raster, si può utilizzare nuovamente l’algoritmo Riproiezione. Eseguiamo la
riproiezione in un CRS avente i metri come unità (ad es. 3857), in modo da poter calcolare correttamente la pendenza,
con SAGA o GDAL.
Con il nuovo DEM, la pendenza può essere ora calcolata.
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E questo è il raster delle pendenze risultante.

584 Capitolo 17. La guida di Processing di QGIS



QGIS Training Manual

La pendenza generata dall’algoritmo Pendenza, Esposizione, Curvatura può essere espressa in gradi o radianti; i gradi
sono più pratici ed unità di misura comuni. Nel caso in cui l’avessi calcolata in radianti, l’algoritmo Conversioni
metriche ci verrà in aiuto per eseguire la conversione (ma qualora non avessi saputo dell’esistenza dell’algoritmo,
avresti potuto usare il calcolatore raster che abbiamo già utilizzato).
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Riproiettato il raster delle pendenze convertito con lo strumento Riproietta raster, otteniamo il raster finale desiderato.

Avvertimento: da fare: Aggiungi immagine

I processi di riproiezione potrebbero aver fatto in modo che il raster finale contenga alcuni dati al di fuori del perimetro
di delimitazione che avevamo calcolato in uno dei passaggi iniziali. Questo può essere risolto tagliandolo di nuovo,
così come abbiamo fatto per ottenere il DEM di base.

17.16 Analisi idrologica

Nota: In questa lezione eseguiremo alcune analisi idrologiche. Questa analisi verrá usata in alcune delle prossime
lezioni, dato che costituisce un buon esempio di flusso di lavoro per l’analisi, e verrá utilizzata per dimostrare alcune
funzionalitá avanzate.

Obiettivi: Partendo da unDEM, estrarremo una rete di incanalature, delineeremo gli spartiacque e elaboreremo alcune
statistiche.

1. La prima cosa da fare é caricare il progetto con i dati della lezione, che contengono il DEM.
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2. Il primo modulo da eseguire è Area di raccolta (in alcune versioni di SAGA si chiama Accumulo di flusso (Top
Down)). Puoi utilizzare uno qualsiasi degli altri moduli denominato Area di cattura. Gli algoritmi sottostanti
sono diversi, ma i risultati sono sostanzialmente gli stessi.

3. Seleziona il DEM nel campo Elevation e lascia i valori predefiniti per il resto dei parametri.
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Alcuni algoritmi calcolano molti layer, ma il layer Area di raccolta è l’unico che utilizzeremo. Se vuoi puoi
eliminare gli altri.
La visualizzazione del layer non é molto informativa.
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Per sapere perché, si può dare un’occhiata all’istogramma e si vedrà che i valori non sono distribuiti in modo
uniforme (ci sono alcune celle con valori molto alti, quelle corrispondenti alla rete di canali). Utilizzando
l’algoritmo Raster calculator per calcolare il logaritmo dell’area del valore del bacino idrografico, si otterrà un
layer con molte più informazioni.
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4. L’area di raccolta (nota anche come accumulo di flusso) può essere utilizzata per stabilire una soglia per l’inizio
del canale. Questo può essere fatto usando l’algoritmo Channel network.

• Initiation grid: utilizza il layer del bacino idrografico e non quello del logaritmo.
• Initiation threshold: 10.000.000
• Initiation type: Greater than

Se aumenti il valore di Initiation threshold, otterrai una rete di canali più rada. Se lo diminuisci, otterrai una
rete più densa. Con il valore proposto, questo è il tuo risultato.
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L’immagine qui sopra mostra solo il layer vettoriale risultante e il DEM, ma dovrebbe esserci anche un layer
raster con la stessa rete di canali. Questo raster sarà, infatti, il layer che utilizzeremo.

5. Ora useremo l’algoritmo Watersheds basins per delineare i sottobacini corrispondenti a quella rete di canali,
usando come punti di uscita tutte le giunzioni in essa presenti. Ecco come impostare la finestra di dialogo dei
parametri corrispondenti.
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E questo é il risultato.
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6. Questo è un risultato raster. Puoi vettorializzarlo utilizzando l’algoritmo Vectorising Raster Classes.
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Si calcolino adesso le statistiche dei valori di elevazione in uno dei sottobacini. L’idea é quella di avere un layer che
rappresenti l’elevazione nei sottobacini e quindi passarlo al modulo che calcola tali statistiche.

1. Per prima cosa, agganciamo il DEM originale con il poligono che rappresenta un sottobacino. Utilizzeremo
l’algoritmoClip Raster with Polygon. Se si seleziona un singolo poligono del sottobacino e si richiama l’algoritmo
di ritaglio, è possibile ritagliare il DEM nell’area coperta da quel poligono, poiché l’algoritmo è già informato
della selezione.
1. Seleziona un poligono
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2. Richiama l’algoritmo di ritaglio con i seguenti parametri:
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L’elemento selezionato nel campo in ingresso è, ovviamente, il DEM che vogliamo ritagliare.
Si otterrá qualcosa del genere.

2. Questo layer è pronto per essere usato nell’algoritmo Statistiche dei layer raster.
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Di seguito le statistiche risultanti.

Utilizzeremo sia la procedura per il calcolo del bacino che il calcolo delle statistiche in altre lezioni, per trovare altri
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elementi che ci possano aiutare ad autmatizzarli e lavorare in modo piú efficiente.

17.17 Per iniziare con il modellatore grafico

Nota: In questa lezione useremo il modellatore grafico, un potente componente che possiamo usare per definire un
flusso di lavoro ed eseguire una concatenazione di algoritmi.

Una normale sessione con gli strumenti di processing include più dell’esecuzione di un singolo algoritmo. Di solito
ne vengono eseguiti diversi per ottenere un risultato, e gli output di alcuni di questi algoritmi vengono utilizzati come
input per alcuni degli altri.
Usando il modellatore grafico, quel flusso di lavoro può essere messo in un modello, che eseguirà tutti gli algoritmi
necessari in una sola esecuzione, semplificando così l’intero processo e automatizzandolo.
Per iniziare questa lezione, calcoleremo un parametro chiamato Indice di Umidità Topografica. L’algoritmo che lo
calcola si chiama Topographic wetness index (twi).

Come puoi vedere, ci sono due input obbligatori: Slope e Catchment area. C’è anche un input opzionale, ma non lo
useremo, quindi possiamo ignorarlo.
I dati per questa lezione contengono solo un DEM, quindi non abbiamo nessuno degli input richiesti. Tuttavia,
sappiamo come calcolarli entrambi da quel DEM, dato che abbiamo già visto gli algoritmi per calcolare la pendenza
e il bacino idrografico. Quindi possiamo prima calcolare quei layer e poi usarli per l’algoritmo TWI.
Ecco le finestre di dialogo dei parametri che dovresti usare per calcolare i 2 layer intermedi.
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Nota: La pendenza deve essere calcolata in radianti, non in gradi.
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Ed è così che devi impostare la finestra di dialogo dei parametri dell’algoritmo TWI.
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Questo è il risultato che otterrai (per la rappresentazione è stata usata la palette invertita pseudocolor a banda singola
di default). Puoi usare lo stile twi.qml fornito.
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Quello che cercheremo di fare ora è creare un algoritmo che calcoli il TWI da un DEM in un solo step. Questo ci
farà risparmiare lavoro nel caso in cui in seguito dovessimo calcolare un layer TWI da un altro DEM, poiché avremo
bisogno di un solo step per farlo invece dei tre di cui sopra. Tutti i processi di cui abbiamo bisogno si trovano nella
casella degli strumenti, quindi quello che dobbiamo fare è definire il flusso di lavoro per impacchettarli. È qui che
entra in gioco il modellatore grafico.

1. Apri il modellatore selezionando la sua voce nel menu di processing.

Due cose sono fondamentali per creare unmodello: impostare gli input di cui avrà bisogno e definire l’algoritmo
che contiene. Entrambe vengono fatte aggiungendo elementi dalle due schede nella parte sinistra della finestra
del modellatore: Input e Algoritmi.

2. Cominciamo con gli input. In questo caso non abbiamo molto da aggiungere. Abbiamo solo bisogno di un layer
raster con il DEM, e questo sarà il nostro unico dato di input.

3. Fai doppio clic sull’input Raster e vedrai la seguente finestra di dialogo.
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4. Qui dobbiamo definire l’input che vogliamo:
1. Poiché ci aspettiamo che questo layer raster sia un DEM, lo chiameremo DEM. Questo è il nome che

l’utente del modello vedrà quando lo esegue.
2. Dato che abbiamo bisogno di tale layer per funzionare, lo definiremo come un layer obbligatorio.

Ecco come dovrebbe essere configurata la finestra di dialogo.

5. Clicca su OK e l’input apparirà nella finestra del modellatore.

6. Ora passiamo alla scheda Algoritmi.
7. Il primo algoritmo che dobbiamo eseguire è l’algoritmo Slope, Aspect, Curvature. Individualo nella lista degli

algoritmi, fai doppio clic su di esso e vedrai la finestra di dialogo mostrata qui sotto.
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Questa finestra di dialogo è molto simile a quella che si può trovare quando si esegue l’algoritmo dalla casella
degli strumenti, ma l’elemento che si può usare come valore del parametro non è preso dal progetto QGIS
corrente, ma dal modello stesso. Ciò significa che, in questo caso, non avremo tutti i layer raster del nostro
progetto disponibili per il campo Elevation, ma solo quelli definiti nel nostro modello. Poiché abbiamo aggiunto
un solo input raster chiamato DEM, questo sarà l’unico layer raster che vedremo nella lista corrispondente al
parametro Elevation`.
Gli output generati da un algoritmo sono gestiti un po” diversamente quando l’algoritmo è usato come parte di
un modello. Invece di selezionare il percorso del file dove si vuole salvare ogni output, si deve solo specificare
se quell’output è un layer intermedio (e non si vuole che sia conservato dopo che il modello è stato eseguito), o
è uno finale. In questo caso, tutti i layer prodotti da questo algoritmo sono intermedi. Noi ne useremo solo uno
( il layer della pendenza), ma non vogliamo conservarlo, poiché ci serve solo per calcolare il layer TWI, che è
il risultato finale che vogliamo ottenere.
Quando i layer non sono un risultato finale, si dovrebbe semplicemente lasciare il campo corrispondente.
Altrimenti, è necessario inserire un nome che verrà utilizzato per identificare il layer nella finestra di dialogo
dei parametri che verrà mostrata quando si esegue il modello in seguito.

8. Non c’è molto da selezionare in questa prima finestra di dialogo, dato che non abbiamo che un solo layer
nel nostro modello (l’input DEM che abbiamo creato). In realtà, la configurazione predefinita della finestra di
dialogo è quella corretta in questo caso, quindi devi solo premere OK. Questo è ciò che avrai ora nella finestra
del modellatore.
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9. Il secondo algoritmo che dobbiamo aggiungere al nostro modello è l’algoritmo del bacino di raccolta. Useremo
l’algoritmo chiamato Catchment area (Paralell). Useremo di nuovo il layer DEM come input, e nessuno degli
ouput che produce è definitivo, quindi ecco come devi riempire la finestra di dialogo corrispondente.
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Ora il tuo modello dovrebbe assomigliare a questo.
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10. L’ultimo step è quello di aggiungere l’algoritmo Topographic wetness index, con la seguente configurazione.

In questo caso, non useremo il DEM come input, ma invece, useremo i layer della pendenza e del bacino
idrografico che sono calcolati dagli algoritmi che abbiamo aggiunto in precedenza.Manmano che si aggiungono
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nuovi algoritmi, gli output che essi producono diventano disponibili per altri algoritmi, e con essi si collegano
gli algoritmi, creando il flusso di lavoro.

11. In questo caso, il layer di output TWI è un layer finale, quindi dobbiamo indicarlo. Nella casella di testo
corrispondente, inserisci il nome che vuoi che sia mostrato per questo output.
Ora il nostro modello è finito e dovrebbe apparire così.

12. Inserisci un nome e un nome di gruppo nella parte superiore della finestra del modello.

13. Salvalo cliccando sul pulsante :guilabel: Salva. Puoi salvarlo dove vuoi e aprirlo in seguito, ma se lo salvi nella
cartella models (che è la cartella che vedrai quando appare la finestra di dialogo del file di salvataggio), il tuo
modello sarà disponibile anche nella casella degli strumenti. Quindi rimani su quella cartella e salva il modello
con il nome del file che preferisci.

14. Ora chiudi la finestra di dialogo del modellatore e vai alla casella degli strumenti. Nella voce Modellatore
troverai il tuo modello.
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15. Puoi eseguirlo come qualsiasi algoritmo normale, facendo doppio clic su di esso.

Come puoi vedere, la finestra di dialogo dei parametri contiene l’input che hai aggiunto al modello, insieme
agli output che hai impostato come finali quando hai aggiunto gli algoritmi corrispondenti.

16. Eseguilo usando il DEM come input e otterrai il layer TWI in un solo step.
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17.18 Modelli più complessi

Nota: In questa lezione lavoreremo con un modello più complesso nel modellatore.

Il primo modello che abbiamo creato nel capitolo precedente era molto semplice, con un solo input e tre algoritmi.
Si possono creare modelli più complessi, con diversi tipi di input e contenenti più step. In questo capitolo lavoreremo
con un modello che crea un layer vettoriale con gli spartiacque, basato su un DEM e un valore di soglia. Questo sarà
molto utile per calcolare diversi layer vettoriali corrispondenti a diverse soglie, senza dover ripetere ogni singolo step
ogni volta.
Questa lezione non contiene istruzioni su come creare il tuo modello. Conosci già i passi necessari (li abbiamo visti
in una previous lesson) e hai già visto le idee di base sul modellatore, quindi dovresti provare da solo. Passa qualche
minuto cercando di creare il tuo modello, e non preoccuparti di fare errori. Ricorda: prima aggiungi gli input e poi
aggiungi gli algoritmi che li usano per creare il flusso di lavoro.

Nota: Nel caso in cui non sei riuscito a creare il modello completo da solo e hai bisogno di un aiuto extra, la cartella
dei dati corrispondente a questa lezione contiene una versione «quasi» finita di esso. Apri il modellatore e poi apri il
file del modello che troverai nella cartella dei dati. Dovresti vedere qualcosa di simile a questo.

Questo modello contiene tutti i passi necessari per completare il calcolo, ma ha solo un input: il DEM. Ciò significa
che la soglia per la definizione dei canali utilizza un valore fisso, il che rende il modello non così utile come potrebbe
essere. Questo non è un problema, dato che possiamo modificare il modello, ed è esattamente quello che faremo.

1. Per prima cosa, aggiungiamo un input numerico. Questo chiederà all’utente un input numerico che possiamo
usare quando tale valore è necessario in uno qualsiasi degli algoritmi inclusi nel nostro modello.

2. Clicca sulla voce Numero nell’albero Input, e vedrai la finestra di dialogo corrispondente.
3. Compilala con i seguenti valori.

• Parametri: Threshold for channel definition
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• Initiation Treshold: 1,000,000

Ora il tuo modello dovrebbe assomigliare a questo.

L’input che abbiamo appena aggiunto non viene utilizzato, quindi il modello non è effettivamente cambiato.
Dobbiamo collegare quell’input all’algoritmo che lo usa, in questo caso quello della Channel network.
Per modificare un algoritmo che esiste già nel modellatore, basta cliccare sull’icona matita sulla casella
corrispondente nella finestra del modellatore.

4. Clicca sull’algoritmo Channel network e vedrai qualcosa di simile a questo.
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La finestra di dialogo è riempita con i valori correnti usati dall’algoritmo. Puoi vedere che il parametro Initiation
threshold ha un valore fisso di 1.000.000 (questo è anche il valore predefinito dell’algoritmo, ma qualsiasi altro
valore potrebbe essere messo lì). Tuttavia, potresti notare che il parametro non è inserito in una comune casella
di testo, ma in un menu a tendina.

5. Apri il menu dei parametri di soglia e vedrai qualcosa di simile a questo.
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L’input che abbiamo aggiunto è lì e possiamo selezionarlo. Ogni volta che un algoritmo in un modello richiede
un valore numerico, è possibile inserire un valore codificato e digitarlo direttamente, oppure è possibile
utilizzare uno qualsiasi degli input e dei valori disponibili (ricorda che alcuni algoritmi generano valori numerici
singoli. Vedremo più avanti questo aspetto). Nel caso di un parametro stringa, vedrai anche degli input stringa
e potrai selezionarne uno o digitare il valore fisso desiderato.

6. Seleziona l’input Soglia per la definizione del canale nel parametro Initiation threshold.
7. Clicca su OK per applicare le modifiche al tuo modello. Ora il grafico del modello dovrebbe assomigliare a

questo.
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8. Il modello è ora completo. Eseguilo usando il DEM che abbiamo usato nelle lezioni precedenti, e con diversi
valori di soglia.
Di seguito hai un esempio del risultato ottenuto per diversi valori. Puoi confrontare con il risultato per il valore
predefinito, che è quello che abbiamo ottenuto nella hydrological analysis lesson.

Fig. 17.1: Initiation Threshold = 100,000
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Fig. 17.2: Initiation Threshold = 1,0000,000

17.19 Calcoli numerici nel modellatore

Avvertimento: Attenzione, questo capitolo non è completamente testato, per cui segnala qualunque problema;
le immagini sono mancanti

Nota: In questa lezione vedremo come utilizzare gli output numerici nel modellatore

In questa lezione, modificheremo il modello idrologico che abbiamo creato nell’ultimo capitolo (aprilo nel modellatore
prima di iniziare), inmodo da poter automatizzare il calcolo di un valore di soglia valido e non dover chiedere all’utente
di inserirlo. Dato che quel valore si riferisce alla variabile della soglia nello strato raster, lo estrarremo da quel layer,
basandoci su qualche semplice analisi statistica.
Partendo dal suddetto modello, facciamo le seguenti modifiche:
Per prima cosa, calcola le statistiche del layer di accumulazione del flusso usando l’algoritmo Statistiche sui layer
raster.
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Questo genererà un insieme di valori statistici che saranno ora disponibili per tutti i campi numerici in altri algoritmi.
Se modifichi l’algoritmo Channel network, come abbiamo fatto nell’ultima lezione, vedrai ora che hai altre opzioni
oltre all’input numerico che hai aggiunto.
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Tuttavia, nessuno di questi valori è adatto per essere usato come soglia valida, poiché risulterà in reti di canali che
non saranno molto realistiche. Possiamo, invece, derivare qualche nuovo parametro basato su di essi, per ottenere un
risultato migliore. Per esempio, possiamo usare la media più 2 volte la deviazione standard.
Per aggiungere questa operazione aritmetica, possiamo usare il calcolatore che si trova nel gruppo
Geoalgorithms/modeler/modeler-tools. Questo gruppo contiene algoritmi che non sono molto utili al di fuori
del modellatore, ma che forniscono alcune funzionalità utili quando si crea un modello.
La finestra di dialogo dei parametri dell’algoritmo del Calcolatore Raster si presenta così:
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Come puoi vedere, la finestra di dialogo è diversa dalle altre che abbiamo visto, ma ci sono le stesse variabili che
erano disponibili nel campo Initiation Threshold nell’algoritmo Channel network. Inserisci la formula di cui sopra e
clicca su OK per aggiungere l’algoritmo.

Se espandi la voce output, come mostrato sopra, vedrai che il modello è collegato a due dei valori, ovvero la media e
la deviazione standard, che sono quelli che abbiamo usato nella formula.
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L’aggiunta di questo nuovo algoritmo aggiungerà un nuovo valore numerico. Se si passa nuovamente all’algoritmo
Channel network, puoi ora selezionare questo valore nel parametro Initiaton Threshold.

Clicca su OK e il tuo modello dovrebbe apparire come questo.
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Non stiamo utilizzando l’input numerico che abbiamo aggiunto al modello, quindi è possibile rimuoverlo. Fare clic
con il tasto destro del mouse su di esso e selezionare Rimuovi.

Avvertimento: da fare: Aggiungi immagine

Il nostro nuovo modello è ora completato.

17.20 Un modello dentro un modello

Avvertimento: Attenzione, questo capitolo non è completamente testato, per cui segnala qualunque problema;
le immagini sono mancanti

Nota: In questa lezione vedremo come usare un modello all’interno di un modello più grande.

Abbiamo già creato alcuni modelli, e in questa lezione vedremo come combinarli in un unico modello più grande.
Un modello si comporta come qualsiasi altro algoritmo, il che significa che puoi aggiungere un modello che hai già
creato come parte di un altro che crei dopo.
In questo caso, amplieremo il nostro modello idrologico, aggiungendo il valore medio di TWI in ciascuno dei bacini
che genera come risultato. Per fare ciò, abbiamo bisogno di calcolare il TWI e di calcolare le statistiche. Poiché
abbiamo già creato un modello per calcolare il TWI da un DEM, è una buona idea riutilizzare quel modello invece
di aggiungere gli algoritmi che contiene individualmente.
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Partiamo dal modello che abbiamo usato nell’ultima lezione come punto di partenza.

Avvertimento: da fare: Aggiungi immagine

Per prima cosa, aggiungeremo il modello TWI. Affinché sia disponibile, deve essere stato salvato nella cartella dei
modelli, altrimenti non verrà visualizzato nella casella degli strumenti o nell’elenco degli algoritmi del modellatore.
Assicurati che sia disponibile.
Aggiungilo al modello corrente e usa il DEM in ingresso come input. L’output è temporaneo, poiché vogliamo solo
il livello TWI per calcolare le statistiche. L’unico output di questo modello che stiamo creando sarà ancora il layer
vettoriale con i bacini idrografici.
Ecco la finestra di dialogo dei relativi parametri:

Avvertimento: da fare: Aggiungi immagine

Ora abbiamo un layer TWI che possiamo utilizzare insieme al layer vettoriale dei bacini idrografici, per generarne
uno nuovo che contenga i valori del TWI corrispondenti a ciascun bacino idrografico.
Questo calcolo viene eseguito utilizzando l’algoritmo Raster Statistics for Polygons. Utilizzare i layer di cui sopra come
input per creare il risultato finale.

Avvertimento: da fare: Aggiungi immagine

L’output dell’algoritmo Vectorize grid classes era originariamente il nostro output finale, ma ora lo vogliamo solo come
risultato intermedio. Per cambiarlo, dobbiamomodificare l’algoritmo. Basta fare doppio clic su di esso per visualizzare
la finestra di dialogo dei parametri e cancellare il nome dell’output. Questo lo renderà un risultato temporaneo, come
è di default.

Avvertimento: da fare: Aggiungi immagine

Ecco come dovrebbe apparire il modello finale:

Avvertimento: da fare: Aggiungi immagine

Come puoi vedere, l’uso di un modello in un altro modello non è niente di speciale e si può aggiungere come si
aggiunge un altro algoritmo, purché il modello sia salvato nella cartella models e sia disponibile nella casella degli
strumenti.

17.21 Usare gli strumenti solo-modellatore per la creazione di un
modello

Nota: Questa lezione mostra come utilizzare alcuni algoritmi disponibili solo nel modellatore, che forniscono
funzionalità aggiuntive ai modelli.

L’obiettivo di questa lezione è utilizzare il modellatore per creare un algoritmo di interpolazione che tenga conto della
selezione corrente, non solo per utilizzare solo gli elementi selezionati, ma per utilizzare l’estensione di tale selezione
per creare il layer raster interpolato.
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Il processo di interpolazione prevede due step, come già spiegato nelle lezioni precedenti: la rasterizzazione del layer
dei punti e il riempimento dei valori senza dati che appaiono nel layer rasterizzato. Se il layer puntuale ha una
selezione, verranno utilizzati solo i punti selezionati, ma se l’estensione dell’output è impostata per essere regolata
automaticamente, verrà utilizzata l’intera estensione del layer. In altre parole, l’estensione del layer viene sempre
considerata come l’estensione completa di tutti gli elementi, non quella calcolata solo da quelli selezionati. Cercheremo
di risolvere questo problema utilizzando alcuni strumenti aggiuntivi nel nostro modello.
Apri il modellatore e avvia il modello aggiungendo gli input necessari. In questo caso abbiamo bisogno di un layer
vettoriale (limitato ai punti) e di un suo attributo, con i valori che utilizzeremo per la rasterizzazione.

Il passo successivo consiste nel calcolare l’estensione degli elementi selezionati. È qui che si può utilizzare lo strumento
di solo-modellatore chiamato Vector layer bounds. Per prima cosa, è necessario creare un layer con l’estensione degli
elementi selezionati. Quindi si può utilizzare questo strumento su tale layer.
Un modo semplice per creare un layer con l’estensione degli elementi selezionati è quello di calcolare una carena
convessa del layer dei punti di input. Si utilizzerà solo il punto selezionato, quindi la carena convessa avrà lo stesso
rettangolo di selezione. Quindi si può aggiungere l’algoritmo Vector layer bounds e usare il layer poligono convesso
come input. L’aspetto dovrebbe essere questo nell’area di disegno del modellatore:
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Il risultato di Vector layer bounds è un insieme di quattro valori numerici e un oggetto extent. Per questo esercizio
utilizzeremo sia i risultati numerici sia l’estensione.

Ora possiamo aggiungere l’algoritmo che rasterizza il layer vettoriale, usando come input l’estensione dell’algoritmo
Vector layer bounds.
Compila i parametri dell’algoritmo come indicato di seguito:
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La finestra del modellatore dovrebbe ora apparire come.
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Infine, riempi i valori no-data del layer raster utilizzando l’algoritmo Close gaps.

L’algoritmo è ora pronto per essere salvato e aggiunto alla casella degli strumenti. È possibile eseguirlo e genererà un
layer raster interpolando i punti selezionati nel layer di input; il layer avrà la stessa estensione della selezione.
Ecco un miglioramento dell’algoritmo. Abbiamo utilizzato un valore codificato per la dimensione delle celle durante
la rasterizzazione. Questo valore va bene per il nostro layer di input di prova, ma potrebbe non esserlo per altri casi.
Si potrebbe aggiungere un nuovo parametro, in modo che l’utente inserisca il valore desiderato, ma un approccio
migliore sarebbe quello di far calcolare automaticamente il valore.
Possiamo usare il calcolatore solo-modellatore e calcolare questo valore dalle coordinate dell’estensione. Ad esempio,
per creare un layer con una larghezza fissa di 100 pixel, si può usare la seguente formula nel calcolatore.
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Ora dobbiamo modificare l’algoritmo di rasterizzazione, in modo che utilizzi l’output del calcolatore invece del valore
codificato.
L’algoritmo finale dovrebbe avere il seguente aspetto:
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17.22 Interpolazione

Nota: Questo capitolo mostra come interpolare dati di punti, e ti mostrerà un altro esempio per effettuare analisi
spaziali

In questa lezione ti accingi a interpolare i dati di punti per ottenere un raster. Prima di farlo, dovrai preparare i dati,
e dopo l’interpolazione farai ulteriori elaborazioni di aggiustamento dei risultati, così da avere un’analisi completa.
Apri i dati di esempio per questa lezione che dovrebbero apparire come di seguito

I dati corrispondono alla resa di una coltivazione, come rilevati da una mietitrice moderna e li userai per avere un
raster delle rese produttive del campo. Non farai ulteriori analisi ma lo userai come livello di base per identificare le
zone più produttive e quelle dove la produttività può essere migliorata.
La prima cosa che devi fare è pulire il livello dai punti ridondanti. Questi sono causati dal movimento della
mietitrebbia, dove deve curvare o dove cambia la velocità. L’algoritmo Points filter ti è utile per questo. Lo usi due
volte, per rimuovere i punti che possono essere considerati valori anomali sia nella parte alta che in quella bassa della
distribuzione.
Per i valori anomali superiormente, usa i seguenti parametri.
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Per continuare usa la configurazione mostrata sotto.
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Nota che non stai usando il layer originale ma l’output ricavato dal passo precedente.
Il vettore finale dovrebbe essere simile a quello iniziale, ma contiene un numero minore di punti. Puoi verificare,
confrontando le rispettive tabelle di attributi.
Ora rasterizziamo il layer usando l’algoritmo Rasterize.
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Il layer Filtered points si riferisce a quello risultante dal secondo filtro. Ha lo stesso nome di quello prodotto dal primo
filtro, in quanto il nome viene assegnato dall’algoritmo, ma non devi utilizzare il primo. Quest’ultimo, dal momento
che non verrà utilizzato per altro, lo puoi rimuovere dal progetto per evitare confusione, e puoi lasciare solo l’ultimo
layer Filtered points.
Il raster risultante si presenta così
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È un raster, ma manca del dato in alcune celle. Esso contiene solo i valori in quelle celle che contenevano un punto
dal vettore che abbiamo appena rasterizzati. Per riempire i valori mancanti, puoi usare l’algoritmo Close gaps.
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Il raster, tolte le celle senza dato appare simile a questo.
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Per limitare l’area coperta dai dati alla regione in cui è stata misurata la resa delle colture, puoi ritagliare il raster con
i limiti del vettore punti.
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E per un risultato più uniforme (meno preciso ma migliore per la visualizzazione di fondo come layer di supporto),
puoi applicare Gaussian filter al raster.
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Con i parametri di cui sopra otterrai il seguente risultato
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17.23 Ancora sull’interpolazione

Nota: Questo capitolo mostra un altro caso pratico sull’algoritmo dell’interpolazione.

L’interpolazione è una tecnica comune, e puoi usarla per mostrare diverse tecniche utili attraverso gli strumenti
di processing QGIS. Questa lezione usa alcuni algoritmi di interpolazione che sono stati già introdotti, ma ha un
approccio diverso.
I dati per questa lezione contengono anche uno layer di punti, in questo caso con dati di elevazione. Ti accingi a
interpolare in modo assai simile a come hai fatto nella lezione precedente, ma stavolta salverai parte dei dati originali
per valutare la qualità del processo di interpolazione.
In primo luogo, devi rasterizzare il layer di punti e riempire le celle vuote, ma utilizzando solo una frazione dei punti
nel livello. Salva il 10% dei punti per un controllo posteriore, quindi hai bisogno di avere il 90% dei punti pronti
per l’interpolazione. Per fare ciò, potrai usare l’algoritmo Split shapes layer randomly, che hai già utilizzato in una
lezione precedente, ma c’è un modo migliore per farlo, senza dover creare ogni nuovo strato intermedio. Invece, puoi
semplicemente selezionare i punti da usare per l’interpolazione (la frazione del 90%), e quindi eseguire l’algoritmo.
Come hai già visto, l’algoritmo di rasterizzazione utilizzerà solo i punti selezionati e ignorare il resto. Puoi fare la
selezione utilizzando l’algoritmo Random selection. Esegui con i seguenti parametri.
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Sarà selezionato il 90% dei punti del layer da rasterizzare.
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La selezione è casuale, così la tua selezione potrebbe differire dalla selezione mostrato nell’immagine qui sopra.
Ora esegui l’algoritmo Shapes to grid per ottenere il primo raster, e quindi esegui l’algoritmo Close gaps per riempire
le celle vuote [risoluzione della cella: 100 m].

Per controllare la qualità dell’interpolazione, ora puoi utilizzare i punti che non sono stati selezionati. A questo punto,
conosci l” elevazione reale (valore nello strato punti) e l’elevazione interpolato (il valore nello strato raster interpolati).
Puoi confrontare le due calcolando le differenze tra questi valori.
Dal momento che utilizzarai i punti che non sono stati selezionati prima, inverti la selezione.
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I punti contengono i valori originali, ma non quelli interpolati. Per aggiungerli in un nuovo campo, possiamo usare
l’algoritmo Add grid values to points.
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Il raster da selezionare (l’algoritmo supporta raster multipla, ma ne abbiamo bisogno di uno solo) è il risultato
dell’interpolazione. Lo hai rinominato interpolate e quel nome di raster è quello che userai per il nome del campo da
aggiungere.
Ora hai un vettore che contiene entrambi i valori, con punti non utilizzati per l’interpolazione

Ora, userai il calcolatore di campi per questo compito. Apri l’algoritmo Field calculator ed eseguilo con i seguenti
parametri.
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Se il tuo campo con i valori del raster ha un nome diverso, è necessario modificare la formula sopra di conseguenza.
XCon l’esecuzione di questo algoritmo, otterrai un nuovo livello con solo i punti che non hai usato per l’interpolazione,
ognuno dei quali contiene la differenza tra i due valori di elevazione.
Rappresentare quello strato in base al valore che ci darà una prima idea di dove si trovano le maggiori differenze.
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Interpolando quello strato otterrà un raster con l’errore stimato in tutti i punti dell’area interpolata.
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Puoi inoltre ottenere le stesse informazioni (differenza tra i valori dei punti di origine e quelli interpolati) direttamente
con GRASS►v.sample.
I tuoio risultati potrebbero differire da questi, dato che c’è una componente casuale introdotta durante l’esecuzione
all’inizio di questa lezione.

17.24 Esecuzione iterativa di algoritmi

Nota: Questa lezione mostra un modo diverso di eseguire algoritmi che usano layer vettoriali, eseguendoli
ripetutamente, iterando sulle proprietà in un layer vettoriale in ingresso

Conosciamo già il modellatore, che è un modo per automatizzare le attività di elaborazione. Tuttavia, in alcune
situazioni, il modellatore potrebbe non essere ciò di cui abbiamo bisogno per automatizzare un determinato processo.
Vediamo una di queste situazioni e come risolverla facilmente utilizzando una funzionalità diversa: l’esecuzione
iterativa di algoritmi.
Apri i dati corrispondenti a questo capitolo. Dovrebbe apparire così.

Riconoscerai il nostro ben noto DEM dei capitoli precedenti e un insieme di bacini idrici estratti da esso. Immagina
di dover tagliare il DEM in diversi layer più piccoli, ognuno dei quali contiene solo i dati di elevazione corrispondenti
ad un singolo bacino. Questo sarà utile se in seguito vorrai calcolare alcuni parametri relativi ad ogni bacino, come
la sua elevazione media o la sua curva ipsografica.
Questo può essere un compito lungo e noioso, specialmente se il numero di bacini è grande. Tuttavia, è un compito
che può essere facilmente automatizzato, come vedremo.
L’algoritmo da utilizzare per il ritaglio di un layer raster con un vettore poligonale si chiama Ritagliare raster con
vettori, e ha i seguenti parametri nello finestra di dialogo.
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Puoi eseguirlo usando il layer dei bacini idrici e il DEM come input, e otterrai il seguente risultato.
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Come puoi vedere, viene utilizzata l’area coperta da tutti i poligoni del bacino idrico.
Puoi ottenere il DEM ritagliato con un solo bacino idrico selezionando il bacino idrico desiderato e poi eseguendo
l’algoritmo come abbiamo fatto prima.

Dato che vengono usati solo gli elementi selezionati, solo il poligono selezionato sarà usato per ritagliare il layer raster.
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Fare questo per tutti i bacini produrrà il risultato che stiamo cercando, ma non sembra un modo molto pratico di
farlo. Vediamo invece come automatizzare la funzione seleziona e ritaglia.
Prima di tutto, rimuovi la selezione precedente, in modo da utilizzare nuovamente tutti i poligoni. Ora apri l’algoritmo
Clip raster with polygon e seleziona gli stessi input di prima, ma questa volta fai clic sul pulsante che troverai a destra
dell’input del layer vettoriale dove hai selezionato il layer watersheds.

Questo pulsante fa sì che il layer di input selezionato venga suddiviso in tanti layer quanti sono gli elementi presenti al
suo interno, ognuno dei quali contiene un singolo poligono. L’algoritmo verrà quindi richiamato ripetutamente, uno
per ciascuno di questi layer a singolo poligono. Il risultato, invece di un solo layer raster nel caso di questo algoritmo,
sarà un insieme di layer raster, ognuno dei quali corrisponde a una delle esecuzioni dell’algoritmo.
Ecco il risultato che si ottiene se esegui l’algoritmo di ritaglio come spiegato.
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Per ogni layer, la tavolozza dei colori bianco e nero, (o qualsiasi tavolozza tu stia usando), è regolata in modo diverso,
dai suoi valori minimi ai suoi valori massimi. Questo è il motivo per cui si possono vedere i diversi pezzi e i colori
non sembrano corrispondere nel bordo tra i layer. I valori, tuttavia, corrispondono.
Se inserisci un nome di file per il risultato, i file risultanti saranno nominati usando quel nome di file e un numero
corrispondente ad ogni iterazione come suffisso.

17.25 Di più su esecuzione iterativa di algoritmi

Nota: Questa lezione mostra come combinare l’esecuzione iterativa degli algoritmi con il modellatore per ottenere
una maggiore automazione.

L’esecuzione iterativa degli algoritmi è disponibile non solo per gli algoritmi incorporati, ma anche per gli algoritmi
che potete creare voi stessi, come i modelli. Vedremo come combinare unmodello e l’esecuzione iterativa di algoritmi,
in modo da poter ottenere risultati più complessi con facilità.
I dati che useremo per questa lezione sono gli stessi che abbiamo già usato per l’ultima lezione. In questo caso, invece
di limitarci a ritagliare il DEM con ogni poligono di bacino, aggiungeremo qualche passo in più e calcoleremo una
curva ipsometrica per ognuno di essi, per studiare come l’altezza è distribuita all’interno del bacino idrografico.
Dato che abbiamo un flusso di lavoro che implica diversi passaggi (ritaglio + calcolo della curva ipsometrica),
dovremmo andare nel modellatore e creare il modello corrispondente a tale flusso di lavoro.
Puoi trovare il modello già creato nella cartella dei dati di questa lezione, ma sarebbe bene che tu prima provassi a
crearlo da solo. Il layer ritagliato non è un risultato finale in questo caso, dato che siamo interessati solo alle curve,
quindi questo modello non genererà alcun layer, ma solo una tabella con i dati delle curve.
Il modello dovrebbe apparire così:
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Aggiungi il modello alla tua cartella models, in modo che sia disponibile nella casella degli strumenti, ed eseguilo.
Seleziona il DEM e i bacini idrografici.
L’algoritmo genererà tabelle per tutti i bacini e le metterà nella cartella in uscita.
Possiamo rendere questo esempio più complesso estendendo il modello e calcolando alcune statistiche di pendenza.
Aggiungi l’algoritmo Slope al modello, e poi l’algoritmo Raster statistics, che dovrebbe usare il risultato della pendenza
come unico ingresso.

Se ora esegui il modello, oltre alle tabelle otterrai una serie di pagine con le statistiche. Queste pagine saranno
disponibili nella finestra di dialogo dei risultati.
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17.26 L’interfaccia per i processi in serie

Nota: Questa lezione introduce l’interfaccia per i processi in serie, che permette di eseguire un singolo algoritmo
con una serie di valori in ingresso differenti.

A volte un dato algoritmo deve essere eseguito ripetutamente con input diversi. Questo è, per esempio, il caso in
cui un insieme di file di input deve essere convertito da un formato a un altro, o quando diversi layer in una data
proiezione devono essere convertiti in un’altra proiezione.
In questo caso, richiamare ripetutamente l’algoritmo negli strumenti non è la migliore opzione. Invece, dovrebbe
essere utilizzata l’interfaccia per i processi in serie, che semplifica enormemente l’esecuzione multipla di un dato
algoritmo. Per eseguire un algoritmo come un processo in serie, cercalo negli strumenti e, invece di fare doppio–click
su di esso, fai click con il tasto destro e seleziona Esegui come processo in serie.

Per questo esempio, useremo l’algoritmo Riproiezione, per cui cercalo e applica quanto descritto sopra. Comparirà la
seguente finestra di dialogo.

Se dai un’occhiata ai dati per questa lezione, vedrai che contengono un insieme di tre shapefile, ma non il file di
progetto QGIS. Questo perché, quando l’algoritmo è eseguito come un processo in serie, i vettori in ingresso possono
essere selezionati o dal progetto QGIS corrente o dai file. Ciò rende più facile processare un grande quantitativo di
vettori, come, per esempio, tutti i vettori in una data cartella.
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Ogni riga nella tabella della finestra di dialogo per i processi in serie rappresenta una singola esecuzione dell’algoritmo.
Le celle in ogni riga corrispondono ai parametri richiesti dall’algoritmo, i quali non sono disposti uno sopra l’altro,
come nella tipica finestra di dialogo per una esecuzione singola, ma orizzontalmente lungo essa.
La definizione del processo in serie da eseguire si effettua riempiendo la tabella con i valori corrispondenti e la finestra
di dialogo stessa contiene diversi strumenti che facilitano questo compito.
Iniziamo a riempire i campi uno per uno. La prima colonna da riempire è quella del vettore in ingresso. Invece di
inserire i nomi di ogni vettore che vogliamo processare, puoi selezionarli tutti e lasciare che sia la finestra di dialogo
a inserirli in ogni riga. Clicca sul pulsante nella cella in alto a sinistra e, nella finestra di dialogo di selezione file che
apparirà, seleziona i tre file da riproiettare. Siccome soltanto uno di essi è necessario per ogni riga, quelli rimanenti
saranno utilizzati per riempire le righe sottostanti.

Il numero predefinito di righe è pari a 3, che è esattamente il numero di vettori che dobbiamo convertire ma, se
selezioni più vettori, saranno aggiunte nuove righe automaticamente. Se vuoi riempire i campi manualmente, puoi
aggiungere più righe utilizzando il pulsante Aggiungi riga.
Dovremo convertire tutti questi layer nel CRS EPSG:23029, per cui dobbiamo selezionare tale CRS nel secondo
campo. Volendo utilizzare lo stesso per tutte le righe, non dobbiamo ripetere la stessa procedura per ogni riga.
Piuttosto, seleziona il CRS per la prima riga (la prima in alto) usando il pulsante nella cella corrispondente, e in
seguito fai doppio click sull’intestazione della colonna. Ciò avrà come conseguenza il riempimento di tutte le celle
nella colonna utilizzando il valore della colonna in cima.
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Infine, dobbiamo selezionare un file in uscita per ogni esecuzione, che conterrà il vettore riproiettato corrispondente.
Di nuovo, eseguiamo l’operazione soltanto sulla prima riga. Clicca sul pulsante nella cella più in alto e, nella cartella
in cui vorrai salvare i tuoi file in uscita, inserisci un nome file (per esempio, riproiettato.shp).
Adesso, quando clicchi OK nella finestra di dialogo di selezione file, il file non sarà automaticamente scritto nella
cella, ma sarà mostrato un riquadro come quello mostrato di seguito.

Se selezioni la prima opzione, sarà riempita soltanto la cella corrente. Se selezioni una qualunque delle altre opzioni,
tutte le celle saranno riempite con un certo schema. In questo caso, selezioniamo l’opzione Riempi con i valori del
parametro, e poi il valore Vettore in Ingresso nel menu a tendina sotto. Ciò farà sì che il valore in Vettore in Ingresso
(che è il nome del vettore) venga aggiunto al nome file che abbiamo definito, rendendo ogni nome file in uscita diverso.
La tabella per i processi in serie dovrebbe ora apparire in questo modo.
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L’ultima colonna definisce se aggiungere o meno il vettore risultante al progetto QGIS corrente. Lascia l’opzione Si
predefinita, in modo tale da vedere i tuoi risultati in questo caso.
Clicca su OK e il processo in serie sarà eseguito. Se tutto funziona bene, tutti i tuoi vettori saranno processati, e 3
nuovi vettori saranno creati.

17.27 I modelli nell’interfaccia per i processi in serie

Avvertimento: Attenzione, questo capitolo non è completamente testato, per cui segnala qualunque problema;
le immagini sono mancanti

Nota: Questa lezione mostra un altro esempio dell’interfaccia per i processi in serie, ma questa volta utilizzando un
modello invece di un algoritmo integrato

I modelli funzionano come un qualunque altro algoritmo, e possono essere utilizzati nell’interfaccia per i processi in
serie. Per dimostrare ciò, ecco un breve esempio di quello che possiamo fare utilizzando il nostro ormai ben noto
modello idrologico.
Assicurati di aver aggiunto il tuo modello negli strumenti, e poi eseguilo nella modalità in serie. Ecco come la finestra
di dialogo per i processi in serie dovrebbe apparire.

Avvertimento: da fare: Aggiungi immagine

Aggiungi righe fino a un totale di 5. Seleziona il file DEM corrispondente a questa lezione come file in ingresso per
ognuno di esse. In seguito, inserisci 5 diversi valori limite come mostrato di seguito.
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Avvertimento: da fare: Aggiungi immagine

Come puoi notare, l’interfaccia per i processi in serie può essere eseguita non solo per lanciare lo stesso processo su
set di dati differenti, ma anche sullo stesso set di dati con diversi parametri.
Fai clic su OK e si dovrebbero ottenere 5 nuovi layer con bacini idrografici corrispondenti ai 5 valori di soglia
specificati.

17.28 Script agganciati pre e post esecuzione

Nota: Questa lezione mostra come utilizzare gli hook di pre- e post-esecuzione, che permettono di eseguire
operazioni aggiuntive prima e dopo il corrente processing.

Gli hook di pre- e post-esecuzione sono script di processing che vengono eseguiti prima e dopo l’effettiva elaborazione
dei dati. Questo può essere usato per automatizzare i processi che dovrebbero essere eseguiti ogni volta che un
algoritmo viene eseguito.
La sintassi degli hook è identica alla sintassi degli script di Processing, vedi il corrispondente capitolo nel QGIS User
Guide per maggiori dettagli.
Oltre a tutte le opzioni degli script, negli hook è possibile utilizzare una speciale variabile globale chiamata alg, che
rappresenta l’algoritmo che è appena stato (o sta per essere) eseguito.
Ecco un esempio di script post-esecuzione. Per impostazione predefinita, Processing memorizza i risultati delle analisi
in file temporanei. Questo script copierà gli output in una cartella specifica, in modo che non vengano cancellati dopo
la chiusura di QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
if isinstance(output, (OutputVector, OutputRaster, OutputFile)):

dirname = os.path.split(output.value)[0]
shutil.copytree(dirname, MY_DIRECTORY)

Nelle prime due righe importiamo i package Python richiesti: os— per la manipolazione del percorso, ad esempio
l’estrazione del nome del file, e shutil— per varie operazioni sul filesystem come la copia dei file. Nella terza riga
importiamo gli output di Processing. Questo sarà spiegato più in dettaglio più avanti in questa lezione.
Poi definiamo una costante MY_DIRECTORY, che è il percorso della cartella dove vogliamo copiare i risultati
dell’analisi.
Alla fine dello script, abbiamo il codice dell’hook principale. Nel ciclo iteriamo tutti gli output dell’algoritmo e
controlliamo se questo output è un output basato su file e può essere copiato. Se è così, individuiamo la cartella
di primo livello in cui sono i file di output e poi copiamo tutti i file nella nostra cartella.
Per attivare questo hook dobbiamo aprire le opzioni di Processing, trovare la voce chiamata Post-execution script file
nel gruppo General, e specificare lì il nome del file dello script hook. l’hook specificato verrà eseguito al termine di
ogni algoritmo di Processing.
In modo simile, possiamo implementare degli hook di pre-esecuzione. Per esempio, creiamo un hook per controllare
i vettori in ingresso per gli errori di geometria.
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from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:
if isinstance(param, ParameterVector):

layer = processing.getObject(param.value)
for f in layer.getFeatures(QgsFeatureRequest().setSubsetOfAttributes([])):

errors = f.geometry().validateGeometry()
if len(errors) > 0:

progress.setInfo('One of the input vectors contains invalid␣
↪→geometries!')

Come nell’esempio precedente, prima importiamo i package QGIS e Processing necessari.
Poi iteriamo su tutti i parametri dell’algoritmo e se viene trovato un parametro ParameterVector, otteniamo l’oggetto
layer vettoriale corrispondente. Eseguiamo un ciclo su tutte gli elementi del layer e controlliamo se ci sono errori di
geometria. Se almeno un elemento contiene una geometria non valida, stampiamo un messaggio di warning.
Per attivare questo hook dobbiamo inserire il suo nome di file nell’opzione Pre-execution script file nella finestra di
configurazione di Processing. L’hook verrà eseguito prima di eseguire qualsiasi algoritmo di Processing.

17.29 Altri programmi

Modulo contribuito da Paolo Cavallini - Faunalia

Nota: Questo capitolo mostra come utilizzare programmi aggiuntivi dall’interno di Processing. Per poterlo seguire,
è necessario aver installato, con gli strumenti del proprio sistema operativo, i relativi pacchetti.

17.29.1 GRASS

GRASS è una suite software GIS gratuita e open source per la gestione e l’analisi dei dati geospaziali, l’elaborazione
delle immagini, la produzione di grafici e mappe, la modellazione spaziale e la visualizzazione.
È installato di default su Windows tramite il programma di installazione standalone OSGeo4W (32 e 64 bit) ed è
disponibile per tutte le principali distribuzioni Linux.

17.29.2 R

R è un ambiente software libero e open source per il calcolo statistico e i grafici.
Deve essere installato separatamente, insieme ad alcune librerie necessarie (LIST). Per consentire l’uso di R in QGIS,
è necessario installare anche il plugin Processing R Provider.
Il bello dell’implementazione di Processing è che si possono aggiungere i propri script, semplici o complessi, che
possono essere utilizzati come qualsiasi altro modulo, inseriti in flussi di lavoro più complessi, ecc.
Prova alcuni degli esempi preinstallati, se hai già installato R (ricorda di attivare i moduli R dalla configurazione
generale di Processing).
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17.29.3 Altri

LASTools è un insieme di comandi misti, gratuiti e proprietari, per elaborare e analizzare i dati LiDAR. La
disponibilità in diversi sistemi operativi può essere differente.
Altri strumenti sono disponibili attraverso plugin aggiuntivi, ad esempio:

• LecoS: una suite per le statistiche sulla copertura del suolo e l’ecologia del paesaggio
• lwgeom: precedentemente parte di PostGIS, questa libreria offre alcuni strumenti utili per la pulizia della
geometria.

• Animove: strumenti per analizzare lo spazio vitale degli animali.
Ne arriveranno altri.

17.29.4 Confronto tra i backend

Buffer e distanze

Carica punti.shp e digita buf nel filtro della casella degli strumenti, quindi fai doppio clic su:
• :menuselezione:`Buffer a distanza fissa`: Distanza 10000
• :menuselezione:`Buffer a distanza variabile`: Campo Distanza DIMENSIONE
• v.buffer.distance: distaza 10000
• v.buffer.column: bufcolumn SIZE
• Shapes Buffer: valore fisso 10000 (dissolvenza e non), campo attributi (con scalatura)

La velocità è molto diversa e sono disponibili opzioni diverse.
Esercizio per il lettore: trovare le differenze nella geometria prodotta tra i diversi metodi.
Ora, buffer raster e distanze:

• per prima cosa, carica e rasterizza il vettore rivers.shp con GRASS ► v.to.rast.value; attenzione: la
dimensione delle celle deve essere impostata a 100 m, altrimenti il tempo di calcolo sarà enorme; la mappa
risultante avrà 1 e NULL

• lo stesso, con SAGA ► Shapes to Grid ► COUNT (mappa risultante: da 6 a 60)
• poi, proximity (valore= 1 per GRASS, un elenco di ID di fiumi per SAGA), r.buffer con parametri
1000,2000,3000, r.grow.distance (la prima delle due mappe; la seconda mostrerà le aree di pertinenza di
ciascun fiume, se fatta sul raster SAGA).

Dissolvere

Dissolvere gli elementi in base a un attributo comune:
• GRASS ► v.dissolve municipalities.shp on PROVINCIA
• QGIS ► Dissolve municipalities.shp on PROVINCIA
• OGR ► Dissolve municipalities.shp on PROVINCIA
• SAGA ► Polygon Dissolve municipalities.shp su PROVINCIA (NB: Mantieni confini interni deve
essere deselezionato)

Nota: L’ultimo è non funzionante in SAGA <=2.10

Esercizio per il lettore: trovare le differenze (geometria e attributi) tra i diversi metodi.

17.29. Altri programmi 655

https://rapidlasso.com/lastools/
https://conservationecology.wordpress.com/qgis-plugins-and-scripts/lecos-land-cover-statistics/
https://plugins.qgis.org/plugins/processinglwgeomprovider/
https://www.faunalia.eu/en/dev/animove


QGIS Training Manual

17.30 Interpolazione e curve di livello

Modulo contribuito da Paolo Cavallini - Faunalia

Nota: Questo capitolo mostra come utilizzare diversi backend per calcolare interpolazioni differenti.

17.30.1 Interpolazione

Il progetto mostra un gradiente di precipitazioni, da sud a nord. Usiamo diversi metodi di interpolazione, tutti basati
sul vettore points.shp, parametro RAIN:

Avvertimento: Imposta la dimensione della cella a 500 per tutte le analisi.

• GRASS ► v.surf.rst

• SAGA ► Multilevel B-Spline Interpolation

• SAGA ► Inverse Distance Weighted [Distanza inversa a una potenza; Potenza: 4; Raggio di ricerca: Globale;
Raggio di ricerca: tutti i punti]

• GDAL ► Grid (Inverse Distance to a power) [Power:4]
• GDAL ► Grid (Moving average) [Radius1&2: 50000]

Quindi misura la variazione tra i metodi e correlala alla distanza dai punti:
• GRASS ► r.series [Unselect Propagate NULLs, Aggregate operation: stddev]
• GRASS ► v.to.rast.value on points.shp
• GDAL ► Proximity

• GRASS ► r.covar per mostrare la matrice di correlazione; verifica la significatività della correlazione, ad
esempio con http://vassarstats.net/rsig.html.

Pertanto, le aree lontane dai punti avranno un’interpolazione meno accurata.

17.30.2 Curve di livello

Vari metodi per disegnare le curve di livello [sempre passo=10] sul raster stddev:
• GRASS ► r.contour.step

• GDAL ► Contour

• SAGA►Contour lines from grid [NB: in alcune vecchie versioni di SAGA, l’output shp non è valido, bug noto].
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17.31 Semplificazione e smussamento vettoriale

Modulo realizzato da Paolo Cavallini - Faunalia

Nota: Questo capitolo mostra come semplificare i vettori e smussare gli angoli acuti.

A volte abbiamo bisogno di una versione semplificata di un vettore, per avere una dimensione di file più piccola e
sbarazzarci di dettagli non necessari. Molti strumenti lo fanno in modo molto approssimativo, e perdono l’adiacenza
e talvolta la correttezza topologica dei poligoni. GRASS è lo strumento ideale per questo: essendo un GIS topologico,
l’adiacenza e la correttezza sono conservate anche a livelli di semplificazione molto alti. Nel nostro caso, abbiamo
un vettore risultante da un raster, che mostra quindi un pattern «a sega» ai bordi. Applicando una semplificazione si
ottengono linee rette:

• GRASS ► v.generalize [Maximal tolerance value: 30 m]
Possiamo anche fare il contrario, e rendere un layer più complesso, smussando gli spigoli:

• GRASS ► v.generalize [method: chaiken]
Prova ad applicare questo secondo comando sia al vettore originale che a quello della prima analisi e vedrai la
differenza. Nota che l’adiacenza non viene persa.
Questa seconda opzione può essere applicata per esempio alle curve di livello risultanti da un raster grossolano, alle
tracce GPS con vertici radi, ecc.

17.32 Pianificare una fattoria solare

Modulo contribuito da Paolo Cavallini - Faunalia

Nota: Questo capitolo mostra come usare diversi criteri per localizzare l’area adatta per l’installazione di una centrale
fotovoltaica

Prima di tutto, creare una mappa di esposizione dal DTM:
• GRASS ► r.aspect [Data type: int; cell size:100]

In GRASS, l’esposizione è calcolata in gradi antiorari partendo da Est. Per estrarre solo i versanti a Sud (270 gradi
+- 45), possiamo riclassificarlo:

• GRASS ► r.reclass

con le seguenti regole:

225 thru 315 = 1 south
* = NULL

Puoi usare il file di testo reclass_south.txt fornito. Nota che con questo file di esempio possiamo creare
anche riclassificazioni molto complesse.
Vogliamo costruire una grande centrale, quindi selezioniamo solo aree grandi (> 100 ha) e contigue:

• GRASS ► r.reclass.greater

Infine, convertiamo in vettore:
• GRASS ► r.to.vect [Feature type: area; Smooth corners: yes]

Esercizio per il lettore: ripeti l’analisi, sostituendo i comandi di GRASS con analoghi di altri programmi.
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17.33 Utilizzare gli script R in Processing

Modulo realizzato da Matteo Ghetta - finanziato dalla Scuola Superiore Sant’Anna
Processing (con il plugin Processing R Provider) consente di scrivere ed eseguire script R all’interno di
QGIS.

Avvertimento: R deve essere installato sul computer e il PATH deve essere impostato correttamente. Inoltre
Processing si limita a chiamare i pacchetti R esterni, non è in grado di installarli. Assicurati quindi di installare i
pacchetti esterni direttamente in R. Vedi il relativo chapter nel manuale d’uso.

Nota: Se hai problemi con il package, è possibile che manchino i pacchetti obbligatori richiesti da Processing, come
sp, rgdal e raster.

17.33.1 Aggiungere script

Aggiungere uno script è semplice. Il modo più semplice è aprire la casella degli strumenti di Processing e scegliere
Create new R script… dal menu R (contrassegnato dall’icona R) nella parte superiore della casella degli strumenti
di Processing. Puoi anche creare lo script, ad esempio in un editor di testo, e salvarlo nella cartella degli script R
(processing/rscripts). Una volta salvato, sarà disponibile per la modifica facendo clic con il pulsante destro
del mouse sul nome dello script nella finestra degli strumenti di elaborazione e scegliendo Edit Script…).

Nota: Se non riesci a vedere R in Processing, devi attivarlo in Impostazioni -> Opzioni -> Sorgenti dati

Apre una finestra dell’editor di script in cui in cui devi specificare alcuni parametri prima di poter aggiungere il corpo
dello script.
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17.33.2 Realizzare grafici

In questa esercitazione creeremo un boxplot di un campo di un layer vettoriale.
Apri il progetto QGIS r_intro.qgs nella cartella exercise_data/processing/r_intro/.

Parametri dello script

Apri l’editor e comincia a scrivere all’inizio dello stesso.
Devi specificare alcuni parametri prima del corpo dello script:

1. Il nome del gruppo (plots in questo caso) in cui si vuoi inserire lo script (se il gruppo non esiste, verrà creato):

##plots=group

Troverai il tuo script nel gruppo R plots nella casella degli strumenti di Processing.
2. Devi dire a Processing che vuoi visualizzare un grafico (in questo esempio):

##showplots

Troverai quindi un collegamento al grafico nel pannelloVisualizzatore risultati (può essere attivato/disattivato
in :menuselection: Visualizza –> Pannelli e con :menuselection:Processing –> Visualizzatore risultati`).

3. Devi inoltre indicare a Processing i dati in ingresso. In questo esempio vogliamo creare un grafico da un campo
di un layer vettoriale:

##Layer=vector

Processing ora sa che l’input è un vettore. Il nome Layer non è importante, ciò che conta è il parametro vector.
4. Infine, devi specificare il campo di input del layer vettoriale (usando il nome che hai fornito sopra - Layer):

##X=Field Layer

Processing ora sa che ti è necessario un campo di Layer e che lo chiamerai X.
5. È anche possibile definire il nome dello script utilizzando name:

##My box plot script=name

Se non viene definito, il nome del file verrà utilizzato come nome dello script.
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Corpo dello script

Ora che hai impostato l”intestazione dello script, puoi aggiungere la funzione:

boxplot(Layer[[X]])

boxplot è il nome della funzione R, il parametro Layer è il nome definito per il set di dati di input e X è il nome
definito per il campo di tale set di dati.

Avvertimento: Il parametro X deve essere racchiuso tra doppie parentesi quadre ([[]]).

Lo script finale si presenta così:

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])

Salva lo script nel percorso predefinito suggerito da Processing (processing/rscripts). Se non hai definito un ``name””
nell’intestazione dello script, il nome del file scelto diventerà il nome dello script nella casella degli strumenti di
Processing.

Nota: Puoi salvare lo script dove vuoi, ma Processing non sarà in grado di includerlo automaticamente nella casella
degli strumenti di elaborazione, quindi dovrai caricarlo manualmente.

Ora è sufficiente eseguirlo utilizzando il pulsante in alto nella finestra dell’editor:
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Una volta chiusa la finestra dell’editor, utilizza la casella di testo di Processing per trovare il tuo script:

Ora puoi inserire i parametri richiesti nella finestra dell’algoritmo di elaborazione:
• per Layer scegli sample_points

• per il campo X scgli value
Clicca su Esegui.
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La finestra Risultati dovrebbe aprirsi automaticamente; in caso contrario, fai clic su Processing ► Visualizzatore
Risultati….
Fai clic sul link nel visualizzatore e si vedrà:
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Nota: Puoi aprire, copiare e salvare l’immagine facendo clic con il tasto destro del mouse sul grafico.

17.33.3 Creare un vettore

Puoi anche creare un layer vettoriale e caricarlo automaticamente in QGIS.
L’esempio seguente è stato tratto dallo script ``Random sampling grid”” che si trova nella raccolta online di script R
(gli script di questa raccolta online si trovano in https://github.com/qgis/QGIS-Processing/tree/master/rscripts).
Lo scopo di questo esercizio è creare un layer vettoriale di punti casuali usando un layer vettoriale di input per limitare
l’estensione usando la funzione spsample del package sp.

Parametri dello script

Come in precedenza, dobbiamo impostare alcuni parametri prima del corpo dello script:
1. Specificare il nome del gruppo in cui si desidera inserire lo script, in questo caso Point pattern analysis:

##Point pattern analysis=group

2. Definire un parametro in ingresso (un layer vettoriale) che vincoli il posizionamento dei punti casuali:

##Layer=vector
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3. Impostare un parametro di input per il numero di punti che verranno creati (Size, con un valore predefinito
di 10):

##Size=number 10

Nota: Poiché è definito un valore predefinito (10), l’utente può modificare questo numero o lasciare il
parametro senza un numero.

4. Specificare che esiste un layer vettoriale di uscita (chiamato Output):

##Output=output vector

Corpo dello script

Ora puoi aggiungere il corpo della funzione:
1. Utilizza la funzione spsample:

pts=spsample(Layer, Size, type="random")

La funzione utilizza il Layer per vincolare il posizionamento dei punti (se si tratta di un layer di linee, un punto
dovrà trovarsi su una delle linee del layer, se si tratta di un layer di poligoni, un punto dovrà trovarsi all’interno
di un poligono). Il numero di punti viene preso dal parametro Size. Il metodo di campionamento è random.

2. Genera il risultato (il parametro Output):

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Lo script finale si presenta così:

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output=output vector
pts=spsample(Layer, Size, type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Salvalo ed eseguilo, facendo clic sul pulsante di esecuzione.
Nella nuova finestra digita i parametri corretti:
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e fai clic su Esegui.
Il layer risultante verrà aggiunto all’indice e i suoi punti verranno visualizzati sulla area di disegno della mappa:
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17.33.4 Risultato testo e grafo da R - sintassi

Processing (con il plugin Processing R Provider) utilizza una sintassi speciale per ottenere i risultati da R:
• > prima del comando, come in >lillie.test(Layer[[Field]]) significa che il risultato deve essere
inviato all’output di R ( Visualizzatore Rrisultati)

• + dopo un grafico abilita la sovrapposizione dei grafici. Ad esempio plot(Layer[[X]], Layer[[Y]])
+ abline(h=mean(Layer[[X]])).

17.34 Prevedere le frane

Modulo realizzato da Paolo Cavallini - Faunalia

Nota: Questo capitolo mostra come creare un modello molto semplificato per prevedere la probabilità di frane.

In primo luogo, calcoliamo la pendenza (scegliere tra vari backend; il lettore interessato può calcolare la differenza
tra i risultati):

• GRASS ► r.slope

• SAGA ► Slope, Aspect, Curvature

• GDAL Slope

Poi creiamo un modello di previsione delle precipitazioni, basato sull’interpolazione dei valori delle precipitazioni
nelle stazioni meteo:

• GRASS ► v.surf.rst (resolution: 500 m)
La probabilità di una frana sarà molto approssimativamente legata sia alle precipitazioni che alla pendenza
(naturalmente un modello reale userà più livelli, e parametri appropriati), diciamo (precipitazioni *
pendenza )/100`:

• SAGA ► Raster calculator pioggia, pendenza: (a*b)/100 (o: GRASS ► r.mapcalc)
• quindi calcoliamo quali sono i comuni con il maggior rischio previsto di precipitazioni: SAGA ► Statistiche

raster con poligoni (i parametri di interesse sono Massimo e Medio)
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CAPITOLO18

Module: Usare i database spaziali in QGIS

In questo modulo imparerete ad usare i database spaziali con QGIS per gestire, visualizzare e manipolare dati in
un database ma anche ad eseguire delle analisi per interrogazione. Useremo principalmente PostgreSQL e PostGIS
(che sono stati descritti nella sezione precedente), ma gli stessi concetti si applicano ad altri database spaziali tra cui
SpatiaLite.

18.1 Lesson: Lavorare con i database in QGIS browser

Nei precedenti 2 moduli hai esaminato i concetti di base, le caratteristiche e le funzioni dei database relazionali e le
estensioni che consentono di archiviare, gestire, interrogare e manipolare i dati spaziali in un database relazionale.
Questa sezione approfondirà come puoi usare efficacemente i database spaziali in QGIS.
Obiettivo di questa lezione: Imparare a interagire con i database spaziali usando l’interfaccia QGIS Browser.

18.1.1 Follow Along: Aggiungere Tabelle Database a QGIS mediante il Browser

Hai già analizzato come aggiungere tabelle da un database come layer QGIS, ora puoi dare un’occhiata a ciò in modo
più dettagliato e osservare i diversi modi in cui ciò può essere fatto in QGIS. Inizia guardando la nuova interfaccia
del browser.

• Start a new empty map in QGIS.
• Apri il browser facendo clic sulla scheda Browser nella parte inferiore del pannello dei Layer

• Apri l’albero di PostGIS e dovresti trovare la connessione precedentemente configurata disponibile (potrebbe
essere necessario fare clic sul pulsante aggiorna nella parte superiore della finestra del browser).
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• Facendo doppio clic su una delle tabelle/layer elencati qui, lo aggiungerai alla mappa.
• Con clic sul tasto destro su una tabella/layer in questa vista, otterrai alcune opzioni. Fai clic sulla voce Proprietà
per esaminare le proprietà del layer.
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Nota: Naturalmente puoi anche usare questa interfaccia per connetterti ai database PostGIS ospitati su un server
esterno alla tua stazione di lavoro. Cliccando con il tasto destro del mouse sulla voce PostGIS nell’albero, potrai
specificare i parametri di connessione per una nuova connessione.

18.1.2 Follow Along: Aggiungi un insieme filtrato di record come un Layer

Ora che hai visto come aggiungere un’intera tabella come layer QGIS, può essere utile imparare come aggiungere
un insieme filtrato di record da una tabella come layer usando le interrogazioni che abbiamo appreso nelle sezioni
precedenti.

• Avvia una nuova mappa vuota
• Clicca il pulsante Aggiungi layer PostGIS o seleziona Layer ► Aggiungi layer PostGIS… dal menu.
• Nella finestra di dialogo Aggiungi tabella(e) PostGIS connetti postgis_demo.
• Espandi il public schema e dovresti trovare le tre tabelle con cui stavamo lavorando in precedenza.
• Fai clic sul layer lines per selezionarlo, ma invece di aggiungerlo, fai clic sul pulsante Imposta filtro per far
apparire la finestra di dialogo Costruttore di Interrogazioni.

• Costruisci la seguente espressione usando i pulsanti o inserendola direttamente:

"roadtype" = 'major'
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• Clicca su OK per completare la creazione del filtro e clicca su :guilabel: Aggiungi per aggiungere il layer filtrato
alla tua mappa.

• Rinomina il layer lines nell’albero a roads_primary.
Noterai che solo le Primary Roads sono state aggiunte alla tua mappa piuttosto che l’intero layer.

18.1.3 In Conclusion

Hai visto come interagire con i database spaziali usando il Browser di QGIS e come aggiungere layer alla tua mappa
sulla base di una query di filtraggio.
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18.1.4 What’s Next?

Successivamente vedrai come lavorare con l’interfaccia DBManager in QGIS per una serie più completa di operazioni
di gestione del database.

18.2 Lesson: Utilizzo di DB Manager per lavorare con i Database
Spaziali in QGIS

Abbiamo già visto come eseguire molte operazioni sui database con QGIS così come con altri strumenti, ma ora è il
momento di guardare lo strumento DB Manager che fornisce molte di queste stesse funzionalità così come strumenti
di gestione più avanzati.
Obiettivo di questa lezione: Imparare a interagire con i database spaziali usando il QGIS DB Manager.

18.2.1 Follow Along: Gestione dei database PostGIS con DB Manager

Dovresti prima aprire l’interfaccia DB Manager selezionando Database –> DB Manager… nel menu o selezionando
l’icona DB Manager sulla barra degli strumenti.

Dovresti già vedere le connessioni precedenti che abbiamo configurato ed essere in grado di espandere la sezione
myPG e il suo schema public per vedere le tabelle con cui abbiamo lavorato nelle sezioni precedenti.
La prima cosa che puoi notare è che ora puoi vedere alcuni metadati sugli schemi contenuti nel tuo database.
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Gli schemi sono un modo di raggruppare tabelle di dati e altri oggetti in un database PostgreSQL e un contenitore
per permessi e altri vincoli. La gestione degli schemi PostgreSQL va oltre lo scopo di questo manuale, ma si possono
trovare maggiori informazioni su di essi in PostgreSQL documentation on Schemas. Puoi usare il DB Manager per
creare nuovi schemi, ma avrai bisogno di usare uno strumento come pgAdmin III o l’interfaccia a riga di comando
per gestirli efficacemente.
DB Manager può anche essere usato per gestire le tabelle all’interno del tuo database. Abbiamo già visto vari modi
per creare e gestire tabelle nella linea di comando, ma ora vediamo come fare questo in DB Manager.
Per prima cosa, è utile guardare i metadati di una tabella cliccando sul suo nome nell’albero e consultando la scheda
Informazioni.

In questo pannello puoi vedere le Informazioni generali sulla tabella così come le informazioni che l’estensione PostGIS
ha riguardo alla geometria e al sistema di riferimento spaziale.
Se scorri verso il basso nella scheda Info, puoi vedere più informazioni su Fields, Constraints e Indexes per la tabella
che stai visualizzando.
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È anche molto comodo utilizzare DB Manager per guardare semplicemente i record nel database più o meno nello
stessomodo in cui si potrebbe fare visualizzando la tabella degli attributi di un layer nell’albero dei layer. Puoi sfogliare
i dati selezionando la scheda Table.
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C’è anche una scheda Anteprima che ti mostrerà i dati del layer in un’anteprima della mappa.
Cliccando con il tasto destro su un layer nell’albero e cliccando su Aggiungi alla Mappa aggiungerai questo layer alla
tua mappa.
Finora abbiamo solo visualizzato il database, i suoi schemi e le sue tabelle e i suoi metadati, ma cosa succederebbe
se volessimo alterare la tabella per aggiungere una colonna aggiuntiva, ad esempio? DB Manager vi permette di farlo
direttamente.

1. Seleziona la tabella che vuoi modificare nell’albero
2. Seleziona :Tabella –> Modifica Tabella dal menu, per aprire la finestra di dialogo Proprietà Tabella.
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Puoi usare questa finestra di dialogo per Aggiungere Colonne, aggiungere Colonne Geometria, modificare colonne
esistenti o rimuovere completamente una colonna.
Utilizzando la scheda Vincoli, puoi gestire quali campi vengono utilizzati come chiave primaria o eliminare i vincoli
esistenti.

18.2. Lesson: Utilizzo di DB Manager per lavorare con i Database Spaziali in QGIS 675



QGIS Training Manual

La scheda Indici può essere usata per aggiungere e cancellare sia indici spaziali che normali.

676 Capitolo 18. Module: Usare i database spaziali in QGIS



QGIS Training Manual

18.2.2 Follow Along: Creare una Nuova Tabella

Ora che abbiamo esaminato il processo di lavoro con le tabelle esistenti nel nostro database, usiamo DBManager per
creare una nuova tabella.

1. Se non è già aperta, apri la finestra DB Manager ed espandi l’albero finché non vedi la lista delle tabelle già
presenti nel tuo database.

2. Dal menu seleziona Tabella –> Crea Tabella per far apparire la finestra di dialogo Crea Tabella.
3. Usa lo schema predefinito Public e denomina la tabella places.
4. Aggiungi i campi id, place_name e elevation come mostrato qui sotto
5. Assicurati che il campo id sia impostato come chiave primaria.
6. Fai clic sulla casella di controllo di Crea colonna geometria e assicurati che sia impostata su tipo POINT e

lascia il nome geom e specifica 4326 come SR.
7. Fai clic sulla casella di controllo Crea indice spaziale e fai clic su Crea per creare la tabella.

18.2. Lesson: Utilizzo di DB Manager per lavorare con i Database Spaziali in QGIS 677



QGIS Training Manual

8. Chiudi la finestra di dialogo per sapere che la tabella è stata creata e fai clic su :guilabel:`Chiudi`per chiudere
la finestra di dialogo Crea tabella.

Ora puoi ispezionare la tua tabella nel DB Manager e ovviamente scoprirai che non ci sono dati al suo interno. Da
qui puoi Attiva Modifiche sul menu del layer e iniziare ad aggiungere posti alla tua tabella.

18.2.3 Follow Along: Gestione di base del database

Il DBManager ti permetterà anche di fare alcune attività di base per l’amministrazione del database. Non è certamente
un sostituto per uno strumento più completo per l’amministrazione del database, ma fornisce alcune funzionalità che
puoi usare per gestire il tuo database.
Le tabelle dei database possono spesso diventare piuttosto grandi e le tabelle che vengono modificate frequentemente
possono finire per lasciare in giro residui di record che non sono più necessari a PostgreSQL. Il comando VACUUM
si occupa di fare una sorta di pulizia per compattare e facoltativamente analizzare le tue tabelle per migliorare le
prestazioni.
Diamo un’occhiata a come possiamo eseguire un comando VACUUM ANALYZE dall’interno di DB Manager.

1. Seleziona una delle tue tabelle nell’albero del DB Manager
2. Seleziona Tabella ► Avvia Vacuum dal menu

PostgreSQL ora eseguirà l’operazione. A seconda di quanto è grande la tua tabella, questo potrebbe richiedere del
tempo per essere completato.
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Puoi trovare maggiori informazioni sul processo VACUUM ANALYZE nella PostgreSQL Documentation on
VACUUM ANALYZE.

18.2.4 Follow Along: Esecuzione di query SQL con DB Manager

DB Manager fornisce anche un modo per scrivere query sulle tabelle del tuo database e per visualizzare i risultati.
Abbiamo già visto questo tipo di funzionalità nel pannello Browser, ma vediamo di nuovo qui con DB Manager.

1. Seleziona la tabella lines nell’albero.
2. Seleziona il pulsante Finestra SQL nella barra degli strumenti di DB Manager.

3. Componi la seguente SQL query nello spazio fornito:

select * from lines where roadtype = 'major';

4. Fai clic sul pulsante Esegui (F5) per eseguire la query.
5. Ora dovresti vedere i record che corrispondono nel pannello Risultati.

6. Fai clic sulla casella di controllo per Carica come nuovo layer per aggiungere i risultati alla mappa.
7. Seleziona la colonna id come Colonna con valori univoci e la colonna geom come Colonna Geometria.
8. Immetti roads_primary come Nome vettore (prefisso).

18.2. Lesson: Utilizzo di DB Manager per lavorare con i Database Spaziali in QGIS 679

https://www.postgresql.org/docs/9.1/sql-vacuum.html
https://www.postgresql.org/docs/9.1/sql-vacuum.html


QGIS Training Manual

9. Fai clic su Carica per caricare i risultati come nuovo layer nella mappa.

I layer che corrispondono alla tua query sono ora visualizzati sulla tua mappa. Naturalmente puoi usare questo
strumento di interrogazione per eseguire qualsiasi comando SQL arbitrario, inclusi molti di quelli che abbiamo visto
nei moduli e nelle sezioni precedenti.

18.2.5 Importare dati in un database con DB Manager

Abbiamo già visto come importare dati in un database spaziale usando strumenti a linea di comando, ora impariamo
come usare DB Manager per fare importazioni.

1. Fai clic sul pulsante Importa layer/file sulla barra degli strumenti nella finestra di dialogo DB Manager.

2. Seleziona il file urban_33S.shp da exercise_data/projected_data come set di dati di input
3. Fai clic sul pulsante Aggiorna opzioni per precompilare alcuni dei valori del modulo.
4. Assicurati che l’opzione :guilabel:”Crea nuova tabella” sia selezionata
5. Specifica il SR sorgente come 32722 e il SR di destinazione come 4326
6. Abilita la casella di controllo su Crea indice spaziale
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7. Fai clic su OK per eseguire l’importazione

8. Abbandona la finestra di dialogo che ti fa sapere che l’importazione ha avuto successo
9. Fai clic sul pulsante Aggiorna sulla barra degli strumenti di DB Manager
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Ora puoi ispezionare la tabella nel database facendo clic su di essa nell’albero. Verifica che i dati siano stati riproiettati
controllando che Riferimento spaziale sia elencato comeWGS 84 (4326)`.

Cliccando con il tasto destro sulla tabella nell’albero e selezionando Aggiungi alla mappa, la tabella verrà aggiunta
come layer nella tua mappa.

18.2.6 Esportare dati da un database con DB Manager

Naturalmente DB Manager può anche essere usato per esportare dati dai vostri database spaziali, quindi diamo
un’occhiata a come si fa.

1. Seleziona il layer lines nella gerarchia e clicca sul pulsante Esporta su File sulla barra degli strumenti per
aprire la finestra di dialogo Export to vector file.

2. Fai clic sul pulsante … per selezionare il Output file e salvare i dati nella cartella exercise_data come
urban_4326.

3. Imposta SR di destinazione come “”4326””.
4. Fai clic su OK per inizializzare l’esportazione.
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5. Chiudi la finestra di dialogo che ti informa che l’esportazione ha avuto successo e chiudi il DB Manager.
Ora puoi ispezionare lo shapefile che hai creato con il pannello Browser.
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18.2.7 In Conclusion

Ora hai visto come usare l’interfaccia DB Manager in QGIS per gestire i tuoi database spaziali, per eseguire query
SQL sui tuoi dati e come importare ed esportare dati.

18.2.8 What’s Next?

Di seguito, vedremo come usare molte di queste stesse tecniche con i database SpatiaLite.

18.3 Lesson: Lavorare con i database SpatiaLite in QGIS

Mentre PostGIS è generalmente usato su un server per fornire funzionalità di database spaziale a più utenti allo stesso
tempo, QGIS supporta anche l’uso di un formato di file chiamato SpatiaLite che è un modo leggero e portatile per
memorizzare un intero database spaziale in un singolo file. Ovviamente, questi 2 tipi di database spaziali dovrebbero
essere usati per scopi diversi, ma gli stessi principi e tecniche di base si applicano ad entrambi. Creiamo un nuovo
database SpatiaLite ed esploriamo le funzionalità fornite per lavorare con questi database in QGIS.
Obiettivo di questa lezione: Imparare come interagire con i database di SpatiaLite usando l’interfaccia QGIS
Browser.

18.3.1 Follow Along: Creare un database SpatiaLite con il Browser

Usando il pannello Browser, possiamo creare un nuovo database SpatiaLite e configurarlo per l’uso in QGIS.
1. Fai clic destro sulla voce SpatiaLite nell’albero del Browser e seleziona Crea Database.
2. Specifica dove vuoi memorizzare nel tuo disco il file e denominalo qgis-sl.db.
3. Ancora una volta fai clic destro sulla voce SpatiaLite nell’albero del Browser e ora seleziona la voce Nuova

Connessione. Trova il file che hai creato nell’ultimo passo e aprilo.
Adesso che il database è configurato puoi notare che la voce nell’albero del Browser non ha niente sotto di sé e che
l’unica cosa che si può fare a questo punto è cancellare la connessione. Ovviamente questo è dovuto al fatto che
nessuna tabella è stata aggiunta al database. Procediamo con questa operazione.

1. Trova il pulsante per creare un nuovo layer e usa il menu a tendina per creare un nuovo layer SpatiaLite, o
seleziona Layer ► Nuovo ► Nuovo Layer SpatiaLite.

2. Seleziona il database creato in precedenza dal menu a tendina.
3. Dai al layer il nome places.
4. Seleziona la casella di controllo vicino a Crea un chiave primaria autoincrementale.
5. Aggiungi due attributi come mostrato di seguito
6. Clic su OK per creare la tabella.
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7. Fai clic sul pulsante di aggiornamento nella parte superiore del Browser e ora dovresti vedere la tua tabella dei
places elencata.
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Puoi fare clic con il tasto destro sulla tabella e vedere le sue proprietà come già fatto nell’esercizio precedente.
Da qui puoi iniziare la sessione di modifica ed aggiungere direttamente dati al nuovo database.
Abbiamo appreso anche come importare dati in un database usando il DB Manager e tu puoi usare questa stessa
tecnica per importare dati nel tuo nuovo SpatiaLite DB.

18.3.2 In Conclusion

Hai visto come creare database SpatiaLite, aggiungere tabelle ad essi e usare queste tabelle come layer in QGIS.
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Appendice: Contribuire a questo Manuale

Per aggiungere materiali a questo corso, è necessario seguire le linee guida in questa Appendice. Non dovete
modificare le condizioni in questa Appendice se non per chiarimenti. Questo per garantire che la qualità e la coerenza
di questo manuale possano essere mantenute.

19.1 Scaricare Risorse

La fonte di questo documento è disponibile su GitHub. Consultare GitHub.com per istruzioni su come utilizzare il
sistema git di controllo della versione.

19.2 Formato del Manuale

Questo manuale è stato scritto utilizzando Sphinx, un generatore di documenti Python che utilizza il linguaggio di
markup reStructuredText. Le istruzioni per l’uso di questi strumenti sono disponibili sui rispettivi siti.

19.3 Aggiungere un Modulo

• Per aggiungere un nuovo modulo, crea prima una nuova cartella (direttamente sotto il livello superiore della
cartella qgis-training-manual) con il nome del nuovo modulo.

• In questa nuova cartella, crea un file chiamato index.rst. Lascia vuoto questo file per ora.
• Apri il file index.rst nella cartella di primo livello. Le sue prime righe sono:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index

Noterai che questo è un elenco di nomi di cartelle, seguito dal nome : kbd:index. Ciò indirizza il file di indice di
primo livello ai file di indice in ciascuna cartella. L’ordine in cui sono elencati determina l’ordine che avranno nel
documento.
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• Aggiungi il nome del tuo nuovo modulo (cioè il nome che hai dato alla nuova directory), seguito da /index,
a questo elenco, ovunque vuoi che il tuo modulo appaia.

• Ricordati di mantenere logico l’ordine dei moduli, in modo tale che i moduli successivi si basino sulla
conoscenza presentata nei moduli precedenti.

• Apri il file indice del tuo nuovo modulo (: kbd: [nome modulo] / index.rst).
• Nella parte superiore della pagina, scrivi una riga di 80 asterischi (*). Questo rappresenta un’intestazione del
modulo.

• Seguita da una riga contenente la frase di markup |MOD| (che sta per «module»), seguita dal nome del tuo
modulo.

• Termina con un’altra riga di 80 asterischi.
• Lascia una linea aperta sotto questo.
• Scrivi un breve paragrafo che spieghi lo scopo e il contenuto del modulo.
• Lascia una riga aperta, quindi aggiungi il testo seguente:

.. toctree::
:maxdepth: 2

lesson1
lesson2

… dove lesson1,:kbd:lesson2, ecc. sono i nomi delle lezioni pianificate.
Il file di indice a livello di modulo sarà simile a questo:

*******************************************************************************
|MOD| Module Name
*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

19.4 Aggiungere una Lezione

Aggiungere una lezione ad un nuovo o esistente modulo:
• Apri la directory del modulo.
• Apri il file index.rst (creato sopra nel caso di nuovi moduli).
• Assicurati che il nome della lezione pianificata sia elencato sotto la direttiva toctree, come mostrato sopra.
• Crea un nuovo file nella cartella del modulo.
• Assegna un nome a questo file esattamente come il nome fornito nel file index.rst del modulo e aggiungi
l’estensione .rst.

Nota: Per scopi di modifica, un file .rst funziona esattamente come un normale file di testo (.txt)

• Per iniziare a scrivere la lezione, scrivi la frase di markup |LS|, seguita dal nome della lezione.
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• Nella riga successiva, scrivi una riga di 80 segni di uguale (=).
• Lascia una linea aperta dopo questo.
• Scrivi una breve descrizione dello scopo previsto della lezione.
• Includi un’introduzione generale all’argomento. Vedere le lezioni esistenti in questo manuale per esempi.
• Sotto questo, inizia un nuovo paragrafo, iniziando con questa frase:

**The goal for this lesson:**

• Spiega brevemente il risultato previsto dal completamento di questa lezione.
• Se non riesci a descrivere l’obiettivo della lezione in una o due frasi, valuta la possibilità di suddividere
l’argomento in più lezioni.

Ogni lezione sarà suddivisa in più sezioni, che verranno affrontate successivamente.

19.5 Aggiungere una Sezione

Esistono due tipi di sezioni: «seguire» e «prova tu stesso».
• Una sezione «seguire» è un insieme dettagliato di istruzioni intese a insegnare al lettore come utilizzare un dato
aspetto di QGIS. Questo viene in genere fatto fornendo indicazioni clic-by-clic il più chiaramente possibile,
intervallate da screenshot.

• Una sezione «prova tu stesso» offre al lettore un breve compito per provare da solo. Di solito è associata a
una voce nel foglio delle risposte alla fine della documentazione, che mostrerà o spiegherà come completare il
compito e mostrerà il risultato atteso se possibile.

Ogni sezione ha un livello di difficoltà. Una sezione facile è indicata da |basic|, moderata da |moderate| e
avanzata da |hard|.

19.5.1 Aggiungere una sezione «seguire»

• Per iniziare questa sezione, scrivi la frase di markup del livello di difficoltà previsto (come mostrato sopra).
• Lascia uno spazio e scrivi |FA| (per «seguire»).
• Lascia un altro spazio e scrivi il nome della sezione (usa solo una lettera maiuscola iniziale, così come le
maiuscole per i nomi propri).

• Nella riga successiva, scrivi una riga di 80 meno/trattini (-). Assicurati che il tuo editor di testo non sostituisca
il carattere meno/trattino predefinito con un trattino lungo o un altro carattere.

• Scrivi una breve introduzione alla sezione, spiegandone lo scopo. Quindi fornisci istruzioni dettagliate (clic per
clic) sulla procedura da seguire.

• In ogni sezione, includie link interni, link esterni e screenshot secondo necessità.
• Cerca di terminare ogni sezione con un breve paragrafo che la concluda e conduca naturalmente alla sezione
successiva, se possibile.
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19.5.2 Aggiungere una sezione «prova tu stesso»

• Per iniziare questa sezione, scrivi la frase di markup del livello di difficoltà previsto (come mostrato sopra).
• Lascia uno spazio e scrivi |TY| (per «prova tu stesso»).
• Nella riga successiva, scrivi una riga di 80 meno/trattini (-). Assicurati che il tuo editor di testo non sostituisca
il carattere meno/trattino predefinito con un trattino lungo o un altro carattere.

• Spiega l’esercizio che vuoi che il lettore completi. Se necessario, fai riferimento alle sezioni, lezioni o moduli
precedenti.

• Includi screenshot per chiarire i requisiti se una semplice descrizione testuale non è chiara.
Nella maggior parte dei casi, vorresti fornire una risposta su come completare il compito fornito in questa sezione.
Per fare ciò, dovrai aggiungere una voce nel modulo delle risposte.

• Per prima cosa, decidi un nome univoco per la risposta. Idealmente, questo nome includerà il nome della lezione
e un numero crescente.

• Crea un collegamento per questa risposta:

:ref:`Check your results <answer-name>`

• Apri il modulo delle risposte (answer/answer.rst).
• Crea un collegamento alla sezione «prova tu stesso» scrivendo questa riga:

.. _answer-name:

• Scrivi le istruzioni su come completare il compito, utilizzando link e immagini dove necessario.
• Per terminare, includi un link alla sezione «prova tu stesso» scrivendo questa riga:

:ref:`Back to text <backlink-answer-name>`

• Per far funzionare questo collegamento, aggiungi la seguente riga sopra l’intestazione alla sezione «prova tu
stesso»:

.. _backlink-answer-name:

Ricorda che ognuna di queste righe mostrate sopra deve avere una riga vuota sopra e sotto di essa, altrimenti potrebbe
causare errori durante la creazione del documento.

19.6 Aggiungere una conclusione

• Per terminare una lezione, scrivi la frase |IC| per «in conclusione», seguita da una nuova riga di 80
meno/trattini (-). Scrivi una conclusione per la lezione, spiegando quali concetti sono stati trattati nella lezione.

19.7 Aggiungere un’ulteriore sezione di lettura

• Questa sezione è facoltativa.
• Scrivi la frase FR per «ulteriori letture», seguita da una nuova riga di 80 meno / trattini (-).
• Includi collegamenti a siti Web esterni appropriati.
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19.8 Aggiungere una Sezione Cosa c’è Dopo

• Scrivi la frase |WN| per «cosa c’è dopo», seguita da una nuova riga di 80 meno/trattini (-).
• Spiega come questa lezione ha preparato gli studenti per la lezione o il modulo successivo.
• Ricordati di cambiare la sezione «cosa c’è dopo» della lezione precedente, se necessario, inmodo che si riferisca
alla tua nuova lezione. Ciò sarà necessario se hai inserito una nuova lezione tra lezioni esistenti o dopo una
lezione esistente.

19.9 Usare Markup

Per aderire agli standard di questo documento, dovrai aggiungere un markup standard al tuo testo.

19.9.1 Nuovi concetti

• Se stai spiegando un nuovo concetto, dovrai scrivere il nome del nuovo concetto in corsivo racchiudendolo tra
asterischi (*).

This sample text shows how to introduce a *new concept*.

19.9.2 Enfasi

• Per enfatizzare un termine cruciale che non è un nuovo concetto, scrivi il termine in grassetto racchiudendolo
tra doppi asterischi (**).

• Usalo con parsimonia! Se usato troppo, può sembrare al lettore che tu stia gridando o sei troppo esigente.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 Immagini

• Quando aggiungi un’immagine, salvala nella cartella _static/lesson_name/.
• Includila nel documento in questo modo:

.. figure:: img/image_file.extension
:align: center

• Ricordati di lasciare una linea aperta sopra e sotto il markup dell’immagine.

19.9.4 Collegamenti interni

• Per creare un ancoraggio per un collegamento, scrivi la riga seguente sopra il punto in cui desideri che il
collegamento punti:

.. _link-name:

• Per creare un collegamento, aggiungi questa linea:

:ref:`Descriptive link text <link-name>`

• Ricordati di lasciare una linea aperta sopra e sotto questa linea.
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19.9.5 Collegamenti Esterni

• Per creare un collegamento esterno, scrivilo in questo modo:

`Descriptive link text <link-url>`_

• Ricordati di lasciare una linea aperta sopra e sotto questa linea.

19.9.6 Usare testo monospazio

• Quando scrivi del testo che l’utente deve inserire, un nome di percorso o il nome di un elemento del database
come il nome di una tabella o di una colonna, devi scriverlo in monospaced text. Per esempio:

Enter the following path in the text box: :kbd:`path/to/file`.

19.9.7 Etichettare gli elementi della GUI

• Se ti riferisci a un elemento della GUI, come un pulsante, devi scrivere il suo nome in the GUI label format.
Per esempio:

To access this tool, click on the :guilabel:`Tool Name` button.

• Questo vale anche se stai citando il nome di uno strumento senza richiedere all’utente di fare clic su un pulsante.

19.9.8 Selezione Menu

• Se stai guidando un utente attraverso i menu, devi usare menu ► selection ► format. Per esempio:

To use the :guilabel:`Tool Name` tool, go to :menuselection:`Plugins -->
Tool Type --> Tool Name`.

19.9.9 Aggiunta di note

• Potresti aver bisogno di una nota nel testo, che spieghi dettagli extra che non possono essere facilmente inseriti
nel flusso della lezione. Questo è il markup:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]
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19.9.10 Aggiunta di una nota di sponsorizzazione/paternità

Se stai scrivendo un nuovo modulo, lezione o sezione per conto di uno sponsor, devi includere un breve messaggio
dello sponsor a sua scelta. Questo deve notificare al lettore il nome dello sponsor e deve apparire sotto l’intestazione
del modulo, della lezione o della sezione che ha sponsorizzato. Tuttavia, dovrebbe non sembrare una pubblicità per
la loro azienda.
Se ti sei offerto volontario per scrivere un modulo, una lezione o una sezione a tuo piacimento e non per conto di
uno sponsor, puoi includere una nota sull’autore sotto l’intestazione del modulo, della lezione o della sezione che
hai creato. Deve assumere la forma Questo [module/lesson/section] contribuito da [nome
dell'autore]. Non aggiungere ulteriore testo, dettagli di contatto, ecc. Tali dettagli devono essere aggiunti
nella sezione «Contributors» della Prefazione, insieme al nome(i) della parte(i) che hai aggiunto. Se hai apportato
solo miglioramenti, correzioni e / o aggiunte, elenca te stesso come editore.

19.10 Grazie!

Grazie per aver contribuito a questo progetto! In questo modo, stai rendendo QGIS più accessibile agli utenti e
aggiungendo valore al progetto QGIS nel suo complesso.
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Preparazione dei dati per le esercitazioni

Nota: Questa procedura è destinata agli organizzatori dei corsi o agli utenti più esperti di QGIS che desiderano creare
set di dati campione locali per il loro corso. I set di dati predefiniti sono forniti con il Manuale di formazione, ma si
possono seguire queste istruzioni se si desidera sostituire i set di dati predefiniti.

Il sample data provided con il Manuale di Formazione si riferisce alla città di Swellendam e ai suoi dintorni.
Swellendam si trova a circa 2 ore a est di Cape Town, nel Cape Western del Sudafrica. Il set di dati contiene nomi di
elementi sia in Inglese che in Afrikaans.
Chiunque può usare questo dataset senza difficoltà, ma potresti preferire usare dati del tuo paese o della tua città. Se
tu scegli di fare così, i tuoi dati georeferenziati verranno usati in tutte le lezioni dal Modulo 3 al Modulo 7.2. I moduli
successivi usano sorgenti di dati più complessi che potrebbero essere o non essere disponibili per la tua regione.

Nota: Queste istruzioni presuppongono che tu abbia una buona conoscenza di QGIS e non sono finalizzate ad essere
usate come materiale di insegnamento.

20.1 Try Yourself Creare file vettoriali basati su OSM

Se desideri sostituire i dati predefiniti con i dati georeferenziati del tuo corso, questo può essere facilmente fatto con
gli strumenti disponibili in QGIS. La regione che tu scegli di usare dovrebbe avere un buon insieme di aree rurali ed
urbane, contenere strade di livello diverso, aree con confini (quali riserve naturali o fattorie) e superfici con acqua,
quali corsi d’acqua e fiumi.

1. Apri un nuovo progetto QGIS
2. Seleziona Layer ► Gestore delle Sorgenti Dati per aprire la finestra di dialogo Data Source Manager

3. Nella scheda Browser, espandi il menu a discesa XYZ Tiles e fai doppio clic sulla voce OpenStreetMap.
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Una mappa del mondo è ora visibile sull’area di visualizzazione della mappa.
4. Chiudi la finestra di dialogo Data Source Manager

5. Spostati nell’area che vorresti usare come area di studio

Ora che abbiamo l’area da cui estrarre i dati, abilitiamo gli strumenti di estrazione.
1. Vai a Plugins ► Gestisci ed Installa Plugin…

2. Nella scheda Tutto, digita QuickOSM nella casella di ricerca
3. Seleziona il plugin QuickOSM, premi Installa Plugin e poi Chidi la finestra di dialogo.
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4. Esegui il nuovo plugin dal menu Vettore ► QuickOSM ► QuickOSM…

5. Nella scheda Richiesta rapida, seleziona building nel menu a discesa Key.
6. Lascia il campo Value vuoto, significa che stai cercando tutti gli edifici.
7. Seleziona Canvas Extent nel menu a discesa successivo
8. Espandi il gruppo Advanced in basso e deseleziona tutti i tipi di geometria sulla destra tranne Multipolygons.
9. Premi Run query

Un nuovo layer building viene aggiunto al pannello Layer, mostrando gli edifici nell’estensione selezionata.
10. Procedi come sopra per estrarre altri dati:

1. Key = landuse e tipo geometria Multipolygons.
2. Key = boundary, Value = protected_area e tipo geometria Multipolygons.
3. Key = natural, Value = water e tipo geometria Multipolygons.
4. Key = highway e scelta tipi geometria Lines e Multilines.
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5. Key = waterway, Value = river e scelta tipi geometria Lines e Multilines.
6. Key = place e tipo geometria Points.

Questo processo aggiunge i layer come file temporanei (indicati dall’icona accanto al loro nome).

Puoi esaminare i dati che la tua regione contiene per vedere che tipo di risultati offre la tua regione.
Ora abbiamo bisogno di salvare i dati risultanti da utilizzare durante il corso. Useremo i formati ESRI Shapefile,
GeoPackage e SpatiaLite a seconda dei dati.
Per convertire il layer temporaneo place in un altro formato:

1. Fai clic sull’icona accanto al layer place per aprire la finestra di dialogo Salva Layer Temporaneo.

Nota: Se hai bisogno di cambiare qualsiasi proprietà del layer temporaneo (SR, estensione, campi…), usa
invece il menu contestuale Esporta ► Salva con Nome… e assicurati che l’opzione Aggiungi il file salvato alla
mappa sia selezionata. Questo aggiunge un nuovo layer.

2. Seleziona il formato ESRI Shapefile

3. Usa il pulsante… per navigare nella cartellaexercise_data/shapefile/ e salva il file comeplaces.
shp.
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4. Premi OK
Nel pannello Layer, il layer temporaneo place viene sostituito con il layer shapefile salvato places e l’icona
temporanea accanto ad esso viene rimossa.

5. Fai doppio clic sul layer per aprire la sua scheda :menuselection: Proprietà Layer –> Sorgente e aggiorna la
proprietà Nome layer per farla corrispondere al nome del file.

6. Ripeti il processo per gli altri layer, rinominandali come segue:
• natural_water in water
• waterway_river in rivers
• boundary_protected_area in protected_areas

Tutti i data set risultati devono essere salvati nella cartella exercise_data/shapefile/.
The next step is to create a GeoPackage file from the building layer to use during the course:

1. Clicca sull’icona accanto al layer building
2. Seleziona il formato GeoPackage

3. Salva il file come training_data.gpkg nella cartella exercise_data/
4. Per impostazione predefinita, il Layer name è riempito con il nome del file. Sostituiscilo con buildings.
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5. Premi OK
6. Rinomina il layer nella sua finestra di dialogo Proprietà
7. Ripeti il processo con il layer highway, salvandolo come roads nello stesso database GeoPackage.

L’ultimo punto è salvare il file temporaneo ancora rimasto come file SpatiaLite.

1. Fai clic sull’icona vicina al layer landuse
2. Seleziona il formato SpatiaLite

3. Salva il file come landuse.sqlite nella cartella exercise_data/. Per opzione predefinita, il Layer
name viene definito com il nome del file . Non cambiarlo.
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4. Premi OK
Ora dovresti avere una mappa che assomiglia a questa (la simbologia sarà certamente molto diversa, perché QGIS
assegna casualmente i colori quando i layer vengono aggiunti alla mappa):

L’importante è che tu abbia 7 layer vettoriali corrispondenti a quelli mostrati sopra e che tutti questi layer abbiano
dei dati.
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20.2 Try Yourself Creare file tiff SRTM DEM

Il programma successivo Per i moduli Modulo: Creazione Dati Vettoriali e Modulo: Raster, avrai anche bisogno di
immagini raster (SRTM DEM) che coprano la regione che hai selezionato per il tuo corso.
Il CGIAR-CGI fornisce alcuni DEM SRTM che puoi scaricare da https://srtm.csi.cgiar.org/srtmdata/.
Avrai bisogno di immagini che coprano l’intera regione che hai scelto di utilizzare. Per trovare le coordinate di
estensione, in QGIS , zooma sull’estensione del layer più grande e prendi i valori nella casella Estensione
della barra di stato. Mantieni il formato GeoTiff. Una volta compilato il modulo, clicca sul pulsante Clicca qui per
iniziare la ricerca >> e scarica il file(i).
Una volta che hai scaricato il file (i files) richiesto, dovranno essere salvati nella cartellaexercise_data, all’interno
delle sottocartelle raster/SRTM.

20.3 Try Yourself Creare file di immagini tiff

Nel modulo Modulo: Creazione Dati Vettoriali, la lezione ��� Passo dopo passo: Sorgenti Dati mostra immagini
ravvicinate di tre campi sportivi scolastici che gli studenti devono digitalizzare. Avrai quindi bisogno di riprodurre
queste immagini usando il tuo nuovo file(i) tiff SRTM DEM. Non c’è l’obbligo di usare i campi sportivi scolastici:
qualsiasi tipo di uso del suolo scolastico può essere usato (per esempio diversi edifici scolastici, campi da gioco o
parcheggi).
Per riferimento, l’immagine nei dati di esempio è:

702 Capitolo 20. Preparazione dei dati per le esercitazioni

https://srtm.csi.cgiar.org/
https://srtm.csi.cgiar.org/srtmdata/


QGIS Training Manual

20.4 Try Yourself Sostituire i token

Dopo aver creato il set di dati in italiano, il passo finale consiste nel sostituire i token nel file substitutions.txt
in modo che i nomi appropriati appaiano nella versione tradotta del Manuale di formazione.
I token che devi sostituire sono i seguenti:

• majorUrbanName: il valore predefinito è «Swellendam». Sostituiscilo con il nome della città principale della
tua regione.

• schoolAreaType1: questo è di default «campo di atletica». Sostituiscilo con il nome del tipo di area
scolastica più grande della tua regione.

• largeLandUseArea: il valore predefinito è «Bontebok National Park». Sostituiscilo con il nome di un
grande poligono uso del suolo nella tua regione.

• srtmFileName: questo è di default srtm_41_19.tif. Sostituiscilo con il nome del tuo file SRTMDEM.
• localCRS: questo è predefinito in WGS 84 / UTM 34S. Dovresti sostituirlo con il SR corretto per la tua
regione.

20.4. Try Yourself Sostituire i token 703
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